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1 What’s New in This Release

What’s New in Siebel Object Types Reference, 2018
No new features have been added to this guide for this release. This guide has been updated to 
reflect only product name changes.

NOTE: Siebel 2018 is a continuation of the Siebel 8.1/8.2 release 

What’s New in Siebel Object Types Reference, Siebel Innovation Pack 
2017, Rev. A
This guide has been updated to correct or remove obsolete product and component terms.

NOTE: Siebel Innovation Pack 2017 is a continuation of the Siebel 8.1/8.2 release.
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2 Overview of Using Siebel Object 
Types Reference

This chapter describes an overview of Siebel Object Types Reference. It includes the following topics:

■ Conventions This Book Uses to Describe Object Types on page 13

■ Common Object Properties on page 15

■ Object Types That You Must Not Modify on page 18

■ Alphabetic List of Object Types on page 20

Conventions This Book Uses to Describe Object Types
This book uses the following conventions:

■ Each object type includes a table that describes the properties that the object type includes. The 
Property column in these tables includes one of the following values:

■ (R) Required. You must include a value for this property.

■ (O) Optional. You are not required to include a value for this property.

■ (S) System. Siebel CRM creates a value that you cannot modify.

■ (H) Hidden. Identifies object types and properties that the Siebel Web Client does not use. 
Siebel CRM hides these items in the client and does not display them in the Object Explorer 
in Siebel Tools. If Siebel CRM hides an object type, then it also hides the properties of this 
object type. To display these hidden items and other object types in the Object Explorer, see 
the topic about displaying object types in Using Siebel Tools.

■ If you spell an object name, then you must use the same spelling that this book uses for this 
object name.

■ A constant is case-sensitive. You typically use all uppercase characters to spell it. For example, 
TRUE or FALSE for a Boolean field.

A user is a person who uses the client of a Siebel Business Application to use Siebel CRM data.

The client is the client of a Siebel Business Application.

The server is the Siebel Server, unless noted otherwise.

An administrator is anyone who uses the administrative views in the client to configure Siebel CRM.

Computer font indicates a value you enter or text that Siebel CRM displays. For example:

This is computer font

A predefined object is an object that comes defined with Siebel CRM. The objects that Siebel Tools 
displays in the Object List Editor immediately after you install Siebel Tools and the Siebel runtime 
repository but before you make any customizations are predefined objects.
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Siebel Tools can display the value for the property of an object type in one of the following ways:

■ Statically in a dropdown list or dialog box.

■ Dynamically in a dropdown list or dialog box.

■ Text entry.

■ With a check mark.

■ As a link.

To view the full list of values that you can use for most properties, you can click the dropdown list 
that Siebel Tools displays if you click anywhere in the value field of the property. This book does not 
describe every property value you can choose. It describes only the property values that require 
elaboration.

This book describes only reference information about object types. For information about how to use 
object types to configure Siebel CRM, see Configuring Siebel Business Applications.

Your Siebel Business Application might not include all the features that this documentation describes, 
depending on the software modules that your company purchases.

Differences That Exist Between the Properties Window and the Object 
List Editor
In most situations, the properties and values that Siebel Tools displays for an object definition in the 
Properties Window and the Object List Editor are identical. There are some differences:

■ The Properties Window sometimes uses an abbreviated label for a property. For example, the 
Properties Window uses Workflow Component while the Object List Editor uses Workflow Policy 
Component to describe the same property of the assignment attribute column object type.

■ The Properties Window might not include every property. For example, it does not include the 
Project property for some object types.

■ The Object List Editor might not include every property.

If differences exist, then this book describes Object List Editor usage unless noted otherwise.

Getting Help From Oracle
If you require help from Oracle for using object types, you can create a service request (SR) on My 
Oracle Support. Alternatively, you can phone Global Customer Support directly to create a service 
request or get a status update on your current SR. Support phone numbers are listed on My Oracle 
Support. You can also contact your Oracle sales representative for Oracle Advanced Customer 
Services to request assistance from Oracle's Application Expert Services.
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Common Object Properties
Table 1 describes object properties that are common for many different object types. Their meaning 
and usage is the same for these object types. If an object type includes a property that Table 1 
describes, then, for brevity, the table in this book that describes the properties for this object type 
might not include this property.

Table 1. Common Object Properties

Property Description

Application Code Reserved for future use.

Changed (S) If you edit a record, then Siebel Tools adds a check mark in the Changed 
property. This check mark indicates that you modified this object 
definition since the date and time that you specify in the General tab of 
the Development Options dialog box. If the Changed property does not 
include a check mark, then no modification has occurred. For more 
information, see Using Siebel Tools.

Comments (O) Includes text that describes the object definition. This text helps the 
developer to understand how Siebel CRM uses this property. It does not 
affect Siebel CRM functionality in any way. It is for documentation 
purposes only.

Description (S) Includes text that describes the object definition. This text helps the 
developer to understand how Siebel CRM uses this property. It does not 
affect Siebel CRM functionality in any way. It is for documentation 
purposes only.

GParent, GGParent (S) Specifies the name of the grandparent or great-grandparent object 
definition. Siebel Tools creates the value that this property contains. It 
displays this property only in the Object List Editor and only if you click 
the Flat tab in the Object Explorer.

ICL Upgrade Path (S) Identifies the releases that Siebel CRM sets for the Upgrade Behavior 
property to Preserve for ICL (Incorporate Custom Layout) user interface 
objects. For more information about ICL, see Siebel Database Upgrade 
Guide.

Inactive (O) If this property includes a check mark, then Siebel Tools does not 
compile this object definition when you deploy your changes to the 
Siebel runtime repository and it does not allow other objects to reference 
it.

Language Code (R) The abbreviation for the language that Siebel Tools uses for this object 
definition. For example, you can use the following value for U.S. English:

ENU

Module Reserved for future use.
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Object Language 
Locked

The abbreviation for the language that Siebel Tools uses for this locked 
object. For example, ENU for U.S. English. For more information about 
object and project locking, see Using Siebel Tools.

Object Locked If this property includes a check mark, then the object definition is 
locked.

Object Locked by Name Contains the user name of the developer who locked the object 
definition.

Object Locked Date Contains the date when the developer locked the object definition.

Parent Name, Parent 
object_defn_name (S)

Contains the parent name of the current object definition. Siebel Tools 
creates this value.

The Parent Business Component property of the Link object type is 
different from the parent property for other object types. If you create 
a new link object, then you must enter a value in the Parent Business 
Component property.

Project (R) Identifies the project that the object definition references.

Redo (O) Describes a single-level redo of a field modification or a record 
modification. The Locale Management Utility uses this property to track 
locale-specific modifications.

Repository Name (S) Identifies the repository that includes the object definition.

String Override (O) A language-independent override of the String Reference property. If a 
value exists in the String Reference property, then Siebel Tools uses this 
value instead of the value that the String Reference property contains.

Siebel Tools displays a string override as property_name-String 
Override. For example:

Display Name - String Override

String Reference (R) References a symbolic string. 

Siebel Tools displays a string reference as property_name-String 
Override. For example:

Display Name - String Override 

For example, the Title - String Reference property contains 
SBL_ACCOUNTS-1004224727-0H5 for the Account List Applet. This 
string reference references a symbolic string locale. The ENU string 
value for this locale is Accounts. 

Tooltip Text Obsolete. You must not use this property.

Translate (S) The Locale Management Utility uses this property to track modifications 
that occur to localization. This property is for Oracle use only.

Table 1. Common Object Properties

Property Description
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About the Scale and Precision Properties
The Scale property of an object type specifies the total number of digits that can exist to left and 
right of the decimal point for a numeric field:

■ A noninteger column can include a total of 22 digits.

■ An integer column can include a total of 10 digits.

For example, if the scale for a number is 6, and if the precision is 2, then this field can represent a 
number that uses the following format:

9999.99

The Precision property of an object type specifies the maximum number of digits that can exist to 
the right of the decimal point for a numeric field:

■ A numeric column can include a total of 7 digits to the right of the decimal point. 

■ An integer column cannot include any digits to the right of the decimal point.

Upgrade Ancestor (S) You can use this property to make sure that the Application Upgrader 
upgrades an object that you copy in the same way that it upgrades the 
original object. For example, assume you make a copy of the Account 
business component, and then name it ESG Account. You set the 
Upgrade Ancestor property of the ESG Account business component to 
Account. This value configures the Application Upgrader to upgrade the 
ESG Account business component in the same way that it upgrades the 
Account business component.

Upgrade Behavior (S) Determines if Siebel CRM preserves a user interface object for ICL 
(Incorporate Custom Layout) handling when it does a repository merge. 
You can use one of the following values:

■ Admin. The object is never eligible for ICL handling and Siebel CRM 
ignores it.

■ Non-Preservable. The object is not eligible for ICL handling for an 
upgrade for the current release. Siebel CRM might modify this value 
to Preserve in a subsequent release.

■ Preserve. The object is eligible for ICL handling.

Oracle sets the value of the Upgrade Behavior property and the ICL 
Upgrade Path property for each release. You must not modify these 
values.

For more information about ICL, see Siebel Database Upgrade Guide.

Table 1. Common Object Properties

Property Description
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Formats You Can Use With an Accelerator Object Type
This topic describes the format that you can use with an Accelerator or Accelerator Locale. A menu 
or toolbar item might include a command field. If this command field includes a command that uses 
an accelerator that you define, then Siebel CRM uses this accelerator. You can use one of the 
following formats:

■ modifier + name

■ modifier_1 + modifier_n + name

■ accelerator

where:

■ modifier is Ctrl, Alt, or Shift.

■ name is 0 through 9, A through Z, F 0 through 24, a key_code, or a constant.

■ key_code is a three-symbol decimal code, such as 128, or a four-symbol hex number, such as 
0x10.

■ constant is INSERT, DEL, LEFT, RIGHT, UP, DOWN, HOME, END, PAGEUP, PGUP, PAGEDOWN, 
PGDN, SPACE, TAB, or ENTER.

For example, you can use the following formats:

■ Ctrl+F10

■ Alt+A

■ Ctrl+ INSERT

■ Ctrl+Alt+0x221

The syntax is not case-sensitive.

Modifying Undocumented User Properties
You can only modify a user property that is documented. For example, you can modify a user 
property for an applet that references the CSSFrameBrowser class. Only Oracle can create or delete 
a user property that is not documented. For more information, see Siebel Developer’s Reference.

Object Types That You Must Not Modify
This topic lists object types that Siebel CRM uses to manage the repository or that are for internal 
Oracle use only. You must not modify or delete any of these objects. For help with using these object 
types, see “Object Types That You Must Not Modify” on page 18. 

CAUTION: You must not modify any object type that this topic lists. Any modification can adversely 
affect Siebel CRM performance and operation.
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Object Types That the Siebel Enterprise Integration Manager Uses 
The Siebel Enterprise Integration Manager Wizard uses the following object types:

■ Attribute on page 276

■ Attribute Mapping on page 178

■ EIM Explicit Primary Mapping on page 179

■ EIM Interface Table on page 179

■ EIM Interface Table Column on page 181

■ EIM Table Mapping on page 183

■ Foreign Key Mapping on page 184

■ Foreign Key Mapping Column on page 185

■ Interface Table User Key Usage on page 186

■ User Key on page 250

■ User Key Attribute on page 250

■ User Key Attribute Join on page 251

■ User Key Attribute Tree Node on page 251

■ User Key Column on page 252

Object Types That Information Access Uses
Information access uses the following object types. Instead of modifying these objects, it is 
recommended that you use the Dock Object Wizard to create a new object:

■ Dock Object on page 173

■ Dock Object Related DObj on page 174

■ Dock Object Table on page 175

■ Dock Object Visibility Rule on page 176

Object Types That Server Components Use
Server components use the following object types:

■ Server Component Event Subtype on page 229

■ Server Component Event Type on page 230

■ Server Component Parameter on page 230

■ Server Component State Value on page 232

■ Server Component Statistic on page 233

■ Server Component Subsystem on page 233

■ Server Component Type on page 234
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Miscellaneous Object Types
You must not modify any of the following object types:

■ Class on page 161

■ Class Method on page 162

■ Class Method Menu Item on page 163

■ Class Method Menu Item Locale on page 163

■ DLL on page 172

■ Repository on page 223. If you migrate a repository, then you can modify the repository name.

■ String (H) on page 235

■ String Map (H) on page 235

■ Attribute on page 276

Alphabetic List of Object Types
The following list includes all object types that this book describes:

■ Accelerator on page 166

■ Accelerator Locale on page 167

■ Applet Locale on page 37

■ Applet User Prop on page 43

■ Applet Web Template on page 44

■ Applet Web Template Item on page 45

■ Applet Web Template Item Locale on page 47

■ Application on page 95

■ Application Browser Script on page 96

■ Application Event Services on page 97

■ Application Find on page 97

■ Application Locale on page 98

■ Application Method Menu Item (H) on page 98

■ Application Method Menu Item Locale (H) on page 99

■ Application Server Script on page 99

■ Application Toolbar (H) on page 100

■ Application User Prop (H) on page 100

■ Assignment Attribute on page 103
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■ Assignment Attribute Column on page 104

■ Assignment Object on page 293

■ Assignment Object Extension on page 308

■ Assignment User Prop on page 310

■ Assignment Criteria on page 106

■ Assignment Criteria Attribute on page 107

■ Assignment Criteria Attribute Locale on page 108

■ Assignment Criteria Locale on page 109

■ Attribute on page 276

■ Attribute Mapping on page 178

■ Bitmap on page 110

■ Bitmap Category on page 111

■ Bitmap Locale on page 111

■ BusComp Browser Script on page 113

■ BusComp Server Script on page 113

■ BusComp View Mode on page 113

■ Business Component on page 115

■ Business Component User Prop on page 123

■ Business Object on page 152

■ Business Object Component on page 153

■ Business Service on page 154

■ Business Service Browser Script on page 156

■ Business Service Locale on page 156

■ Business Service Method on page 157

■ Business Service Method Arg on page 157

■ Business Service Method Arg Locale on page 158

■ Business Service Method Arg User Prop on page 159

■ Business Service Method Locale on page 159

■ Business Service Server Script on page 160

■ Business Service Subsystem on page 160

■ Business Service User Prop on page 160

■ Class on page 161

■ Class Method on page 162
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■ Class Method Menu Item on page 163

■ Class Method Menu Item Locale on page 163

■ Class User Prop on page 164

■ Class User Prop Value on page 165

■ Column on page 239

■ Command on page 168

■ Command Locale on page 170

■ Content Object on page 170

■ Content Object View on page 171

■ Chart on page 47

■ Chart Element on page 54

■ Chart Element Locale on page 63

■ Chart Locale on page 64

■ Control on page 64

■ Control Locale on page 78

■ Control User Prop on page 79

■ Drilldown Object on page 80

■ Drilldown Object Locale on page 82

■ Dynamic Candidate (H) on page 311

■ Dynamic Candidate Attribute (H) on page 312

■ Dynamic Candidate Component (H) on page 312

■ Dynamic Candidate Component Col (H) on page 313

■ Dynamic Candidate Locale (H) on page 314

■ Dynamic Drilldown Destination on page 314

■ Data Source (H) on page 244

■ DLL on page 172

■ Dock Object on page 173

■ Dock Object Related DObj on page 174

■ Dock Object Table on page 175

■ Dock Object Visibility Rule on page 176

■ EIM Explicit Primary Mapping on page 179

■ EIM Interface Table on page 179

■ EIM Interface Table Column on page 181
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■ EIM Table Mapping on page 183

■ Entity on page 186

■ Entity Attribute (H) on page 187

■ Entity Physical Relation (H) on page 188

■ Entity Relation on page 188

■ Entity Relationship Diagram on page 189

■ External Search Engine (H) on page 190

■ Field on page 124

■ Field Locale on page 134

■ Field User Prop on page 135

■ Find on page 190

■ Find Field on page 191

■ Find Field Locale on page 193

■ Find Locale on page 194

■ Find Pick View on page 194

■ Find View on page 195

■ Foreign Key Mapping on page 184

■ Foreign Key Mapping Column on page 185

■ Help Id on page 196

■ HTML Hierarchy Bitmap on page 197

■ Icon on page 199

■ Icon Map on page 199

■ Import Aux Field on page 200

■ Import Field on page 200

■ Import Field Column on page 201

■ Import Field Locale on page 201

■ Import Field Map on page 202

■ Import Key Field on page 202

■ Import Object on page 203

■ Import Source on page 203

■ Index on page 245

■ Index Column on page 247

■ Integration Component on page 204
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■ Integration Component Field on page 205

■ Integration Component Field User Prop on page 207

■ Integration Component Key on page 207

■ Integration Component Key Field on page 208

■ Integration Component User Prop on page 209

■ Integration Object on page 209

■ Integration Object User Prop on page 210

■ Interface Table User Key Usage on page 186

■ Join on page 135

■ Join Constraint on page 136

■ Join Specification on page 137

■ Link on page 210

■ List on page 82

■ List Column on page 83

■ List Column Locale on page 89

■ List Column User Prop on page 90

■ List Locale on page 91

■ Menu on page 215

■ Menu Item on page 215

■ Menu Item Locale on page 216

■ Message on page 217

■ Message Category on page 217

■ Message Locale on page 218

■ Multi Value Field on page 138

■ Multi Value Link on page 140

■ MVF Pick Map on page 143

■ MVF Pick Map UpdOnlyIfNull on page 144

■ Page Tab on page 100

■ Page Tab Locale on page 101

■ Pager Object on page 218

■ Pick List on page 220

■ Pick Map on page 145

■ Pick Map UpdOnlyIfNull on page 146
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■ Project on page 222

■ Repository on page 223

■ Screen Menu Item on page 101

■ Screen Menu Item Locale on page 102

■ Schema Maintenance on page 223

■ Screen on page 224

■ Screen Locale on page 226

■ Screen View on page 226

■ Screen View Locale on page 228

■ Server Component Event Subtype on page 229

■ Server Component Event Type on page 230

■ Server Component Parameter on page 230

■ Server Component State Value on page 232

■ Server Component Statistic on page 233

■ Server Component Subsystem on page 233

■ Server Component Type on page 234

■ Single Value Field on page 147

■ String (H) on page 235

■ String Map (H) on page 235

■ SVF Pick Map on page 151

■ SVF Pick Map UpdOnlyIfNull on page 152

■ Symbolic String (H) on page 235

■ Symbolic String Locale on page 237

■ System Activity Object on page 237

■ Table on page 247

■ Task on page 253

■ Task Branch on page 255

■ Task Branch Criteria on page 256

■ Task Branch Criteria Value on page 257

■ Task Chapter on page 257

■ Task Chapter Locale on page 258

■ Task Event on page 258

■ Task Event IO Argument on page 259
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■ Task Group on page 270

■ Task Group Item on page 270

■ Task Group Locale on page 271

■ Task Locale on page 261

■ Task Metric on page 261

■ Task Property on page 262

■ Task Step on page 264

■ Task Step Context on page 266

■ Task Step IO Argument on page 268

■ Task Step Locale on page 269

■ Text Style (H) on page 272

■ Toolbar on page 273

■ Toolbar Item on page 273

■ Toolbar Item Locale on page 274

■ Toolbar Locale on page 275

■ Tree on page 91

■ Tree Node on page 91

■ Tree Node Locale on page 93

■ Type on page 277

■ User Key on page 250

■ User Key Attribute on page 250

■ User Key Attribute Join on page 251

■ User Key Attribute Tree Node on page 251

■ User Key Column on page 252

■ View on page 278

■ View Locale on page 283

■ View Task Group on page 284

■ View Task Group Locale on page 285

■ View User Prop (H) on page 285

■ View Web Template on page 285

■ View Web Template Item on page 286

■ View Web Template Item Locale on page 288

■ Web Page on page 288
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■ Web Page Item on page 289

■ Web Page Item Locale on page 290

■ Web Page Item Parameter on page 290

■ Web Page Locale (H) on page 291

■ Web Template on page 291

■ WF Branch Connector (H) on page 325

■ WF Branch Criteria (H) on page 326

■ WF Branch Criteria Value (H) on page 327

■ WF Process Metric on page 328

■ WF Process Prop on page 328

■ WF Step on page 331

■ WF Step Branch (H) on page 337

■ WF Step I/O Argument (H) on page 339

■ WF Step Recipient (H) on page 340

■ Workflow Policy Column on page 292

■ Workflow Policy Component on page 315

■ Workflow Policy Component Col on page 317

■ Workflow Policy Object on page 317

■ Workflow Policy Program on page 318

■ Workflow Policy Program Arg on page 320

■ Workflow Process on page 341
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3 Siebel Object Types Reference

This chapter describes Siebel Object Types. It includes the following topics. This is the same list of 
topics that the Object Explorer displays in Siebel Tools:

■ Applet Object Types on page 30

■ Application Object Types on page 94

■ Assignment Attribute Object Types on page 102

■ Assignment Criteria Object Types on page 105

■ Bitmap Category Object Types on page 109

■ Business Component Object Types on page 112

■ Business Object Types on page 152

■ Business Service Object Types on page 153

■ Class Object Types on page 161

■ Command Object Types on page 166

■ Content Object Types on page 170

■ DLL Object Type on page 172

■ Dock Object Types on page 173

■ EIM Interface Table Object Types on page 178

■ Entity Relationship Diagram Object Types on page 186

■ External Search Engine Object Type on page 190

■ Find Object Types on page 190

■ Help ID Object Type on page 196

■ HTML Hierarchy Bitmap Object Type on page 197

■ Icon Map Object Types on page 198

■ Import Object Types on page 199

■ Integration Object Types on page 203

■ Link Object Type on page 210

■ Menu Object Types on page 215

■ Message Category Object Types on page 217

■ Pager Object Type on page 218

■ Link Object Type on page 210
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■ Pick List Object Type on page 220

■ Project Object Type on page 221

■ Repository Object Type on page 223

■ Schema Maintenance Object Types on page 223

■ Screen Object Types on page 224

■ Server Component Object Types on page 229

■ String Object Types on page 235

■ Symbolic String Object Types on page 235

■ System Activity Object Types on page 237

■ Table Object Types on page 238

■ Task Object Types on page 252

■ Task Group Object Types on page 269

■ Text Style Object Types on page 271

■ Toolbar Object Types on page 272

■ Type Object Types on page 276

■ View Object Types on page 278

■ Web Page Object Types on page 288

■ Web Template on page 291

■ Workflow Policy Column Object Type on page 292

■ Workflow Policy Object Types on page 293

■ Workflow Policy Program Object Types on page 318

■ Workflow Process Object Types on page 325

Applet Object Types
This topic describes the Applet object type and object types that are children of an applet. It includes 
the following topics:

■ Applet on page 31

■ Applet Browser Script on page 37

■ Applet Locale on page 37

■ Applet Message on page 38

■ Applet Message Locale on page 39

■ Applet Message Variable on page 39

■ Applet Message Variable Locale on page 40
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■ Applet Method Menu Item on page 40

■ Applet Method Menu Item Locale on page 41

■ Applet Script (H) on page 42

■ Applet Server Script on page 42

■ Applet Toggle on page 42

■ Applet User Prop on page 43

■ Applet Web Template on page 44

■ Applet Web Template Item on page 45

■ Applet Web Template Item Locale on page 47

■ Chart on page 47

■ Chart Element on page 54

■ Chart Element Locale on page 63

■ Chart Locale on page 64

■ Control on page 64

■ Control Locale on page 78

■ Control User Prop on page 79

■ Drilldown Object on page 80

■ Drilldown Object Locale on page 82

■ List on page 82

■ List Column on page 83

■ List Column Locale on page 89

■ List Column User Prop on page 90

■ List Locale on page 91

■ Tree on page 91

■ Tree Node on page 91

■ Tree Node Locale on page 93

Applet
An applet allows the user to view, enter, and modify data that the applet gets from a single business 
component. It includes the following qualities:

■ Occupies a section of a view

■ Composed of controls, such as buttons, fields, check boxes, and other types of controls, such as 
buttons that call a method or an ActiveX control
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■ Allows the user to view, enter, modify, and navigate through records

■ Can display as a form, list of records, chart, business graphics, or navigation tree

■ Allows data entry for a single record or through a scrolling table that Siebel CRM displays multiple 
records

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet

Table 2 describes properties that Siebel CRM uses with an applet.

Table 2. Properties of the Applet

Property Description

Associate Applet (O) Specifies the name of an applet that relates data from two different 
entities. It uses a many-to-many relationship.

Siebel CRM can associate rows from entity B with rows from entity 
A, where entity B is an association applet that includes a many-to-
many relationship and entity A is the main applet.

You can specify an association list applet.

Auto Query Mode (O) You can use one of the following values:

■ New Query. Deletes the business component search 
specification, deletes the predefined query for the business 
object, and sets the business component to Query mode. 
Automatically displays the applet in Query mode.

■ Refine Query. Uses the existing search specifications and 
predefined queries. 

Background Bitmap (O)(H) The bitmap that Siebel CRM displays in the applet background. You 
can specify the object definition for any applet background bitmap.

Background Bitmap 
Style (O)(H)

Specifies how Siebel CRM arranges the background bitmap. You can 
use one of the following values:

■ Center. Display the image centered in the middle of the 
background.

■ Stretch. Stretch the image so that it covers the entire 
background. 

■ Tile. Display multiple copies of the image so that it covers the 
entire background.
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Business Component (O) Specifies the name of the business component that includes the 
data that Siebel CRM displays.

A view that uses an applet references a business object. This 
business object must include a business object component that 
references the business component that includes the data that 
Siebel CRM must display.

Class (O) Specifies the name of a C++ class that Siebel CRM uses to manage 
the applet. You can use one of the following values:

■ CSSFrame. Form applet.

■ CSSFrameChart. Chart applet.

■ CSSFrameList. List applet.

■ CSSFrameTree. Tree applet.

You can also use a specialized applet class. For example:

■ CSSFrameListAttachment

■ CSSFrameListActivity

Default Applet Method Specifies the method that runs if the user presses the Enter key in 
the applet.

Height (R)(H) Specifies the vertical size of the applet in sector units. You can use 
one of the following values:

■ 1

■ 2

■ 3

■ 4

Help Identifier (O) Not used. 

HTML Number of Rows (O) Specifies the number of rows that Siebel CRM displays in a list 
applet. If the HTML Number of Rows Property property is empty, 
then Siebel CRM uses the value of the NumberOfListRows 
parameter in the application configuration file. This parameter sets 
the default number of rows for the list applets that this application 
displays. If the NumberOfListRows parameter is also not specified, 
then Siebel CRM sets the default value to 10. In some Siebel CRM 
versions, the default value for some applets might equal seven.

Table 2. Properties of the Applet

Property Description
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HTML Popup Dimension 
(O)(H)

Specifies the dimension in pixels of the pop-up dialog box. You use 
the following format:

numberxnumber

where:

■ x is lower case.

You cannot include empty spaces.

For example:

640x480

ICL Upgrade Path For more information, see “Common Object Properties” on page 15.

Insert Applet (O) Not used.

Insert Position (O) Specifies the position where Siebel CRM creates a new record. You 
can use one of the following values:

■ BEFORE. Before the current record.

■ AFTER. After the current record.

■ FIRST. After first record.

■ LAST. After last record.

Mail Address Field (O) Specifies the default email recipient that Siebel CRM displays in the 
Message Properties dialog box. It uses the list of recipients in the 
applet user properties. For example:

Email Address

Where:

■ Email Address is a business component field.

Mail Template (O) Specifies the text file that Siebel CRM uses to fill in data in the 
default email message. It can include the following placeholder that 
uses a substitution value for a field:

%field%

The contents of the C:\Siebel\MSGTEMPL directory determines the 
list of mail templates that are available.

Name (R) Specifies the name of the applet. The name can include spaces. It 
must be unique among applets. Any object that references an 
applet references the applet name. For example:

Account Form Applet

Table 2. Properties of the Applet

Property Description
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No Delete (O) Specifies if Siebel CRM can delete a row in an applet. You can use 
one of the following values:

■ TRUE. No row deletion allowed.

■ FALSE. Row deletion allowed.

No Insert (O) Specifies if Siebel CRM can insert a row in an applet. You can use 
one of the following values:

■ TRUE. No row insertion allowed.

■ FALSE. Row insertion allowed.

No Merge (O) Specifies if Siebel CRM can merge a row in an applet. You can use 
one of the following values:

■ TRUE. No row merge allowed.

■ FALSE. Row merge allowed.

No Update (O) Specifies if Siebel CRM can update a field in an applet. You can use 
one of the following values:

■ TRUE. No field update allowed.

■ FALSE. Field update merge allowed.

Popup Dimension (O)(H) Specifies the size of the pop-up applet. This text property is valid 
only for association, pick, multivalue group, and detail applets. You 
can use the following format:

W X H

where:

■ W is the width in pixels.

■ H is the height in pixels.

■ X is upper-case.

■ A space must precede and follow the X.

For example:

512 X 220

Scripted (S) Specifies if a Siebel VB or Siebel eScript script is attached to the 
applet. It can include of the following values:

■ TRUE. Script attached.

■ FALSE. No script attached.

Table 2. Properties of the Applet

Property Description
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How Siebel CRM Uses an Applet Search Specification
An applet search specification is a search specification that resides in the Search Specification 
property of an applet. If an applet includes a search specification, and if the business component 
that the applet references includes a search specification, then Siebel CRM appends the applet search 
specification to the end of the value in the Search Specification property of this business component. 
It does not use the applet search specification to override the search specification on this business 
component.

If the user navigates to an applet that does not include a search specification, then Siebel CRM does 
not requery or use the existing search specification except in the following situations:

■ The user navigates from a parent applet to a child applet. It uses an empty applet search 
specification. 

Search Specification (O) Specifies a conditional expression that Siebel CRM uses to restrict 
the records it gets from the business component that the applet 
references. For example:

[Service Flag] = ‘Y’

For more information, see “How Siebel CRM Uses an Applet Search 
Specification” on page 36.

Task Specifies the name of the Task object for an applet that a task uses. 
For example:

Asset To Contract Task

Text Style (O)(H) Specifies a text style for all controls that the applet includes. Siebel 
CRM uses this value by default only if the control does not specify 
a text style. If you do not specify a value for the Text Style 
property, then Siebel CRM uses the text style that the Browser 
specifies or that the .css files for the Siebel Business Application 
specifies.

Title (O) Specifies the text that Siebel CRM uses for the applet title. For 
example:

Account

Type (O) Specifies the type of the applet.

Upgrade Behavior For more information, see “Common Object Properties” on page 15.

Width (R)(H) Specifies the horizontal size of the applet in sectors. You can use 
one of the following values:

■ 1

■ 2

Table 2. Properties of the Applet

Property Description
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■ Siebel CRM modifies the visibility mode of the parent applet. It uses the applet search 
specification even if this search specification is empty.

If multiple applets in one view reference the same business component, then you must not specify 
different applet search specifications. You must make sure all of these applets use the same search 
specification or that all of these applet search specifications are empty.

An applet search specification can modify the query context for a user who performs a query.

The applet search specification is not available for multivalue group and association applets in 
versions prior to Siebel CRM version 5.0.

Applet Browser Script
An applet browser script defines the browser script that an applet uses. For more information, see 
Siebel Object Interfaces Reference.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Applet Browser Script

Table 3 describes properties that Siebel CRM uses with an applet browser script.

Applet Locale
An applet locale defines a language override that Siebel CRM uses with an applet.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Applet Locale

Table 3. Properties of the Applet Browser Script

Property Description

Browser Group (O) Not used.

Name (S) Specifies a unique name for the script record. For example:

Applet_ChangeRecord_All

You must not modify this property. To create a value for this 
property, Siebel Tools combines the User Agent and Procedure 
properties.

Procedure (O) Specifies the applet name that Siebel CRM uses to upgrade the 
current applet during the next repository merge. It typically uses 
the ancestor applet that this property specifies as the source to 
create a new applet.

Script (O) Text for the function.
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Table 4 describes properties that Siebel CRM uses with an applet locale.

Applet Message
An applet message allows Siebel CRM to combine static text with dynamic data, such as the value 
from a business component field. If you bind an applet message to an applet control, then Siebel 
CRM displays this message as a read-only, translated string that includes dynamic data. For more 
information about configuring an applet message, see Siebel Business Process Framework: Task UI 
Guide. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Applet Message

Table 5 describes properties that Siebel CRM uses with an applet message.

Table 4. Properties of the Applet Locale

Property Description

Name (R) The language abbreviation that the Siebel Business Application 
uses. For example:

ENU

Title (O) The text that Siebel CRM uses for the applet title for a language.

Table 5. Properties of the Applet Message

Property Description

Name (R) Specifies the name for the applet message. You can use this name 
and the Field picklist to bind the applet message to a control.

Text Message (R) Specifies the text message. It references a symbolic string that 
includes static text and placeholders for dynamic data. A 
placeholder uses the following format:

%n

where:

■ n is a number.

For example:

Here is the tracking number for your case: %1 

Text Message - String 
Override

Specifies the override message of a symbolic string. This override 
is for a text message.
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Applet Message Locale
An applet message locale defines language overrides that Siebel CRM uses with an applet message.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Applet Message > Applet Message Locale

Table 6 describes properties that Siebel CRM uses with an applet message locale.

Applet Message Variable
An applet message variable includes a list of business component fields and their corresponding 
numerical key. Siebel CRM uses this numerical key to identify the placeholder it must replace in the 
parent applet message.

For example, assume the following applet message: 

Here is the tracking number for your case: %1. 

The Applet Message Variable that Siebel CRM uses for the Case Id business component field in this 
example is a value of 1. At runtime, if the value of Case Id is 12-ABCX, then the Applet Message 
contains the following value:

Here is the tracking number for your case: 12-ABCX. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Applet Message > Applet Message Variable

Table 7 describes properties that Siebel CRM uses with an applet message variable.

Table 6. Properties of the Applet Message Locale

Property Description

Language Code (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Text Message (R) Specifies the string that Siebel CRM uses for the Applet Message. 
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Applet Message Variable Locale
An applet message variable locale defines a language override that Siebel CRM uses with an applet 
message variable.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Applet Message > Applet Message Variable > Applet Message Variable 
Locale

Table 8 describes properties that Siebel CRM uses with an applet message variable locale.

Applet Method Menu Item
An applet method menu item defines the applet menu that Siebel CRM displays if the applet is 
activate. You must write script in the PreInvokeMethod event handler that examines the method 
string and performs an action. If this string does not exist, then an error occurs. For more 
information, see Siebel Object Interfaces Reference.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Applet Method Menu Item

Table 7. Properties of the Applet Message Variable

Property Description

Field (R) Specifies a field from the business component that the applet 
references. 

Field - Language Override 
(O) 

Specifies the language that Siebel CRM uses for a field that is 
different from the language that the Siebel Business Application 
uses.

Value (R) Specifies a numeric value for the field value that Siebel CRM 
replaces at runtime. This value must correspond to one of the 
placeholders in the text of the parent applet message. 

Table 8. Properties of the Applet Message Variable Locale

Property Description

Field (O) Specifies the name of an alternative field that Siebel CRM uses if 
the value of the Name property is the active locale. 

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU
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Table 9 describes properties that Siebel CRM uses with an applet method menu item.

Applet Method Menu Item Locale
An applet method menu item locale defines the language override that Siebel CRM uses with an 
applet method menu item.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Applet Method Menu Item > Applet Method Menu Item Locale

Table 10 describes properties that Siebel CRM uses with an applet method menu item locale.

Table 9. Properties of the Applet Method Menu Item

Property Description

Command (O) Specifies the command that Siebel CRM runs if the user chooses an 
item in an applet menu.

Menu Text (R) Specifies the text that Siebel CRM displays in the menu item.

Name (O) Specifies the name of the menu item in a menu.

Position (R) Specifies the position of the menu item in a menu. This value is an 
integer.

Suppress Menu Item (O) Removes the menu item that the Name property identifies from the 
applet menu. You can use one of the following values:

■ TRUE. Suppress the menu item.

■ FALSE. Do not suppress the menu item.

Table 10. Properties of the Applet Method Menu Item Locale

Property Description

Menu Text (R) Specifies the text that Siebel CRM displays in the menu item for a 
language.

Name (O) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU
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Applet Script (H)
An applet script defines a Siebel VB script or Siebel eScript script for an applet. Starting with Siebel 
CRM version 7.0, applet browser script and applet server script replace applet script.

This object type occurs in the following location in the object hierarchy:

■ Applet > Applet Script

Table 11 describes properties that Siebel CRM uses with an applet script.

Applet Server Script
An applet server script defines script for a server applet. For more information, see Siebel Object 
Interfaces Reference. Starting with Siebel CRM version 7.0, applet server script replaces applet script 
and applet web script.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Applet Server Script

The applet server script uses the same properties as the applet script. For more information, see 
Table 11 on page 42.

Applet Toggle
An applet toggle allows the user to navigate back and forth between different applets in the same 
view. For more information, see Configuring Siebel Business Applications.

Table 11. Properties of the Applet Script

Property Description

Name (R) Specifies the name of the script.

Program Language (O) Specifies the script programming language. You can use one of the 
following values:

■ SBL. Siebel VB.

■ JS. Siebel eScript.

Script (R) Specifies the body of the script. The maximum size of this body is 
16KB.

Sequence (R) Specifies the order that Siebel CRM uses to compile scripts that this 
object contains. This property can contain only an integer. For 
example, assume the Sequence property for Script A is 1 and the 
Sequence property for Script B is 2. Siebel CRM compiles script 
Script A first and then Script B second.
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This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Applet Toggle

Table 12 describes properties that Siebel CRM uses with an applet toggle.

Applet User Prop
An applet user prop sends a value to the C++ code that implements specialized applet configuration. 
Siebel CRM persists the value that you configure for a user property in the Siebel runtime repository. 
For more information, see “Object Types That You Must Not Modify” on page 18.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Applet User Prop

Table 13 describes properties that Siebel CRM uses with an applet user prop.

Table 12. Properties of the Applet Toggle

Property Description

Applet (R) Specifies the name of the applet that Siebel CRM displays for a 
static toggle. For example:

Activity Form Applet

Auto Toggle Field (O) Specifies the business component field for a dynamic toggle. Siebel 
CRM examines the current value that this field contains to the value 
that the Auto Toggle Value property contains. For example:

Item Type BusObj Name

Auto Toggle Value (O) Specifies the value in the business component field for a dynamic 
toggle. If this field contains the value that the Auto Toggle Value 
property specifies, then Siebel CRM displays the applet. For 
example:

Action

Name (R) Specifies the name of the applet that Siebel CRM displays. For 
example: 

Activity Form Applet

Sequence (O) Specifies the order that Siebel CRM uses to display this applet for a 
dynamic toggle. This property can contain only an integer. For 
example, assume the Sequence property for Applet Toggle A is 1 
and the Sequence property for Applet Toggle B is 2. Siebel CRM 
displays Applet Toggle A first and then Applet Toggle B second.
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Applet Web Template
An applet web template does the following:

■ Identifies the web template that an applet uses. 

■ Identifies external HTML or other markup language files that define the layout and Siebel Web 
Engine interactions for an applet. 

■ Includes child applet web template items that define the mappings between controls or list 
columns in the applet and placeholder tags in the web template file.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Applet Web Template

Table 14 describes properties that Siebel CRM uses with an applet web template.

Table 13. Properties of the Applet User Prop

Property Description

Name (R) Specifies the name of the user property.

Value (R) Specifies the value of the user property.

Table 14. Properties of the Applet Web Template

Property Description

Expression (O)(H) Not used.

Name (R) Specifies the name of this applet web template.

Sequence (O) Specifies the sequence for an edit template. If a user opens multiple 
Edit pages, then Siebel CRM uses the sequence number to identify 
each template.

This property can contain only an integer. The starting value for the 
web template sequence is 0. If more than one template exists with 
the same type, then Siebel CRM uses the following sequence:

■ 0

■ 1

■ 2

■ And so forth
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Applet Web Template Item
An applet web template item maps a control or list column to a placeholder ID. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Applet Web Template > Applet Web Template Item

Table 15 describes properties that Siebel CRM uses with an applet web template item.

Type (R) Specifies the mode that Siebel CRM uses for this applet web 
template. You can use one of the following values:

■ Base. Displays the applet in standard read-only mode.

■ Edit. Modifies existing data in a record. Used with the 
EditRecord method.

■ Edit List. Displays a list applet in a mode where the chosen row 
or column is editable. You can use the Edit List mode instead of 
the BASE mode for a list applet.

■ New. Enters data into new records. Used with the NewRecord 
method. 

■ Query. Displays the fields that Siebel CRM searches. Used with 
the NewQuery method.

Web Template (R) Specifies the web template that Siebel CRM uses to display the 
applet.

Table 15. Properties of the Applet Web Template Item

Property Description

Column Span (O) Specifies the width of an item in a grid form applet. This width 
contains cells. Each cell is 8 pixels wide and 8 pixels high.

This property can contain an integer that is less than or equal to 
120.

You must not manually modify this property.

Column Span - Language 
Override (O)

Allows you to override the Column Span property if a language 
locale is active.

It can contain an integer that is less than or equal to 120.

You must not manually modify this property.

Table 14. Properties of the Applet Web Template

Property Description
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Control (R) Specifies the name of the control or list column. For example:

Button Reorder

Expression (O) Specifies the condition in which Siebel CRM maps this item. For 
example:

Not Siebel Sales

Grid Property (R) Specifies the item type for a grid form applet. If you use the Grid 
Layout Editor, then Siebel Tools automatically sets this property. 
You can use one of the following values:

■ FormattedLabel

■ FormattedHtml

Item Identifier (R) Specifies the ID of the swe:control tag. The Siebel Web Engine 
uses this property to associate a control with a position in a web 
template. To populate this property, you can drag and drop a 
control in the Web Applet Layout Editor.

Item Identifier - Language 
Override (O)

Specifies the language that Siebel CRM uses for the item identifier 
if this language is different from the language that the Siebel 
Business Application.

Mode (O) Specifies to use the More/Less feature. It allows an applet to display 
a limited set of fields. If the user clicks More/Less, then Siebel CRM 
displays more fields.

A combo box in the toolbar allows you to switch between modes 
when you edit a layout.

You can use one of the following values:

■ Less. Siebel CRM enters Less in the Mode property for each 
control you create.

■ More. Siebel CRM enters More in the Mode property for each 
control you create.

Name (R) Specifies the name of the item. Same as the control property.

Namespace - Language 
Override (O)

Not used.

Namespace (O) Not used.

Row Span (O) Specifies the height of an item in a grid form applet. This height 
contains cells. Each cell is 8 pixels wide and 8 pixels high.

This property can contain an integer that is less than or equal to 
100.

You must not manually modify this property.

Table 15. Properties of the Applet Web Template Item

Property Description
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Applet Web Template Item Locale
An applet web template item locale defines the language overrides that Siebel CRM uses with an 
applet web template item.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Applet Web Template > Applet Web Template Item > Applet Web 
Template Item Locale

Table 16 describes properties that Siebel CRM uses with an applet web template item locale.

Chart
A chart displays graphical data in the boundaries of an applet.

Row Span - Language 
Override (O)

Allows you to override the Row Span property if a language locale 
is active.

It can contain an integer that is less than or equal to 100.

You must not manually modify this property.

Type (R) Specifies the type of the item. To view the values you can use, click 
the Type property in Siebel Tools.

Table 16. Properties of the Applet Web Template Item Locale

Property Description

Column Span (O) Allows you to modify the Column Span property if a language or 
locale is active. This property affects the Column Span Language 
Override property of an applet web template item. 

Item Identifier (O) Specifies the control ID that Siebel CRM maps to the control that 
the Siebel Web Template for a language identifies.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Namespace (O) Not used.

Row Span (O) Allows you to modify the Row Span property if a language or locale 
is active. This property affects the Row Span Language Override 
property of an applet web template item. 

Table 15. Properties of the Applet Web Template Item

Property Description



Siebel Object Types Reference Siebel 2018

Siebel Object Types Reference ■ Applet Object Types

48 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Chart

Table 17 describes properties that Siebel CRM uses with a chart.

Table 17. Properties of the Chart

Property Description

Bar Colors (O) Specifies a list of colors for bars or pie slices in an itemized list of 
red, green, and blue triplets:

■ The first triplet specifies the color for the first series.

■ The second triplet specifies the color for the second series.

■ And so on. 

If the list contains more series members than triplets, then Siebel 
CRM repeats the list of colors.

You can specify up to 15 triplets. Each number in a triplet must be 
between 0 and 255. For example, 128 0 0, 0 128 0, 0 0 128.

The following value is the default value:

0 255 0,0 0 255,255 0 0,255 0 255,255 255 0,0 255 255,255 
0 128,255 128 0,0 255 128,128 0 255,255 255 128,128 255 
255,128 128 64,128 64 128,64 128 128

Category Captions (O) Specifies the caption for the x-axis.

Category Field (R) For more information, see “Configuring the Category Field Property 
of a Chart” on page 52.

Compare (O)(H) Obsolete. Do not use.

Data Function (O) Specifies the operation that Siebel CRM performs on data. You can 
use one of the following values:

■ COUNT. Counts the number of records.

■ SUM. Sums field values for all records in the category.

■ AVERAGE. Calculates the average value for each record of the 
field.

■ PLOT. Plots all cell values. If a cell in the logical table does not 
contain a value, then Siebel CRM sets the chart value to NULL.

If COUNT is the only data function you must apply to the chart 
because the Picklist Functions property is empty, then it is 
recommended that you do specify a value for the Data Point Field 
property value. This configuration can improve performance.

For more information, see “Configuring the Data Function Property of 
a Chart” on page 53.
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Data Point Captions (O) Specifies the caption for the y-axis.

Data Point Field (O) Specifies the field that contains the data that Siebel CRM plots on 
the y-axis. If you do not specify this property, then specify COUNT 
in the Data Function property.

For more information, see “Configuring the Data Function Property of 
a Chart” on page 53.

Editable (O) Obsolete. Do not use.

Invert (O) You can use one of the following values:

■ TRUE. Invert the x-axis, z-axis, labels, and titles. This 
configuration can be useful to display a different view of the 
data.

■ FALSE. Do not invert the x-axis, z-axis, labels, and titles.

Choosing a By picklist item modifies this property except in a time 
period chart where it modifies the time period on the x-axis.

Multi Data Point (O) You can use one of the following values:

■ TRUE. Plot multiple line-graph curves on the same y-axis 
according to different source field and function combinations. 
Siebel CRM displays the name for each curve in the legend. You 
must also set the following properties in the chart object 
definition: 

■ Data Point Field

■ Data Function

■ Picklist Functions

■ Multi Data Point

■ FALSE. Do not plot multiple curves.

Name (R) Specifies the name of the chart. 

Period (O) Specifies a calendar period or a time period that the user defines as 
the default time period for this chart. To view the values you can 
choose, click the Period property in Siebel Tools.

If you specify the Period property, then you must set the field type 
of the business component field that supplies the values for the 
chart categories to Date or DateTime.

The user can define any time period that the Period business 
component contains, such as fiscal month, quarter, or year. To 
allow the user to define a time period in a chart, you must add the 
Period business component to the current business object.

Table 17. Properties of the Chart

Property Description
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Picklist Function Captions 
(O)

Specifies captions for the list of functions that the y-axis uses.

Picklist Functions (O) Specifies the data functions that Siebel CRM lists in the Show 
picklist in the applet. To suppress a function in this picklist, do not 
specify a string in the position of this function. For more 
information, see “Configuring the Data Function Property of a Chart” 
on page 53.

Siebel CRM does not specify a value for this property and does not 
display this picklist in the applet, by default.

For example:

Number of Opportunities, Opportunity Revenue, Average 
Revenue.

Siebel CRM associates each item you enter with a data point field 
and data function in a corresponding position in the Data Point Field 
property and the Data Function property. It makes this association 
according to the order that you use when you enter the items in the 
Picklist Functions property.

Picklist Period Captions (O) Specifies the captions that Siebel CRM displays for the list of date 
time periods that the x-axis uses.

Picklist Periods (O) Specifies the time periods that Siebel CRM displays in a picklist in 
an applet. You enter a comma-separated list that does not include 
a space after the comma. For example:

Month(Calendar),
Quarter (Calendar), Year(Calendar),Day,Week,Mont,
Quarter,Year

If the Picklist Periods property is empty, then Siebel CRM does not 
display time periods in the picklist in the client.

To allow the user to define a time period in a chart, you must add 
the Period business component to the current business object.

Picklist Type Captions (O) Specifies the captions for the types of charts.

Table 17. Properties of the Chart

Property Description
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Picklist Types (O) Specifies the chart types that Siebel CRM includes in the picklist in 
the applet. You enter a comma-separated list that does not include 
a space after the comma. For example:

2dBar,3dBar

If the Picklist Types property is empty, then Siebel CRM does not 
display chart types in the picklist in the client.

To display a 2dScatter, 3dScatter, or Combo chart, you must use 
the Type property. You cannot use the Picklist Types property to 
display these chart types.

For a list of chart types that you can specify, see the description for 
the Type property.

Selection Based (O) You can use one of the following values:

■ TRUE. Chart only the currently active record that the business 
component contains.

■ FALSE. Chart all records that the business component contains.

Series Captions (O) Specifies the caption for the z-axis.

Series Field (O) Specifies the field that contains the data that Siebel CRM plots on 
the z-axis. If this property is empty, then it maps all of the records 
into a single series. For more information, “Configuring the Series 
Field Property of a Chart” on page 53.

Table 17. Properties of the Chart

Property Description
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Configuring the Category Field Property of a Chart
If the Category Field property contains:

■ The name of a business component field. Siebel CRM gets the x-axis labels from this field. 
To display these field values, the By picklist allows the user to choose the x-axis or the z-axis.

■ A comma-separated list of field names. Siebel CRM displays a list of fields in the By picklist 
in the client. The value that the user chooses determines the field that populates the x-axis. The 
first value in the comma-separated list is the default value. You must not use an empty space 
before or after a field name. If you specify a list of x-axis source fields, then you must not use 
the following properties of the chart element:

■ Coordinates

■ Display Format

■ Divisions

■ List Of Values

■ Sort Specification

Type (O) Specifies the type of chart that Siebel CRM displays. You can use 
one of the following values:

■ 2dBar, 3dBar, 2dStackedBar, 3dStackedBar, 2dLine, 3dLine, 
Combo, 2dHorizBar, 3dHorizBar, 2dCube, 3dCube

■ 3dClusteredBar, 2dPie, 3dPie, 2dDoughnut

■ 2dScatter, 3dScatter, 2dSpline, 3dSpline

To display a combo chart, you must specify a value in the Data Point 
Field property. Siebel CRM displays the Sum (Data Function) of this 
field on the y-axis and the Count for this field on the second y-axis.

To display a 2dScatter chart or a 3dScatter chart, you must specify 
the Coordinates property for the axis label of the x-axis. For more 
information, see “Chart Element” on page 54.

Use Category MVGroup Data 
(O)

You can use one of the following values:

■ TRUE. If the category field is a multivalue group (MVG), then 
Siebel CRM gets the charting data from this field. If you set this 
property to TRUE, then you cannot use the following properties:

■ Data Function

■ Data Point Captions

■ Data Point Field

■ FALSE. Use the value listed in the business component.

Table 17. Properties of the Chart

Property Description
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■ Text 

These properties define the label for the x-axis. Siebel CRM can use these properties only for one 
x-axis field.

If Siebel CRM creates a new business component field that the chart references, and if it maps this 
field to a Calculated field in another business component through a multivalue link, and if a category 
field uses this new field for the chart, then the drilldown on the chart does not work correctly because 
the Calculated field cannot preserve the context.

Configuring the Series Field Property of a Chart
Configuration for the Series Field property of the chart is identical to configuration for the Category 
Field property except that the Series Field property applies to the z-axis instead of the x-axis. For 
more information, see “Configuring the Category Field Property of a Chart” on page 52.

Configuring the Data Function Property of a Chart
This topic describes how to configure the Data Function Property for a chart.

Configuring the Show Picklist to Display Field and Function Combinations
You can configure the Show picklist to display a list of field and function combinations. The item that 
the user chooses determines the values that Siebel CRM plots on the y-axis.

To configure the Show Picklist to display field and function combinations
1 Enter a comma-separated list in the following properties of the chart object:

■ Data Point Field

■ Data Function

■ Picklist Functions 

2 Add the following list to the Data Function property. If the Data Function property is empty, or 
if the value that it contains is shorter than the value that the Picklist Functions property contains, 
then Siebel CRM uses this same list:

Sum,Count,Average,Plot

Configuring Siebel CRM to Plot Multiple Line-Graph Curves on the Same Y-Axis
Siebel CRM can plot multiple line-graph curves on the same y-axis according to different source field 
and function combinations. It displays the name for each curve in the legend. 

To configure Siebel CRM to plot multiple line-graph curves on the same y-axis
1 Modify the same properties that you modify in Step 1 on page 53. You also modify the following 

properties:

■ Category Field
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■ Multi Data Point

2 Make sure the Series Field property is empty. 

3 In the Data Function property, enter the same comma-separated list that you add in Step 2 on 
page 53.

Configuring Siebel CRM to Display Two Line-graph Curves on Different Y-axes 
You can configure Siebel CRM to plot one axis to the left of the graph and another axis to the right 
of the graph.

To configure Siebel CRM to display two line-graph curves on different y-axes
1 Specify two functions in the Data Function property of the chart object. Use a comma to separate 

these functions. 

The first function defines the left y-axis and the second function defines the right y-axis. 

2 Specify two fields in the Data Point Field property.

Chart Element
A chart element specifies one of the static characteristics of a chart, including title, legend, labels, 
chart body, or axis.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Chart > Chart Element

Table 18 describes properties that Siebel CRM uses with a chart element. Each property applies to 
only some types of chart elements. For more information, see “Properties That Siebel CRM Uses for 
Different Types of Chart Elements” on page 61.
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Table 18. Properties of the Chart Element

Property Description

Axis Id (O) Specifies the axis to which subsequent axis elements apply. Applies 
to the AxisLabel, AxisLineGrid, and AxisTitle elements. To view the 
values you can use, click the Axis Id property in Siebel Tools.

Color (O) Specifies color for all elements. In particular, it specifies color for 
the following elements:

■ Sets the text color for elements that contain text. 

■ Sets the fill color for the Plot element, chart element, and the 
HorizArea graphic.

■ Sets the line color for the Axis Line Grid element and the Line, 
Rectangle, Ellipse, and HorizLine graphics.

The value you enter must use the following format:

■ A space-separated red, green, blue triplet with each value in the 
range 0 through 255.

Coordinates (O) For more information, see “Configuring the Coordinates Property of a 
Chart Element” on page 60.

Display Format (O) Specifies the format for the label of the AxisLabel element on the 
axis that the Axis Id property specifies. If this property:

■ Includes a value. Siebel CRM applies the format string that 
this property specifies. It applies this format to the axis label 
before it displays the label in the chart.

■ Does not include a value. Siebel CRM applies the default 
format for the Category, Series, or Data Point Field business 
component field that it uses for the x-axis, z-axis, or y-axis.

You can use any format string that the Display Format accepts. For 
example:

0.##%
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Divisions (O) Specifies the number of divisions for the axis that the Axis Id 
property specifies. Applies to the AxisLabel element. It applies to 
the y-axis. It applies differently for the following charts:

■ Scatter chart. Applies to the x-axis and the y-axis.

■ Other charts. If the field values are numbers, then it applies 
to the x-axis or z-axis.

■ Histogram chart. The axis that the Axis Id property specifies 
must display numeric data. If it does not, then Siebel CRM 
displays labels and does not bucket data. To support a 
histogram chart, you must also specify the Coordinates 
property.

You can use any number greater than 0. If the Divisions property 
does not include a value, then Siebel CRM automatically calculates 
the number of divisions. For example, if the Divisions property 
includes the following value, then Siebel CRM draws five labels on 
the axis:

4

The Divisions property is required only for the x-axis and z-axis in 
a histogram chart.

Font Effect (O)(H) Specifies format to apply to the font, such as StrikeThrough. 
Applies to the AxisLabel, AxisTitle, Legend, and Title elements. To 
view the values you can use, click the Font Effect property in Siebel 
Tools.

Font Name (O) Specifies the font name that Siebel CRM uses for the element text. 
Applies to the Axis Label, Axis Title, and Title elements.

Font Size (O) Specifies the font size that Siebel CRM uses for the element text. 
Applies to the Axis Label, Axis Title, and Title elements. Siebel CRM 
does the following:

■ If the chart is minimized, and if the screen resolution is 1024 by 
768 or higher, then it applies this font size. 

■ If the chart is maximized, then it uses a larger font. 

■ If the screen resolution is lower, then it uses a smaller font.

Font Style (O)(H) Specifies the font style that Siebel CRM uses for the element text, 
such as Bold. Applies to the AxisLabel, AxisTitle, Legend, and Title 
elements. To view the values you can use, click the Font Style 
property in Siebel Tools.

Table 18. Properties of the Chart Element

Property Description
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Graphic Type (O) Specifies the type of graphic element that Siebel CRM draws. The 
Coordinates property specifies the graphic geometry. Applies to the 
Graphic element. To view the values you can use, click the Graphic 
Type property in Siebel Tools.

If you set the Type property of the chart element to Graphic, then 
you must set the Graphic Type property. 

Line Style (O) Specifies the line style that Siebel CRM uses for a Graphic or 
AxisLineGrid element. Applies to the AxisLineGrid and Graphic 
elements. Siebel CRM applies this property only if the Line Width 
property is 0 or is empty. To view the values you can use, click the 
Line Style property in Siebel Tools.

Line Width (O) Specifies the line thickness that Siebel CRM uses. Applies to the 
AxisLineGrid and Graphic elements. You can use any positive 
number. The default value is 0, which is a thin line.

Table 18. Properties of the Chart Element

Property Description
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List Of Values (O) Specifies the list of possible values for the x-axis, y-axis, or z-axis 
that the Axis Id property specifies. Applies to the AxisLabel 
element. This property allows the user to specify values that Siebel 
CRM does not display, such as 0 or an empty value.

If you apply this property to the y-axis, then Siebel CRM displays 
string values on the y-axis instead of numeric values.

If you specify a list of values on the AxisLabel label for the X axis, 
then Siebel CRM displays every value that this list contains even if 
the returned value in the Y axis is 0 or empty. It displays these 
values on the X axis.

By default, if the value is empty, then Siebel CRM uses only the 
corresponding field values that the current business component 
contains for a given axis.

This property uses the following format:

business_component,field_name,search_specification,sor
t_specification

where:

■ business_component identifies the name of the business 
component that the current business object references.

■ field_name identifies the business component field that Siebel 
CRM uses to get the values that it displays.

■ search_specification specifies the search specification that 
Siebel CRM uses on the business component.

■ sort_specification specifies the sort specification that Siebel 
CRM uses on the business component. 

For example:

List Of Values,Value,Type = LEAD_QUALITY,Order By

For example:

Sales Cycle Def,Sales Cycle Stage,Sales Stage Order

Log Base (O) Specifies to use a logarithmic axis instead of a linear axis. Applies 
to the AxisLabel element. You can use any positive number. For 
example: 

■ If the value of the LogBase property is 10, then the axis displays 
1, 10, 100, 1000, 10000, and so on.

■ if the value of the LogBase property is 2, then the axis displays 
1, 2, 4, 8, 16, 32, 64, and so on.

Table 18. Properties of the Chart Element

Property Description
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Name (R) Specifies the name for the chart element. This name must be 
unique in the chart object.

Show Category Legend (O) Specifies to display a legend for the axis that the Axis Id property 
specifies. Siebel CRM applies this property only to the x-axis and z-
axis for the AxisLabel element.

If the x-axis labels are long, or if a large number of labels exist, 
then the labels might overlap.

You can use one of the following values:

■ TRUE. Display the entire x-axis group label on the x-axis.

■ FALSE. Do not display the entire x-axis group label on the x-
axis.

By default, if Siebel CRM displays more than one group on the x-
axis legend, then it displays only the first three letters of each x-
axis group.

Sort Specification (O) Specifies the sort operation that Siebel CRM performs on the axis 
that the Axis Id property identifies. Applies to the x-axis, y-axis, or 
z-axis of the AxisLabel element. This property uses the following 
format:

order,field_name

where:

■ order is Ascending, Descending, or None.

■ field_name identifies the field that Siebel CRM sorts according 
to a column other than the category or series.

For example, the following setting configures Siebel CRM to sort the 
Sales Stage Order field in ascending order:

Ascending,Sales Stage Order

For the y-axis, Siebel CRM sorts the x-axis labels according to y-
axis numeric values. If you specify a sort specification for the 
y-axis, then you cannot specify a sort specification for the x-axis.

If the List Of Values property contains a value, then Siebel CRM 
ignores the Sort Specification property. 

Text (O) Specifies the text that Siebel CRM displays for the AxisTitle, 
Legend, Title, or HorizLine element.

Table 18. Properties of the Chart Element

Property Description
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Configuring the Coordinates Property of a Chart Element
The Coordinates property of a chart element specifies coordinates for the Graphic and AxisLabel 
elements. This property is required for the following items:

■ Graphic elements

■ X-axis labels in a scatter chart

■ X-axis and z-axis labels in a histogram chart

Rectangle, Ellipse, and Line apply only to the scatter chart. HorizLine and HorizArea apply to all 
charts. 

A histogram chart requires the following items:

■ Coordinates for the axes that the user categorizes

■ A value in the Divisions property. 

The value you enter depends on the following type of element you specify:

■ AxisLabel. You specify the minimum and maximum values for the Axis Id. You enter two 
numbers that specify the following coordinates:

■ Minimum value

■ Maximum value

For example:

0 1000000

This example sets a range that includes 0 through 1 million.

Type (O) Specifies the type of chart element. Applies to all elements. To view 
the values you can use, click the Type property in Siebel Tools.

Vertical (O) Specifies to display labels vertically on the x-axis. Applies to the 
AxisLabel element. Note the following:

■ If the x-axis contains less than five labels, then Siebel CRM 
ignores the Vertical property and displays all labels horizontally.

■ If a long label exists, then Siebel CRM moves the chart upward. 

■ If the monitor is a low resolution, then space is limited.

■ Siebel CRM cannot display all fonts vertically. 

■ The Vertical property does not apply to a Period chart.

You can use one of the following values:

■ TRUE. Display the labels vertically.

■ FALSE. Display the labels horizontally.

Table 18. Properties of the Chart Element

Property Description
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■ Rectangle, Line, or Ellipse. You enter four numbers that specify the following coordinates:

■ Left

■ Bottom

■ Top

■ Right

For example:

60 1000 80 3000

This example sets the coordinates so that the left side of the element occurs at coordinate 60, 
the bottom at coordinate 1000, the top at coordinate 80, and the right side at coordinate 3000.

■ HorizArea. You enter four numbers that specify the following coordinates:

■ minYaxisValue

■ maxYaxisValue

20 50

This example configures Siebel CRM to draw the horizontal area between y coordinate 20 and y 
coordinate 50.

■ HorizLine. You enter one number that specifies the YaxisValue. For example:

40000

This example configures Siebel CRM to draw a horizontal line at a y coordinate of 40000.

Properties That Siebel CRM Uses for Different Types of Chart Elements
Table 19 describes the properties that Siebel CRM uses for different types of chart elements.
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Table 19. Properties That Siebel CRM Uses for Different Types of Chart Elements

Type of Chart Element Properties

Axis Label Siebel CRM uses the following properties:

■ Axis Id

■ Color

■ Coordinates

■ Display Format

■ Divisions

■ Font Effect

■ Font Name

■ Font Size

■ Font Style

■ List Of Values

■ Log Base

■ Show Category Legend

■ Sort Specification

■ Vertical

Axis Line Grid Siebel CRM uses the following properties:

■ Axis Id

■ Color

■ Line Style

■ Line Width

You cannot configure the AxisLineGrid element.

Axis Title Siebel CRM uses the following properties:

■ Axis Id

■ Color

■ Font Effects

■ Font Name

■ Font Size

■ Font Style

■ Text
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Chart Element Locale
A chart defines language overrides that Siebel CRM uses with a chart element.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Chart > Chart Element > Chart Element Locale

Graphic Siebel CRM uses the following properties:

■ Color

■ Coordinates

■ Graphic Type

■ Line Style

■ Line Width

■ Text

Legend Siebel CRM uses the following properties:

■ Color

■ Font Effect

■ Font Name

■ Font Size

■ Font Style

You cannot configure the Font Name property or the Font Size 
property.

Plot Siebel CRM uses the following properties:

■ Color

Siebel CRM release 7.x does not support the Plot chart element.

Title Siebel CRM uses the following properties:

■ Color

■ Font Effect

■ Font Name

■ Font Size

■ Font Style

■ Text

Table 19. Properties That Siebel CRM Uses for Different Types of Chart Elements

Type of Chart Element Properties
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Table 20 describes properties that Siebel CRM uses with a chart element locale.

Chart Locale
A chart locale defines language overrides that Siebel CRM uses with a chart.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Chart > Chart Locale

Table 21 describes properties that Siebel CRM uses with a chart locale.

Control
A control defines an element in an applet, such as a text box, check box, or button. You can add user 
properties to a control.

Table 20. Properties of the Chart Element Locale

Property Description

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Text (O) Specifies the name of the chart element that Siebel CRM displays in 
the client for a language.

Table 21. Properties of the Chart Locale

Property Description

Category Captions (O) Specifies the caption for the x-axis for a language.

Data Point Captions (O) Specifies the caption for the y-axis for a language.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Picklist Function Captions 
(O)

Specifies the captions for the list of functions that Siebel CRM 
displays for the y-axis label for a language.

Picklist Period Captions (O) Specifies the captions for the list of time periods that Siebel CRM 
displays for the x-axis label for a language.

Picklist Type Captions (O) Specifies the captions for the types of charts for a language.

Series Captions (O) Specifies the caption for the z-axis for a language.
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This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Control

Table 22 describes properties for the control object. For more information about controls, see the 
topic on field data types in Configuring Siebel Business Applications. For information about user 
properties, see Siebel Developer’s Reference.

Table 22. Properties of the Control

Property Description

ActiveX Bind Property 
(O)(H)

Specifies the name of a property of an ActiveX control. To bind a 
field to an ActiveX control, you must also specify the name of this 
field in the Field property of this control object. This field must 
reside in the business component that the applet references. Siebel 
CRM does the following:

■ If Siebel CRM modifies the property value of the ActiveX control, 
then it saves this value in this field in the current business 
component record. 

■ If Siebel CRM modifies the field value, then it saves this value 
in the property of the ActiveX control.

This property applies to an ActiveX control.

ActiveX Properties (O)(H) Includes a compressed version of the ActiveX properties for this 
control. You do not edit this property. Siebel CRM automatically sets 
the value that this property contains. To determine this value, it 
uses values of the ActiveX properties in the Properties window or 
values of the properties in the property window for the control.

This property applies to an ActiveX control.

Automatic Horizontal Scroll 
(O)(H)

Enables automatic horizontal scroll. If set to TRUE, and if:

■ The user types a character at the end of the line, then Siebel 
CRM automatically scrolls text to the right by ten characters. 

■ The user presses Enter, then Siebel CRM automatically scrolls 
all text back to position 0.

This property applies only to a TextBox control.

Automatic Vertical Scroll 
(O)(H)

Enables automatic vertical scroll. If set to TRUE, and if the user 
presses the ENTER key on the last line, then Siebel CRM 
automatically scrolls text up one page.

This property applies only to a TextBox control.
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Background Color (O)(H) Specifies a space-separated RGB (red, green, blue) value. You can 
set the value of the Background Color property to for a Label, 
Image, or PushButton control to one of the following values:

■ Transparent. Makes the control transparent. 

■ A value other than Transparent. Makes these controls 
opaque.

Siebel CRM only sets the area under the caption to the color that 
the Background Color property specifies for a Group control. 

This property applies to the following types of controls:

■ Textbox

■ Label

■ PushButton

■ ComboBox

■ Group

Bitmap (O)(H) Specifies a bitmap from the Control Icons bitmap category that 
Siebel CRM uses for the image control. This value applies to static 
image controls that do not reference a field in the current record.

This property applies to an Image control.

Caption (O) Specifies headers for list applet columns, field prompts, and link 
names. You can set this property to a bitmap that resides in the 
Button Icons bitmap category. 

For a list applet, Siebel CRM uses the value that the Caption control 
property contains in the following ways:

■ To create the sortable list header. The ListHeader property of 
the swe:control tag determines this header. 

■ To determine a field prompt. The DisplayName property of the 
swe:control tag determines this prompt.

If a control calls a method, then Siebel CRM uses the value in the 
Caption property as the link name or button label. The 
FormattedHtml property of the swe:control tag determines this 
name or label.

Class (O) Specifies the name of the C++ class that this control references. 
This property applies only to a Java control or an ActiveX control.

Table 22. Properties of the Control

Property Description
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Content Fixup Name (O) Specifies a name that determines how Siebel CRM fixes links and 
images in the HTML page:

■ The Siebel Server for a Siebel Business Application. Siebel CRM 
fixes links and images.

■ The client browser fixes links and images. 

For more information, see Siebel Portal Framework Guide.

Default Button (O)(H) Not used. This property applies only to a PushButton control.

Detail Applet (O) Specifies the name of the pop-up applet that Siebel CRM uses to 
display data from fields in the business component. This property 
applies only to a TextBox control or a PushButton control.

Display Format (O) Specifies the format that Siebel CRM uses to display data for this 
control. This property applies only to a TextBox control.

Field (O) Specifies the business component field or applet message that 
provides the data that this control displays. This property applies to 
the following types of controls:

■ TextBox

■ CheckBox

■ ImageControl

Field Retrieval Type (O) Specifies the type of field data. You can use one of the following 
values:

■ Field Data. Rich content HTML.

■ Service.

■ Symbolic URL. Specially constructed URL that integrates data 
from the Siebel database and the external content service.

■ URL. Standard reference to a Web page.

■ Empty. Siebel CRM encloses the field value with a SPAN tag.

■ HTML Attachment. Obsolete. Do not use.

Field Type (O) Specifies to display data from a business component field or an 
applet message. Siebel Tools automatically sets this property when 
you set the Field property.

Table 22. Properties of the Control

Property Description
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Foreground Color (O)(H) Specifies an RGB value. You use an empty space to separate each 
number in this value.

This property applies to the following types of controls:

■ Textbox

■ Label

■ PushButton

■ CheckBox

■ ComboBox

■ Group

Group (O)(H) Not used.

Height - Language Override 
(O)(H)

Specifies the height of the control in pixels if a language or locale 
is active.

Height (O)(H) Specifies the height of the control in pixels. You can set this 
property to a number that is greater than or equal to 0. The default 
value is 10. This property applies to all controls.

HTML Attributes (O) Specifies to add HTML tag attributes to the HTML tags that the client 
creates when it displays the control.

For example, If you set the HTML Attributes property to size=30 for 
a text box, then the client creates the following tag:

<input type = text size=30 . . .>

HTML Bitmap (O) Specifies a Bitmap object that resides in the HTML Control Icons 
bitmap category. If the HTML Disabled Bitmap property is:

■ Empty. Siebel CRM uses the image that the HTML Bitmap 
property references.

■ Not empty. Siebel CRM uses the image that the HTML Bitmap 
property references only if the control is in an enabled state.

HTML Default Control 
(O)(H)

Not used.

HTML Disabled Bitmap (O) Specifies the image to use instead of the image that the HTML 
Bitmap property references if the control is in a disabled state.

Table 22. Properties of the Control

Property Description
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HTML Display Mode (O) Specifies how to display the field value. To support an applet 
message, you must set this property to FormatData. This 
configuration allows Siebel CRM to use newlines and spaces in the 
applet message. You can use one of the following values:

■ EncodeData. Siebel CRM encodes any HTML reserved 
characters that the field value contains before it displays these 
characters. Each of the following symbols is an example of an 
HTML reserved character:

■ < (less than symbol)

■ > (greater than symbol)

■ & (ampersand)

■ and so on

It is recommended that you set the HTML Display Mode to 
EncodeData for security purposes. For more information about 
setting this property, see Siebel Security Hardening Guide.

■ FormatData. Siebel CRM formats text that the user enters. For 
example, assume the user enters text that includes new lines 
and tabs in the description field of a service request. Assume 
you set the HTML Display Mode property to one of the following 
values:

■ FormatData. Siebel CRM formats the text that the user 
enters in HTML so that it uses the same format that the user 
enters.

■ Not set to FormatData. Siebel CRM does not format the 
text that the user enters. It displays the entire text string 
that the user enters on one line. 

Table 22. Properties of the Control

Property Description
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HTML Height (O) Specifies the height of the control in pixels.

You typically do not modify this property manually. Siebel Tools 
sets it automatically if you edit an applet layout in a Siebel Tools 
layout editor. 

If you use a TextArea field that spans multiple fields, then to 
accommodate the buffer between the fields of a grid form, it might 
be necessary for you to add 2 pixels for each row. For example, 
consider the TextArea field that the Description control of the 
Service Request Detail Applet references. This field spans three 
rows of single-row fields. To align the bottom of this field with other 
fields, such as Home Phone#, you must increase the value in the 
HTML Height property an additional 2 pixels for every row of fields 
that the TextArea field spans, not including the first row. In this 
situation, the Description control spans three rows of fields. You 
increase the HTML Height property to 2 rows multiplied by 2 pixels 
for a total of 4 pixels. You modify the original HTML Height of 72 
pixels to 76 pixels. 

This property applies to the following types of controls:

■ Java applet

■ ActiveX

■ Input type controls

HTML Height - Language 
Override (O)

Specifies the height of the control in pixels if a language or locale 
is active.

HTML Icon Map (O) Specifies to map field values to icons as defined in the icon map.

HTML Max Chars Displayed 
(O)

Specifies the maximum number of characters that Siebel CRM 
displays in a control.

This property applies only if the parent applet is in Base mode or if 
the control is read-only. It does not limit the number of characters 
that the user can enter into a text control in edit mode.

HTML Max Chars Displayed - 
Language Override (O)

Specifies the maximum number of characters that Siebel CRM 
displays in a control if a language or locale is active.

HTML Only (O) Specifies to use the control only in the Siebel Web Client. You can 
use one of the following values:

■ TRUE. Use this control only in the Siebel Web Client. 

■ FALSE. Use this control in any client. 

Table 22. Properties of the Control

Property Description
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HTML Row Sensitive (O) Specifies to position the applet. You can use one of the following 
values:

■ TRUE. Position the applet on the current record before calling 
the method that the Method Invoked property references.

■ FALSE. Do not position the applet.

The following methods are examples that require you to set the 
HTML Row Sensitive property to TRUE:

■ EditRecord

■ DeleteRecord

■ Drilldown

HTML Sequence (O) Specifies the order that Siebel CRM uses to position this control 
relative to other controls that it displays in the applet in the Siebel 
Web Client.

HTML Sequence - Language 
Override (O)

Specifies the HTML sequence if a language or locale is active.

HTML Type (O) Specifies how to display the control. If the HTML Type property is 
empty, then Siebel CRM uses the Type property.

If your configuration requires an applet message, then you must set 
this property to Plain Text so that Siebel CRM wraps long text in the 
applet message.

HTML Width (O) Specifies the width of the control in pixels in the Siebel Web Client. 
The maximum value is 2048. This property applies to the following 
types of controls:

■ Java applet

■ ActiveX

■ Input type controls

HTML Width - Language 
Override (O)

Specifies the HTML width if a language or locale is active.

Left - Language Override 
(O)(H)

Specifies the left coordinate of a control if a language or locale is 
active.

Left (O)(H) Specifies the left coordinate of this control in pixels. This property 
applies to all controls. You can enter a number that is greater than 
or equal to 0.

Left Text (O)(H) If this property is TRUE, then Siebel CRM places text on the left side 
of the control. This property applies only to a CheckBox control.

Table 22. Properties of the Control

Property Description
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MethodInvoked (O) Specifies the method that Siebel CRM calls if the user clicks a button 
control. If the control type is not PushButton, then Siebel CRM 
ignores this property.

The method that is available for a button control depends on the 
class that the applet references and the class that the business 
component references. The following methods are available for the 
CSSFrameList applet class and the CSSFrame applet class:

■ NewRecord

■ DeleteRecord

■ CopyRecord

■ UndoRecord 

You must use other methods only with caution. For more 
information, see “Configuring the MethodInvoked Property of a 
Control” on page 77 and Siebel Developer’s Reference.

This property applies only to a PushButton control.

Table 22. Properties of the Control

Property Description
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Multi Line (O)(H) Specifies a multiple-line TextBox control. You can use one of the 
following values:

■ TRUE. Allows a multiple-line TextBox.

■ FALSE. Does not allow a multiple-line TextBox.

Scrolling depends on the following value of the Automatic Vertical 
Scroll style:

■ TRUE. Siebel CRM displays the control for as many lines as 
possible. If the user presses Enter, then it scrolls vertically.

■ FALSE. Siebel CRM displays the control for as many lines as 
possible. If it cannot display any more lines, and if the user 
presses the Enter key, then it beeps. If the Automatic 
Horizontal Scroll style is TRUE, and if the cursor goes past the 
right edge of the control, then multiple-line control 
automatically scrolls horizontally.

To start a new line, the user must press the ENTER key. If 
Automatic Horizontal Scroll is FALSE, then Siebel CRM 
automatically wraps the control words to the beginning of the next 
line, if necessary. If the user presses the ENTER key, then Siebel 
CRM starts a new line. The window size determines the text 
position. If the user modifies the window size, then Siebel CRM 
displays the text again.

If a TextBox control:

■ Includes scroll bars. It processes its own scroll bar messages. 

■ Does not include scroll bars. It processes any scroll 
messages that the parent window sends.

The default value is single line.

This property applies only to a TextBox control.

MVG Applet (O) Specifies the applet that Siebel CRM uses for a pop-up multivalue 
group if the field that the control references is a multivalue field and 
if the Runtime property of this control is TRUE.

This property applies only to a TextBox control.

Name (R) Specifies the name of the control. This property applies to all 
controls.

Owner Draw (O)(H) If TRUE, then Siebel CRM displays the bitmap that the Caption 
property references. It displays this bitmap on the button. This 
property applies only to a PushButton control.

Table 22. Properties of the Control

Property Description
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Pick Applet (O) Specifies the applet that Siebel CRM uses for the pop-up picklist if 
you specify a picklist for the field that the control references and if 
the Runtime property of this control is TRUE.

This property applies only to a TextBox control.

Prompt (O) Not used. This property applies only to a TextBox control.

Prompt Text (O) For more information, see “Configuring the Prompt Text Property of 
a Control or List Column” on page 78.

Read Only (O) You can use one of the following values:

■ TRUE. The user cannot edit the control.

■ FALSE. The user can edit the control.

If the Read Only property of the field that this control references is 
TRUE, then this control is also read-only even if the Read Only 
property of this control is FALSE.

This property applies only to a TextBox control.

Runtime (O) You can use one of the following values:

■ TRUE. Siebel CRM displays a pop-up button for a picklist, 
calculator, calendar, or multivalue group at run time.

■ FALSE. Siebel CRM does not display a pop-up button.

This property applies only to a TextBox control.

Sequence - Language 
Override (O)(H)

Specifies the order that Siebel CRM uses to display this control 
relative to other controls in the applet if a language or locale is 
active.

Sequence (O)(H) Specifies the order that Siebel CRM uses to display this control 
relative to other controls in the applet. You can use a number that 
is greater than or equal to 1.

This property applies to all controls.

Table 22. Properties of the Control

Property Description
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Show Popup (O) You can use one of the following values:

■ TRUE. Siebel CRM opens a new browser window before it calls 
the method.

■ FALSE. Siebel CRM calls the method in the current browser 
window.

You must not set the Show Popup property to TRUE in the following 
situations:

■ A script uses the GotoView application object method.

■ Siebel CRM uses TheApplication.GotoView. In this situation, it 
opens the view in a new browser window. The client does not 
support Multiple Document Interface (MDI). Siebel CRM does 
not support this configuration.

Sort (O) You can use one of the following values:

■ TRUE. Siebel CRM automatically sorts strings that the user 
enters in the control.

■ FALSE. Siebel CRM does not automatically sort strings that the 
user enters in the control.

This property applies only to a ComboBox control.

Tab Stop (O)(H) You can use one of the following values:

■ TRUE. Allow the user to use the TAB key to navigate to the next 
control that the Sequence property specifies.

■ FALSE. Do not allow the user to use the TAB key.

This property applies to all controls.

Target View Frame (O) Specifies the HTML page that Siebel CRM loads into the frame if the 
user clicks a control that calls a method.

You can use one of the following values:

■ Self. Open the frame that contains the applet control.

■ Blank. Open a new full feature window.

■ Others. Open some other frame.

This property applies to a Siebel Web Client control.

Text Alignment (O) Specifies how to align the text in the control. To view the values you 
can use, click the Text Alignment property in Siebel Tools. This 
property applies only to a TextBox control or a 
Label control.

Table 22. Properties of the Control

Property Description
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Text Alignment - Language 
Override (O)

Specifies how to align the text in the control if a language or locale 
is active. For more information, see the description for the Text-
Alignment Label property.

Text Alignment-Label - 
Language Override (O)

Specifies how to align the text of a control label on a form applet if 
a language or locale is active. This alignment occurs automatically 
for a locale that the user reads from right to left, such as Japanese.

Text Style (O)(H) Specifies the text style that Siebel CRM uses to display this control. 
The Text Style object type determines the font type and font style. 
For more information, see “Text Style (H)” on page 272.

This property applies to the following types of controls:

■ CheckBox

■ ComboBox

■ Group

■ Label

■ PushButton

■ TextBox

Text-Alignment Label (O) Specifies how to align the text of a control label on a form applet. 
To view the values you can use, click the Text-Alignment Label 
property in Siebel Tools. 

For example, a field and a field label in a grid form applet are 
separate applet web template items that each reference the same 
control. To place a label to the left of a field, you do the following:

■ Set the Text-Alignment Label property for the control that 
includes the label text to Right. 

■ Set the Text-Alignment Label property for the control that 
includes the field text to Left.

Tooltip Text (O)(H) Obsolete. Do not use. This property applies to a Button control.

Top - Language Override 
(O)(H)

Specifies the order that Siebel CRM uses to display controls if a 
language or locale is active.

Top (O)(H) Specifies the top coordinate of this control in pixels. The top 
coordinate of the applet is 0. You can specify a number that is 
greater than or equal to 0. This property applies to all controls.

Type (O)(H) Specifies the control type. To view the values you can use, click the 
Type property in Siebel Tools. This property applies to all controls.

Table 22. Properties of the Control

Property Description
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Configuring the MethodInvoked Property of a Control
Siebel CRM does the following in an HTML client according to the value of the MethodInvoked 
property:

1 The user clicks a button.

2 The MethodName property of control that this button references control calls an InvokeMethod 
call in the browser applet class. This class runs in the HTML browser.

3 A Browser Script on the applet includes a PreInvokeMethod handler that intercepts the method 
and handles the PreInvokeMethod event.

Vertical Scroll (O)(H) You can use one of the following values:

■ TRUE. Siebel CRM displays a vertical scroll bar in the control.

■ FALSE. Siebel CRM does not display a vertical scroll bar in the 
control.

This property applies only to a ComboBox control or a TextBox 
control.

Visible (O) You can use one of the following values:

■ TRUE. Siebel CRM displays the control in the client.

■ FALSE. Siebel CRM does not display the control in the client.

This property applies to all controls.

Visible - Language Override 
(O)

You can use one of the following values:

■ TRUE. Siebel CRM displays the control in the client if it uses the 
language that you specify as the language override.

■ FALSE. Siebel CRM does not display the control in the client.

Want Return (O)(H) If the user presses the ENTER key in a multiple-line TextBox 
control, and if the Want Return property is:

■ TRUE. Siebel CRM inserts a carriage return.

■ FALSE. Siebel CRM performs the same logic it performs if the 
user clicks the default pushbutton for the applet.

This property applies only to a multiple-line TextBox control. It has 
no effect on a single-line TextBox control.

Width - Language Override 
(O)(H)

Specifies the order of controls if a language or locale is active.

Width (O)(H) Specifies the width of the control in pixels. You can specify a 
number that is greater than or equal to 0. The default value is 40. 
This property applies to all controls.

Table 22. Properties of the Control

Property Description
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4 If Siebel CRM does not handle the InvokeMethod call in the:

■ Browser applet class. It does an InvokeMethod call in the server applet class. The client 
applet class uses this method to call the server applet unless a specialized client applet exists 
that handles this method in the client. To handle this method, you can use a 
WebApplet_PreInvokeMethod script in Siebel VB or Siebel eScript.

■ Server applet class. It forwards the call to the business component that the applet 
references. This business component resides on the server. To handle this method, you can 
use a BusComp_PreInvokeMethod script in Siebel VB or Siebel eScript.

5 If Siebel CRM does not handle the InvokeMethod on the business component that resides on the 
server, then it returns an error.

Configuring the Prompt Text Property of a Control or List Column
The Prompt Text Property specifies the text that Siebel CRM displays in the status bar of the Browser 
that displays the client. This property applies only to a form applet or list applet. The Prompt Text 
field can include a maximum of 250 characters. This maximum value exceeds the space that is 
available for this text in the Browser status bar. This status bar can display only approximately 127 
characters in Internet Explorer version 7.0.

Control Locale
A control locale defines language overrides that Siebel CRM uses with a control.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Control > Control Locale

Table 23 describes properties that Siebel CRM uses with a control locale.

Table 23. Properties of the Control Locale

Property Description

Caption (O) Specifies the as headers for list applets columns, field prompts, and 
link names.

Height (O)(H) Specifies the height of the control in pixels.

HTML Height (O) Specifies the height of the control in pixels.

HTML Max Chars Displayed 
(O)

Specifies the maximum number of characters that Siebel CRM 
displays in a control.

HTML Sequence (O) Specifies the order that Siebel CRM uses to 

The (order) position of this control relative to other controls in the 
applet in the Siebel Web Client. Indicates tab sequence.

HTML Width (O) Specifies the width of the control in pixels in the Siebel Web Client.
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Control User Prop
A control user prop sends a property value to specialized C++ code. Siebel CRM persists the value 
that you configure for a user property in the Siebel runtime repository. For more information, see 
“Object Types That You Must Not Modify” on page 18.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Control > Control User Prop

Table 24 describes properties that Siebel CRM uses with a control user prop.

Left (O)(H) Specifies the left coordinate of this control in pixels.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Prompt Text (O) For more information, see “Configuring the Prompt Text Property of 
a Control or List Column” on page 78.

Sequence (O)(H) Specifies the order that Siebel CRM uses to 

Sets the (order) position of this control relative to other controls in 
the applet.

Text Alignment (O) Specifies how to align text in the control. You can use one of the 
following values:

■ Left

■ Center

■ Right

Text-Alignment Label (O) Specifies the Text-Alignment Label property if a language or locale 
is active. Siebel CRM associates this property with the Text 
Alignment Label Language Override property of a control.

Tooltip Text (O) Obsolete. Do not use. 

Top (O)(H) Specifies the top coordinate of this control in pixels. The top 
coordinate of the applet is 0. You can specify a number that is 
greater than or equal to 0.

Visible (O) You can use one of the following values:

■ TRUE. Siebel CRM displays the control in the client.

■ FALSE. Siebel CRM does not display the control in the client.

Width (O)(H) Specifies the width of the control in pixels. You can specify a 
number that is greater than or equal to 0.

Table 23. Properties of the Control Locale

Property Description
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Drilldown Object
A drilldown object allows the user to drill down on a field in a list applet and navigate to another view 
where Siebel CRM displays more data about the field. To identify a drilldown field in a list, Siebel 
CRM uses colored, underlined text. For more information about how to configure drilldown on a form 
applet in Siebel Open UI, see Article ID 539183.1 on My Oracle Support.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Drilldown Object

Table 25 describes properties that Siebel CRM uses with a drilldown object.

Table 24. Properties of the Control User Prop

Property Description

Name (R) Specifies the name of the user property.

Value (R) Specifies the value of the user property.

Table 25. Properties of the Drilldown Object 

Property Description

Business Component (O) Specifies the destination business component. If this property is 
empty, then Siebel CRM uses the same business component for the 
destination business component that it uses for the source business 
component, although it typically modifies the view.

If the destination view must display the same active business 
components in the same context, and if you do not require Siebel 
CRM to modify the current query context, then do not specify a 
value in any of the following properties for this drilldown object:

■ Business Component

■ Destination Field

■ Source Field

Destination Field (O) Specifies field in the destination business component. The value 
that this field contains equals the value that the source field 
contains in the source business component. If you do not specify a 
business component, then do not specify a value in the Destination 
Field property.

If the Destination Field property is empty, then it defaults to Id, 
which is the row ID of the destination business component.
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Hyperlink Field (O) Specifies a business component field that the applet references that 
Siebel CRM uses for the drilldown. This property also determines 
the field in the list column in the list applet that is blue and 
underlined.

You must enter a value in the Hyperlink Field property. If you do 
not enter a value, then Siebel CRM does not display a link that the 
user can click to drill down.

Menu Text (O) Not used.

Name (R) Specifies the name of the drilldown object. This name must be 
unique among drilldown objects in the applet.

Sequence (O) Specifies a sequence number that Siebel CRM uses in a dynamic 
drilldown. This number determines the default drilldown object.

Source Field (O) Specifies a business component field that the applet references. 
This field is the source of the drilldown. Siebel CRM applies the 
value that this field contains as a search specification to the 
destination field in the destination business component. Because 
the user navigates from one view to another view, a new active 
business component occurs. The following properties establish a 
relationship from a record in the source business component to the 
appropriate record or set of records in the destination business 
component:

■ Source Field

■ Business Component

■ Destination Field

If you do not specify a value in the Business Component property 
for this drilldown object, then do not specify a value in the Source 
Field property.

If the Source Field property is empty, then Siebel CRM drills down 
to the same row in the destination business component.

Table 25. Properties of the Drilldown Object 

Property Description



Siebel Object Types Reference Siebel 2018

Siebel Object Types Reference ■ Applet Object Types

82 

Drilldown Object Locale
A drilldown object locale defines language overrides that Siebel CRM uses with a drilldown object.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Drilldown Object > Drilldown Object Locale

Table 26 describes properties that Siebel CRM uses with a drilldown object locale.

List
A list contains information for list applets. For a list applet, there must be one and only one list object 
definition. If the applet is not a list applet, then there are no list object definitions.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > List

Table 27 describes properties that Siebel CRM uses with a list.

View (O) Specifies the view that Siebel CRM displays if the user drills down. 
If the View property is empty, then:

■ Siebel CRM continues to display the current view. For example, 
if the user drills down from an account to a subaccount.

■ You must specify a value in the Business Component property.

Visibility Type (O) Specifies a visibility type that is different than the default visibility 
for the destination business component. To view the values you can 
use, click the Visibility Type property in Siebel Tools.

You typically set this value to All. This value makes sure that Siebel 
CRM can display the destination record.

Table 26. Properties of the Drilldown Object Locale

Property Description

Menu Text (O) Specifies the text that Siebel CRM displays in the right-click 
shortcut menu for a row for a language.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Table 25. Properties of the Drilldown Object 

Property Description
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List Column
A list column associates one list column to a list applet. You can add user properties to a list column. 
For more information about controls, see the topic about field data types in Configuring Siebel 
Business Applications. For information about user properties, see Siebel Developer’s Reference.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > List > List Column

Table 28 describes properties that Siebel CRM uses with a list column.

Table 27. Properties of the List

Property Description

Alpha Tab Search Field 
(O)(H)

Specifies the name of the business component field that Siebel CRM 
uses when it does an alpha tab search. If this property includes a 
value, then Siebel CRM displays an alphabet tab search bar in the 
list applet.

Alpha Tab Search Field - 
Language Override (O)(H)

Specifies the alpha tab search field if a language or locale is active.

HTML Hierarchy Bitmap (O) Specifies the name of the HTML hierarchy bitmap. For more 
information, see “HTML Hierarchy Bitmap” on page 197.

HTML Multi Row Edit (O) You can use one of the following values:

■ TRUE. Siebel CRM can edit multiple rows without saving each 
row while in the Edit List mode of the applet.

■ FALSE. Siebel CRM must save each row to the Siebel database 
before it edits another row.

HTML Multi Row Select (O) You can use one of the following values:

■ TRUE. The user can choose multiple rows in an applet. 

■ FALSE. The user cannot choose multiple rows in an applet.

Name (R) Specifies the name in the applet. This value is List.

Total Displayed (O) Not used.

Total Required (O) If TRUE, then Siebel CRM sums and displays at the bottom of the 
list the columns whose Total Required property is TRUE. Siebel CRM 
uses this property only if the applet is a list applet.

Variable Row Height (O)(H) If TRUE, then the list applet supports variable row heights. For 
example, Notes. A variable row displays the first three lines by 
default. To display the entire line, the user must set the Text Lines 
Per Note Row in the List tab of the Options window to 3.
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Table 28. Properties of the List Column

Property Description

Available (O) If FALSE, then Siebel CRM does not display the list column in the 
list or in the Columns Displayed dialogue box. For more 
information, see the description of the Show In List property for this 
list column.

Available - Language 
Override (O)

Specifies to use this column with a list applet if a language or locale 
is active.

Bitmap Column Heading 
(O)(H)

You can use one of the following values:

■ TRUE. Display the bitmap specified in the Check Bitmap 
Identifier property as the list column heading.

■ FALSE. Display the normal name and display name in the list 
column heading.

You can use this property only in a Boolean list column that 
specifies a value for the Check Bitmap Identifier property.

Check Bitmap Identifier 
(O)(H)

Specifies the bitmap that Siebel CRM displays in the TRUE state if 
this list column is a CheckBox list column.

Content Fixup Name (O) Specifies to use the Siebel Server or the client browser to do fixup. 
This fixup allows Siebel CRM to display links and images in the HTML 
page. For more information, see Siebel Portal Framework Guide.

Detail Applet (O) Specifies the applet that Siebel CRM uses to display related data for 
the field that the list column from the same business component 
specifies.

Display Format (O) Specifies the format mask that Siebel CRM applies to the data. For 
example:

$#,###,###,###

Display Name (O) Specifies the value that Siebel CRM uses as the list column heading 
or the key to the international message table. For example:

Expected Value

Field (O) Specifies the field that provides the data that the list column 
displays. For example:

Amount Expected Value

Field Retrieval Type (O) Specifies that the field data is one of the following:

■ Rich content HTML data (Field Data) 

■ A predefined reference to a Web page (URL)

■ A specially created URL that integrates data from the Siebel 
database and the external content service (Symbolic URL)
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HTML Attribute (O) Specifies to add HTML tag attributes to the HTML tags that the client 
creates to display the list column.

HTML Display Mode (O) Specifies the display mode that Siebel CRM uses with a control that 
displays a field value. You can use one of the following values:

■ EncodeData. Encode any reserved characters in the markup 
language that exist in the field data so that it displays correctly.

■ FormatData. Encode any reserved characters in the markup 
language that exist in the field data so that it displays correctly. 
Format the field value using the markup language using the 
same format that the Siebel database uses. For example, if 
HTML is the markup language, then do the following:

■ Replace a newline with a br tag.

■ Replace contiguous white space with &nbsp.

HTML Height (O) Specifies the height of this list column in pixels in the Siebel Web 
Client.

HTML Height - Language 
Override (O)

Specifies the height of this list column in pixels in the Siebel Web 
Client if a language or locale is active.

HTML Icon Map (O) Specifies to map field values to icons that the icon map defines. For 
example:

CHECK

HTML List Edit (O) You can use one of the following values:

TRUE. If the applet displays in the Edit List mode, then display this 
control as a data input control.

FALSE. Display this control as a read-only control.

HTML Max Chars Displayed 
(O)

Specifies the maximum number of characters that Siebel CRM 
displays in a list column. This property applies only if the parent 
applet is in Base mode, or if the list column is read only. It does not 
limit the number of characters that the user can enter in a text 
control in edit mode.

HTML Max Chars Displayed - 
Language Override (O)

Specifies the maximum number of characters that Siebel CRM 
displays in a list column if a language or locale is active.

HTML Only (O) If TRUE, then Siebel CRM uses the control only in the Siebel Web 
Client.

Table 28. Properties of the List Column

Property Description
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HTML Row Sensitive (O) Specifies to position the applet on the current record before calling 
the method that the Method Invoked property specifies. The 
following methods are examples that require you to set the HTML 
Row Sensitive property TRUE:

■ EditRecord

■ DeleteRecord

■ Drilldown

HTML Sequence (O) Specifies the position of this list column relative to other list 
columns that Siebel CRM displays in the applet in the Siebel Web 
Client.

HTML Sequence - Language 
Override (O)

Specifies the position of this list column relative to other list 
columns that Siebel CRM displays in the applet in the Siebel Web 
Client if a language or locale is active.

HTML Type (O) Specifies how to display the list column. If this property is empty, 
then Siebel CRM uses the value that the Type property specifies.

HTML Width (O) Specifies the width of the list column in pixels in the Siebel Web 
Client. The maximum value is 2048.

HTML Width - Language 
Override (O)

Specifies the width of the list column in pixels in the Siebel Web 
Client if a language or locale is active.

MVG Applet (O) Specifies the applet that Siebel CRM uses to display the pop-up 
multivalue group if the properties of this list column are set as 
follows:

■ The Field property references a multivalue field.

■ The Runtime property is TRUE.

Name (R) Specifies the name of this list column.

Pick Applet (O) Specifies the applet that Siebel CRM uses to display the pop-up 
picklist if the properties of this list column are set as follows:

■ The Field property references a multivalue field.

■ The Runtime property is TRUE.

If this list column references a field that contains a static picklist, 
then Siebel CRM ignores this property. The only exception to this 
configuration occurs if the Long List property of this picklist is TRUE.

Popup Edit (O)(H) If TRUE, then a text field uses a pop-up edit box.

Prompt Text (O) For more information, see “Configuring the Prompt Text Property of 
a Control or List Column” on page 78.

Table 28. Properties of the List Column

Property Description
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Read Only (O) If TRUE, then the user cannot edit data. If the Read Only property 
of the field that the Field property of this list column references is 
TRUE, then this list column is read-only even if the Read Only 
property of this list column is FALSE.

Runtime (O) You can use one of the following values:

■ TRUE. Display a pop-up button at run time for a picklist, 
calculator, calendar, or multivalue group.

■ FALSE. Do not display a pop-up button at run time. Siebel CRM 
assumes there is no picklist or multivalue group or that the field 
is a date or time field.

Sequence (R)(H) Specifies the position of this list column in the list. This property can 
contain only an integer. For more information, see “Configuring the 
Sequence Property of a List Column to Import Records” on page 88.

Sequence - Language 
Override (O)(H)

Specifies the position of this list column in the list if a language or 
locale is active. This property can contain only an integer.

Show In List (O) If TRUE, then Siebel CRM displays this list column in a list.

If the Show In List property is FALSE, and if the Available property 
of this list column is TRUE, then Siebel CRM does not display list 
column in the applet unless the user chooses it from the Columns 
Displayed window.

Show In List - Language 
Override (O)

Specifies the list column that Siebel CRM displays in a list if a 
language or locale is active.

Show Popup (O) You can use one of the following values:

■ TRUE. Open a new browser window before calling the method.

■ FALSE. Call the method in the same browser window.

Text Alignment (O) Specifies the text alignment of this list column. 

Text Alignment - Language 
Override (O)

Specifies the text alignment of the list column if a language locale 
is active. You can use one of the following values:

■ Center

■ Left

■ Right

Text-Alignment Label (O) Specifies to align the text of the list column label on a list applet.

Table 28. Properties of the List Column

Property Description
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Configuring the Sequence Property of a List Column to Import Records
To import records, you must make sure you set the Sequence property of the list column so that 
Siebel CRM imports records in the correct order. For example, assume you must configure Siebel CRM 
so that the user can import service requests. To do this, the user navigates the Service Requests list, 
clicks Menu, and then clicks Import. To support this requirement, assume you do the following:

■ Configure hierarchical pick lists in the Service Request business component on the following 
fields:

■ Area. The Area field constrains the Sub-Area field.

■ Sub-Area. The Sub-Area field constrains the SR Type field. 

■ SR Type.

■ Create a custom import object and a list applet that uses the following configuration: 

Text Alignment-Label - 
Language Override (O)

Specifies the Text-Alignment Label property for a list column if a 
language or locale is active. Siebel CRM applies this configuration 
automatically for a locale that reads right-to-left, such as Japanese. 
You can use one of the following values:

■ Center

■ Left

■ Right

Total Currency Code 
Expression (O)

Specifies the currency that Siebel CRM uses to display the total 
value. You can use this property to display the list column total in 
a converted currency. For example, assume an opportunity that 
uses dollars as the currency code includes two products. One 
product is priced with YEN and the other product is priced in USD. 
To display the list total in these currencies, you set the Total 
Currency Code Expression to the following value:

Parent: 'Opportunity.Currency Code'

Total Required (O) You can use one of the following values:

■ TRUE. Create a total value of all the values that this list column 
displays. You must also set the Total Required property of the 
list object definition to TRUE.

■ FALSE. Do not create a total value.

Type (O)(H) Specifies the list column type. 

Width (O)(H) Specifies the list column width.

Width - Language Override 
(O)(H)

Specifies the list column width if a language or locale is active.

Table 28. Properties of the List Column

Property Description
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■ Set Input Format to Comma Separated Text File 

■ Set Input Source to Auto Mapping

■ In the applet, you set the Sequence property to the following:

❏ 4 for the Sub-Area list column

❏ 1 for the SR Type list column

When the user runs this import, it fails and Siebel CRM enters the following errors in the import log 
file:

Failed to import 'Information' into the field 'SR Type'. 
Failed to import 'Information' into the field 'SR Type'. 

This import fails because the sequence that Siebel CRM uses when it imports these fields is not 
correct. It attempts to set the SR Type field before it sets the Sub-Area field, but this is not possible 
because the Sub-Area field constrains the SR Type. Siebel CRM must import the Sub-Area field first, 
choose a value for it, constrain the SR Type field according to the Sub-Area field, and then import 
the SR Type field. 

To avoid this problem, you must set the Sequence property of the list column in the applet that 
displays these fields to the following:

■ 1 for the Sub-Area list column.

■ 4 for the SR Type list column. 

List Column Locale
A list column locale defines language overrides that Siebel CRM uses with a list column.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > List > List Column > List Column Locale

Table 29 describes properties that Siebel CRM uses with a list column locale.

Table 29. Properties of the List Column Locale

Property Description

Available (O) If TRUE, then Siebel CRM can associate this list column with a list 
applet.

Display Name (O) Specifies a symbolic string that Siebel CRM uses for the list column 
heading. 

HTML Height (O) Specifies the height of this list column in pixels in the Siebel Web 
Client.
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List Column User Prop
A list column user prop sends a property value to specialized C++ code. Siebel CRM persists the 
value that you configure for a user property in the Siebel runtime repository.

For more information, see “Object Types That You Must Not Modify” on page 18.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > List > List Column > List Column User Prop

Table 30 describes properties that Siebel CRM uses with a list column user prop.

HTML Max Chars Displayed 
(O)

Specifies the maximum number of characters that Siebel CRM 
displays in a list column.

HTML Sequence (O) Specifies the position of this list column relative to other list 
columns in the applet in the Siebel Web Client if the list applet is in 
Edit, Query, or New mode.

HTML Width (O) Specifies the width of the list column in pixels in the Siebel Web 
Client. The maximum value is 2048.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Prompt Text (O) For more information, see “Configuring the Prompt Text Property of 
a Control or List Column” on page 78.

Sequence (O)(H) Specifies the position of this list column in the list. This property can 
contain only an integer.

Show In List (O) If TRUE, then Siebel CRM displays this list column in a list.

Text Alignment (O) Specifies the text alignment of the list column.

Text-Alignment Label (O) Specifies the Text-Alignment Label property if a language or locale 
is active. This property affects the Text Alignment Label Language 
Override property for this list column.

Width (O)(H) Specifies the width for this list column.

Table 30. Properties of the List Column User Prop

Property Description

Name (R) Specifies the name of the user property.

Value (R) Specifies the value of the user property.

Table 29. Properties of the List Column Locale

Property Description
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List Locale
A list locale defines language overrides that Siebel CRM uses with a list.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > List > List Locale

Table 31 describes properties that Siebel CRM uses with a list locale.

Tree
A tree defines a tree control in a tree applet. To create a view that allows the user to navigate a 
hierarchal list of records, Siebel CRM uses a tree applet. For example, the explorer view in the 
Service Requests screen uses a tree applet.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Tree

Table 32 describes properties that Siebel CRM uses with a tree.

Tree Node
A tree node corresponds to one folder that Siebel CRM displays in a tree applet. It references the 
following items:

Table 31. Properties of the List Locale

Property Description

Alpha Tab Search Field 
(O)(H)

Specifies the name of the business component field that Siebel CRM 
uses when it does an alpha tab search. If this property includes a 
value, then Siebel CRM displays an alphabet tab search bar in the 
list applet.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Table 32. Properties of the Tree

Property Description

HTML Hierarchy Bitmap (O) Specifies the name of the HTML hierarchy bitmap object that Siebel 
CRM uses to display icons on the tree.

Name (S) Specifies the name of this tree. The name is Tree.
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■ Label. Specifies the source of the text that Siebel CRM displays next to this folder. 

■ Applet. Specifies the name of the applet that Siebel CRM displays in the right half of the view if 
the user opens the folder. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Tree > Tree Node

Table 33 describes properties that Siebel CRM uses with a tree node.

Table 33. Properties of the Tree Node

Property Description

Applet (O) Specifies the applet that Siebel CRM displays if the user clicks this 
tree node. This applet is typically a list applet. A list applet is not 
required. If the Applet property is empty, then Siebel CRM does 
nothing.

Bitmap Category (O)(H) Not used.

Bitmap Index (O)(H) Specifies an integer that Siebel CRM uses to choose a bitmap for the 
document symbol as a subset of a multiimage bitmap. Siebel CRM 
uses this property internally. You must set it to the following value:

5 = document symbol

Bitmap Index Field (O)(H) Not used.

Business Component (O) Specifies the business component that Siebel CRM uses to populate 
values in this tree node. You specify the same business component 
that the applet references. You specify this applet in the Applet 
property of this tree node.

Display Name (O) Specifies the text that Siebel CRM displays next to the folder that it 
displays for this tree node.

HTML Closed Bitmap (O) Specifies the bitmap object that defines the properties of a closed 
folder image. The parent of the bitmap object must be the HTML 
Tree Icons bitmap category.

If the HTML Closed Bitmap property is not empty, then it overrides 
the Close Bitmap property of the HTML hierarchy bitmap object.

HTML Open Bitmap (O) Specifies the bitmap object that defines the properties of an open 
folder image. The parent of the bitmap object must be the HTML 
Tree Icons bitmap category.

If the HTML Open Bitmap property is not empty, then it overrides 
the Open Bitmap property of the HTML hierarchy bitmap object.

Label Field (O) Specifies the name of a business component field that Siebel CRM 
uses to populate the names of the document object definitions in 
this tree node.
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Tree Node Locale
A tree node locale defines language overrides that Siebel CRM uses with a tree node.

This object type occurs in the following location in the object hierarchy:

Max Child Items (O) Specifies an integer that sets a limit on the number of child items 
that Siebel CRM displays in this tree node.

Name (R) Specifies the name of this tree node. This name must be unique in 
the tree.

Position (R) Specifies the position where Siebel CRM places this tree node in the 
tree hierarchy. This value includes integer values separated by 
periods. For example:

1.2.3.14

where:

■ 1 is the top level in the hierarchy.

■ 2 is one level below level 1.

■ 3 is one level below level 2.

■ 14 is one level below level 3 and indicates that this tree node is 
in the 14th position of level 4.

Recursive (S) If TRUE, then this tree node and all the tree nodes below it include 
the same type of Siebel CRM data. For example, an account can 
include subaccounts. Each of these subaccounts can include more 
subaccounts.

Recursive Link (O) Specifies the name of the link that defines the relationship with the 
business component. You can use it only if the Recursive property 
of this tree node is TRUE.

Root Search Spec (O) Specifies a string value that determines the list of records at the top 
level of the tree. You use it primarily for a recursive tree to create 
a starting point for the tree. For example:

[Parent Account Id] is NULL

Selected Bitmap Index 
(O)(H)

Specifies an integer that identifies the bitmap in a multiple bitmap 
file that Siebel CRM displays if the user chooses a record. You must 
use the following value:

5

Selected Bitmap Index Field 
(O)(H)

Not used.

Table 33. Properties of the Tree Node

Property Description
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■ Siebel Objects > Applet > Tree > Tree Node > Tree Node Locale

Table 34 describes properties that Siebel CRM uses with a tree node locale.

Application Object Types
This topic describes the Application object type and object types that are children of this object type. 
It includes the following topics:

■ Application on page 95

■ Application Browser Script on page 96

■ Application Event Services on page 97

■ Application Find on page 97

■ Application Locale on page 98

■ Application Method Menu Item (H) on page 98

■ Application Method Menu Item Locale (H) on page 99

■ Application Server Script on page 99

■ Application Toolbar (H) on page 100

■ Application User Prop (H) on page 100

■ Page Tab on page 100

■ Page Tab Locale on page 101

■ Screen Menu Item on page 101

■ Screen Menu Item Locale on page 102

Table 34. Properties of the Tree Node Locale

Property Description

Display Name (O) Specifies the text that Siebel CRM displays next to the folder that 
corresponds to the tree node.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU
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Application
An application defines the screens and views that the user can access through menus and page tabs. 
You must not configure Siebel Tools as an application in the same way that you configure a Siebel 
Business Application, such as Siebel Sales or Siebel Service. Although the views and applets that 
Siebel Tools uses do exist in the repository, you must not modify this information.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Applet Web Template > Applet Web Template Item > Siebel Object Types 
Reference > Application

Table 35 describes properties that Siebel CRM uses with an application.

Table 35. Properties of the Application

Property Description

Acknowledgement Web Page 
(O)

Specifies the name of the Web page that Siebel CRM displays after 
the user logs in.

Siebel CRM uses the Acknowledgement Web Page property only if 
the Acknowledgement Web View property does not contain a value.

The Acknowledgement Web Page property or the Acknowledgement 
Web View property must contain a value.

Acknowledgement Web View 
(O)

Specifies the name of the view that Siebel CRM displays after the 
user logs in.

The Acknowledgement Web Page property or the Acknowledgement 
Web View property must contain a value.

Company Logo Bitmap 
(O)(H)

Specifies the name of a bitmap object definition in the Company 
Logos bitmap category.

Container Web Page (O) Specifies the Web page object definition that Siebel CRM uses to 
display the elements that surround a Siebel view. This page 
contains typical user interface elements, such as viewbars, 
screenbars, logos, and so on.

All views, pages, and applets use the page that the Container Web 
Page properties specifies, by default. The Container Page property 
of a view can override this configuration.

Default Find (O) Specifies the default value for a Find object. If the Default Find 
property of the Application Find object is True, then Siebel CRM 
displays this Find object in the Look In drop-down list in the Search 
Center. 

Display Name (O) Specifies the name that Siebel CRM displays on menus and page 
tabs for an application.

Error Web Page (O) Specifies the error page that Siebel CRM displays if an error occurs. 
This value must reference a Web Page object type.
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Application Browser Script
An application browser script defines the browser script that an application uses.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Application > Application Browser Script

Table 36 describes properties that Siebel CRM uses with an application browser script.

Login Web Page (O) Specifies the page that Siebel CRM displays that allows the user to 
enter a user name and password. This value must reference a Web 
Page object type.

Logoff Acknowledgement 
Web Page (O)

Specifies the page that Siebel CRM displays after the user logs off. 
This value must reference a Web Page object type.

Menu (O) Specifies the menu object definition that Siebel CRM uses.

Name (R) Specifies a unique application name.

Scripted (S) Specifies if a Siebel VB or Siebel eScript script is attached to the 
Application object. It can contain one of the following values:

■ TRUE. Siebel script attached.

■ FALSE. No Siebel script attached.

Sort Web Page (O) Specifies the page that allows the user to choose the fields to sort 
in a list applet. This value must reference a Web Page object type.

Text Style (O)(H) Specifies the text style that Siebel CRM uses by default for all 
controls in the application object. It uses this property only if the 
control, applet, or view do not specify a text style. 

The configuration file provides the default value for this property. 

Task Screen (O) Specifies the screen that allows the user to restart a task UI.

Table 36. Properties of the Application Browser Script

Property Description

Browser Group (O) Specifies the browser type that this script supports.

Name (R) Specifies a unique name for this script. To create this value, Siebel 
Tools automatically combines the values in the User Agent property 
and the Procedure property.

You must not modify this property.

Table 35. Properties of the Application

Property Description
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Application Event Services
A application event services defines the application event services that Siebel CRM uses.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Application > Application Event Services

Table 37 describes properties that Siebel CRM uses with an application event services.

Application Find
An application find defines the find object definitions that Siebel CRM uses for an application.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Application > Application Find

Table 38 describes properties that Siebel CRM uses with an application find.

Procedure (O) Specifies the name of the function or the procedure.

Script (O) Specifies the text for the function.

Table 37. Properties of the Application Event Services

Property Description

Event Name (R) Specifies the name of the application event service. It can include 
only the following value:

Start

Method Name (R) Specifies the name of the business service method that Siebel CRM 
must call. It can include only the following value:

Start

Name (R) Specifies the event description.

Sequence (R) Specifies the order that Siebel CRM uses to process the services. 
This property only contain an integer.

Business Service (R) Specifies the name of the business service that Siebel CRM must 
call.

Table 36. Properties of the Application Browser Script

Property Description
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Application Locale
An application locale defines language overrides that Siebel CRM uses with an application.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Application > Application Locale

Table 39 describes properties that Siebel CRM uses with an application locale.

Application Method Menu Item (H)
An application method menu item defines the menu for the application object.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Application > Application Method Menu Item 

Table 38. Properties of the Application Find

Property Description

Default Find (O) Specifies the default value for a Find object. If the Default Find 
property of the Application Find object is True, then Siebel CRM 
displays this Find object in the Look In drop-down list in the Search 
Center

Find (R) Specifies the name of the find object definition that Siebel CRM 
includes in the application object. For example: 

Contact

Name (R) Same as the Find property.

Sequence (O) Specifies the order that Siebel CRM uses relative to other 
application find objects that it includes in the Find dialog box. This 
property can contain only an integer.

Table 39. Properties of the Application Locale

Property Description

Display Name (O) Specifies the name that Siebel CRM displays on menus and page 
tabs for an application for a language.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU
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Table 40 describes properties that Siebel CRM uses with an application method menu item.

Application Method Menu Item Locale (H)
An application method menu item locale defines language overrides that Siebel CRM uses with an 
application method menu item.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Application > Application Method Menu Item (H) > Application Method Menu Item 
Locale 

Table 41 describes properties that Siebel CRM uses with an application method menu item locale.

Application Server Script
An application server script defines the Siebel VB and Siebel eScript script that an application object 
contains. For more information, see Siebel Object Interfaces Reference.

This object type occurs in the following location in the object hierarchy:

Table 40. Properties of the Application Method Menu Item

Property Description

Menu Text (R) Specifies the text that Siebel CRM displays in the menu item.

Method (R) Specifies the method that the menu item calls.

Name (R) Specifies the name of the application method menu item.

Position (R) Specifies the position of the menu item in the menu tree. For 
example, the following position identifies the first menu item of the 
submenu that resides in the third menu item. This third menu item 
resides in the top-level menu:

3.1

Table 41. Properties of the Application Method Menu Item Locale

Property Description

Menu Text (R) Specifies the text that Siebel CRM displays in the menu item for a 
language.

Name (O) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU
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■ Siebel Objects > Application > Application Server Script

An application server script uses the same properties as an applet script. For more information, see 
Table 11 on page 42.

Application Toolbar (H)
An application toolbar associates a toolbar with an application. Different applications can use 
different toolbars.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Application > Application Toolbar 

Table 42 describes properties that Siebel CRM uses with an application toolbar.

Application User Prop (H)
An application user prop is for Oracle use only.

Page Tab
A page tab defines the screens that the user access through a page tab.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Application > Page Tab

Table 43 describes properties that Siebel CRM uses with a page tab.

Table 42. Properties of the Application Toolbar

Property Description

Name (R) Specifies the name of the application toolbar object definition. This 
name must be unique in this application.

Sequence (O) Specifies the order that Siebel CRM uses to display this toolbar 
relative to other toolbars that it displays at the top of the main 
window. This property can contain only an integer.

Toolbar (R) Specifies the name of the toolbar object definition that Siebel CRM 
uses in an application.
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Page Tab Locale
A page tab locale defines language overrides that Siebel CRM uses with a page tab.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Application > Page Tab > Page Tab Locale

Table 44 describes properties that Siebel CRM uses with a page tab locale.

Screen Menu Item
A screen menu item adds a menu item to a screen menu.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Application > Screen Menu Item

Table 45 describes properties that Siebel CRM uses with a screen menu item.

Table 43. Properties of the Page Tab

Property Description

Bitmap Category (O)(H) Reserved for future use.

Screen (R) Specifies the screen that Siebel CRM displays if the user clicks a 
page tab. For example:

Accounts Screen

Sequence (O) Specifies the order that Siebel CRM uses when it displays the page 
tabs. This property can contain only an integer.

Text (R) Specifies the text or the key to localized text that Siebel CRM 
displays on the page tab. For example:

Accounts

Table 44. Properties of the Page Tab Locale

Property Description

Name (R) Specifies the abbreviation for the language that Siebel CRM uses. 
For example:

ENU

Text (O) Specifies the text or the key to localized text Siebel CRM displays 
on the page tab.
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Screen Menu Item Locale
A screen menu item locale defines language overrides for a screen menu item.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Application > Screen Menu Item > Screen Menu Item Locale 

Table 46 describes properties that Siebel CRM uses with a screen menu item locale.

Assignment Attribute Object Types
This topic describes the Assignment Attribute object type and object types that are children of this 
object type. It includes the following topics:

■ Assignment Attribute on page 103

■ Assignment Attribute Column on page 104

Table 45. Properties of the Screen Menu Item

Property Description

Screen (R) Specifies the name of the screen that this screen menu item 
displays. If a screen contains multiple screen views, and if the user 
clicks a screen menu item, then Siebel CRM expands this screen 
menu item and then displays screen menu items for each of these 
views.

Sequence (O) Specifies the order that Siebel CRM uses to display this screen 
menu item on the Screen menu.

Text (R) Specifies the text label that Siebel CRM uses for this screen menu 
item. If localized text exists for this screen menu item, then the 
value in this Text property is a key that identifies the message table 
that Siebel CRM uses to find the localized text.

Table 46. Properties of the Screen Menu Item Locale

Property Description

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Text (O) Specifies the text that Siebel CRM uses for the screen menu item.
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Assignment Attribute
An assignment attribute does the following:

■ Defines an attribute that an assignment criteria can reference. 

■ Specifies the picklist that Siebel CRM uses in the Values applet in the Assignment Criteria view 
that an administrator can use in the client to configure an attribute.

■ Does not directly specify a database column or a combination of database columns. The child 
assignment attribute column defines a column mapping.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Application > Assignment Attribute

Table 47 describes properties that Siebel CRM uses with an assignment attribute.

Table 47. Properties of the Assignment Attribute

Property Description

Bounded (O) You can use one of the following values:

■ TRUE. The administrator must choose a value from the picklist.

■ FALSE. The administrator can enter a value that the picklist 
does not display.

Data Type (R) Specifies the data type for the assignment attribute. You can use 
one of the following values:

■ Varchar

■ Number

Name (R) Specifies the name of the assignment attribute. The value that this 
property contains must be unique in the repository.

Order By LOV Type (O) Not used.

Pick Field (O) Specifies the name of the field that the administrator can choose 
from the picklist. You can use one of the following values:

■ Created

■ Created By

■ Id

■ Updated

■ Updated By

Picklist (O) Specifies the name of the picklist that provides the values that 
populate a list column in the Values applet in the Assignment 
Criteria view.
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Checking In Assignment Objects
You must check the project that an assignment object references in to the Siebel Server.

Assignment Attribute Column
An assignment attribute column does the following:

■ Assigns an assignment attribute to an assignment object and a workflow policy component 
column. These mappings set up value matching in the assignment object and workflow policy 
object for criteria that use the parent assignment attribute.

■ Maps an assignment object to a workflow policy component column. 

■ Each assignment attribute column can specify a different assignment object or a different 
attribute in the same assignment object.

You must check in modifications you make. For more information, see “Checking In Assignment 
Objects” on page 104.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Assignment Attribute > Assignment Attribute Column

Table 48 describes properties that Siebel CRM uses with an assignment attribute column.

Translate Pick Field (O) Specifies to save the Language Independent Code in the Siebel 
database or in the display value for the assignment criteria.

Use Range (O) You can use one of the following values:

■ TRUE. Display a pair of list columns that allows an 
administrator to specify a range of values for assignment 
criteria attributes.

■ FALSE. Display a single column that requires the administrator 
to specify a single value for assignment criteria attributes.

For example, the Use Range property of the Revenue assignment 
attribute is TRUE. It displays two list columns: Revenue Low and 
Revenue High. It allows the administrator to enter 50000 in the 
Revenue Low column and 100000 in the Revenue High column to 
indicate a range of $50,000 through $100,000.

Table 47. Properties of the Assignment Attribute

Property Description
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Assignment Criteria Object Types
This topic describes the Assignment Criteria object type and object types that are children of this 
object type. It includes the following topics:

■ Assignment Criteria on page 106

■ Assignment Criteria Attribute on page 107

■ Assignment Criteria Attribute Locale on page 108

■ Assignment Criteria Locale on page 109

Table 48. Properties of the Assignment Attribute Column

Property Description

Assignment Object (R) Specifies an assignment object. Siebel CRM examines the values 
that this object contains to determine if a match exists with values 
that the parent assignment attribute contains.

Name (R) Specifies the name of the assignment attribute column. You can use 
the following format:

assignment_object: workflow_policy_component_column

For example:

Account: Area Code

Sequence (R) Specifies a unique sequence number for the assignment attribute 
column.

If an assignment attribute contains multiple assignment attribute 
columns, then Assignment Manager searches for attribute values in 
the order that you define them in this property.

This property can contain only an integer.

Workflow Policy Component 
(R)

Specifies the name of the workflow policy component in the 
workflow policy object that this assignment attribute column 
references. For example:

Account

Workflow Policy Component 
Column (R)

Specifies the name of the workflow policy component column in the 
workflow policy component that this assignment attribute column 
references. For example:

Account Area Code

Workflow Policy Object (R) Specifies the name of the workflow policy object that this 
assignment attribute column references. For example:

Account
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Assignment Criteria
An assignment criteria defines an attribute that Siebel CRM uses in an assignment criteria record. 
Siebel CRM displays assignment criteria in the picklist that it displays if the user clicks in the Criteria 
list column when the user edits an assignment criteria record in the client.

You must check in modifications you make. For more information, see “Checking In Assignment 
Objects” on page 104.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Assignment Criteria

Table 49 describes properties that Siebel CRM uses with an assignment criteria.

Table 49. Properties of the Assignment Criteria

Property Description

Display Flag (O) You can use one of the following values:

■ TRUE. Display the Criteria object in the Assignment Criteria 
view in the client.

■ FALSE. Do not display the Criteria object in the Assignment 
Criteria view in the client.

Display Name (O) Specifies the name that Siebel CRM displays for this assignment 
criteria object in the picklist and in the Criteria list column in the 
Assignment Criteria applet in the Assignment Criteria view.

If Display Name does not contain a value, then Siebel CRM uses the 
value in the Name property.

Employee Skill (O) You can use one of the following values:

■ TRUE. Display the Assignment Criteria object in the Skill 
applets in the client.

■ FALSE. Do not display the Assignment Criteria object in the 
Skill applets in the client.

Name (R) Specifies the name of the assignment criteria.
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Assignment Criteria Attribute
An assignment criteria attribute allows an assignment criteria to include multiple attributes.

You must check in modifications you make. For more information, see “Checking In Assignment 
Objects” on page 104.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Assignment Criteria > Assignment Criteria Attribute

Table 50 describes properties that Siebel CRM uses with an assignment criteria attribute.

Team Specifies Used with dynamic candidates feature.

You can use one of the following values:

■ TRUE. Use a column on the team table to calculate assignment 
criteria.

■ FALSE. Do not use a column on the team table to calculate 
assignment criteria.

Use Expertise (O) You can use one of the following values:

■ TRUE. Assignment Manager uses the expertise code to match 
an assignment object to a person.

■ FALSE. Assignment Manager does not use the expertise code 
to match an assignment object to a person.

Table 50. Properties of the Assignment Criteria Attribute

Property Description

Assignment Attribute (R) Specifies the assignment attribute that this assignment criteria 
attribute references.

Display Name (R) Specifies the list column label that Siebel CRM displays for this 
assignment criteria attribute in the Values list applet. If this 
property does not include a value, then Siebel CRM uses the name 
in the list column label.

Display Sequence (R) Specifies the order that Siebel CRM uses to display the list column 
for this assignment criteria attribute in the list applet relative to 
other assignment criteria attributes in the assignment item. A lower 
number places the list column farther to the left.

Display Sequence - 
Language Override

Allows you to order the list columns in the list applet differently for 
different languages. 

Table 49. Properties of the Assignment Criteria

Property Description
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Assignment Criteria Attribute Locale
An assignment criteria attribute locale defines language overrides that Siebel CRM uses with an 
assignment criteria attribute.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Assignment Criteria > Assignment Criteria Attribute > Assignment Criteria 
Attribute Locale

Table 51 describes properties that Siebel CRM uses with an assignment criteria attribute locale.

Name (R) Specifies the name of the assignment criteria attribute. This name 
must be unique in the parent assignment criteria.

Pick Applet (O) Specifies the name of the pick applet that Siebel CRM displays in a 
picklist. If a picklist is defined, then this picklist allows the user to 
choose a value in a list column for the assignment attribute.

Store Column (R) Specifies the column in the S_ASGN_RULE_ITEM (assignment rule 
item) table that contains the value for the assignment criteria 
attribute. To save assignment criteria attribute values for each 
assignment criteria, Siebel CRM uses four columns for each of the 
following data types:

■ Number

■ Varchar

The Data Type property in the assignment attribute determines this 
data type.

The Store Column property must contain one of the following 
unique values for each assignment criteria attribute that uses the 
same data type:

■ 1

■ 2

■ 3

■ 4

Table 50. Properties of the Assignment Criteria Attribute

Property Description
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Assignment Criteria Locale
An assignment criteria locale defines language overrides that Siebel CRM uses with an assignment 
criteria.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Assignment Criteria > Assignment Criteria Locale

Table 52 describes properties that Siebel CRM uses with an assignment criteria locale.

Bitmap Category Object Types
This topic describes Bitmap Category object type and object types that are children of this object 
type. It includes the following topics:

■ Bitmap on page 110

■ Bitmap Category on page 111

Table 51. Properties of the Assignment Criteria Attribute Locale

Property Description

Display Name (R) Specifies the list column label that Siebel CRM displays for this 
assignment criteria attribute in the Values list applet for a 
language.

Display Sequence Specifies the order that Siebel CRM uses to display the list column 
for this assignment criteria attribute in the list applet relative to 
other assignment criteria attributes in the assignment item. A lower 
number places the list column farther to the left.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Table 52. Properties of the Assignment Criteria Locale

Property Description

Display Name (R) Specifies the name that Siebel CRM displays for this assignment 
criteria in the picklist and the Criteria list column in the Assignment 
Criteria applet in the Assignment Criteria view for a language.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU
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■ Bitmap Locale on page 111

Bitmap
A bitmap references a GIF or JPG image file that a button control or another object uses. Each bitmap 
image in the repository can exist in only one bitmap category.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Bitmap Category > Bitmap

Table 53 describes properties that Siebel CRM uses with a bitmap.

Table 53. Properties of the Bitmap

Property Description

Alt Text (O) Specifies alternative text that Siebel CRM uses instead of the value 
that the Name property contains.

Data (S)(H) Specifies the bitmap data.

File Name (O) Specifies the file name of the bitmap. The following directory is the 
default directory for this file:

\public\language\images 

where:

■ language is enu for U.S. English.

Height (S) Specifies the height in pixels of the bitmap.

MIME Type (O) Specifies the MIME type of the file contents.

Name (R) Specifies the name of the bitmap object definition.

Transparent Color (O)(H) Specifies to use 1-bit transparency support for logos, toolbars, 
buttons, and similar bitmap object definitions.

If the user sets a custom background color, then this configuration 
allows Siebel CRM to use this background color so that a toolbar 
button or applet button that displays over this background is 
visible.

The color you choose or enter in the Transparent Color property 
specifies the color that Siebel CRM uses as a substitute for a Clear 
color. You can enter it as a triplet of integers. You can also click the 
Transparent Color button during a bitmap import and then use the 
color selection dialog box that Siebel Tools displays.

Width (S) Specifies the width in pixels of the bitmap.
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Bitmap Category
A bitmap category allows Siebel CRM to group bitmaps according to function or some other 
relationship. You can use some predefined bitmap categories only for a specific purpose. For 
example, the Background Bitmap property of an applet references the Applet Backgrounds bitmap 
category for the bitmap file.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Bitmap Category

Table 54 describes properties that Siebel CRM uses with a bitmap category.

Bitmap Locale
A bitmap locale defines a language override that Siebel CRM uses with a bitmap.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Bitmap > Bitmap Locale

Table 55 describes properties that Siebel CRM uses with a bitmap locale.

Table 54. Properties of the Bitmap Category

Property Description

Name (R) Specifies the name of the bitmap category.

Predefined (O)(H) You can use one of the following values:

TRUE. A predefined bitmap category that typically contains a 
bitmap file that you or Oracle provides. You can add or remove a 
bitmap file from a predefined category. You cannot delete or 
rename the object definition for a bitmap category.

FALSE. A bitmap category that you provide. You can create, delete, 
or modify the object definition of the bitmap category. This bitmap 
is typically a view bar logo that uses the Logo.bmp name. You 
provide the bitmap category name and reference it in the Bitmap 
Category property of the view.
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Business Component Object Types
This topic describes the Business Component object type and object types that are children of this 
object type. It includes the following topics:

■ BusComp Browser Script on page 113

■ BusComp Server Script on page 113

■ BusComp View Mode on page 113

■ Business Component on page 115

■ Business Component User Prop on page 123

■ Field on page 124

■ Field Locale on page 134

■ Field User Prop on page 135

■ Join on page 135

■ Join Constraint on page 136

■ Join Specification on page 137

■ Multi Value Field on page 138

■ Multi Value Link on page 140

■ MVF Pick Map on page 143

■ MVF Pick Map UpdOnlyIfNull on page 144

■ Pick Map on page 145

■ Pick Map UpdOnlyIfNull on page 146

■ Single Value Field on page 147

■ SVF Pick Map on page 151

■ SVF Pick Map UpdOnlyIfNull on page 152

Table 55. Properties of the Bitmap Locale

Property Description

Alt Text (O) Alternative text that Siebel CRM uses instead of the parent name 
property for a bitmap for a language.

Name (R) The abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU
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BusComp Browser Script
A buscomp browser script defines the browser script that a business component uses.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Component > BusComp Browser Script

Table 56 describes properties that Siebel CRM uses with a buscomp browser script.

BusComp Server Script
A buscomp server script defines Siebel VB or Siebel eScript script for a business component. For 
more information, see Siebel Object Interfaces Reference.

Starting with Siebel CRM version 7.0, buscomp server scripts replace business component scripts.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Component > BusComp Server Script

A buscomp server script uses the same properties as a applet script. For more information, see 
Table 11 on page 42.

BusComp View Mode
A buscomp view mode defines access control for a business component in a view.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Component > BusComp View Mode

Table 57 describes properties that Siebel CRM uses with a buscomp view mode.

Table 56. Properties of the BusComp Browser Script

Property Description

Browser Group (O) Not used.

Name (R) Specifies a unique name for the script. To define this property, 
Siebel Tools automatically combines the Browser Group and 
Procedure properties. You must not modify this property.

Procedure (O) Specifies the name of the function or the procedure.

Script (R) The text for the script.
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Table 57. Properties of the BusComp View Mode

Property Description

Name (R) Specifies the view mode name. To examine the values you can use, 
you can click this Name property in Siebel Tools.

Owner Type (R) Specifies the owner of the records in the current view mode. For 
example, if the user chooses My Opportunities, then the position is 
the owner of the opportunities that Siebel CRM displays.

To examine the values you can use, you can click this Owner Type 
property in Siebel Tools.

For more information about using the Owner Type property, see the 
topic about business component view mode fields in Siebel Security 
Guide.

Private Field (O) Specifies the name of a field that indicates private or public access 
to a record. This field is typically named Private or Private Flag. This 
property allows Siebel CRM to display private predefined queries 
that a user creates and public queries that an administrator creates. 
It can display these queries in the same list. 

The field that the Private Field property references contains a TRUE 
or FALSE value that indicates if the record is private. This value 
determines the following visibility:

■ Private. Only the record owner can view this record. 

■ Not private. All users can view this record.

Visibility Field (O) Specifies the field that Siebel CRM uses to establish single-owner 
visibility. This field identifies the record ID of a record that the 
business component contains.

Visibility MVField (O) Specifies the name of the multivalue field that Siebel CRM uses to 
maintain the list of owners that it displays in team visibility. This 
field typically references the Name property in the business 
component. Siebel CRM uses this property with the Visibility MVLink 
property.

To examine the values you can use, you can click this Visibility 
MVField property in Siebel Tools.

Visibility MVLink (O) Specifies the name of the multivalue link that Siebel CRM uses to 
maintain the list of owners that it displays in team visibility. Siebel 
CRM uses this property with the Visibility MVField property.

To examine the values you can use, you can click this Visibility 
MVLink property in Siebel Tools.
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Business Component
A business component defines a logical entity that organizes columns from one or more tables into 
a single entity. It provides a foundation that controls how Siebel CRM chooses, inserts, and updates 
data in underlying tables. This data is typically specific to a functional area, such as a product, a 
contact, or an account. An applet references a business component. It does not directly reference 
the tables. This configuration allows you to reference data according to functional area. It might also 
separate work that a developer performs from work that an administrator performs.

A virtual business component defines external data. For more information, see “Properties of the Field 
Object Type That Siebel CRM Supports for a Virtual Business Component” on page 133.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Component

Table 58 describes properties that Siebel CRM uses with a business component.

Table 58. Properties of the Business Component

Property Description

Browser Class (O)(H) Not used.

Cache Data (O) You can use one of the following values:

■ TRUE. Siebel CRM does the following:

■ If a query runs more than one time on a business 
component, and if each query uses the same search 
specification, the Siebel CRM reads business component 
data only one time for all of these queries.

■ If a query runs more than one time on a business 
component, and if each query uses a different search 
specification, then Siebel CRM reads data for each query.

■ FALSE. Siebel CRM reads business component data for each 
query.

For more information, see “Configuring the Cache Data Property of a 
Business Component” on page 122.

Class (R) Specifies the name of the class that determines the configuration of 
the business component. For example, you can use the following 
value:

CSSBcVAbsResult
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Data Source (O) Allows a business component to use a different name for the 
configuration file that identifies the data source. This name is 
different from the name that the Siebel Business Application 
currently uses. Server or Local are examples of a data source. This 
configuration allows a business component to get data from a 
database other than the typical SQL database.

If a business component specifies a data source, then all the tables 
it implicitly and explicitly joins must reside in the same data source. 

If the Data Source property is empty, then Siebel CRM uses the 
same data source that it uses to start the Siebel Business 
Application. 

Dirty Reads (O) You can use one of the following values:

■ TRUE. The business component supports database dirty reads.

■ FALSE. The business component does not support database 
dirty reads.

Siebel CRM uses this property only if it use a Sybase database. If 
Siebel CRM does not use a Sybase database, then it ignores this 
property. It is recommended that you modify the default setting of 
TRUE for this property only to support workflow processes or 
Enterprise Application Integration (EAI). 

If TRUE, then the user can read data that can be modified without 
their knowledge. This configuration might be desirable in a situation 
where the data is available for reading and anybody can update it. 
If dirty reads are not allowed, then nobody can update the data 
until everybody finishes displaying this data.

If dirty reads are allowed, and if another user does not modify the 
same record since Siebel CRM last queried this record, then it 
updates data immediately. For example, if user A updates a record, 
and if user B is not aware of this update and then attempts to 
update the same record, then Siebel CRM displays a message to 
user B that states that the data was updated and the user must 
requery.

Distinct (O) You can use one of the following values:

■ TRUE. Siebel CRM suppresses system fields. Allows the 
equivalent of a distinct query because it suppresses system 
fields, such as Created, Updated, Id, and so. 

■ FALSE.Siebel CRM does not suppress system fields.

Enclosure Id Field (O) Specifies the ID of a recipient of literature, typically the contact ID.

Table 58. Properties of the Business Component

Property Description
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Extension Type (O) You can use one of the following values:

■ JOIN. Siebel CRM joins the extension table and gets the 
extended data and the other data that it requires. 

■ LINK. Siebel CRM uses a separate SQL statement that gets 
extended data. It uses this property with a Sybase database 
server because Sybase uses a 2 KB record length limit.

If the Extension Type property is empty, and if Siebel CRM:

■ Uses Sybase. This property defaults to LINK.

■ Does not use Sybase. This property defaults to JOIN.

Force Active (O) You can use one of the following values:

■ TRUE. Siebel CRM gets all fields from the server database. This 
configuration degrades business component performance. It is 
not recommended.

■ FALSE. Siebel CRM gets only the fields that the client registers 
or that a specialized business component requests. This 
configuration improves performance.

GenReassignAct (O) You can use one of the following values:

■ TRUE. If the business component uses a multivalue group for 
visibility, and if Siebel CRM modifies the primary team member, 
then it creates an activity.

■ FALSE. Siebel CRM does not create an activity.

Hierarchy Parent Field (O) Specifies the field that contains the parent data in a hierarchy. It 
allows Siebel CRM to display nesting in a hierarchical list applet.

Insert Update All Columns 
(S)

Used internally to make each SQL INSERT or UPDATE statement 
include a column. This configuration allows Siebel CRM to reuse 
parsed statements more effectively during batch processing.

You must not modify this value.

Log Changes (O) You can use one of the following values:

■ TRUE. Siebel CRM enables logging.

■ FALSE. Siebel CRM disables logging.

CAUTION: Siebel CRM sets this property to TRUE, by default. You 
must not modify it. Any modification you make might adversely 
affect data integrity.

Table 58. Properties of the Business Component

Property Description
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Maximum Cursor Size (O) Specifies the maximum number of records that Siebel CRM can get 
from the server database. It applies only to an Oracle or DB2 UDB 
database. You can use one of the following numbers:

■ - 1. Siebel CRM gets records until it encounters an EOF (end of 
file) record. 

■ A number greater than 0. Siebel CRM gets the number of 
records that you specify.

If the Maximum Cursor Size property contains a value, then this 
value overrides the MaxCursorSize parameter in the configuration 
file.

You can also use this property with a multivalue group business 
component. For more information, see “Configuring a Multivalue 
Group Business Component” on page 123.

Multi Recipient Select (S) You can use one of the following values:

■ TRUE. Siebel CRM allows the user to choose multiple recipients.

■ FALSE. Siebel CRM does not allow the user to choose multiple 
recipients.

The Service Request business component sets this property.

Name (R) Specifies the name for the business component. This name must be 
unique among business components. It can include spaces. It 
cannot include special characters.

No Delete (O) You can use one of the following values:

■ TRUE. Siebel CRM does not allow the user to delete a record in 
an applet that references this business component.

■ FALSE. Siebel CRM allows the user to delete a record in an 
applet that references this business component.

If the Admin Mode Flag property of the current view is TRUE, then 
Siebel CRM ignores this property.

No Insert (O) You can use one of the following values:

■ TRUE. Siebel CRM does not allow the user to insert a record in 
an applet that references this business component.

■ FALSE. Siebel CRM allows the user to insert a record in an 
applet that references this business component.

If the Admin Mode Flag property of the current view is TRUE, then 
Siebel CRM ignores this property.

Table 58. Properties of the Business Component

Property Description
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No Merge (O) You can use one of the following values:

■ TRUE. Siebel CRM does not allow the user to merge two 
existing records into a single record in an applet that references 
this business component.

■ FALSE. Siebel CRM allows the user to merge two existing 
records into a single record in an applet that references this 
business component. You must also set the No Delete property 
to FALSE because merging requires Siebel CRM to delete one of 
the records that it merges.

If the Admin Mode Flag property of the current view is TRUE, then 
Siebel CRM ignores this property.

No Update (O) You can use one of the following values:

■ TRUE. Siebel CRM does not allow the user to update a record 
in an applet that references this business component.

■ FALSE. Siebel CRM allows the user to update a record in an 
applet that references this business component.

If the Admin Mode Flag property of the current view is TRUE, then 
Siebel CRM ignores this property.

Owner Delete (O) You can use one of the following values:

■ TRUE. Only the owner can delete a record.

■ FALSE. Anyone can delete a record.

The following visibility determines the owner:

■ Team visibility. The owner is the primary position on the sales 
team. Team visibility occurs if the Visibility MVLink property and 
the Visibility MVField property of the BusComp View Mode each 
includes a value.

■ Position visibility. The owner is the position that the visibility 
field contains. The Visibility Field property of the BusComp View 
Mode specifies this field.

If a view uses Admin mode, then Siebel CRM disables the Owner 
Delete property and any user who can access the view can delete 
the record.

Placeholder (O) Not used.

Popup Visibility Auto All (O) You can use one of the following values:

■ TRUE. Pop-up visibility is All.

■ FALSE. The Popup Visibility Type property determines pop-up 
visibility.

Table 58. Properties of the Business Component

Property Description
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Popup Visibility Type (O) Specifies the type of pop-up visibility. To view the values you can 
use, click the Popup Visibility Type property in Siebel Tools. If this 
property is empty, then Siebel CRM uses the Sales Rep default 
value.

PreFetch Size (O) Specifies the number of records that Siebel CRM gets from the 
server database for a business component. If this property includes 
a value, then it overrides the MaxCursorSize parameter in the 
configuration file.

If you set the PreFetch Size property to the same value that the 
Maximum Cursor Size property contains, then Siebel CRM does the 
following:

■ Reads the number of records that you specify in the PreFetch 
Size parameter. 

■ Resets the Siebel database cursor so that Siebel CRM can use it 
for a subsequent query.

You can use this property with the Maximum Cursor Size property 
only with a DB2 UDB database.

You can use this property with a multivalue group business 
component. For more information, see “Configuring a Multivalue 
Group Business Component” on page 123.

Recipient Id Field (O) Specifies the field that references the recipient IDs. This ID is 
typically the Contact ID. This property specifies the field that 
references the ID. It does not specify the ID.

If the user uses CTRL+L in the Service Request screen to create 
recipients, and if the Recipient Id Field property of the Service 
Request business component is empty, then Siebel CRM does not 
create any recipients. 

Reverse Fill Threshold (O) Specifies the maximum number of records that Siebel CRM reads 
when it runs the first record or the last record request. It does this 
before the SQL statement that automatically reruns with a reversed 
sort sequence.

The default value is 100.

Scripted (S) Indicates a Siebel VB or Siebel eScript script is attached to the 
business component:

TRUE. Script is attached.

FALSE. No script is attached.

Table 58. Properties of the Business Component

Property Description
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Search Specification (O) Specifies a conditional expression that Siebel CRM uses to restrict 
the records it gets for this business component. You can enter a 
maximum of 255 characters in this property.

Sort Specification (O) Specifies the sort expression that Siebel CRM uses to sort the 
records it gets from the server database.

If the business component references any class other than 
CSSBusComp, then Siebel CRM might disable the sort specification.

For performance reasons, the Application Object Manager ignores 
the sort specification property for the All view mode and the 
Manager view mode.

You cannot define a sort specification on an administrative list.

The user can sort records after the first query. To improve 
performance, Siebel CRM requires the user to filter for a smaller 
record set.

You can enter a maximum of 255 characters in this property.

For more information, see “Business Component User Prop” on 
page 123.

Status Field (O) Specifies the name of a field that contains the value that 
determines the New status for a record. If this field value is:

■ TRUE. The record is new and no user has viewed it.

■ FALSE. A user has viewed the record.

You use this property with the visibility properties of the business 
component, such as the Visibility MVLink property and the Position 
Visibility Field property.

Synonym Field (O) Specifies the field that contains synonyms for the business 
component. If this property includes a value, then any bounded 
picklist that the business component contains searches these 
synonyms.

Table (R) Specifies the name of the primary SQL table where Siebel CRM gets 
records for this business component. The table name is case-
sensitive. It must use the same format that it uses in the Siebel 
database.

A virtual business component does not use this property.

Table 58. Properties of the Business Component

Property Description
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Restrictions on Inserts, Updates, and Deletes
An insert, update, or delete operation affects data in the table that the Table property of a business 
component references. It does not affect data in a table that a join references.

How Siebel CRM Persists a Business Component Instance
Siebel CRM ends the persistence of a business component instance when the business object 
instance that references this business component instance ends.

Configuring the Cache Data Property of a Business Component
If Siebel CRM caches data for a business component, and if it modifies the contents of this cache, 
then this business component might reference obsolete data. This problem might occur in the 
following situations:

■ A user modifies some data through another business component. For example, the user modifies 
data through a business component that uses a multivalue link.

■ Another user modifies data while the user who first modified this data is still connected.

For this reason, it is recommended that you configure Siebel CRM to use caching only with static 
data, such as a list of values or a product. Do not configure Siebel CRM to use caching with data that 
the user might modify frequently, such as accounts or opportunities. If you do this, then the client 
cache might not remain synchronized with data in the server database.

Type You can use one of the following values:

■ Transient. Save data only when the task UI commits it. You 
use this value only with a task UI.

■ Non-Transient. Save data in an underlying table. You use this 
value with any business component that a task UI does not 
reference.

For more information, see Siebel Business Process Framework: 
Task UI Guide.

Upgrade Ancestor For more information, see “Common Object Properties” on page 15.

XA Attribute Value BusComp 
(O)

Specifies the child business component that contains the attribute 
values for this business component. This property enables extended 
dynamic attributes for this business component.

XA Class Id Field (O) Specifies the field that this business component references that 
contains the class data.

Table 58. Properties of the Business Component

Property Description
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It is recommended that you do not set the Cache Data property of a business component to TRUE 
and also set the Use Primary Join property of a multi value link to TRUE. If Siebel CRM modifies the 
primary record of a multivalue group business component in this situation, then it might not update 
data for the cached parent.

Configuring a Multivalue Group Business Component
You can use the Maximum Cursor Size property and the PreFetch Size property with a multivalue 
group business component. These properties are available only with a DB2 UDB database. The 
following items affect the number of rows that Siebel CRM returns for the first operation that a 
multivalue group business component performs:

■ If the multivalue group business component uses aggregation, then it reads every record. The 
sum function and the count function are examples of aggregation.

■ A multivalue group business component attempts to make the primary record the current record. 
Siebel CRM loads records until it finds the primary record. For example, if the primary record is 
the 4,000th record, then it loads 4,000 records. To prevent this configuration, you can use a 
detail view instead of a multivalue group. For example, you can use the Contact - Address detail 
view with the Contact in the top applet and a list of addresses in the bottom applet.

Business Component User Prop
A business component user prop sends a property value to the C++ code that implements specialized 
business component configuration. If you configure the value for a user property, then Siebel CRM 
persists this value in the Siebel runtime repository. For more information, see “Object Types That You 
Must Not Modify” on page 18.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Component > Business Component User Prop

Table 59 describes properties that Siebel CRM uses with a business component user prop.

How a Business Component User Property Might Affect View Modes
Sometimes it might seem that Siebel CRM ignores the All view mode and the Manager view mode in 
the client. In this situation, the All Mode Sort business component user property might control the 
configuration for these modes. For more information about this user property, see Siebel Developer’s 
Reference. For information about virtual business components, see Siebel Developer’s Reference or 
Overview: Siebel Enterprise Application Integration.

Table 59. Properties of the Business Component User Prop

Property Description

Name (R) Specifies the name of the user property.

Value (R) Specifies the value of the user property.
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Field
A field defines a business component field. The fields in a business component record include entries 
from a single value field or a multi value field. Siebel CRM evaluates required fields in alphabetical 
order according to the parent business component. For example, assume two required fields named 
Alpha and Omega exist on an applet and that these fields reference a business component field. 
Siebel CRM processes Alpha first and then Omega. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Component > Field

Table 60 describes properties that Siebel CRM uses with a field.

Table 60. Properties of the Field

Property Description

Calculated (O) If TRUE, then Siebel CRM gets values from the business component 
to calculate the field value rather than getting values from the 
server database.

Calculated Value (O) Specifies the expression Siebel CRM uses to calculate the field value 
if the Calculated property is TRUE.

Column (R) Specifies the table column name. Other objects that reference this 
field can reference it through the column name.

This property is not used or required for the following items:

■ Calculated fields

■ Multi-value fields

■ Fields in a virtual business component

The column name is name is case-sensitive. It must use the same 
format that it uses in the Siebel database.

Currency Code Field (O) Specifies the name of the currency code field that Siebel CRM uses 
with a DTYPE_CURRENCY data type.

The default field name is Currency Code.

Dest Field (O) Specifies a field in the destination business component that is 
defined in the Multi Value Link field.

Siebel CRM uses the Dest Field property only if the Multi Valued 
property is TRUE

If the Multi Valued property is FALSE, the Siebel CRM ignores the 
Dest Field property.
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Disable Search You can use one of the following values:

■ TRUE. The user cannot use this field to search in the client.

■ FALSE. The user can use this field to search in the client.

Disable Sort You can use one of the following values:

■ TRUE. The user cannot use this field to sort in the client.

■ FALSE. The user can use this field to sort in the client.

Exchange Date Field (O) Specifies the name of the exchange date field that Siebel CRM uses 
with a DTYPE_CURRENCY data type. The default field name is 
Exchange Date.

Force Active (O) If TRUE, then to get the field value, Siebel CRM queries the Siebel 
database each time it instantiates the parent business component. 
It does this even if it does not display this field in the client. You 
must set the Force Active property to TRUE only if you must script 
a field in the active business component, and only if Siebel CRM 
does not display this field in the active applet. Setting this property 
to TRUE might reduce performance.

Force Case (O) Specifies the case for the field value. You can use one of the 
following values:

■ UPPER

■ LOWER

■ FIRSTUPPER

Hidden (O) If TRUE, then the field is not visible to a dynamically created list 
view, such as the view that the forecasting module uses. Siebel 
CRM uses this property to support only specialized functionality. It 
does not support general configuration.

The default value of the Hidden property is one of the following:

■ TRUE for a business component that uses the DTYPE_ID data 
type.

■ FALSE for business components that do not use the DTYPE_ID 
data type.

Immediate Post Changes 
(O)

For more information, see “Configuring the Immediate Post Changes 
Property of a Field” on page 130.

Internal Pick Applet (O) Specifies a pick applet that Siebel Tools displays for a workflow 
process. You can set the conditions for the Decision Point step in a 
workflow process to use values from business component fields. 
You can use the Internal Pick Applet property to specify the applet 
that this user interface displays.

Table 60. Properties of the Field

Property Description
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Join (O) Specifies the name of the join object definition that this field uses. 
Siebel CRM uses this join to get data from the table that the join 
defines. The value in the Join property corresponds to the Name 
property of this join. For more information, see “Join” on page 135.

Link Specification (O) If TRUE, then Siebel CRM sends the field value as a default value to 
a field in the child business component.

Message Display Mode Specifies the data to display if a validation failure occurs. You can 
use one of the following values:

■ User Msg. Display only the validation message.

■ User Msg with Error Code Only. Display the validation 
message and a Siebel error code in the following format:

SBL-xxx-yyy

■ User Msg with Error Code/Msg. Display the validation 
message, Siebel error code, and the default error message.

Multi Value Link (O) Depends on the following value of the Multi Valued property of this 
field:

■ TRUE. The Multi Value Link property specifies the multivalue 
link for this field. 

■ FALSE. Siebel CRM ignores the Multi Value Link property.

Multi Valued (O) You can use one of the following values:

■ TRUE. This field is a multivalue field.

■ FALSE. This field is a single value field.

Name (R) Specifies the name for this field. Other objects reference this field 
through this Name property.

You must not modify the name of a predefined field. Doing this can 
create upgrade problems and might affect intended configuration.

The name can include spaces. It must be unique in the business 
component.

Table 60. Properties of the Field

Property Description
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No Copy (O) You can use one of the following values:

■ TRUE. Siebel CRM does not copy the field value to the newly 
created record during a Based On Last operation.

■ FALSE. Siebel CRM copies the field value to the newly created 
record during a Based On Last operation. If you set the No Copy 
property to false for a field that Siebel CRM derives from a 
joined table, then you must make sure that No Copy in the join 
field is also set to FALSE. The Source Field property in the join 
specification identifies this join field. If you do not do this, then 
Siebel CRM displays the new record. It does this to copy the 
fields from the joined table. If the record is required, then it 
does not populate the fields. This situation occurs only in a 
Based On Last operation.

Oracle Sequence Object (O) Specifies the name of an Oracle sequence object. If Siebel CRM 
creates a new record, then it uses this sequence for this field.

You must manually create the Oracle sequence object in the Oracle 
Database. This is an exception to the normal way that you configure 
an Oracle sequence object.

Siebel Remote does not support an Oracle sequence object.

PickList (O) Specifies the name of a picklist object definition that Siebel CRM 
uses to display a list of valid values that the user can choose.

Post Default Value (O) Specifies the field value that Siebel CRM inserts in this field if it is 
empty the first time Siebel CRM writes it to the Siebel database. 
Note the following:

■ Siebel CRM inserts the post default value even if it does not 
display this field in the client.

■ If this field is empty during a subsequent update of this field, 
then Siebel CRM does not insert this post default value. 

■ Siebel CRM does not validate the value that the Post Default 
Value property contains for a calculated field.

■ Siebel CRM limits the value in the Post Default Value property 
to 255 characters.

■ To make sure the configuration in the linked field of a child 
business component works correctly, the Link Specification 
property must be TRUE on the parent business component.

Table 60. Properties of the Field

Property Description
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Pre Default Value (O) Specifies the field value that Siebel CRM inserts in this field when it 
creates a new record through an Add New Record or Copy Record 
operation. Note the following:

■ The user can modify this value before Siebel CRM writes the 
record to the Siebel database. 

■ Siebel CRM inserts the predefault value even if it does not 
display this field in the client.

■ Siebel CRM does not validate the value that the Pre Default 
Value property contains for a calculated field.

■ Siebel CRM limits the value in the Pre Default Value property to 
255 characters.

■ If a predefault value expression depends on other fields, then 
these fields must be populated when Siebel CRM evaluates this 
expression. For example, the following predefault value works 
because Siebel CMR populates the Row Id or Id field when it 
initializes the record:

Expr: Field 'ID'

The following predefault value does not work because Siebel 
CRM populates the Picklist Field after it initializes the record:

Expr: Field: 'picklist_field_name'

This situation is true for a Copy Record operation only if the 
NoCopy property is TRUE.

Precision (O) For more information, see “About the Scale and Precision Properties” 
on page 17.

Table 60. Properties of the Field

Property Description
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Read Only (O) If TRUE, then the user cannot modify the field value for this field. A 
field that references a joined table is typically read-only with the 
following exceptions:

■ A join to an extension table

■ A join to an active intersection table

Some fields are read-only even if the Read Only property is FALSE. 
The Effective Start Date field for the following business components 
is read-only:

■ Account Product

■ Promotion

■ Promotion Account

■ Promotion Account Product

■ Promotion Administration

■ Promotion Product

For more information, see “Join” on page 135.

Required (O) If TRUE, then Siebel CMR writes the field value to the Siebel 
database only if this field contains a value.

Scale (O) For more information, see “About the Scale and Precision Properties” 
on page 17.

Text Length (O) Specifies the maximum length of text that the field can contain.

Siebel CRM typically ignores this property. It typically gets the 
length from the table column that this field references.

If a Text field includes a user property named Text Length Override, 
then Siebel CRM does not ignore the Text Length property.

Type (R) Specifies the field data type. For more information, see “Configuring 
the Type Property of a Field” on page 131.

Table 60. Properties of the Field

Property Description
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Configuring the Immediate Post Changes Property of a Field
You can set the Immediate Post Changes property to one of the following values:

■ TRUE. Siebel CRM immediately saves the field value to the Siebel Server. For example, if a user 
modifies a field value and then tabs to the next field in the same record, then Siebel CRM 
immediately saves this new value to the Siebel Server and then refreshes the data that it displays 
in the client. To do this, it makes a round trip to the Siebel Server and calls a PreSetFieldValue 
browser script event. For more information about this event, see Siebel Object Interfaces 
Reference. 

■ FALSE. Siebel CRM does not immediately save the field value to the Siebel Server. For example, 
if a user modifies a field value and then tabs to the next field in the same record, then Siebel 
CRM does not save this new value to the Siebel Server. The default value is FALSE.

Situations Where You Must Set the Immediate Post Changes Property to True
Setting the Immediate Post Changes property to TRUE might negatively affect performance. You 
typically set it to TRUE only to support the following configurations:

Validation (O) Specifies the expression that Siebel CRM uses to validate the data 
that the user enters in this field. Note the following:

■ You can use the Validation property only with a single value 
field. You cannot use it with a multivalue field. 

■ Siebel CRM limits the value in the Validation property to 255 
characters.

Validation Message (O) Specifies to override the default validation message that the 
Application Object Manager provides. For example, if a user enters 
250 in a field, and if this value must not exceed 200, then the 
Application Object Manager displays the following validation 
message: 

Incorrect fields values:  field_name <= 200.

The user might not understand this message. To improve it, you 
can use the Validation Message property to configure Siebel CRM to 
display the following message:

Please enter a value under 200 for the field_name field.

For more information about validation messages, see the 
description for the Message Display Mode property.

Table 60. Properties of the Field

Property Description
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■ Calculated field. For example, assume field B is a calculated field that uses values from field A. 
The Application Object Manager on the server does the calculation for a calculated field. If Siebel 
CRM modifies the value in field A, then it must do a server round trip to calculate and display the 
new value for field B. To allow this round trip, you must set the Immediate Post Changes property 
for field A to TRUE. You do not set it to TRUE for field B because Siebel CRM is not required to 
do a round trip if it modifies the value in field B.

If the user modifies a value in a field, then Siebel CRM must run the code that the following event 
handlers contain on the Siebel Server:

■ BusComp_PreSetFieldValue performs a validation

■ BusComp_SetFieldValue causes some other action to occur after Siebel CRM validates a value

If the Immediate Post Changes property is FALSE, then Siebel CRM does not run the code on the 
Siebel Server until the next time it performs a server round trip. If the PreSetFieldValue event 
finds a problem with the field value, and if the Immediate Post Changes property is FALSE, then 
Siebel CRM does not notify the user that a problem exists until the next time it performs a server 
round trip. For more information about event handlers, see Siebel Object Interfaces Reference.

■ Constrained drop-down list. Assume the following constraints exists:

If field A = Y, then field B can contain Y1, Y2, Y3.

If field A = Z, then field B can contain Z1, Z2, Z3. 

In this example, Siebel CRM cannot populate the picklist for field B until the user chooses field 
A. To get the values for field B, it must perform a server round trip after the user chooses field 
A. To allow this round trip, you must set the Immediate Post Changes property for field A to 
TRUE. You do not set it to TRUE for field B because Siebel CRM is not required to do a round trip 
if it modifies the value in field B.

Configuring the Type Property of a Field
The Type property of a field corresponds to the physical type of the table column that resides in the 
Siebel database:

■ The value in the Type property includes a DTYPE_ prefix.

■ You must use the data types that come predefined with Siebel CRM.

■ If you configure Siebel CRM to map a column to a data type, then you must make sure you 
configure it to use a similar type. For example, Siebel CRM can map an integer column to the 
DTYPE_INTEGER data type. It cannot map an incompatible type. For example, it cannot map a 
Long column to the DTYPE_BOOL data type.

Table 61 describes the data types that Siebel CRM supports for a field.
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Table 61. Data Types That Siebel CRM Supports for the Field

Data Type Description

DTYPE_BOOL This data type includes the following qualities:

■ Stores Boolean data, such as Y or N.

■ Mapped to a column that uses a Character(1) physical type and length.

■ Typically displayed as TRUE or FALSE, or checked or unchecked.

DTYPE_CURRENCY This data type includes the following qualities:

■ Stores currency data.

■ Mapped to a column that uses a Number physical type. 

DTYPE_DATE This data type includes the following qualities:

■ Stores date data. It ignores other saved data, such as time.

■ Mapped to a column that uses a Date physical type.

DTYPE_DATETIME This data type includes the following qualities:

■ Stores date and time data.

■ Mapped to a column that uses a DateTime physical type.

DTYPE_ID This data type includes the following qualities:

■ Stores a key that Siebel CRM creates.

■ Mapped to a column that uses a Varchar(15) physical type and length.

DTYPE_INTEGER This data type includes the following qualities:

■ Stores integer data.

■ Mapped to a column that uses a Number physical type.

DTYPE_NOTE This data type includes the following qualities:

■ Stores long string data.

■ Mapped to a column that uses a Long physical type.

DTYPE_NUMBER This data type includes the following qualities:

■ Stores number data.

■ Mapped to a column that uses a Number physical type.

DTYPE_PHONE This data type includes the following qualities:

■ Stores phone number data.

■ Mapped to a column that uses a Varchar(40) physical type and length.
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Properties of the Field Object Type That Siebel CRM Supports for a 
Virtual Business Component
Table 62 describes the properties of a field that Siebel CRM supports in a virtual business component.

DTYPE_TEXT This data type includes the following qualities:

■ Stores string data.

■ Mapped to a column that uses a Varchar physical type.

■ Uses upper and lower case text that the user enters.

■ The ForceCase property on a field can force text to Upper, Lower, or 
FirstUpper case.

DTYPE_TIME This data type includes the following qualities:

■ Stores time data.

■ Mapped to a column that uses a Time physical type.

■ Siebel CRM ignores other saved data, such as date.

DTYPE_UTCDATETIM
E

Specifies the time as Greenwich mean time (GMT). For more information, 
see Siebel Global Deployment Guide. 

Table 61. Data Types That Siebel CRM Supports for the Field

Data Type Description
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Field Locale
A field locale defines language overrides that Siebel CRM uses with a field.

This object type occurs in the following location in the object hierarchy:

Siebel Objects > Business Component > Field > Field Locale

Table 63 describes properties that Siebel CRM uses with a field locale.

Table 62. Field Properties That Siebel CRM Supports for a Virtual Business Component

Properties That Siebel CRM Supports Properties That Siebel CRM Does Not Support 

Siebel CRM supports the following 
properties of a field in a virtual business 
component:

■ Calculated

■ Calculated Value

■ Currency Code Field

■ Exchange Date Field

■ Force Case

■ Hidden

■ Internal Pick Applet

■ Link Specification 

■ Pick List

■ Post Default Value 

■ Pre Default Value 

■ Precision

■ Read Only

■ Required

■ Scale

■ Text Length

■ Type

Siebel CRM does not support the following properties 
of a field in a virtual business component:

■ Column

■ Dest Field

■ Force Active

■ Join

■ Link Specification

■ Multi Value Link

■ Multi Valued

■ No Copy

■ Oracle Sequence Object

■ Validation
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Field User Prop
A field user prop sends a property value to specialized C++ code. Siebel CRM persists the value that 
you configure for a user property in the Siebel runtime repository. For more information, see “Object 
Types That You Must Not Modify” on page 18.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Component > Field > Field User Prop

Table 64 describes properties that Siebel CRM uses with a field user prop.

Join
A join defines the logical join between the table that a business component references and another 
table. Siebel CRM can update an implicit joined field. It cannot update an explicit join. For a complete 
explanation of restrictions on left, self, and simple joins, see an SQL language reference manual.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Component > Join

Table 65 describes properties that Siebel CRM uses with a join.

Table 63. Properties of the Field Locale

Property Description

Validation Message (R) Specifies the language text that Siebel CRM displays if validation 
fails. The Validation property on the parent field determines 
validation.

You can specify an error message. Siebel CRM displays this 
message in the client. It uses the language that the Language Code 
property specifies.

Table 64. Properties of the Field User Prop

Property Description

Name (R) Specifies the name of the user property.

Value (O) Specifies the value of the user property.
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Join Constraint
A join constraint is a constant value search specification that Siebel CRM applies to a column during 
a join. Outer joins use it.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Component > Join > Join Constraint

Table 66 describes properties that Siebel CRM uses with a join constraint.

Table 65. Properties of the Join

Property Description

Name (R) Specifies the name of the join object definition. This value defaults 
to the table that the Table property specifies. If two joins to the 
same table exist, then you must modify the name of one of these 
joins.

Outer Join Flag (O) You can use one of the following values:

■ TRUE. Indicates a left outer join. Siebel CRM applies an outer 
join to the table that the Table property of the join defines. It 
receives values even if the join returns no values.

■ FALSE. Indicates an inner join.

Table (R) Specifies the name of an SQL table. This name is case sensitive. It 
must use the same format that the table name uses in the Siebel 
database.

Table 66. Properties of the Join Constraint

Property Description

Destination Column (O) Specifies the column of a destination table. Siebel CRM to applies 
the constraint to this destination table. For example, you can use 
the following value:

LANG_CD
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Join Specification
A join specification specifies the columns to join from the tables on the left side and the right side of 
a join.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Component > Join > Join Specification

Table 67 describes properties that Siebel CRM uses with a join specification.

Name (R) Specifies the name of the join constraint.

Value (O) Specifies a constant value or constant function that is not empty, 
such as LoginId, PositionId, or DivisionId. For example, you can 
specify the following value:

Language()

You can specify GetProfileAttr. A profile attribute can be persistent 
or dynamic. If it is dynamic, then this Value property must contain 
a value before Siebel CRM uses the join. If this property does not 
contain a value, then GetProfileAttr returns a null value and the join 
fails.

Table 67. Properties of the Join Specification

Property Description

Destination Column (O) Specifies the name of the column in the destination table that 
Siebel CRM uses for the join. This name is case-sensitive. It must 
use the same format that it uses in the Siebel database. If the join 
occurs on a column other than the ROW_ID column, then the 
Destination Column property is required.

Table 66. Properties of the Join Constraint

Property Description
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Multi Value Field
A multi value field displays the child records of a parent record. If the user clicks a multivalue field, 
then Siebel CRM displays these child records.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Component > Multi Value Field

Table 68 describes properties that Siebel CRM uses with a multi value field.

Name (R) Specifies the name of the join specification object definition, which 
must be unique in the join. The name defaults to the Source Field 
value for the join specification.

By default, the name of a join specification is the name of the 
source field specified for the object definition. You must not modify 
this value unless two join specification object definitions exist for 
the same join that use the same source field. The merge and 
upgrade utility uses this field to determine matching entries.

For more information about the join specification, see Configuring 
Siebel Business Applications. 

Source Field (O) Specifies the name of a field. Siebel CRM uses this field to join the 
destination table. Note the following:

■ This field resides in the parent business component of the join 
object definition.

■ The Source Field property must reference a field that defines a 
database column. A computed field is an example of a field that 
does not reference a database column. You cannot use it as the 
source field for a join specification.

■ This field must be a foreign key to the Destination Column.

■ If the join occurs on a field other than the ID field, then the 
Source Field property is required.

Table 67. Properties of the Join Specification

Property Description
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Table 68. Properties of the Multi Value Field

Property Description

Calculated (O) If TRUE, then Siebel CRM uses business component data to 
calculate the field value.

Field (R) Specifies the name of a single-value field in the child business 
component that the multivalue link references. This field must be 
visible in a list applet.

To avoid performance problems, it is recommended that you do not 
specify a multivalue field from another business component in this 
property. If you must specify a multivalue field from another 
business component, then get help from Oracle. For more 
information, see “Object Types That You Must Not Modify” on 
page 18.

Force Active (O) If TRUE, then Siebel CRM gets the field value from the Siebel 
database.

Hidden (O) If TRUE, then Siebel CRM does not display this multivalue field in 
any list view that it dynamically creates at runtime. The default 
value is one of the following:

■ TRUE for a business component data type of DTYPE_ID

■ FALSE for any business component data type that is not 
DTYPE_ID

Link Specification (O) If TRUE, then Siebel CRM sends the field value as a default value to 
a field in the child business component. This configuration is 
required to support any business component that Siebel CRM uses 
as the child of a link from this business component, and if this child 
uses the Parent type of default values and expects to receive a 
value.

Multi Value Link (R) Specifies the name of the multivalue link that Siebel CRM uses when 
it gets data.

Name (R) Specifies the name of this multivalue field. The name must be 
unique in the business component. It can contain spaces. To 
reference this multivalue field, other objects use this name.

No Copy (O) If TRUE, then Siebel CRM does not copy the value that this 
multivalue field contains into the newly created record during a 
Based On Last operation. Also, if one of the following objects for this 
multivalue field specifies No Copy as TRUE, then Siebel CRM does 
not copy this value:

■ The multi value link

■ The source field
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Multi Value Link
A multi value link gets the records that Siebel CRM displays through a multivalue field.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Component > Multi Value Link

Table 69 describes properties that Siebel CRM uses with a multi value link.

PickList (O) Specifies the name of a picklist that Siebel CRM uses to display a 
list of values that the user can choose.

Read Only (O) If TRUE, then the user cannot modify the value of this multivalue 
field.

Required (O) Not used.

Table 68. Properties of the Multi Value Field

Property Description
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Table 69. Properties of the Multi Value Link

Property Description

Auto Primary (O) Specifies how Siebel CRM populates row ID values in the primary 
ID field. You can use one of the following values:

■ DEFAULT. Automatically set the first record as the primary.

■ NONE. Require the user to manually set the primary.

■ SELECTED. Use the primary that the user chooses in a 
multivalue list to set the primary for other lists. For example, if 
the user chooses a primary Shipping Address, then Siebel CRM 
also sets this address as the primary Billing Address. Siebel 
CRM does the following:

■ Sets these primary values only if the primary is not set. 

■ Does not set a value if a primary already includes a value. 

■ Uses SELECTED only if more than one multivalue link 
references the same detail business component.

Check No Match (O) Specifies how to set the primary if the foreign key field in the parent 
business component contains a value of No Match. You can use one 
of the following values:

■ TRUE. It runs a separate query. If the Auto Primary property of 
this multivalue link is:

■ Default. It sets the first record as the primary. 

■ SELECTED. It determines if another multivalue link to this 
business component indicates a primary record. If it does, 
then Siebel CRM sets this record as the primary of this 
multivalue link.

■ FALSE. It does not run a separate query.

For more information, see the topic about using the Check No Match 
property with a primary join in Configuring Siebel Business 
Applications. See the topic about how the Check No Match property 
impacts performance in Siebel Performance Tuning Guide.

Destination Business 
Component (R)

Specifies the name of the child business component.

Destination Link (R) Specifies the name of the link that Siebel CRM uses.
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Name (R) Specifies the name for this multivalue link. Note the following:

■ Other objects use this name to reference this multivalue link. 

■ The name must be unique among the multivalue links for this 
business component. 

■ The name can contain spaces. 

■ The name cannot contain numbers or special characters. 

No Associate (O) If TRUE, then Siebel CRM does not create associations through this 
multivalue link. It can add new detail records.

If the current view is in Admin Mode, then Siebel CRM ignores the 
No Associate property.

No Copy (O) You can use one of the following values:

■ TRUE. Siebel CRM does not copy child records through this 
multivalue link.

■ FALSE. Siebel CRM does the following:

■ Copies child records through this multivalue link. 

■ Only copies records that are directly related to this 
multivalue group. The copy operation on the child business 
component might fail due to a unique index violation.

■ If the No Copy property of a multivalue link on a child 
business component is FALSE, then Siebel CRM ignores it 
and does not use the Deep Copy feature to copy grandchild 
records.

No Delete (O) If TRUE, then the user cannot delete records associated with this 
multivalue link.

No Insert (O) If TRUE, then the user cannot insert records associated with this 
multivalue link.

No Update (O) If TRUE, then the user cannot update records associated with this 
multivalue link.

Popup Update Only (O) If TRUE, then Siebel CRM displays the multivalue group window for 
any of the multivalue group values that it must update.

Primary Id Field (O) Specifies the name of the field in the master business component 
that contains the row ID values that reference the primary records 
in the detail business component.

Table 69. Properties of the Multi Value Link

Property Description
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MVF Pick Map
An MVF pick map specifies instructions for copying fields when a drop-down list is used by a field in 
a business component. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Component > Multi Value Field > MVF Pick Map

Table 70 describes properties that Siebel CRM uses with a MVF pick map.

Source Field (O) Specifies the name of a source field that Siebel CRM uses to link the 
child business component with the source business component. The 
source business component is the business component that 
includes the object definition for the multivalue link.

If the source field is different from the Id, then the Source Field 
property is required.

Type Field (O) Specifies the name of a field in the DestBusComp business 
component that Siebel CRM uses as a filter to get a subset of 
records. It uses this property with the Type Value property.

Type Value (O) Specifies the data value that Siebel CRM uses to filter a subset of 
records.

Use Primary Join (O) You can use one of the following values:

■ TRUE. Run a primary join that uses the value in the Primary Id 
Field property to get the data for the primary child. To get the 
value for a nonprimary multivalue field, the user must type 
EXISTS in the query.

■ FALSE. Run the second query that gets all child records. Siebel 
CRM automatically creates the EXISTS query.

If the Cache Data property of the business component is TRUE, then 
you must not set the Use Primary Join property to TRUE. For more 
information, see the description for the Cache Data property in the 
“Business Component” on page 115 topic.

Table 69. Properties of the Multi Value Link

Property Description
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MVF Pick Map UpdOnlyIfNull
An mvf pick map updonlyifnull marks a copy pick map to perform the copy operation only if the field 
that the pick map specifies is not empty. A constrain pick map also copies a pick map. If the 
constraint is active, then this configuration results in no operation. If an mvf pick map updonlyifnull 
causes Siebel CRM to ignore the constraint, then the copy operation works. To avoid the copy 
operation, you can use a calculated field as the field for the constrain pick map.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Component > Multi Value Field > MVF Pick Map > MVF Pick Map 
UpdOnlyIfNull

Table 71 describes properties that Siebel CRM uses with an mvf pick map updonlyifnull.

Table 70. Properties of the MVF Pick Map

Property Description

Constrain (O) You can use one of the following values:

■ TRUE. Defines the MVF pick map as a constraint pick map. 

■ FALSE. Defines the MVF pick map as a copy pick map. 

For more information, see “About Copy and Constraint Pick Maps” on 
page 146.

Field (R) Specifies the field in the parent business component that Siebel 
CRM uses with this MVF pick map. To constrain a picklist on a 
multivalue field:

■ You cannot use a field in the parent business component.

■ You can only use a multivalue field that resides in the detail 
business component.

No Clear (O) You can use one of the following values:

■ TRUE. If the user does not pick a value from the drop-down list, 
then do not set the field that the Field property specifies to 
NULL.

■ FALSE. Delete any value that exists in the field that the Field 
property specifies. If the drop-down list is not bound, then 
Siebel CRM does not delete these field values.

Pick List Field (O) Specifies the field in the picklist business component Siebel CRM 
uses with this MVF pick map.
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Pick Map
A pick map specifies how to copy fields if a field uses a picklist. You cannot use a field in the parent 
business component to constrain a picklist on a multivalue field. You can only use a multivalue field 
that the detail business component includes.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Component > Field > Pick Map

Table 72 describes properties that Siebel CRM uses with a pick map.

Table 71. Properties of the MVF Pick Map UpdOnlyIfNull

Property Description

Field (R) Specifies the field in the parent business component that Siebel 
CRM examines for a NULL value before it does the copy operation 
that the parent pick map specifies.

Table 72. Properties of the Pick Map

Property Description

Constrain (O) You can use one of the following values:

■ TRUE. Define the pick map as a constraint pick map.

■ FALSE. Define the pick map as a copy pick map.

For more information, see “About Copy and Constraint Pick Maps” on 
page 146.

Field (R) Specifies a field in the parent business component that this pick 
map references.

No Clear (O) Specifies how to set the Field property if the user does not choose 
a value from the picklist. You can use one of the following values:

■ FALSE. The Field property is NULL.

■ TRUE. The Field property is not set to NULL.

Pick List Field (O) Specifies the field in the picklist business component that this pick 
map references.

Sequence (O) Specifies the order that Siebel CRM uses to copy the field values 
back to the business component after the user picks a row. This 
property can contain only an integer.

If Siebel CRM can get the Pick List Source Id, then it ignores the 
Sequence property.
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About Copy and Constraint Pick Maps
Siebel CRM can use the following types of pick maps:

■ Constraint pick map. Siebel CRM applies the value from a field in the parent business 
component as a search specification on a field in the picklist business component. 

■ Copy pick map. Siebel CRM copies the value of a field in the picklist business component to a 
field in the parent business component.

The Pick List Field property specifies the field in the picklist business component. The Field property 
specifies the field in the parent business component.

Pick Map UpdOnlyIfNull
A pick map updonlyifnull configures a copy pick map to do a copy operation only if the values of the 
fields that the updonlyifnull pick map specifies are empty. For more information, see “Pick Map” on 
page 145.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Component > Field > Pick Map > Pick Map UpdOnlyIfNull

Table 73 describes properties that Siebel CRM uses with a pick map updonlyifnull.
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Single Value Field
A single value field defines properties for a single value field.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Component > Single Value Field

Table 74 describes properties that Siebel CRM uses with a single value field.

Table 73. Properties of the Pick Map UpdOnlyIfNull

Property Description

Field (R) Specifies the field in the parent business component that Siebel 
CRM examines for the empty condition before it does the copy 
operation that the parent pick map specifies.

Each pick map object definition includes a child object definition of 
type Pick Map UpdOnlyIfNull. If you add one of these child object 
definitions to the pick map that constrains the picklist, and if the 
constraining value is NULL, then Siebel CRM ignores the constraint. 
If a picklist field that is not empty exists, then this field returns 
records and Siebel CRM displays these records.

If the value of the constraining field is empty, and if the values of 
the fields that the Pick Map UpdOnlyIfNull constraint pick map 
specifies are empty, then this Pick Map UpdOnlyIfNull works like a 
copy pickmap. To disable the constraint if the constraining field 
value is empty, you can use a calculated field as the field for the 
constraint pickmap.

Siebel CRM disables the constraint only if the following situations 
are true:

■ The field that the parent constraint pick map references is 
empty.

■ The field that this Pick Map UpdOnlyIfNull references is empty.

Table 74. Properties of the Single Value Field

Property Description

Calculated (O) If TRUE, then Siebel CRM calculates the value for this field.

Calculated Value (O) Specifies an expression that Siebel CRM uses to calculate value for 
this field.
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Column (R) Specifies the name of a database table column. This name is case-
sensitive. It must use the same format that it uses in the Siebel 
database.

The Column property is not allowed for a calculated field. It is 
required for a field that Siebel CRM does not calculate.

Currency Code Field (O) Specifies the name of the currency code field that Siebel CRM uses 
with a DTYPE_CURRENCY data type. The default value is Currency 
Code.

Exchange Date Field (O) Specifies the name of the exchange date field that Siebel CRM uses 
with a DTYPE_CURRENCY data type. The default value is Exchange 
Date.

Force Active (O) If TRUE, then Siebel CRM gets the data value from the Siebel 
database. For best performance, it is recommended that you set the 
Force Active to FALSE in most situations.

This property does not affect how browser script references or uses 
the value that this field contains.

Force Case (O) Specifies the case for the field value. You can use one of the 
following values:

■ UPPER

■ LOWER

■ FIRSTUPPER

Hidden (O) If TRUE, then Siebel CRM does not display this field in any list view 
that it creates dynamically at runtime. If business component data 
is:

■ Of type DTYPE_ID, then the default value is TRUE. 

■ Not of type DTYPE_ID, then the default value is FALSE. 

Join (O) Specifies the name of the join that this field uses. Siebel CRM uses 
this name only if the field value it gets is from the table that the 
join defines. For more information, see “Join” on page 135.

Table 74. Properties of the Single Value Field

Property Description
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Link Specification (O) If TRUE, then Siebel CRM sends the field value as a default value to 
a field in a child business component. If a business component is a 
child of this link, and if this business component uses the Parent 
type of default value, and if it expects to get a value, then a link 
specification is required.

For performance reasons, it is recommended that you set the Link 
Specification property TRUE only if Siebel CRM must predefault the 
parent value to the child value through the link. This configuration 
requires Siebel CRM to get the column value any time that this 
object is active. It is similar to the configuration that Siebel CRM 
uses for the ForceActive property.

This property does not affect how browser script references or uses 
the value that this field contains.

Message Display Mode Specifies the details that Siebel CRM displays in the validation 
message. You can use one of the following values:

■ User Msg. Display only the message that you define in Siebel 
Tools.

■ User Msg with Error Code Only. Display the message and the 
error code that the Application Object Manager returns.

■ User Msg with Error Code/Msg. Display the message that 
you define in Siebel Tools Display. Also display the message and 
the error code that the Application Object Manager returns.

Name (R) Specifies a name for this field. This name must be unique in the 
business component. It can contain spaces. Other objects use this 
name to reference this field.

No Copy (O) If TRUE, then Siebel CRM does not copy the field value to the new 
record during a Based On Last operation.

Oracle Sequence Object (O) Specifies the name of an Oracle sequence object. It determines the 
sequence that Siebel CRM uses for field defaults when it creates a 
new record.

PickList (O) Specifies the name of a picklist that Siebel CRM uses to display a 
list of valid values that the user can choose.

Post Default Value (O) Specifies a value that Siebel CRM uses for this field if the user does 
not enter a value and saves the record. Siebel CRM does not 
validate this value for a calculated field.

The Post Default Value property can contain no more than 255 
characters.

Table 74. Properties of the Single Value Field

Property Description
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Pre Default Value (O) Specifies the value that Siebel CRM uses for an empty field if an Add 
New Record or Copy Record operation creates a new record. The 
user might modify this value before Siebel CRM writes it to the 
Siebel database. Siebel CRM does not validate this value for a 
calculated field.

The Post Default Value property can contain no more than 255 
characters.

Precision (O) For more information, see “About the Scale and Precision Properties” 
on page 17.

Read Only (O) If TRUE, then the user cannot modify the field value. Some fields 
are read-only even if the Read Only property is FALSE. For example, 
the Effective Start Date field for the following business components 
is read-only:

■ Account Product

■ Promotion

■ Promotion Account

■ Promotion Account Product

■ Promotion Administration

■ Promotion Product

In general, a field that references a joined table is read-only. There 
are two exceptions to this rule: 

■ The join references an extension table.

■ The join references an active intersection table.

For more information, see “Join” on page 135.

Required (O) If TRUE, then the user must enter a value in this field before Siebel 
CRM can write the record to the Siebel database. 

For information about how you can use a user property to control 
required according to an expression, see Siebel Developer’s 
Reference.

Scale (O) For more information, see “About the Scale and Precision Properties” 
on page 17.

Text Length (O) Specifies the maximum length of text that the user can enter in this 
field. Siebel CRM typically ignores this property. It gets the length 
from the underlying column definition.

Table 74. Properties of the Single Value Field

Property Description
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SVF Pick Map
An svf pick map specifies how to copy fields if another field uses a picklist.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Component > Single Value Field > SVF Pick Map

Table 75 describes properties that Siebel CRM uses with an svf pick map.

Type (R) Specifies the data type for this field. You must make sure that the 
type you choose uses the same data type that the column uses. The 
Column property of this field specifies this column.

Validation (O) Specifies the expression Siebel CRM uses to make sure the data 
that the user enters is correct. You can use validation only with a 
single value field. You cannot use it with a multivalue field. The 
Validation property can contain no more than 255 characters.

Table 75. Properties of the SVF Pick Map

Property Description

Constrain (O) You can use one of the following values:

TRUE. Defines this SVF pick map as a constraint pick map.

FALSE. Defines this SVF pick map as a copy pick map.

For more information, see “About Copy and Constraint Pick Maps” on 
page 146.

Field (R) Specifies the field in the parent business component that this SVF 
pick map uses.

No Clear (O) Specifies how to set the Field property if the user does not choose 
a value from the picklist. You can use one of the following values:

FALSE. Set the Field property to NULL.

TRUE. Do not set the Field property to NULL.

Pick List Field (O) Specifies the field in the picklist business component that this SVF 
pick map uses.

Table 74. Properties of the Single Value Field

Property Description
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SVF Pick Map UpdOnlyIfNull
An svf pick map updonlyifnull marks a copy pick map to perform the copy operation only if the field 
that the pick map specifies is not empty. A constrain pick map also copies a pick map. If the 
constraint is active, then this configuration results in no operation. If the UpdOnlyIfNull causes Siebel 
CRM to ignore the constraint, then the copy operation works. To avoid the copy operation, you can 
use a calculated field as the field for the constrain pick map.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Component > Single Value Field > SVF Pick Map > SVF Pick Map 
UpdOnlyIfNull

Table 76 describes properties that Siebel CRM uses with an svf pick map updonlyifnull.

Business Object Types
This topic describes the object type known as the Business Object and object types that are children 
of this object type. It includes the following topics:

■ Business Object on page 152

■ Business Object Component on page 153

Business Object
A business object organizes one or more business components according to functional requirements. 
For example, the Opportunity business object can reference the following business components:

■ Opportunity

■ Contact

■ Product

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Object

Table 77 describes properties that Siebel CRM uses with a business object.

Table 76. Properties of the SVF Pick Map UpdOnlyIfNull

Property Description

Field (R) Specifies the field in the parent business component that Siebel 
CRM examines to determine if the field is empty before it performs 
the copy operation that the parent pick map specifies.
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Business Object Component
A business object component identifies a business component. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Object > Business Object Component

Table 78 describes properties that Siebel CRM uses with a business object component.

Business Service Object Types
This topic describes the Business Service object type and object types that are children of this object 
type. It includes the following topics:

Table 77. Properties of the Business Object

Property Description

Name (R) Specifies the name of the business object. This name must be 
unique among business objects. It can include spaces but it cannot 
include special characters.

To reference a business object, other objects reference this name.

Primary Business 
Component (O)

Specifies the parent business component of the business object.

Query List Business 
Component (O)

Specifies the name of the business component that Siebel CRM uses 
to save predefined queries for the business object.

Table 78. Properties of the Business Object Component

Property Description

BusComp (R) Specifies the name of a business component. For example:

Contact

Link (O) Specifies the name of a link that Siebel CRM uses between two 
business components. If this property does not include a value, 
then Siebel CRM does not create a link. For example:

Account/Contact

For more information, see “Link” on page 210.

Name (S) Specifies the name of the business object component. For example:

Contact
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■ Business Service on page 154

■ Business Service Browser Script on page 156

■ Business Service Locale on page 156

■ Business Service Method on page 157

■ Business Service Method Arg on page 157

■ Business Service Method Arg Locale on page 158

■ Business Service Method Arg User Prop on page 159

■ Business Service Method Locale on page 159

■ Business Service Server Script on page 160

■ Business Service Subsystem on page 160

■ Business Service User Prop on page 160

Business Service
A business service defines reusable business logic. You can configure the following types of business 
services: 

■ Built-in business service that you define in Siebel Tools. It can reference the predefined 
CSSService class or a specialized class. A specialized business service is for Oracle use only.

■ Run-time business service that you define in the client.

You can use a business service as a reusable code library that Siebel CRM can call from another 
script.

To configure a business service, you can use properties and Siebel VB script or Siebel eScript script. 

Starting with Siebel CRM version 8.0, if a business service uses the Web Client Automation Server 
or Browser Script, then you must use Siebel Tools to register this business service as an application 
user property. This configuration prevents a Service Not Found error. For more information about 
registering a business service, see Siebel Object Interfaces Reference.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Service

Table 79 describes properties that Siebel CRM uses with a business service.
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Table 79. Properties of the Business Service

Property Description

Browser Class (O)(H) Not used.

Cache (O) You can use one of the following values:

■ TRUE. The business service instance exists until the user 
session finishes.

■ FALSE. Siebel CRM deletes the business service instance after 
it finishes running.

Class (R) Specifies the class. If you create a business service, then you must 
set the Class property to CSSService. For example:

CSSService

Display Name (R) Specifies the name that Siebel CRM displays in the picklist.

External Use (O) Specifies that Siebel CRM can use the business service in a script 
and test it in a simulator. If you create a business service, then you 
must set the External Use property to TRUE.

Hidden (O) You can use one of the following values:

■ TRUE. Siebel CRM hides the object.

■ FALSE. Siebel CRM does not hide the object.

Name (R) Specifies the name of the business service.

Server Enabled (S) You can use one of the following values:

■ TRUE. Siebel CRM enables the business service on the Siebel 
Server. In most situations, you must set the Server Enabled 
property to TRUE.

■ FALSE. Siebel CRM does not enable the business service on the 
Siebel Server.

State Management Type (R) Specifies the state management type for a workflow process. For 
more information, see the description about the State Management 
Type property in Table 258 on page 341.

Web Service Enabled (O) You can use one of the following values:

■ TRUE. Expose the business service as a Web service.

■ FALSE. Do not expose the business service as a Web service.

For more information, see Siebel CRM Web Services Reference.
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Business Service Browser Script
A business service browser script specifies the browser script that the business service uses. For 
more information, see Siebel Object Interfaces Reference.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Service > Business Service Browser Script

Table 80 describes properties that Siebel CRM uses with a business service browser script.

Business Service Locale
A business service locale defines language overrides that Siebel CRM uses with a business service.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Service > Business Service Locale

Table 81 describes properties that Siebel CRM uses with a business service locale.

Table 80. Properties of the Business Service Browser Script

Property Description

Browser Group (O) Not used.

Name (S) Specifies a unique name for the script. To create a value for this 
property, Siebel Tools combines the values that the Browser Group 
property and the Procedure property contains. You must not modify 
this property. 

Procedure (O) Specifies the name of the function or the procedure.

Script (R) Specifies the text for the function.

Table 81. Properties of the Business Service Locale

Property Description

Display Name (R) Specifies the name that Siebel CRM displays in the picklist for a 
language.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU
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Business Service Method
A business service method defines functionality for a business service. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Service > Business Service Method

Table 82 describes properties that Siebel CRM uses with a business service method.

Business Service Method Arg
A business service method arg defines the arguments for a business service method.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Service > Business Service Method > Business Service Method Arg

Table 83 describes properties that Siebel CRM uses with a business service method arg.

Table 82. Properties of the Business Service Method

Property Description

Display Name (O) Specifies the name that Siebel CRM displays in various picklists.

Hidden (O) You can use one of the following values:

■ TRUE. Do not display the business service method in picklists 
in the Workflow Process Designer.

■ FALSE. Display the business service method in picklists in the 
Workflow Process Designer.

Name (R) Specifies the name of the business service method.

Table 83. Properties of the Business Service Method Arg

Property Description

Data Type (R) Specifies the data type of the business service method arg. To view 
the values you can use, click the Data Type property in Siebel Tools.

Display Name (O) Specifies the name that Siebel CRM displays in the client.

Hidden (O) You can use one of the following values:

■ TRUE. Hide the business service method argument.

■ FALSE. Display the business method argument.
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Business Service Method Arg Locale
A business service method arg locale defines language overrides that Siebel CRM uses with a 
business service method arg.

This object type occurs in the following location in the object hierarchy:

Integration Object (O) Specifies the name of the integration object that Siebel CRM uses 
for the business service method argument.

To view the values you can use, click the Integration Object 
property in Siebel Tools.

Siebel CRM uses this property only if the Data Type property is 
Integration Object.

Name (R) Specifies the name of the business service method argument.

Optional (O) You can use one of the following values:

■ TRUE. The business service method argument is optional.

■ FALSE. The business service method argument is required.

Pick Applet (O) Specifies the name of the pick applet that this business service 
method argument reference.

Pick Field (O) Specifies the name of the pick field that this business service 
method argument references.

Picklist (O) Specifies the name of the picklist that this business service method 
argument references.

Preferred Sequence (O) Specifies the order that Siebel CRM uses to call the business service 
method arguments that a business service contains.

This property can contain only an integer.

Storage Type (R) Specifies the storage type. To view the values you can use, click the 
Storage Type property in Siebel Tools.

Type (R) Specifies the type of business service method argument. You can 
use one of the following values:

Input. The argument is part of the Input property set for the 
InvokeMethod call.

Input / Output. The argument is part of the Input property set 
and the Output property set.

Output. The argument is part of the Output property set.

Table 83. Properties of the Business Service Method Arg

Property Description
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■ Siebel Objects > Business Service > Business Service Method > Business Service Method Arg > 
Business Service Method Arg Locale

Table 84 describes properties that Siebel CRM uses with a business service method arg locale.

Business Service Method Arg User Prop
A business service method arg user prop sends a property value to C++ code. Siebel CRM typically 
uses these user properties to import WSDL documents and to modify the metadata it uses to create 
a SOAP document at run-time. Siebel CRM persists the value that you configure for a user property 
in the Siebel runtime repository.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Service > Business Service Method > Business Service Method Arg > 
Business Service Method Arg User Prop

Table 85 describes properties that Siebel CRM uses with a business service method arg user prop.

Business Service Method Locale
A business service method locale defines language overrides that Siebel CRM uses with a business 
service method. These values persist in the repository and in the Siebel runtime repository.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Service > Business Service Method > Business Service Method Locale

A business service method locale uses the same properties that a business service method arg locale 
uses. For more information, see Table 84 on page 159.

Table 84. Properties of the Business Service Method Arg Locale

Property Description

Display Name (O) Specifies the name that Siebel CRM displays in the client for a 
language.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Table 85. Properties of the Business Service Method Arg User Prop

Property Description

Name (R) Specifies the name of the user property.

Value (R) Specifies the value of the user property.
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Business Service Server Script
A business service server script includes the Siebel VB script or Siebel eScript script that a business 
service contains.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Service > Business Service Server Script

A business service server script uses the same properties that an applet script uses. For more 
information, see Table 11 on page 42.

For more information, see Siebel Object Interfaces Reference.

Business Service Subsystem
A business service subsystem defines the subsystem that a business service references.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Service > Business Service Subsystem

Table 86 describes properties that Siebel CRM uses with a business service subsystem.

Business Service User Prop
A business service user prop sets the initial values for the properties of a business service. It 
communicates a property value to the C++ code or script that implements the business service 
configuration. Siebel CRM can modify these values during configuration or at run time. The 
GetProperty and SetProperty functions provide run-time access.

For more information, see “Object Types That You Must Not Modify” on page 18. For more information 
about properties that Siebel CRM supports, see Siebel Developer’s Reference.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Business Service > Business Service User Prop

Table 87 describes properties that Siebel CRM uses with a business service user prop. 

Table 86. Properties of the Business Service Subsystem

Property Description

Name (R) Specifies the name of the internal Oracle business service 
subsystem.

Subsystem (R) Specifies the name of an external business service subsystem.
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Class Object Types
This topic describes Class object type and object types that are children of this object type. It 
includes the following topics:

■ Class on page 161

■ Class Method on page 162

■ Class Method Menu Item on page 163

■ Class Method Menu Item Locale on page 163

■ Class User Prop on page 164

■ Class User Prop Value on page 165

Class
A class identifies the class for some object types, such as applet or business component. It includes 
a list of classes that the repository contains.

CAUTION: You can modify a class only if you are adding a new ActiveX control or Java Applet to the 
Siebel Web Client. Any modification you make to any other object can adversely affect performance 
and operation.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Class

Table 88 describes properties that Siebel CRM uses with a class.

Table 87. Properties of the Business Service User Prop

Property Description

Name (R) Specifies the name of the business service user prop.

Value (R) Specifies the value of the business service user property.

Table 88. Properties of the Class

Property Description

DLL (S) Specifies the DLL that includes the class.

Handheld Client (S) You can use one of the following values:

■ TRUE. Siebel CRM can use the class in the mobile client.

■ FALSE. Siebel CRM cannot use the class in the mobile client.
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Class Method
A class method describes the method that the class calls.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Class > Class Method

Table 89 describes properties that Siebel CRM uses with a class method.

High Interactivity Enabled 
(S)

The property has been deprecated and is ignored.

Java Thin Client (S)(H) You can use one of the following values:

■ TRUE. Siebel CRM can use this class for the Java thin client.

■ FALSE. Siebel CRM cannot use this class for the Java thin client.

Name (S) Specifies the name of the C++ class.

Object Type (S) Specifies the name of the object type that this class references.

Super Class (S) Specifies the name of the parent class.

Thin Client (S)(H) You can use one of the following values:

■ TRUE. Siebel CRM can use this class with the Siebel Web Client.

■ FALSE. Siebel CRM cannot use this class with the Siebel Web 
Client.

UNIX Support (S)(H) Specifies to support this class on the UNIX operating system.

Table 89. Properties of the Class Method

Property Description

Method (S) Specifies the method that the class calls.

Name (S) Specifies the name of the method.

Table 88. Properties of the Class

Property Description
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Class Method Menu Item
A class method menu item controls a menu item on an applet-level menu of a Siebel Web Engine 
applet of an applet class and the subclasses of this applet class.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Class > Class Method Menu Item

Table 90 describes properties that Siebel CRM uses with a class method menu item.

Class Method Menu Item Locale
A class method menu item locale defines language overrides that Siebel CRM uses with a class 
method menu item.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Class > Class Method Menu Item > Class Method Menu Item Locale

Table 91 describes properties that Siebel CRM uses with a class method menu item locale.

Table 90. Properties of the Class Method Menu Item

Property Description

Command (S) Specifies the name of the command that provides the method and 
target for the menu item.

Menu Text (S) Specifies the text that Siebel CRM displays in the menu item.

Name (S) Specifies the name of the class method menu item.

Position (S) Specifies the sequence of the menu item in the single-level list of 
menu items. This property can contain only an integer.

Suppress Menu Item (S) You can use one of the following values:

■ TRUE. Removes the applet-level menu items from the applet-
level menu in all applets that Siebel CRM gets from this class 
and the subclasses of this class.

■ FALSE. Does not remove these menu items.
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Class User Prop
A class user prop specifies a user property that Siebel CRM can use on Siebel repository objects that 
use the parent class.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Class > Class User Prop

Table 92 describes properties that Siebel CRM uses with a class user prop. For information about user 
properties, see Siebel Developer’s Reference.

Table 91. Properties of the Class Method Menu Item Locale

Property Description

Menu Text (S) Specifies the text that Siebel CRM displays in the menu item.

Name (S) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Table 92. Properties of the Class User Prop

Property Description

Description (O) Specifies a description for this user property. Siebel CRM displays 
this description in the picklist where it calls the user property so the 
user can quickly understand the usage and implications of the user 
property.

For example, to force a view to sort according to the ORDER BY 
clause on the predefined user key, Siebel CRM overrides the sort 
specification on this view for some visibility types. To override the 
sort specification and use a sort that Siebel CRM applies to the 
business component for the affected views, you can use the All 
Mode Sort user property.

Name (R) Specifies the name of the user property. This is the name that the 
C++ code of the class uses if it gets the value of the user property. 
It is also the name that Siebel Tools displays in the user property 
picklist for some objects. For example, a business component user 
property.

For example, you can enter the following value:

All Mode Sort
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Class User Prop Value
A class user prop value defines a value that Siebel CRM displays in the picklist for the parent class 
user prop.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Class > Class User Prop > Class User Prop Value

Table 93 describes properties that Siebel CRM uses with a class user prop value. For information 
about user properties, see Siebel Developer’s Reference.

Type (R) Specifies the object type that Siebel CRM uses with this class user 
property. You can enter one of the following values:

■ Business Component

■ Business Service

■ Applet

Value Type (O) Specifies the type of value that Siebel enters in this user property. 
If the user property contains plain text, then you can leave this 
property empty. You can use one of the following values:

■ Field

■ Link

■ Business Service

Table 92. Properties of the Class User Prop

Property Description
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Command Object Types
This topic describes Command object type and object types that are children of this object type. It 
includes the following topics:

■ Accelerator on page 166

■ Accelerator Locale on page 167

■ Command on page 168

■ Command Locale on page 170

Accelerator
An accelerator defines an accelerator key sequence for each browser for a menu item that uses this 
command. For more information, see “Formats You Can Use With an Accelerator Object Type” on 
page 18.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Command > Accelerator

Table 94 describes properties that Siebel CRM uses with an accelerator.

Table 93. Properties of the Class User Prop Value

Property Description

Description (O) Includes text that describes the object definition for this class user 
property. Siebel CRM displays this description in the picklist where 
the user uses the user property value. It allows this user to quickly 
understand the usage and implications of this value as compared to 
other values in the picklist.

For example, if the All Mode Sort user property value is Normal, 
then Siebel CRM uses a sort specification that is defined on a 
business component. This configuration also allows the user to run 
a predefined query that incorporates a sort.

Name (R) Specifies the name of the user property value. This is the name that 
Siebel Tools displays in the picklist for a user property value for an 
object type. For example, a business component user property.

For example, you can use one of the following values: 

■ TRUE

■ FALSE

■ Normal
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Accelerator Locale
An accelerator locale defines a language override that Siebel CRM uses with an accelerator. For more 
information, see “Formats You Can Use With an Accelerator Object Type” on page 18.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Command > Accelerator > Accelerator Locale

Table 95 describes properties that Siebel CRM uses with an accelerator locale.

Table 94. Properties of the Accelerator

Property Description

Browser Platform (O) User Agent. A user agent is typically a browser version, such as 
Internet Explorer 9.0.

You can use one of the following values:

■ All. Applies to all versions of a browser version.

■ Basic. Defines the capabilities of a major version of a browser.

■ Extended. Defines the extended capabilities of minor versions 
of the same browser.

Display Name (O) Specifies the name of the shortcut that Siebel CRM displays on a 
menu. For example:

CTRL+N

Key Sequence (O) The series of keyboard strokes in a shortcut.

For values you can use, see “Accelerator Locale” on page 167.

Key Sequence - Language 
Override (O)

The language code that Siebel CRM uses for the current key 
sequence. An Accelerator Locale object can override this value.

Name (R) Specifies the name of the accelerator. For example:

New record

Table 95. Properties of the Accelerator Locale

Property Description

Display Name (O) The series of keyboard strokes in a shortcut for a language and how 
Siebel CRM displays it on a menu. For example:

CTRL+N
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Command
A command specifies the method that Siebel CRM calls if a toolbar icon associated with this command 
runs. It also defines the bitmap that it displays on the toolbar icon. A toolbar item or menu item 
references a command.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Command

Table 96 describes properties that Siebel CRM uses with a command.

Key Sequence (O) The series of keyboard strokes in a shortcut for a language.

Name (O) The abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Table 96. Properties of the Command

Property Description

Bitmap (R)(H) Not used.

Business Service (O) Specifies a browser service or server service, depending on the 
property that handles the method.

Category (R) Specifies the category name for a customize dialog box.

Category Display Name (O) Not used.

Display Name (O) Specifies the name of the command. If you do not specify a name 
for a menu, then Siebel CRM uses the value that the Display Name 
property contains.

Dynamic Tooltip (O) Specifies to make a tooltip dynamic or static. It can include one of 
the following values:

■ TRUE. To get the dynamic tooltip text, Siebel CRM calls an 
underlying object, such as an application, applet, or service. 

■ FALSE. Use a static value.

Reserved for future use. 

Force Enable (O) Specifies to associate the menu item or toolbar item with this 
command object.

Reserved for future use.

Table 95. Properties of the Accelerator Locale

Property Description
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HTML Bitmap (O) Specifies the name of the bitmap that Siebel CRM displays if the 
control is in the enabled state.

HTML Disabled Bitmap (O) Specifies the name of the bitmap that Siebel CRM displays if the 
control is in a disabled state.

HTML Popup Dimension (O) Specifies the dimensions of the pop-up window, in pixels. For 
example:

640x480

The format requires a lower case x and no empty spaces.

Method (R) Specifies the name of the method that Siebel CRM calls if the user 
chooses a menu item or toolbar icon. This method can be 
predefined or a custom method that you define. 

Method Argument (O) Specifies the method argument that Siebel CRM sends to the 
method that the Method property contains. For example, assume a 
command item opens a new window and then navigates to a URL in 
that window. To implement this requirement, a command can 
specify the following:

■ The GotoURL method in the Method property.

■ The URL to navigate to in the Method Argument property.

Name (R) Specifies the name of the command object definition. This is the 
name of the toolbar icon that Siebel CRM displays in the Commands 
list on the Commands tab of the Customize dialog box in Siebel 
CRM.

Show Popup (O) You can use one of the following values:

■ TRUE. Open a new browser window before calling the method.

■ FALSE. Call the method in the current browser window.

Status Text (O) Not used.

Target (O) Specifies the name of the target. To view the values you can use, 
click the Target property in Siebel Tools. Note the following values:

■ Active Applet. The command is visible in all clients.

■ Service. The command displays only in a client that 
implements this service. This service must handle the 
CanInvokeMethod and InvokeMethod methods.

■ Application. Do not use. This value is for Oracle use only.

Tooltip Text (O) Obsolete. Do not use. 

Table 96. Properties of the Command

Property Description
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Command Locale
A command locale defines language overrides that Siebel CRM uses with a command.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Command > Command Locale

Table 97 describes properties that Siebel CRM uses with a command locale.

Content Object Types
This topic describes Content object type and object types that are children of this object type. It 
includes the following topics:

■ Content Object on page 170

■ Content Object View on page 171

Content Object
A content object specifies a class of content for the Content Center. It defines the fields and 
attachments of the content that Siebel CRM transfers from a staging environment to a production 
environment for use with the Content Center.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Content Object

Table 98 describes properties that Siebel CRM uses with a content object.

Table 97. Properties of the Command Locale

Property Description

Category Display Name (O) Not used.

Display Name (O) Specifies the name of the command in the client.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Status Text (O) Not used.

Tooltip Text (O) Obsolete. Do not use. 
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Content Object View
A content object view specifies the view that Siebel CRM uses to work with a class of content in the 
Content Center.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Content Object > Content Object View

Table 99 describes properties that Siebel CRM uses with a content object view.

Table 98. Properties of the Content Object

Property Description

Business Object (O) Specifies the business object. You can specify any business object 
that references a primary business component.

Integration Object (O) Specifies the integration object. You can specify any EAI object that 
Siebel CRM creates from the business object that the Business 
Object property specifies.

Name (R) Specifies the name of the content object.

Pick Applet (O) Specifies the name of the pick applet that Siebel CRM uses to 
choose the content data for a content item. The Business 
Component property of this applet must reference the primary 
business component of the business object.

Pick List (O) Specifies the name of the picklist for the pick applet. The Business 
Component property of this picklist must reference the primary 
business component of the business object.

Sequence (O) Specifies the order that Siebel CRM uses to publish content items. 
It uses this sequence only if it publishes a content project that 
includes content items from different content objects. 

Siebel CRM publishes the content items from the content object 
that possesses the lowest sequence number first. It then publishes 
the content object that possesses the next lowest sequence 
number, and then proceeds in this order until it publishes all 
content items from all content objects.

This property can contain only an integer.

Source Field (O) Specifies the field from the picklist that Siebel CRM uses to pick and 
fill in the content item reference ID. This property must only contain 
the following value:

Id
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DLL Object Type
This topic describes the DLL object type.

DLL
A DLL object contains the Siebel Tools program library files.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > DLL

Table 100 describes properties that Siebel CRM uses with a DLL object.

Table 99. Properties of the Content Object View

Property Description

Name (R) Specifies the name of the content object view. It is recommended 
that the name of the content object view be the same as the view 
name.

Sequence (O) Specifies the order that Siebel CRM uses to look up the content 
object views that the content object includes. A content object can 
include multiple content object views.

Siebel CRM looks up the view that includes the lowest sequence 
value first. It ignores any view for which the user does not possess 
visibility.

This property can contain only an integer.

View Name (O) Specifies the name of the view that the content contributor or 
approver drills down to from a content item. This user uses this 
destination view to edit or add content data.

You can specify any view. Typically, the top applet in this view 
references the primary business component of the business object 
that the content object references.
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Dock Object Types
This topic describes the object type known as the Dock Object and objects that are children of this 
object type. It includes the following topics:

■ Dock Object on page 173

■ Dock Object Related DObj on page 174

■ Dock Object Table on page 175

■ Dock Object Visibility Rule on page 176

Dock Object
A dock object defines rules or groups of rules that Siebel CRM uses to synchronize records to remote 
users. For more information, see Siebel Developer’s Reference.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Dock Object

Table 101 describes properties that Siebel CRM uses with a dock object.

Table 100. Properties of the DLL Object

Property Description

Attributes (O) Specifies any attributes that are associated with the applet tag.

Code or Class Id (O) Specifies the complete classname of the Java applet including the 
package name.

File Name (R) Specifies the name of the DLL file.

Java Package (O) Specifies the Java packages that this DLL requires.

Name (R) Specifies the name of the DLL object without a DLL filename 
extension.

Table 101. Properties of the Dock Object

Property Description

Active (S) If TRUE, then the dock object is active in Siebel CRM.

Dock Code (S) Specifies the code that Siebel CRM uses for this dock object.

Name (S) Specifies the abbreviated name of the primary table.
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Dock Object Related DObj
A dock object related dobj affects information access. For more information, see Siebel Developer’s 
Reference.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Dock Object > Dock Object Related DObj

Table 102 describes properties that Siebel CRM uses with a dock object related dobj.

Primary Table Name (S) Specifies the name of the primary table. Tables that the dock object 
tables identify for a dock object are related through foreign keys in 
the data model to one primary table.

User Name (S) Specifies the full name of the dock object.

Visibility Level (S) Specifies the level at which to download tables to a corresponding 
set of tables.

Write DB cache (S) If TRUE, then the dock object writes explicitly to the S_DOCK_INST 
table.

Table 102. Properties of the Dock Object Related DObj

Property Description

Active (S) If TRUE, then the dock object is active in Siebel CRM.

Check Visibility (S) If TRUE, then Siebel CRM examines the visibility rules for the 
user.

Name (S) Specifies the name of the dock object in which this doc object 
related dock dobj belongs.

Rel DObj Visibility Strength (S) Specifies the visibility strength of the related dock object. This 
property can contain only an integer.

Related Dock Object Name (S) Specifies the name of the related dock object.

SQL Statement (S) Specifies the SQL script that Siebel CRM uses to handle special 
exceptions for a rule.

Sequence (S) Specifies the position of the dock object. This property can 
contain only an integer.

Table 101. Properties of the Dock Object

Property Description
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Dock Object Table
A dock object table specifies the table that contains the records that Siebel CRM downloads with a 
dock object. For more information, see Siebel Developer’s Reference.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Dock Object > Dock Object Table

Table 103 describes properties that Siebel CRM uses with a dock object table.

Visibility Event Columns (S) Specifies the name of the visibility event columns for the related 
dock object visibility rule.

Visibility Strength (S) Specifies the visibility strength of the related dock object. This 
property can contain only an integer between 0 and 100:

■ A value of 100 provides full visibility. 

■ A value of 0 provides no visibility. 

■ A value between 1 and 100 provides partial visibility.

Table 103. Properties of the Dock Object Table

Property Description

Dock Object Sub Type (S) Specifies the sub type of the dock object.

Filter Sql Statement (S) Specifies the SQL script that Siebel CRM uses to filter data 
regarding the dock object tables.

Name (S) Specifies the name of the table that receives the records.

Node Language Filter (S) Specifies to use language selective downloading of translation 
tables to a remote client according to the client preferred language.

You can use one of the following values:

■ TRUE. Siebel CRM applies the node language filter to the 
translation tables. 

■ TRUE. Siebel CRM does not apply the node language filter and 
treats the table the same as it does a normal dock table.

Notify (S) If TRUE, then Siebel CRM logs events to the Client Diagnostics view 
of the Siebel Remote Admin screen.

Table 102. Properties of the Dock Object Related DObj

Property Description
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Dock Object Visibility Rule
A dock object visibility rule defines a set of rules that evaluate the records in a dock object that Siebel 
CRM displays for a remote user. For more information, see Siebel Developer’s Reference.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Dock Object > Dock Object Visibility Rule

Table 104 describes properties that Siebel CRM uses with a dock object visibility rule.

Source Column Name (S) Specifies the name of the column that Siebel CRM uses as the 
source for the dock object table.

Table Name (S) Specifies the name of the table that contains the records that Siebel 
CRM downloads with the dock object.

Target Column Name (S) Specifies the target column of the table that contains the records 
that Siebel CRM must download.

Target Table Name (S) Specifies the name of the table that receives the records that Siebel 
CRM downloads with the dock object.

Visibility Event (S) If TRUE, then the Transaction Router examines visibility rules on a 
visibility event and makes sure that any modification that exists in 
a dock table is a visibility event transaction.

Visibility Strength (S) Specifies the visibility strength of the dock object table. This 
property can contain only an integer between 0 and 100:

■ A value of 100 provides full visibility.

■ A value of 0 provides no visibility.

■ A value between 1 and 100 provides partial visibility.

Table 104. Properties of the Dock Object Visibility Rule

Property Description

Active (S) If TRUE, then the dock object visibility rule is active in Siebel 
CRM.

Category Column Name (S) Specifies the name of the category column that Siebel CRM uses 
to determine if a category is visible to a user.

Category Table Name (S) Specifies the name of the category table that Siebel CRM uses 
to determine if a category is visible to a user.

Table 103. Properties of the Dock Object Table

Property Description
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Check DObj Visibility Strength 
(S)

Specifies the property that Siebel CRM examines to determine 
the visibility strength of the dock object.

Check Dock Object Name (S) Specifies the name of an object definition that Siebel CRM uses 
to determine if it is related to another record that the user 
receives.

DBX SQL Statement (S) Specifies the SQL statement that Siebel CRM uses to extract a 
database.

Dock Object Sub Type (S) Specifies the sub type of the dock object.

Employee Column Name (S) Specifies the name of the column that Siebel CRM uses to 
evaluate each record according to if it includes a foreign key to 
the Employee record of the remote user.

Employee Table Name (S) Specifies the name of the employee table.

Name (S) Specifies the name of the dock object visibility rule.

Node Column Name (S) Specifies the column name for the node dock object visibility 
rule.

Node Table Name (S) Specifies the table name for the node dock object visibility rule.

Organization Column Name (S) Specifies the column name for the organization dock object 
visibility rule.

Organization Table Name (S) Specifies the table name for the organization dock object 
visibility rule.

Partial (S) Not used.

Position Column Name (S) Specifies the column name for the position dock object visibility 
rule.

Position Table Name (S) Specifies the table name for the position dock object visibility 
rule.

Sequence (S) Specifies an integer that determines the order that Siebel CRM 
uses to run this visibility rule relative to other visibility rules.

Source Column Name (S) Specifies the source column name for the check dock object 
visibility rule.

Source Table Name (S) Specifies the source table name for the check dock object 
visibility rule.

SQL Statement (S) Specifies the SQL statement for the SQL dock object visibility 
rule.

Target Column Name (S) Specifies the target column name for the check dock object 
visibility rule.

Table 104. Properties of the Dock Object Visibility Rule

Property Description
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EIM Interface Table Object Types
This topic describes EIM Interface Table object type and object types that are children of this object 
type. It includes the following topics:

■ Attribute Mapping on page 178

■ EIM Explicit Primary Mapping on page 179

■ EIM Interface Table on page 179

■ EIM Interface Table Column on page 181

■ EIM Table Mapping on page 183

■ Foreign Key Mapping on page 184

■ Foreign Key Mapping Column on page 185

■ Interface Table User Key Usage on page 186

Attribute Mapping
An attribute mapping identifies an attribute column that Siebel CRM updates. This column resides in 
the destination table that the parent Siebel Enterprise Integration Manager (EIM) table mapping 
identifies.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > EIM Interface Table > EIM Table Mapping > Attribute Mapping

Table 105 describes properties that Siebel CRM uses with an attribute mapping.

Target Table Name (S) Specifies the target table name for the check dock object 
visibility rule.

Type (S) Specifies the type of the dock object visibility rule.

Visibility Event Columns (S) Specifies the visibility event columns for the dock object 
visibility rule.

Visibility Strength (S) Specifies the visibility strength of the dock object visibility rule. 
This property can contain only an integer between 0 and 100:

■ A value of 100 provides full visibility.

■ A value of 0 provides no visibility.

■ A value between 1 and 100 provides partial visibility.

Table 104. Properties of the Dock Object Visibility Rule

Property Description
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EIM Explicit Primary Mapping
An EIM explicit primary mapping maps a primary for the Siebel Enterprise Integration Manager 
(EIM). For more information, see Siebel Developer’s Reference.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > EIM Interface Table > EIM Table Mapping > EIM Explicit Primary Mapping

Table 106 describes properties that Siebel CRM uses with an EIM explicit primary mapping.

EIM Interface Table
An EIM interface table is an alternative representation of a table that the Siebel Enterprise 
Integration Manager (EIM) uses only for interface tables. For more information, see Siebel Enterprise 
Integration Manager Administration Guide.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

Table 105. Properties of the Attribute Mapping

Property Description

Base Table Attribute Column 
Name (S)

Specifies the name of the attribute column in the base table.

Export Only (O) You can use one of the following values:

■ TRUE. Siebel CRM considers mappings for export. 

■ FALSE. Siebel CRM does not consider mappings for export. 

Interface Table Data Column 
(S)

Specifies the name of corresponding EIM Interface Table Column.

Name (S) Specifies the name of the attribute column in the target table.

Table 106. Properties of the EIM Explicit Primary Mapping

Property Description

Inf Tbl Exp Primary Flg Col 
Name (S)

Specifies the name of the column that Siebel CRM uses for primary 
mapping.

Name (S) Specifies the name of the table that Siebel CRM uses for the primary 
mapping.



Siebel Object Types Reference Siebel 2018

Siebel Object Types Reference ■ EIM Interface Table Object Types

180 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > EIM Interface Table

Table 107 describes properties that Siebel CRM uses with an EIM interface table.

Table 107. Properties of the EIM Interface Table

Property Description

Abbreviation 1 - 3 (S) Specifies up to three alternative abbreviations for the table.

Alias (S) Not used.

Base Table Name (S) Specifies the Type property as one of the following:

■ Ext for extending 

■ Journal for the name of the table that is journaling

EIM Delete Proc Column 
Name (S)

Specifies the name of the column that Siebel CRM deletes during 
data integration.

EIM Export Proc Column 
Name (S)

Specifies the name of the column that Siebel CRM exports during 
data integration.

EIM Merge Proc Column Name 
(S)

Specifies the name of the column that Siebel CRM merges during 
data integration.

File (S) If TRUE, then Siebel CRM uses the table to save file attachment 
data.

Name (S) Specifies the unique name of the table.

Parent Interface Table Name 
(S)

Specifies the name of the parent interface table.

Parent Table Column 1 Name 
(S)

Specifies the name of the column that references the primary 
parent if this table is a child table or intersection table.

Parent Table Column 2 Name 
(S)

Specifies the name of the column that references the second 
parent if this table is an intersection table.

Target Table Name (S) Specifies the name of the target table.

Type (S) Specifies the type of table.

User Name (S) Specifies a user-friendly name for the table.
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EIM Interface Table Column
An EIM interface table column is an alternative representation of a column that Siebel Enterprise 
Integration Manager (EIM) uses for a column that is a child of an interface table. For more 
information, see Siebel Enterprise Integration Manager Administration Guide.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > EIM Interface Table > EIM Interface Table Column

Table 108 describes properties that Siebel CRM uses with an EIM interface table column.

Table 108. Properties of the EIM Interface Table Column

Property Description

Alias (S) Not used.

Cascade Clear (S) If TRUE, then EIM clears this foreign key if Siebel CRM deletes the 
related entity. This property must be FALSE for an extension column.

Default (S) Specifies the value that Siebel CRM uses for this column in a new 
record.

Denormalization Path (S) Specifies the path that Siebel CRM denormalizes if this is a 
denormalization column. Applies to denormalization of a user key 
column into an intersection table.

EIM Processing Column Flag 
(S)

If TRUE, then the column for this interface table is reserved for EIM 
processing. You must not use this property to allow this column to 
contain customer data.

Force Case (S) Specifies to force new values to uppercase letters.

Foreign Key Table Name 
(S)

Specifies the table to which this column is a foreign key, EIM uses 
this property.

Lov Bounded (S) If TRUE, then EIM examines the values in a list defined in a LOV 
Type. You must configure Siebel CRM to first import LOV data into 
the S_LST_OF_VAL table and you must specify LOV Type.

This property is read-only for a predefined column in Siebel CRM but 
is editable for a column that you add through the Database Extension 
Designer.
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Lov Type (S) Specifies the list of values where Siebel CRM validates this column. 
Siebel CRM uses the Lov Type property with the LOV Bounded 
property. You define a list of values in List of Values administration 
screen in the client.

This property is read-only for a predefined column in Siebel CRM but 
is editable for a column that you add through the Database Extension 
Designer.

Name (S) Specifies a name that must be unique in the table.

Nullable (S) If TRUE, then Siebel CRM can save NULL in this column.

Physical Type (S) Specifies the data type of the column in the Siebel database.

Precision (S) For more information, see “About the Scale and Precision Properties” 
on page 17.

Primary Child Col (S) EIM uses this property. For Oracle use only.

Primary Child Column Name 
(S)

Specifies the name of the column that contains the primary ID value.

Primary Child Table Name 
(S)

Specifies the name of the table where Siebel CRM can locate the 
primary child.

Primary Inter Table Name 
(S)

EIM uses this property. For Oracle use only.

Primary Join Column Name 
(S)

Specifies the name of the column that Siebel CRM uses to join the 
record. 

Primary Key (S) If TRUE, then Siebel CRM uses this column as part of the primary key 
of the table.

Required (S) If TRUE, then Siebel CRM requires this column. This requirement is 
true even if the Siebel database allows a NULL value.

Scale (S) For more information, see “About the Scale and Precision Properties” 
on page 17.

Sequence Object (S) If TRUE, then Siebel CRM uses a sequence object and automatically 
creates case column values. Only one foreign key can exist for the 
foreign key table for each table.

For Oracle use only.

Text Length (S) Specifies the length in characters for a Text column or Varchar 
column. The column size in Siebel Tools is not the same as the 
column size in the physical database. For more information about 
this difference, see 531960.1 (Article ID) on My Oracle Support. 

Translate For Oracle internal use only. You must leave this property set to 
FALSE for an extension column.

Table 108. Properties of the EIM Interface Table Column

Property Description
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EIM Table Mapping
An EIM table mapping identifies a data table that the parent EIM interface table object definition 
updates. Siebel Enterprise Integration Manager (EIM) uses this object. For more information, see 
Siebel Enterprise Integration Manager Administration Guide.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > EIM Interface Table > EIM Table Mapping

Table 109 describes properties that Siebel CRM uses with an EIM table mapping.

Translation Table Name (S) Specifies the name of the translation table.

Type (S) Specifies the type. 

Use FKey (S) If TRUE, then Siebel CRM uses this foreign key during 
synchronization to evaluate visibility. You must leave this property 
set to FALSE for an extension column.

Use Key Sequence (S) Specifies the order that Siebel CRM uses this column in the user key.

User Name (S) Specifies the user-friendly name for the column.

Valid Condition (S) Specifies the expression that Siebel CRM uses to validate column 
values.

Table 109. Properties of the EIM Table Mapping

Property Description

Default Map Column Name 
Prefix (S)

Specifies the prefix for the default column that Siebel CRM maps 
during data integration.

Destination Table Name (S) Specifies the name of the target table for the mapping.

EIM Exists Proc Column Name 
(S) 

Specifies the name of the existing column that Siebel CRM uses 
during data integration.

EIM ROW_ID Proc Column 
Name (S)

Specifies the name of the row ID column that Siebel CRM uses 
during data integration.

EIM Status Proc Column Name 
(S)

Specifies the name of the status column that Siebel CRM uses 
during data integration.

EIM Unique Proc Column Name 
(S)

Specifies the unique name of the column that Siebel CRM uses 
during data integration.

Table 108. Properties of the EIM Interface Table Column

Property Description
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Foreign Key Mapping
A foreign key mapping identifies a foreign key column in the destination table that an interface table 
populates. Siebel Enterprise Integration Manager (EIM) uses this object type. For more information, 
see Siebel Enterprise Integration Manager Administration Guide.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > EIM Interface Table > EIM Table Mapping > Foreign Key Mapping

Table 110 describes properties that Siebel CRM uses with a foreign key mapping.

Explicit Mapping (S) If TRUE, then Siebel CRM maps the table during data integration.

Name (S) Specifies the name of the target table.

Second Row (S) If TRUE, then Siebel CRM separates one row in the EIM table into 
two different rows in the table. If you must map a table to an 
EIM table two times, then you can set this property. You can use 
this property with a table that includes a data row pair, such as 
the S_INV_LGR_ENTRY table. 

Table 110. Properties of the Foreign Key Mapping

Property Description

EIM Foreign Key Proc Column 
(S)

Specifies the name of the column that EIM uses as the foreign 
key.

Export Only (O) If TRUE, then the Foreign Key Mapping Column object definitions 
identify user key columns to the interface table so that Siebel 
CRM gets foreign key values when an export occurs.

Each Foreign Key Mapping Column object definition identifies 
part of the user key columns that Siebel CRM uses to locate rows 
in the table that the foreign key references. The combination of 
user key columns uniquely identifies rows in this table. 

Foreign Key Column Name (S) Specifies the name of the column that Siebel CRM uses as the 
foreign key.

Name (S) Specifies the name of the foreign key column.

Table 109. Properties of the EIM Table Mapping

Property Description
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Foreign Key Mapping Column
A foreign key mapping column identifies a part of the user key. It identifies an attribute column that 
Siebel CRM uses to locate rows in the table that the foreign key references. The combination of user 
key columns uniquely identifies rows in this table. Siebel Enterprise Integration Manager (EIM) uses 
this object type. For more information, see Siebel Enterprise Integration Manager Administration 
Guide.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > EIM Interface Table > EIM Table Mapping > Foreign Key Mapping > Foreign Key 
Mapping Column

Table 111 describes properties that Siebel CRM uses with a foreign key mapping column.

Override Ref Column Name (S) Specifies the name of the column that Siebel CRM uses to 
override the value that the EIM Foreign Key Proc Column 
property contains.

User Key Name (S) Specifies the name of the user key column that Siebel CRM finds 
in the user key index.

Table 111. Properties of the Foreign Key Mapping Column

Property Description

Interface Table Data Column Name 
(S)

Specifies the name of the column in the interface table that 
supplies the data.

Name (S) Specifies the name of the user key column.

Self Ref Mapping Column Name (S) Specifies the name of the column.

Self Reference Join (S) If TRUE, then Siebel CRM allows a join operation between the 
self-reference mapping column and the foreign key mapping 
column.

User Key Attribute Name (S) Specifies the name of the attribute column. 

Table 110. Properties of the Foreign Key Mapping

Property Description
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Interface Table User Key Usage
An interface table user key usage provides support for alternative user keys for tables. It determines 
how Siebel CRM uses a nontraditional user key for an interface table. Siebel Enterprise Integration 
Manager (EIM) uses this object type. For more information, see Siebel Enterprise Integration 
Manager Administration Guide.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > EIM Interface Table > Interface Table User Key Usage

Table 112 describes properties that Siebel CRM uses with an interface table user key usage.

Entity Relationship Diagram Object 
Types
This topic describes Entity Relationship Diagram object type and object types that are children of this 
object type. It includes the following topics:

■ Entity on page 186

■ Entity Attribute (H) on page 187

■ Entity Physical Relation (H) on page 188

■ Entity Relation on page 188

■ Entity Relationship Diagram on page 189

Entity
An entity contains entity properties.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Entity Relationship Diagram > Entity

Table 113 describes properties that Siebel CRM uses with an entity.

Table 112. Properties of the Interface Table User Key Usage

Property Description

Application Table Name (S) Specifies the name of the base table in an interface table.

Name (S) Specifies the name of an interface table user key usage.

User Key Name (S) Specifies the name of the user key.
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Entity Attribute (H)
An entity attribute contains information about an attribute in an entity.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Entity Relationship Diagram > Entity > Entity Attribute

Table 114 describes properties that Siebel CRM uses with an entity attribute.

Table 113. Properties of the Entity

Property Description

Business Component Specifies a user-defined entity or an entity that is associated with 
an existing business component.

Name Specifies the name of the entity. The default name is Entity 1. You 
can modify this value.

Table 114. Properties of the Entity Attribute

Property Description

Business Component Specifies the business component to display for the parent entity 
object.

This property is read only.

Business Component Field Specifies the field that contains a picklist of the properties on the 
business component that Siebel CRM maps to the entity.

For example, if Siebel CRM maps the Account business component 
to an entity, then the Business Component Field picklist contains 
Account Competitors, Account Conditions, Account Markets, and so 
on.

Data Example Specifies a text example of an entity attribute.

Data Type Specifies the data type for this entity attribute.

Format String Specifies the string format for this entity attribute. For example, to 
specify the format string for a telephone number, you can enter the 
following value:

(XXX)XXX-XXXX

Length Specifies the maximum length for this entity attribute.

Name Specifies the name for this entity attribute.

Pick List Domain Specifies the set of values for an entity attribute that you define 
from a picklist.



Siebel Object Types Reference Siebel 2018

Siebel Object Types Reference ■ Entity Relationship Diagram Object Types

188 

Entity Physical Relation (H)
An entity physical relation if you bind a relation in the ERD these fields become populated as read-
only fields.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Entity Relationship Diagram > Entity Relation > Entity Physical Relation

Table 115 describes properties that Siebel CRM uses with an entity physical relation.

Entity Relation
An entity relation contains the definition of the relation that Siebel Tools displays on the canvas.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Entity Relationship Diagram > Entity Relation

Table 116 describes properties that Siebel CRM uses with an entity relation.

Pick List Required If TRUE, then a picklist is required.

User Key Flag If TRUE, then this entity attribute is a user key.

Table 115. Properties of the Entity Physical Relation

Property Description

Business Component Specifies the primary business component depending on if this 
entity physical relation is a:

■ Link. Specifies the business component name.

■ Join. Specifies the parent business component.

Join Alias Specifies the join alias if this entity physical relation is a join.

Link Name Specifies the link name if this entity physical relation is a link.

Name Specifies the name of the repository object that Siebel CRM binds 
to this entity physical relation depending on if this entity physical 
relation is a:

■ Link. Specifies the link name.

■ Join. Specifies the join alias.

Table 114. Properties of the Entity Attribute

Property Description
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Entity Relationship Diagram
An entity relationship diagram allows a business analyst or developer to define business entities and 
then map the appropriate Siebel object to each entity.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Entity Relationship Diagram

Table 117 describes properties that Siebel CRM uses with an entity relationship diagram.

Table 116. Properties of the Entity Relation

Property Description

Cardinality Specifies one of the following relationships:

■ 1:1 (one to one)

■ 1:M (one to many)

■ M:1 (many to one)

■ M:M (many to many)

End Name 1 Specifies the name for the start of the relationship.

End Name 2 Specifies the name for the end of the relationship.

Entity 1 Specifies the entity at the start of the relationship. You can specify 
an entity that references a predefined business component or a 
custom entity.

Entity 2 Specifies the entity at the end of the relationship. You can specify 
an entity that references a predefined business component or a 
custom entity.

Name Specifies the name of the entity relation. You can specify the default 
name, such as Relation0, or you can use a custom name, such as 
one the following names:

Owns for Customer 

Owns Automobile

Table 117. Properties of the Entity Relationship Diagram

Property Description

Name Specifies the name of the entity relationship diagram (ERD). This 
name must be unique.

Status Specifies the status of the entity relationship diagram.
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External Search Engine Object Type
This topic describes External Search Engine object type.

External Search Engine (H)
An external search engine customizes search content. A search engine includes one or more search 
tables and each of these tables includes one or more search fields.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > External Search Engine 

Table 118 describes properties that Siebel CRM uses with an external search engine.

Find Object Types
This topic describes the Find object type and object types that are children of this object type. It 
includes the following topics:

■ Find on page 190

■ Find Field on page 191

■ Find Field Locale on page 193

■ Find Locale on page 194

■ Find Pick View on page 194

■ Find View on page 195

Find
A find creates an entry that Siebel CRM can add to the Find dialog box in the client.

Table 118. Properties of the External Search Engine

Property Description

Max Rows (O) Specifies the maximum number of result rows to get.

Max Time (O) Specifies the maximum time in seconds to search.

Name (R) Specifies the logical name of this search definition. This value is the 
value for the SearchDefName parameter in the configuration file.

Sort Specification (O) Specifies the sort expression that orders the records that Siebel 
CRM returns. For example: 

SCORE DESC, FILENAME ASC
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This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Find

Table 119 describes properties that Siebel CRM uses with a find.

Find Field
A find field adds a search field to the Find dialog box that Siebel CRM displays in the client.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Find > Find Field

Table 120 describes properties that Siebel CRM uses with a find field.

Table 119. Properties of the Find

Property Description

Applet (R) Specifies the applet that the find uses. The view that Siebel CRM 
specifies for every Find View object definition for the Find object 
must include this applet.

Destination Field (R) Specifies the destination field that Siebel CRM uses to drill down 
into a record. This field resides in the business component that the 
applet references. If the Destination Field property is empty, then 
Siebel CRM uses the row ID field.

Display Name (O) Specifies the display name for the Find object.

Drilldown View (O) Specifies the view that Siebel CRM displays if the user drills down. 
If the Drilldown View property is empty, then it uses the Find View.

Name (R) Specifies the name of the Find object definition. You reference this 
value when you configure the application find object definitions that 
use this Find object definition.

Preview (O) Specifies the view that Siebel CRM displays in a separate browser 
window if the user clicks the Preview button in the Search Center. 
This preview view is typically a read-only view.

For example, the preview for the Accounts find is Accounts Preview 
View.
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Table 120. Properties of the Find Field

Property Description

Display In Entry (O) Specifies a TRUE or FALSE value.

Display In Results (O) Specifies a TRUE or FALSE value.

Display Name (O) Specifies the text or a key to the localized text that Siebel CRM 
displays for this find field if the parent find object definition of this 
find field is active in the Find dialog box.

Drilldown Business 
Component

Specifies the business component of the search result record that 
Siebel CRM queries in the destination view. This property allows you 
to configure separate drilldowns on the various fields in the Find 
Results applet. 

Drilldown Destination Field Specifies the field in the destination business component whose 
value equals the value of the source field in the source business 
component. This property allows you to configure separate 
drilldowns on the various fields in the Find Results applet. If you do 
not specify a value in the Drilldown Source Field property, then do 
not specify a value in the Drilldown Destination Field property.

The value you enter in the Drilldown Destination Field property is 
valid only for Find results.

Drilldown Source Field Specifies the field in the source business component whose value 
equals the value of the field in the destination business component. 
This property allows you to configure separate drilldowns on the 
various fields in the Find Results applet.

The value you enter in the Drilldown Source Field property is valid 
only for Find results.

Drilldown View Specifies the view where Siebel CRM displays the search result 
record if the user drills down. This property allows you to configure 
separate drilldowns on the various fields in the Find Results applet. 

Field (R) Specifies the field that Siebel CRM searches in the business 
component.

Name (R) Specifies the name of the search field.

Sequence (O) Specifies the order that Siebel CRM uses to position this find field 
in the list of fields that it displays in the Find dialog box for the 
parent find object definition. The Sequence property can contain 
only an integer.
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Configuring the Field for a Find Field
The field that you specify in a find field must exist in the business component that the applet 
references for the find object definition.

Configuring Query For the Find Dialog Box
The configuration of the Find dialog box and the configuration of a query by example might be 
different for a multivalue field. The Find dialog box uses the same query that an EXISTS query on a 
field in a query by example uses. To verify this configuration, you can use an Exists expression in 
the query by example. For example:

Exists (Aga*)

Query by example supports each type of querying, but to keep the Find dialog box simple, Siebel 
CRM uses a query that works in all situations. If your implementation must not use the EXISTS 
configuration in the Find dialog box, then you can do the following:

1 Create a join from the primary ID field for the multivalue link to the table that contains the data. 

2 Add a field on the table that you joined in Step 1.

3 Configure the find field to reference the field you added in Step 2.

Find Field Locale
A find field locale defines language overrides that Siebel CRM uses with a find field.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Find > Find Field > Find Field Locale

Table 121 describes properties that Siebel CRM uses with a find field locale.

Sequence - Language 
Override (O)

Specifies to modify the Sequence property if a language or locale is 
active. The Sequence - Language Override property can contain 
only an integer.

Title (O) Reserved for future use.

Table 120. Properties of the Find Field

Property Description
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Find Locale
A find locale defines the language overrides that Siebel CRM uses with a find. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Find > Find Locale

Table 122 describes properties that Siebel CRM uses with a find locale.

Find Pick View
A find pick view identifies the applet in the pick view that receives items from the find results list. 
Siebel CRM can associate find results to an applet if a relationship exists between the applet and the 
parent of this applet, and if the search result and the Pick Applet reference the same business 
components. To create this relationship in Siebel Tools, you use an intersection table that creates a 
link between the two business components.

Table 121. Properties of the Find Field Locale

Property Description

Display Name (O) Specifies the text or the key to the localized text that Siebel CRM 
displays for this find field if the parent find object definition is active 
in the Find dialog box for a language.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Sequence (O) Specifies the order that Siebel CRM uses to position this find field 
in the list of fields that it displays in the Find dialog box for the 
parent find object definition. The Sequence property can contain 
only an integer.

Table 122. Properties of the Find Locale

Property Description

Display Name (O) Specifies the display name for the Find object for a language.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU
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The following is an example configuration for the Opportunities find category:

■ Configuration of the pick view is Contact Detail - Opportunities View

■ Configuration of the pick applet is Opportunity List Applet - Basic

In this example, if a many-to-many relationship exists between the parent Contact applet and the 
child Opportunity List Applet - Basic applet, then Siebel CRM can attach an Opportunity Find result 
to the Opportunity List Applet - Basic applet.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Find > Find Pick View

Table 123 describes properties that Siebel CRM uses with a find pick view.

Find View
A find view specifies the view that Siebel CRM displays if it uses the Find dialog box to perform a find 
operation.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Find > Find View

Table 124 describes properties that Siebel CRM uses with a find view.

Table 123. Properties of the Find Pick View

Property Description

Applet Name (O) Specifies the name of an applet in a view that allows the user to 
associate a child record to a parent.

Field Name (O) Specifies the MVG field. Siebel CRM does not support this property 
in Siebel CRM version 7.

Name (R) Property is hidden and its value is defaulted from the View Name 
property.

View Name (O) Specifies the name of the view.



Siebel Object Types Reference Siebel 2018

Siebel Object Types Reference ■ Help ID Object Type

196 

Help ID Object Type
This topic describes the Help Id object type.

Help Id
A help Id specifies the HTML file name that contains the help topics for a screen in the client. To 
reference it, you enter the help Id name in the Help Identifier property of a view or screen. If the 
user chooses the Help menu and then clicks Contents, then Siebel CRM calls the GotoPage method 
of the Siebel Web Engine (SWE). This method uses SWE code to display the correct help topic in a 
separate browser window. For more information about help, see Siebel Object Interfaces Reference.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Help Id

Table 125 describes properties that Siebel CRM uses with a help Id.

Table 124. Properties of the Find View

Property Description

Sequence (O) Specifies the order that Siebel CRM uses to display views for a find 
object definition. The find operation uses the first find view object 
definition that it encounters in the responsibility list for the user. 
Different views apply different visibility. It is recommended that 
you configure Siebel CRM to examine the least restrictive view in 
this list first and the most restrictive view last. This order allows 
users who possess different responsibilities to use the broadest 
visibility that Siebel CRM allows the user to apply when the user 
must find an item.

View (R) Specifies the name of the view that Siebel CRM uses for the find 
operation if this find view is used.
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HTML Hierarchy Bitmap Object Type
This topic describes the HTML Hierarchy Bitmap object type.

HTML Hierarchy Bitmap
An HTML hierarchy bitmap is a top-level object that determines the set of bitmaps that Siebel CRM 
uses to display hierarchical information. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > HTML Hierarchy Bitmap

Table 126 describes properties that Siebel CRM uses with an html hierarchy bitmap. If a property in 
this table references a bitmap, then the Bitmap Category property of this bitmap must be set to HTML 
Hierarchy Icons.

Table 125. Properties of the Help Id

Property Description

HTML Help URL (O) Specifies the URL that Siebel CRM displays. The URL is relative to 
the public directory on the Siebel Web Server. This URL includes the 
HTML file that includes help content. For example, you can enter the 
following value in the HTML Help URL property:

help/siebaccounts.htm

Name (R) Specifies the string that identifies the help topic. This string must 
contain no special characters except for the underscore (_) symbol. 
It uses the following format:

ID_type_object_name

where:

■ type is VIEW or SCREEN. You must use all upper case letters.

■ object_name identifies the view or screen

For example, you can use the following value for the Accounts 
screen help:

ID_SCREEN_ACCOUNTS

Type (O) Specifies the object type that can use this help topic. For example:

View

Value (O) Not used.
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Icon Map Object Types
This topic describes Icon Map object type and object types that are children of this object type. It 
includes the following topics:

Table 126. Properties of the HTML Hierarchy Bitmap

Property Description

Arrow Down Bitmap (O) Specifies the name of the bitmap object that defines a down arrow 
image.

Arrow Up Bitmap (O) Specifies the name of the bitmap object that defines an up arrow 
image.

Bar Bitmap (O) Specifies the name of the bitmap object that defines a vertical bar 
image.

Close Bitmap (O) Specifies the name of the bitmap object that defines a closed folder 
image.

Collapse Bitmap (O) Specifies the name of the bitmap object that defines a collapsed 
folder image.

Collapse Elbow Bitmap (O) Specifies the name of the bitmap object that defines a collapsed 
elbow image.

Collapse Tee Bitmap (O) Specifies the name of the bitmap object that defines a collapsed tee 
image.

Elbow Bitmap (O) Specifies the name of the bitmap object that defines an elbow 
image.

Expand Bitmap (O) Specifies the name of the bitmap object that defines an expanded 
image.

Expand Elbow Bitmap (O) Specifies the name of the bitmap object that defines an expanded 
elbow image.

Expand Tee Bitmap (O) Specifies the name of the bitmap object that defines an expanded 
tee image.

Leaf Bitmap (O) Specifies the name of the bitmap object that defines a document 
image.

Name (R) Specifies the name of this HTML hierarchy bitmap.

Open Bitmap (O) Specifies the name of the bitmap object that defines an open folder 
image.

Space Bitmap (O) Specifies the name of the bitmap object that defines a white space 
image.

Tee Bitmap (O) Specifies the name of the bitmap object that defines a |- (pipe 
dash) image.



Siebel Object Types Reference ■ Import Object Types

Siebel Object Types Reference Siebel 2018 199

■ Icon on page 199

■ Icon Map on page 199

Icon
An icon specifies then icon that a bitmap uses to define the image for the icon.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Icon Map > Icon

Table 127 describes properties that Siebel CRM uses with an icon.

Icon Map
An icon map defines a collection of icon objects that Siebel CRM uses in controls and list columns to 
map a field value to an icon. To determine the icon that Siebel CRM uses to display the field value, 
it compares the field value to the icon name.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Icon Map

Table 128 describes properties that Siebel CRM uses with an icon map.

Import Object Types
This topic describes the object type known as the Import Object and object types that are children 
of this object type. It includes the following topics:

■ Import Aux Field on page 200

Table 127. Properties of the Icon

Property Description

Bitmap (O) Specifies the bitmap that Siebel CRM uses for the icon.

Bitmap Category (O) Specifies the bitmap category in which the icon bitmap belongs.

Name (R) Specifies the name of the icon that Siebel CRM compares to the field 
value.

Table 128. Properties of the Icon Map

Property Description

Name (R) Specifies the name of the icon map.
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■ Import Field on page 200

■ Import Field Column on page 201

■ Import Field Locale on page 201

■ Import Field Map on page 202

■ Import Key Field on page 202

■ Import Object on page 203

■ Import Source on page 203

Import Aux Field
An import aux field defines the auxiliary key field name for the business component defined in the 
import object. If more than one item references the key field, then Siebel CRM does a second search 
that uses the auxiliary key fields. For example, Account and Account Location for Contact.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Import Object > Import Aux Field

Table 129 describes properties that Siebel CRM uses with an import aux field.

Import Field
An import field defines a field. Siebel CRM imports data to this field.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Import Object > Import Field

Table 130 describes properties that Siebel CRM uses with an import field.

Table 129. Properties of the Import Aux Field

Property Description

Aux Field Name (R) Specifies the auxiliary key field name.

Name (R) Specifies the name in the import object.

Table 130. Properties of the Import Field

Property Description

Display Name (O) Specifies the value that Siebel CRM uses as the column heading or 
the key to the international message table.
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Import Field Column
An import field column defines the column in the import source that Siebel CRM uses to import the 
data. It imports this data into the parent import field of the corresponding data map.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Import Object > Import Source > Import Field Map > Import Field Column

Table 131 describes properties that Siebel CRM uses with an import field column.

Import Field Locale
An import field locale defines language overrides that Siebel CRM uses with an import field.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Import Object > Import Field > Import Field Locale

Table 132 describes properties that Siebel CRM uses with an import field locale.

Field (R) Specifies the name of a field. Siebel CRM imports data to this field.

Name (R) Specifies the name in the import object. 

Table 131. Properties of the Import Field Column

Property Description

Column (R) Specifies the name of the column.

Name (R) Specifies the name in the import object.

Table 132. Properties of the Import Field Locale

Property Description

Display Name (O) Specifies the value that Siebel CRM uses as the column heading or 
the key to the international message table for a language.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Table 130. Properties of the Import Field

Property Description
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Import Field Map
An import field map defines the mapping between the business component field and the column in 
the import source.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Import Object > Import Source > Import Field Map

Table 133 describes properties that Siebel CRM uses with an import field map.

Import Key Field
An import key field defines the key field name for the business component defined in the import 
object. Siebel CRM uses the import key field to search for duplicates. For example, the contact import 
object includes the First Name, Middle Name, and Last Name key fields.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Import Object > Import Key Field

Table 134 describes properties that Siebel CRM uses with an import key field.

Table 133. Properties of the Import Field Map

Property Description

Country Code Column (O) Specifies the name of the country code column in the import source.

Display Name (O) Specifies the value that Siebel CRM uses as the column heading or 
the key to the international message table.

Field (R) Specifies the name of a field. Siebel CRM imports data to this field.

Name (R) Specifies the name in the import source.

Parse Middle Name (O) If TRUE, then Siebel CRM parses the middle name out of the full 
name.

Separator Character (O) Specifies the character that Siebel CRM inserts between the parts 
the input data if this input data include separate parts.

Table 134. Properties of the Import Key Field

Property Description

Key Field (R) Specifies the key field name.

Name (R) Specifies the name in the import object. 
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Import Object
An import object defines the information that Siebel CRM uses to import external data into a business 
component. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Import Object

Table 135 describes properties that Siebel CRM uses with an import object.

Import Source
An import source defines the source that Siebel CRM uses to import data. For example, ACT! or 
ECCO.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Import Object > Import Source

Table 136 describes properties that Siebel CRM uses with an import source.

Integration Object Types
This topic describes the object type known as the Integration Object and object types that are 
children of this object type. It includes the following topics:

■ Integration Component on page 204

■ Integration Component Field on page 205

■ Integration Component Field User Prop on page 207

■ Integration Component Key on page 207

■ Integration Component Key Field on page 208

Table 135. Properties of the Import Object

Property Description

Business Component (R) Specifies the name of a business component. Siebel CRM imports 
data into this business component.

Name (R) Specifies the name of the import object.

Table 136. Properties of the Import Source

Property Description

Name (R) Specifies the name of the import source.
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■ Integration Component User Prop on page 209

■ Integration Object on page 209

■ Integration Object User Prop on page 210

Integration Component
An integration component structures an inbound or outbound message string into a format that 
Siebel CRM or an external application can recognize. The integration component is an intermediate 
structure that helps resolve any difference that exists between the format that Siebel CRM uses and 
the format that an external application uses.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Integration Object > Integration Component

Table 137 describes properties that Siebel CRM uses with an integration component.

Table 137. Properties of the Integration Component

Property Description

Adapter Info (S) Oracle uses this property with the Integration Object Wizard.

Business Component (O) Specifies the name of the business component. 

Cardinality (O) Specifies the number of integration components.

External Name (S) Specifies the name of the structure that the external application can 
recognize.

External Sequence (O) Specifies the order that Siebel CRM uses to process integration 
components. This property can contain only an integer.

Name (R) Specifies the name of the integration component.

Parent Integration 
Component (O)

Specifies the name of the parent integration component for this 
component only if a parent exists.

Only one active integration component in an integration object can 
be the root integration component. If this integration component is 
the root integration component, the you must leave the Parent 
Integration Component property empty.

XML Container Element (O) Specifies the XML Tag that Siebel CRM uses to enclose elements 
that represent this integration component.
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Integration Component Field
An integration component field is a field of an integration component object.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Integration Object > Integration Component > Integration Component Field

Table 138 describes properties that Siebel CRM uses with an integration component field.

XML Sequence (O) Specifies the order that Siebel CRM uses to display integration 
components in an XML document. This property can contain only an 
integer.

XML Tag (O) Specifies the XML tag name that Siebel CRM creates for this 
integration component if Siebel CRM converts it into an XML 
document.

Table 138. Properties of the Integration Component Field

Property Description

Adapter Info (S) Oracle this property with the Integration Object Wizard.

Business Component Field 
(O)

Specifies the name of the business component field.

Column (O) Specifies the name of the column.

External Data Type (R) Specifies the data type of the field that Siebel CRM gets from the 
external application.

External Length (O) Specifies the length of the external data element that corresponds 
to the Integration component field.

External Name (O) Specifies the external name of a data component or element that 
an external application can recognize.

External Precision (O) For more information, see “About the Scale and Precision Properties” 
on page 17.

External Required (O) If TRUE, then the external application requires the external data 
element. For example, an external application might require a 
ROWID that uses ROWID as a primary key field in a non-Siebel 
database.

External Scale (O) For more information, see “About the Scale and Precision Properties” 
on page 17.

Table 137. Properties of the Integration Component

Property Description
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External Sequence (O) Specifies the order that the adapter uses to process integration 
component fields. Semantics are different for each adapter.

Field Type (O) Specifies the field type. The Object List Editor uses the following 
label to represent a field type:

Type

You can use one of the following values:

■ Custom. Manually sends custom attributes that are not 
necessarily part of the actual data but are related to the data 
context. For more information about this field type value, see 
Integration Platform Technologies: Siebel Enterprise 
Application Integration. 

■ Data. Contains raw field data that can Siebel CRM can format. 
It formats an XML document as delimited strings and saves it in 
this type of field.

■ System. Contains data that Siebel CRM formats in Siebel 
format. You can use it to specify the primary rows of a 
multivalue group or to specify an operation for an integration 
object instance.

Group (O) Not used.

Length (O) Specifies the length of the Siebel field that corresponds to a Siebel 
table column.

Name (R) Specifies the name of the field. The maximum length is 75 
characters.

Physical Data Type (O) Specifies the data type of the integration field in the integration 
space.

Precision (O) For more information, see “About the Scale and Precision Properties” 
on page 17.

Required (O) Specifies that the integration component is required in an 
integration object.

Scale (O) For more information, see “About the Scale and Precision Properties” 
on page 17.

User Visible (O) If TRUE, then this integration component field is visible to Data 
Transformation Engine users.

XML Literal Value (O) Specifies the default value that Siebel CRM displays in an XML 
document if the value for this integration component field is not 
specified.

XML Parent Element (O) Specifies the name of the parent element to which this integration 
component field belongs. This parent element becomes an XML tag.

Table 138. Properties of the Integration Component Field

Property Description
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Integration Component Field User Prop
An integration component field user prop sends a property value to the C++ code that implements 
special configuration for an integration component field. Siebel CRM persists the value that you 
configure for a user property in the Siebel runtime repository.

For more information, see “Object Types That You Must Not Modify” on page 18.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Integration Object > Integration Component > Integration Component Field > 
Integration Component Field User Prop

Table 139 describes properties that Siebel CRM uses with an integration component field user prop.

Integration Component Key
An integration component key defines a key for an integration component. A key includes one or 
more key fields that Siebel CRM uses to detect duplicate rows. An integration component key field 
defines these key fields.

This object type occurs in the following location in the object hierarchy:

XML Sequence (O) Specifies the order that Siebel CRM uses to display integration 
component fields in an XML document. This property can contain 
only an integer.

XML Style (O) Specifies the name of the XML style. It determines if Siebel CRM 
formats this integration component field as an XML attribute or an 
XML element if Siebel CRM creates an XML document for the 
integration object that contains this field.

XML Tag (O) Specifies an XML element that defines this integration component 
field. If the XML Tag property is empty, then Siebel CRM assigns an 
XML tag to the integration component field when it sends this data 
to an external application.

The maximum length for this property is 75 characters.

Table 139. Properties of the Integration Component Field User Prop

Property Description

Name (R) Specifies the name of the integration component field user prop.

Value (O) Specifies the value of the integration component field user prop.

Table 138. Properties of the Integration Component Field

Property Description
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■ Siebel Objects > Integration Object > Integration Component > Integration Component Key

Table 140 describes properties that Siebel CRM uses with an integration component key.

Integration Component Key Field
An integration component key field defines an integration field as a key field for a key in an 
integration object. Siebel CRM implements the integration component key field object as an 
intersection table between integration fields and integration component keys.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Integration Object > Integration Component > Integration Component Key > 
Integration Component Key Field

Table 141 describes properties that Siebel CRM uses with an integration component key field.

Table 140. Properties of the Integration Component Key

Property Description

Key Sequence Number (O) Specifies the order that Siebel CRM uses to process integration 
component keys that are of the same type. This property can 
contain only an integer.

Key Type (R) Type of integration component key.

Name (R) Specifies the name of this integration component key. The 
maximum length that you can specify in this property is 75 
characters.

Target Key Name (O) Specifies the target key that this foreign key references. Siebel CRM 
maps fields are mapped according to sequence.

Siebel CRM uses the Target Key Name property only for a key of 
type Foreign Key.

Table 141. Properties of the Integration Component Key Field

Property Description

Field Name (R) Specifies the name of integration component field.

Name (R) Specifies the name of the integration component key field.

Sequence (O) Specifies the order that Siebel CRM uses to process integration 
component key fields. This property can contain only an integer.
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Integration Component User Prop
An integration component user prop sends a property value to C ++ code that implements special 
configuration for an integration component. Siebel CRM persists the value that you configure for a 
user property in the Siebel runtime repository.

For more information, see “Object Types That You Must Not Modify” on page 18.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Integration Object > Integration Component > Integration Component User Prop

Table 142 describes properties that Siebel CRM uses with an integration component user prop.

Integration Object
An integration object provides a logical representation of external application data or of Siebel data 
that Siebel CRM must map to an external application.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Integration Object

Table 143 describes properties that Siebel CRM uses with an integration object.

Table 142. Properties of the Integration Component User Prop

Property Description

Name (R) Specifies the name of the integration component user prop.

Value (O) Specifies the Value of the integration component user prop.

Table 143. Properties of the Integration Object

Property Description

Adapter Info (O) Oracle uses this property to support the Integration Object Wizard.

Base Object Type (R) Specifies one of several predefined object types that this 
integration object references.

Business Object (O) Specifies the name of the business object.

External Major Version (O) Not used.

External Minor Version (O) Not used.

External Name (R) Specifies the name of the object that an external function can 
recognize.
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Integration Object User Prop
An integration object user prop sends a property value to C ++ code that implements special 
configuration for an integration object. Siebel CRM persists the value that you configure for a user 
property in the Siebel runtime repository.

For more information, see “Object Types That You Must Not Modify” on page 18.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Integration Object > Integration Object User Prop

Table 144 describes properties that Siebel CRM uses with an integration object user prop.

Link Object Type
This topic describes the Link object type.

Link
A link specifies the relationship between two business components. The relationship can be one-to-
many (1:M), such as parent and child, or many-to-many (M:M). For more information about links, 
see Configuring Siebel Business Applications. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Link

Table Table 145 describes properties that Siebel CRM uses with a link.

Name (R) Specifies the name of the integration object.

XML Tag (R) Specifies the XML tag name that Siebel CRM creates for this object 
when it converts an object to an XML document.

Table 144. Properties of the Integration Object User Prop

Property Description

Name (R) Specifies the name of the integration object user prop.

Value (O) Specifies the value of the integration object user prop.

Table 143. Properties of the Integration Object

Property Description
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Table 145. Properties of the Link

Property Description

Cascade Delete (O) For more information, see “Setting the Cascade Delete Property of a 
Link” on page 214.

Child Business Component 
(R)

Specifies the name of a business component. The business 
component that the Parent Business Component property specifies 
determines the data for the business component that the Child 
Business Component property specifies.

Destination Field (R) Specifies the name of a field in the child business component that 
Siebel CRM uses to logically join to the parent business component. 
The Destination Field property is required for a 1:M link.

Inter Child Column (R) Specifies the name of a column in the intersection table that links 
this table to the child business component. The name is case-
sensitive. It must use the same format that it uses in the Siebel 
database. The Inter Child Column property is required for a M:M 
link.

Inter Child Delete (O) You can use one of the following values:

■ TRUE. Siebel CRM deletes the association and the child record.

■ FALSE. Siebel CRM deletes only the association for the child 
record. You use FALSE only with a M:M link.

Inter Parent Column (R) Specifies the name of a column in the intersection table that links 
this table to the parent business component. The name is case-
sensitive. It must use the same format that it uses in the Siebel 
database. The Inter Parent Column property is required for a M:M 
link.

Inter Table (R) Specifies the name of the intersection table. The name is case-
sensitive. It must use the same format that it uses in the Siebel 
database. The Inter Table property is required for a M:M link.
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Name (R) Specifies the name for the link. The name can contain spaces and 
must be unique among links. Other objects use this name to 
reference this link. Siebel CRM manages this property. It uses the 
following format:

parent business component name/child business component 
name

For example:

Account/Account Contact

Note the following:

■ You must not modify the value in the Name property unless 
necessary. 

■ You must not use the Calendar business component as the 
master or detail business component in a link.

No Associate (O) If TRUE, then Siebel CRM cannot create a new association through 
the link. It can add new detail records. It does not display the 
association applet when it creates a new record for the child in a 
M:M relationship. It requires the user to enter a new record. It does 
not allow the user to associate this new record to an existing record.

If the current view uses Admin Mode, then Siebel CRM ignores this 
property.

You specify the No Associate property only for a M:M link.

No Delete (O) If TRUE, then Siebel CRM does not delete child records through this 
link.

No Insert (O) If TRUE, then Siebel CRM does not create new child records through 
this link. You specify the No Insert property only for a 1:M link. For 
more information, see the No Associate property for this object 
type.

No Inter Delete (O) You can use one of the following values:

■ TRUE. Siebel CRM never deletes intersection table records.

■ FALSE. Siebel CRM deletes intersection table records if it 
deletes a parent or a child record.

The No Inter Delete property applies only to a M:M relationship.

No Update (O) If TRUE, then Siebel CRM does not update child records through this 
link.

Table 145. Properties of the Link

Property Description
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Parent Business Component 
(R)

Specifies the name of the business component whose data 
determines the records that the child business component gets. The 
Child Business Component property of this link specifies this child 
business component.

Primary Id Field (O) Specifies the name of the field in the master business component 
that contains the row ID values that reference the primary records 
in the detail business component.

Search Specification (O) Specifies an expression that Siebel CRM uses to filter the records it 
gets. If the link is active, then it applies this filter to the child 
business component.

Sort Spec (O) Specifies an expression that Siebel CRM uses in an association list 
to order the detail records that it gets. You use the Sort Spec 
property only for a M:M link.

Source Field (O) Specifies the name of a field in the parent business component that 
Siebel CRM uses to link to the child business component. This 
source field is a unique identifier for rows that exist in the parent 
business component. It is typically the field that maps to the 
ROW_ID column in the table that the parent business component 
references and that possesses the name Id.

Siebel CRM does not display this field in the Fields list in the Object 
List Editor for the business component. The Id field displays only in 
the dropdown list for some properties, such as the Source Field 
property in some object types, such as the link. 

The default value for the Source Field property is Id. If this property 
is empty, then Siebel CRM uses Id.

Visibility Auto All (O) You can use one of the following values:

■ TRUE. The user can access all views and can view all records in 
the child business component. 

■ FALSE. The Visibility Type property of this link determines 
visibility. 

Table 145. Properties of the Link

Property Description
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Setting the Cascade Delete Property of a Link
the Cascade Delete property of a link specifies the action that Siebel CRM performs on detail business 
component records of the link if Siebel CRM deletes the master. You can use one of the following 
values:

■ CLEAR. Siebel CRM removes the foreign key reference.

■ DELETE. Siebel CRM deletes the child record.

■ NONE. Siebel CRM performs no operations on the child record.

You must set the Cascade Delete property to CLEAR in the following situations:

■ The child business component in this link is also a child business component in another link.

■ Another business component references the same table that a child business component 
references, and this other business component is the child business component in another link. 
For example, assume the following links exist:

■ Contact/Action

■ Contact/Activity Plan 

Action and Activity Plan reference the same table. You must make sure Cascade Delete is CLEAR 
for each link.

Do not set the Cascade Delete property to NONE for a many-to-many link. Siebel CRM deletes the 
intersection record for a many-to-many link but does not delete the child record. This child record 
might have other parents.

Visibility Rule Applied (O) Specifies how Siebel CRM applies visibility rules in a view that uses 
this link. Visibility settings in a view apply to the applet that the 
Visibility Applet property specifies. If a master-detail relationship 
exists between this applet and an applet that displays detail 
records, then you can use the Visibility Rule Applied property to 
allow the user to view detail records that the user cannot normally 
view because of visibility rules. The user cannot drill down to view 
the entire record.

You can use one of the following values. Siebel CRM does the 
following if the current master-detail view references this link:

■ Always. Allow visibility rules in the detail records even though 
the Visibility Applet and Visibility Applet Type properties of this 
view do not use the active visibility.

■ Never. Disable visibility rules in the detail records.

Visibility Type (O) Specifies the visibility type if the business component displays as a 
child in the given link. For more information, see the description of 
the Visibility Auto All property for this link.

Table 145. Properties of the Link

Property Description
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If multiple links exist that reference the same tables, then you must make sure that you set the 
Cascade Delete property consistently among all of these links. If Siebel CRM deletes a record that is 
a foreign key of another table, then it might or might not delete these references. If it does not delete 
these references, then row IDs might reference nonexistent records. Siebel CRM might convert these 
foreign keys to No Match Row Id for a multivalue group.

Menu Object Types
This topic describes the Menu object type and object types that are children of this object type. It 
includes the following topics:

■ Menu on page 215

■ Menu Item on page 215

■ Menu Item Locale on page 216

Menu
A menu defines a menu that the user can access.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Menu

Table 146 describes properties that Siebel CRM uses with a menu.

Menu Item
A menu item references a command.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Menu > Menu Item

Table 147 describes properties that Siebel CRM uses with a menu item.

Table 146. Properties of the Menu

Property Description

Name (R) Specifies the name of the menu.
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Menu Item Locale
A menu item locale defines language overrides that Siebel CRM uses with a menu item.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Menu > Menu Item > Menu Item Locale

Table 148 describes properties that Siebel CRM uses with a menu item locale.

Table 147. Properties of the Menu Item

Property Description

Caption (O) Specifies the text that Siebel CRM displays in the menu. For 
example:

&Insert Record

Command (O) Specifies the name of a command object definition. This command 
specifies the method or accelerator for the menu item. For 
example:

Create Record

Name (R) Specifies the name of the menu item. For example:

Edit - Insert Record

Position (R) Identifies the position of the menu item. The top level positions are 
1, 2, 3, and so on. The dot notation indicates hierarchy. For 
example:

3.1

Restricted For Oracle use only.

Table 148. Properties of the Menu Item Locale

Property Description

Caption (O) Specifies the text that Siebel CRM displays in the menu.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU
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Message Category Object Types
This topic describes the Message Category object type and object types that are children of this 
object type. It includes the following topics:

■ Message on page 217

■ Message Category on page 217

■ Message Locale on page 218

Message
A message specifies the message that Siebel CRM displays in the client after it runs a query that the 
user requests. Siebel CRM uses with this object type with a swe:messages tag of the Siebel Web 
Engine.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Message Category > Message

Table 149 describes properties that Siebel CRM uses with a message.

Message Category
A message category includes content for messages that Siebel CRM displays in the client, messages 
in the swe:messages tag, other messages that the Siebel Web Engine uses, and error messages that 
you define.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Message Category

Table 150 describes properties that Siebel CRM uses with a message category.

Table 149. Properties of the Message

Property Description

Name (R) Specifies the name of the message. For example: 

Query Mode Prompt

Text (O) Specifies the text of the message. For example:

Enter Query
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Message Locale
A message locale defines the language overrides that Siebel CRM uses with a message.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Message Category > Message > Message Locale

Table 151 describes properties that Siebel CRM uses with a message locale.

Pager Object Type
This topic describes Pager object type.

Pager Object
A pager object defines properties of business components that Siebel CRM uses to populate the 
default data in the Send Page applet.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Pager Object

Table 152 describes properties that Siebel CRM uses with a pager object.

Table 150. Properties of the Message Category

Property Description

Name (R) Specifies the name of the message category. For example:

User Defined Errors

Table 151. Properties of the Message Locale

Property Description

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Text (O) Specifies the text of the message.
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Table 152. Properties of the Pager Object

Property Description

Alpha Template (O) Specifies the template that Siebel CRM uses to create default text 
to page an alphanumeric pager. It can include placeholders for 
business components field that Siebel CRM substitutes with real 
values at run time. The value for the Alpha Template property can 
contain the name of any template file that exists in the following 
user directory:

MSGTEMPL\language

Business Component (R) Specifies the business component that includes the paging-related 
properties. You can specify any business component that includes 
references to employees or fields that store data about pagers.

Employee Field (O) Specifies the business component field that contains the login name 
of the employee that Siebel CRM must page. Siebel CRM locates this 
login name in the Employee business component that contains the 
default phone number and pager ID.

If the Phone Field property and the PIN Field property contain 
values, then Siebel CRM ignores the Employee Field property.

Name (S) For Oracle use only. You must not modify this property.

Numeric Template (O) Specifies the template that Siebel CRM uses to create the default 
message text it uses when it pages a numeric pagers. It can include 
placeholders for business components field that Siebel CRM 
substitutes with real values at run time. The value for the Numeric 
Template property can contain the name of any template file that 
exists in the following user directory:

MSGTEMPL\language

Phone Field (O) Specifies the business component field that contains the computer 
paging phone number that Siebel CRM uses when it sends a page. 
This computer paging phone number is different from the personal 
phone number assigned to some pagers. It is also different from the 
phone number to page a touch-tone phone. Typically there is only 
one computer paging phone number available for each pager 
company. This number must support the TAPI protocol that 
computer paging uses.

PIN Field (O) Specifies the business component field that contains the PIN 
(Personal Identification Number) or pager ID of the pager that 
Siebel CRM must page. This number is typically a six or seven digit 
number that identifies a pager.
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Pick List Object Type
This topic describes Pick List object type.

Pick List
A pick list lists valid values for a control or list column. To specify source and destination fields, you 
use a pick map. You do not specify source and destination fields in a pick list. For more information, 
see “Pick Map” on page 145.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Pick List

Table 153 describes properties that Siebel CRM uses with a pick list.

Table 153. Properties of the Pick List

Property Description

Bounded (O) If TRUE, then the user must use a value from the list of values that 
the drop-down list contains.

Business Component (R) Specifies the name of the business component that Siebel CRM uses 
to populate values in the list of values.

Long List (O) If TRUE, then Siebel CRM attempts to position the cursor on the 
current value in a long list of values.

If the Long List property is TRUE, then the picklist returns a large 
set of values. To avoid affecting performance when the user scrolls 
or positions the cursor on the current value in the field, Siebel CRM 
does not immediately update field values for the current record.

If the picklist contains more than 500 records, then it is 
recommended that you set the Long List property to TRUE.

Name (R) Specifies the name of the picklist. The name must be unique among 
picklists. Other objects use this name to reference this picklist. The 
name can contain spaces.

No Delete (O) If TRUE, then the user cannot delete a value from this picklist.

No Insert (O) If TRUE, then the user cannot insert a value in this picklist.

No Merge (O) If TRUE, then the user cannot merge two existing picklist values 
into a single value.

No Update (O) If TRUE, then the user cannot update a value in this picklist.
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Project Object Type
This topic describes Project object type.

Search Specification (O) Specifies the search specification that Siebel CRM uses for this 
picklist. This specification is addition to the condition that the 
Search Specification property of the business component specifies. 
The Business Component property of this picklist specifies this 
business component.

Sort Specification (O) Specifies the sort specification that Siebel CRM uses for this picklist. 
This specification replaces the condition that the Sort Specification 
property of the business component specifies. The Business 
Component property of this picklist specifies this business 
component.

Static (O) You can use one of the following values:

■ TRUE. Use a static picklist. Get values for this picklist from a 
predefined list of values. A static picklist typically uses the 
PickList Generic or PickList Hierarchical business component. 
These business components display data that an administrator 
enters in the List of Values administration views. Siebel CRM 
displays a static picklist as a drop-down menu. For more 
information, see Siebel Developer’s Reference.

■ FALSE. Use a dynamic picklist. Get the values for this picklist 
from the business component that the Business Component 
property specifies. Siebel CRM uses a pick applet dialog box to 
display a dynamic picklist.

Type Field (O) Specifies the name of a business component field that Siebel CRM 
uses to get a set of records. It uses this field name with the Type 
Value property of this picklist.

Type Value (O) Specifies the data value that Siebel CRM uses to get a set of 
records.

Visibility Auto All (O) If TRUE, and if the user:

■ Can access any All views, then Siebel CRM sets visibility for the 
picklist business component to All.

■ Cannot access any All views, then the Visibility Type property 
determines visibility.

Visibility Type (O) Specifies the visibility type if Siebel CRM uses values from the 
business component that this picklist references. For more 
information, see the description for the Visibility Auto All property 
of this picklist.

Table 153. Properties of the Pick List

Property Description
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Project
A project organizes object definitions and allows you to lock objects. Every object definition in the 
repository except for repositories or projects must belong to a project. If an object definition has a 
parent, then the child resides in the same project as the parent. For example, a field is a child of a 
business component.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Project

Table 154 describes properties that Siebel CRM uses with a project.

Report Object Type
This topic describes object types that are related to reports.

Report
To get help from Oracle with configuring Report object types, you can create a service request (SR) 
on My Oracle Support. Alternatively, you can phone Global Customer Support directly to create a 
service request or to get a status update on your current SR. Support phone numbers are listed on 
My Oracle Support. You can also contact your Oracle sales representative for Oracle Advanced 
Customer Services to request assistance from Oracle's Application Expert Services.

The following object types are for Oracle use only:

■ Report

Table 154. Properties of the Project

Property Description

Allow Object Locking Specifies to allow you to lock an object, such as an applet or a 
business component.

Language Locked (S) Specifies the language that Siebel CRM uses when it locks a record. 
It uses the current language that Siebel Tools is using. For example, 
ENU, JPN, DEU.

Locked (O) If TRUE, then this project is currently locked.

Locked By Name (O) If the Locked property is TRUE, then the Locked By Name property 
displays the name of the person who locked the project.

Locked Date (O) If the Locked property is TRUE, then the Locked Date property 
displays the date and time when someone locked the project.

Name (R) Specifies a unique name for this project.

Owner Branch Reserved for future use.
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■ Report Field

■ Report Locale

■ Sub Report

■ Sub Report Field

■ View Report

■ View Report Locale

Repository Object Type
This topic describes the Repository object type.

Repository
A repository includes tables in a database where Siebel CRM stores object definitions.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Repository

Table 155 describes properties that Siebel CRM uses with a repository.

Schema Maintenance Object Types
This topic describes the Schema Maintenance object type and object types that are children of this 
object type.

Schema Maintenance
The following object types are for Oracle use only:

■ Schema Maintenance Dependent Step

■ Schema Maintenance Phase

■ Schema Maintenance Phase Usage

Table 155. Properties of the Repository

Property Description

Name (S) Specifies the name of the repository.
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■ Schema Maintenance Platform Path

■ Schema Maintenance Process

■ Schema Maintenance Process Variable

■ Schema Maintenance Step

■ Schema Maintenance Step From

■ Schema Maintenance Step Database Implementation

■ Schema Maintenance Step Implementation

■ Schema Maintenance Step To

Screen Object Types
This topic describes the Screen object type and object types that are children of this object type. It 
includes the following topics:

■ Screen on page 224

■ Screen Locale on page 226

■ Screen View on page 226

■ Screen View Locale on page 228

Screen
A screen organizes views.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Screen

Table 156 describes properties that Siebel CRM uses with a screen.
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Table 156. Properties of the Screen

Property Description

Bitmap Category (O)(H) Specifies the name of the bitmap category that contains the 
definitions of the bitmap objects that this screen uses. For example, 
the Accounts bitmap category contains bitmap object definitions for 
the following items:

■ Logo bitmap that Siebel CRM displays at the top of the view bar 
in the Accounts screen. 

■ Screen Tab Icon bitmap that Siebel CRM displays on the tab of 
the Accounts screen. 

The Accounts screen uses this Accounts bitmap category.

Default View (O) Specifies the view that Siebel CRM displays if the user clicks a page 
tab for the screen. The view must be an entry in the screen view of 
the current screen. For example: 

Account List View

Help Identifier (O) Specifies a help ID for a screen that includes help. For example:

ID_SCREEN_ACCOUNTS

ICL Upgrade Path For more information, see “Common Object Properties” on page 15.

Name (R) Specifies the name of a screen. Other objects use this name to 
reference this screen. For example:

Accounts Screen

Unrestricted Viewbar 
(O)(H)

You can use one of the following values:

■ TRUE. Siebel CRM displays all the views that the screen 
contains even if a view does not reference the same business 
object that this screen references. It displays these views in the 
view bar.

■ FALSE. Siebel CRM displays only the views that reference the 
same business object that this screen references. If you require 
the thread bar to display these views, then do not set the 
Unrestricted Viewbar property to FALSE.

Upgrade Behavior For more information, see “Common Object Properties” on page 15.

Viewbar Text (O) Specifies the label that Siebel CRM displays below the optional Logo 
bitmap in the view bar. For example:

Accounts
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Screen Locale
A screen locale defines language overrides that Siebel CRM uses with a screen.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Screen > Screen Locale

Table 157 describes properties that Siebel CRM uses with a screen locale.

Screen View
A screen view defines the collection of views for a screen.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Screen > Screen View

Table 158 describes properties that Siebel CRM uses with a screen view.

Table 157. Properties of the Screen Locale

Property Description

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Viewbar Text (O) Specifies the label that Siebel CRM displays below the optional Logo 
bitmap in the view bar.

Table 158. Properties of the Screen View

Property Description

Category Default View (O) Specifies the default view for this screen view. Siebel CRM uses the 
Category Default View property only if the Type property of this 
screen view is Aggregate Category or Detail Category. 

If the Category Default View does not contain a value, then Siebel 
CRM uses the first available view for the Category or the Default 
View that is defined for the screen.

Category Name (O) (R) Specifies the name of the category that Siebel CRM uses to group 
similar views in this screen view. If the Type property of this screen 
view is Aggregate Category or Detail Category, then the Category 
Name property is required.



Siebel Object Types Reference ■ Screen Object Types

Siebel Object Types Reference Siebel 2018 227

Client Restriction (O) Specifies if Siebel CRM displays this screen view in a client. For 
example:

Mobile Client Only

Display In Page (O) You can use one of the following values:

■ TRUE. Siebel CRM displays this screen view in the client. If the 
Type property of this screen view is Aggregate Category or 
Detail Category, then the Display In Page property must be 
TRUE.

■ FALSE. Siebel CRM displays this screen view as hidden in the 
View Tab layout.

Display In Site Map (O) If TRUE, then Siebel CRM displays this screen view in the Site Map 
in the client.

Menu Text (O) Specifies the text that Siebel CRM displays in the Site Map for this 
screen view. For more information, see “Setting the Menu Text and 
Viewbar Text Properties of a Screen View” on page 228.

Object Manager Restriction 
(O)

You can use the following values:

■ NULL. This screen view is available if the Application Object 
Manager runs on any server that Siebel CRM supports. 

■ NT Only. This screen view is available only if the Application 
Object Manager runs on a Windows server. 

The UNIX Support property of the applet or business component 
class might not allow Siebel CRM to display this screen view in a 
UNIX environment.

Parent Category (O) (R) Specifies how Siebel CRM organizes a view in a category or how it 
associates a detail category with an aggregate category. If the Type 
property of this screen view is:

■ Detail View or Detail Category. The Parent Category 
property is required.

■ Aggregate View. The Parent Category property is optional.

■ Aggregate Category. The Parent Category property must be 
empty.

Sequence (O) Specifies the order that Siebel CRM uses to display the view in the 
submenu of the screen view. You can sequence the views that 
Siebel CRM displays on the view bar but not the categories. Siebel 
CRM displays categories last in the list. This property can contain 
only an integer.

Status Text (O) Not used.

Table 158. Properties of the Screen View

Property Description
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Setting the Menu Text and Viewbar Text Properties of a Screen View
In this example, the following screen views are of type Category Detail:

■ Account Detail-A View

■ Account Detail-B View

■ Account Detail-C View

Table 159 describes an example that displays all these screen views in the Site Map and only displays 
screen views A and B in the view bar.

Screen View Locale
A screen view locale defines language overrides that Siebel CRM uses with a screen view.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Screen > Screen View > Screen View Locale

Table 160 describes properties that Siebel CRM uses with a screen view locale.

Type (R) Specifies the type of screen view. A screen view is one of the 
following:

■ A view 

■ A group of views or categories

View (R) Specifies the view that Siebel CRM includes in the screen view. For 
example:

Detail - Contacts View

Viewbar Text (O) Specifies the Text that Siebel CRM displays on a view tab, a drop-
down list, or a link for a view or category. For more information, see 
“Setting the Menu Text and Viewbar Text Properties of a Screen View” 
on page 228.

Table 159. Example of Setting the Menu Text and Viewbar Text Properties of a Screen View

Screen View Type Category Menu Text Viewbar Text

Account Detail-A Category Detail Account Detail Detail

Account Detail-B Category Detail Account Detail Detail

Account Detail-C Category Detail Account Detail Not applicable.

Table 158. Properties of the Screen View

Property Description
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Server Component Object Types
This topic describes the Server Component object type and object types that are children of this 
object type. It includes the following topics:

■ Server Component Event Subtype on page 229

■ Server Component Event Type on page 230

■ Server Component Parameter on page 230

■ Server Component State Value on page 232

■ Server Component Statistic on page 233

■ Server Component Subsystem on page 233

■ Server Component Type on page 234

Server Component Event Subtype
A server component event subtype is a code reference that specifies an event.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Server Component Type > Server Component Event Type > Server Component 
Event Subtype

Table 161 describes properties that Siebel CRM uses with a server component event subtype.

Table 160. Properties of the Screen View Locale

Property Description

Menu Text (O) Specifies the text that Siebel CRM displays in the Site Map for this 
View or Category. 

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Status Text (O) Not used.

Viewbar Text (O) Specifies the text that Siebel CRM displays on a view tab, drop down 
list, or link for a screen view or category.
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Server Component Event Type
A server component event type specifies an event for a server component.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Server Component Type > Server Component Event Type

Table 162 describes properties that Siebel CRM uses with a server component event type.

Server Component Parameter
A server component parameter specifies parameters in a server component type.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Server Component Type > Server Component Parameter

Table 161. Properties of the Server Component Event Subtype

Property Description

Code Symbol (S) Specifies this server component event subtype as an enum, which 
is a short list of known values. This configuration allows faster 
searching than using the full descriptive name.

Display Name (S) Specifies the name of this server component event subtype that 
Siebel CRM displays in the Server Manager.

Name (S) Specifies the name of the object definition.

Table 162. Properties of the Server Component Event Type

Property Description

Code Symbol (S) Specifies this server component event type as an enum, which is a 
short list of known values. This configuration allows faster 
searching than using the full descriptive name.

Display Name (S) Specifies the name of this server component event type that Siebel 
CRM displays in the Server Manager.

Name (S) Specifies the name of the object definition.
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Table 163 describes properties that Siebel CRM uses with a server component parameter.

Table 163. Properties of the Server Component Parameter

Property Description

Code Symbol (S) Specifies this server component parameter type as an enum, which 
is a short list of known values. This configuration allows faster 
searching than using the full descriptive name.

Component Definition 
Settable (S)

For more information, see the description for the Enterprise 
Settable property.

Component Settable (S) For more information, see the description for the Enterprise 
Settable property.

Data Type (S) Specifies the data type for the values this server component 
parameter contains.

Default Value (S) Specify a default value for this server component parameter.

Display Name (S) Specifies the name of this server component parameter event type 
that Siebel CRM displays in the Server Manager.

Enterprise Settable (S) If TRUE, then Siebel CRM sets this server component parameter for 
the entire enterprise. The settable flags specify the levels at which 
Siebel CRM sets this parameter, from enterprise down through a 
server task. For example, if the value for a server component 
parameter is set at level A, then all levels below level A use this 
value.

Name (S) Specifies the name of the object definition.

Performance Impact Not used.

Pick List (S) Specifies the name of the picklist.

Requires Component 
Reconfig (S)

If TRUE, then Siebel CRM can modify the configuration for a server 
component. This modification affects server tasks that start after a 
modification occurs but allows existing server tasks to continue 
running using the old configuration. 

A new server task automatically uses the new configuration but 
these modifications might not affect some arguments until Siebel 
CRM reconfigures the server component. Setting the Requires 
Component Reconfig property to TRUE allows Siebel CRM to update 
these arguments.

Requires Server Reconfig Similar to the Requires Component Reconfig property except 
applies to the server.

Server Settable (S) For more information, see the description for the Enterprise 
Settable property.

Task Settable (S) For more information, see the description for the Enterprise 
Settable property.
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Server Component State Value
A server component state value contains data about the current operation of a server task or server 
component. A server task periodically updates state values that describe current processing, such 
as the current phase of an operation. The state for a server component describes the state of the 
entire server component.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Server Component Type > Server Component State Value

Table 164 describes properties that Siebel CRM uses with a server component state value.

Text Length (S) Specifies the maximum text length in characters.

Visibility Not used.

Table 164. Properties of the Server Component State Value

Property Description

Code Symbol (S) Specifies this server component state value as an enum, which is a 
short list of known values. This configuration allows faster 
searching than using the full descriptive name.

Data Type (S) Specifies the data type of the values that this server component 
state value contains.

Display Name (S) Specifies the name of the component state value type that Siebel 
CRM displays in the Server Manager.

Level (S) Specifies the level that Siebel CRM uses for this server component 
state value.

Name (S) Specifies the name of this server component state value.

Text Length (S) Specifies the maximum text length in characters.

Visibility Not used. 

Table 163. Properties of the Server Component Parameter

Property Description
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Server Component Statistic
A server component statistic records statistics at the server task level for server component tasks. 
You can use these statistics to monitor the progress and performance of a server component or to 
optimize system performance.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Server Component Type > Server Component Statistic

Table 165 describes properties that Siebel CRM uses with a server component statistic.

Server Component Subsystem
A server component subsystem defines a subsystem of the server component type object.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Server Component Type > Server Component Subsystem

Table 166 describes properties that Siebel CRM uses with a server component subsystem.

Table 165. Properties of the Server Component Statistic

Property Description

Calculated (S) If TRUE, then Siebel CRM calculates this server component statistic.

Calculated Value (S) Specifies the script for the calculation.

Code Symbol (S) Specifies this server component statistic as an enum, which is a 
short list of known values. This configuration allows faster 
searching than using the full descriptive name.

Data Type (S) Specifies the data type of the value that Siebel CRM saves for this 
server component statistic.

Display Name (S) Specifies the name of the server component statistic that Siebel 
CRM displays in the Server Manager.

Name (S) Specifies the name of this server component statistic.

Visibility Not used. 
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Server Component Type
A server component type supports multiple server component types. Each of these types performs 
a function or job.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Server Component Type

Table 167 describes properties that Siebel CRM uses with a server component type.

Table 166. Properties of the Server Component Subsystem

Property Description

Name (S) Specifies the name of this server component subsystem.

Subsystem (S) Specifies the name of the subsystem.

Table 167. Properties of the Server Component Type

Property Description

Background Mode If TRUE, then a server component that uses this server component 
type can run in the background. 

Batch Mode If TRUE, then a server component that uses this server component 
type can run in batch. 

Code Symbol (S) Specifies this server component type as an enum, which is a short 
list of known values. This configuration allows faster searching than 
using the full descriptive name.

Debug Only If TRUE, then a server component that uses this server component 
type can run only in debug mode.

Display Name (S) Specifies the name of this server component type that Siebel CRM 
displays in the Server Manager.

Interactive If TRUE, then a server component that uses this server component 
type can interactive. 

Key Based Routing (S) If TRUE, then some batch mode components can control how Siebel 
CRM partitions and routes a request. These batch mode 
components can register a key or a set of keys so that each key only 
gets the requests that match the key.

Name (S) Specifies the name of the object definition.
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String Object Types
This topic describes the String object type and object types that are children of this object type. It 
includes the following topics:

■ String (H) on page 235

■ String Map (H) on page 235

String (H)
A string is for Oracle use only.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > String Map (H) > String

String Map (H)
A string map is for Oracle use only.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > String Map

Symbolic String Object Types
This topic describes the Symbolic String object type and object types that are children of this object 
type. It includes the following topics:

■ Symbolic String (H) on page 235

■ Symbolic String Locale on page 237

Symbolic String (H)
A symbolic string includes text that Siebel CRM displays in the client. Many objects include a 
translatable string property, such as the caption of a Control object. To get a string value, the string 
reference property of this object can reference a symbolic string. For example, the Caption - String 
Reference property can reference a symbolic string. To support separate languages, Siebel CRM can 
save the contents of a symbolic string in one or more child symbolic string locale objects. For 
example, the SBL_ACCOUNTS-0910145428-0HN symbolic string might include two symbolic string 
locale children, where one child contains a display value for English, such as Account, and another 
child contains a display value for German, such as Kunde.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Symbolic String
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Table 168 describes properties that Siebel CRM uses with a symbolic string.

Table 168. Properties of the Symbolic String

Property Description

Approval Flag (O) For Oracle use only.

Current String Value Specifies the text that Siebel CRM displays in the client. Siebel Tools 
automatically determines this value. It uses the value that the 
String Value property of the child symbolic string locale contains. It 
uses the symbolic string locale for the language that is currently 
active in Siebel Tools. For example, if the Siebel Tools language 
mode is German, then Siebel Tools displays the following value in 
the Current String Value property for the SBL_ACCOUNTS-
0910145428-0HN symbolic string:

Kunde

If you modify the Siebel Tools language mode to English, then it 
displays the following value in the Current String Value property:

Accounts

Although Siebel Tools calculates the value that it displays in this 
property, you can edit this value. If you edit the value in the 
Current String Value property, then Siebel Tools modifies the value 
that the String Value property contains. This is a property of the 
child symbolic string locale for the language mode that is currently 
active in Siebel Tools.

Definition (O) Specifies the text of this symbolic string.

Glossary Flag (O) For Oracle use only. 

Name (R) Specifies the name of this symbolic string. It must be unique among 
symbolic strings. Other objects use this name to reference this 
symbolic string. The name of each predefined symbolic string 
begins with the SBL_ prefix and contains an uppercase version of 
the ENU string value for this symbolic string. For example, the 
following name is the ENU value for the Accounts symbolic string:

SBL_ACCOUNTS-0910145428-0HN

Type (O) Specifies the type of symbolic string. Siebel CRM converts each 
predefined symbolic string. It sets the Type property for each of 
these symbolic strings to Conversion. This Type property can 
include one of the following values:

■ Conversion

■ Private
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Symbolic String Locale
A symbolic string locale defines the language display values for a symbolic string.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Symbolic String (H) > Symbolic String Locale

Table 169 describes properties that Siebel CRM uses with a symbolic string locale.

System Activity Object Types
This topic describes the object type known as the System Activity Object.

System Activity Object
A system activity object defines the properties of a business component that Siebel CRM uses to 
create activities that some commands require, such as the Send Mail or Send Page command.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > System Activity Object

Table 170 describes properties that Siebel CRM uses with a system activity object.

Table 169. Properties of the Symbolic String Locale

Property Description

String Value (R) Specifies the text string that Siebel CRM displays in the client for a 
language. For example:

Kunde

Symbolic String Name Specifies the symbolic string that Siebel CRM uses to associate the 
string values that the symbolic string locale contains with the 
parent symbolic string. The Symbolic String Name property can 
contain the name of any existing symbolic string. For example:

SBL_#_OF_CONCURRENT_LICENSES-1004225906-00M
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Table Object Types
This topic describes the Table object type and object types that are children of this object type. It 
includes the following topics:

■ Column on page 239

■ Data Source (H) on page 244

■ Index on page 245

■ Index Column on page 247

■ Table on page 247

■ User Key on page 250

■ User Key Attribute on page 250

■ User Key Attribute Join on page 251

■ User Key Attribute Tree Node on page 251

■ User Key Column on page 252

Table 170. Properties of the System Activity Object

Property Description

Account Id Field (O) Specifies the field that contains the row ID of the account that 
Siebel CRM must associate with the activity.

Business Component (R) Specifies the business component that includes data that Siebel 
CRM requires to create an activity. For example, assume the 
Service Request business component includes a system activity 
object. To create an activity that sends a communication, Siebel 
CRM can use data in the service request, such as the account Id.

Contact Id Field (O) Specifies the field that contains the row ID of the contact that Siebel 
CRM must associate with the activity.

Defect Id Field (O) Specifies the field that contains a defect row ID value that Siebel 
CRM can use to populate the Activity Defect Id field of the new 
activity.

Opportunity Id Field (O) Specifies the field that contains the row ID of the opportunity that 
Siebel CRM must associate with the activity.

Service Request Id Field (O) Specifies the field that contains the row ID of the service request 
that Siebel CRM must associate with the activity.

Source Id Field (O) Specifies the field that contains a campaign row ID value that Siebel 
CRM can use to populate the Campaign Id field of the activity.
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Column
A column corresponds to one column in a database table.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Table > Column

Table 171 describes properties that Siebel CRM uses with a column.

Table 171. Properties of the Column

Property Description

Alias (O) Not used.

ASCII Only (O) You can use one of the following values:

■ TRUE. Siebel CRM uses only ASCII text in columns.

■ FALSE. Siebel CRM does not use only ASCII text in columns.

Cascade Clear (O) For Oracle use only.
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Computation Expression (O) Specifies a computation that Siebel CRM uses on a field if it saves 
this field to the Siebel database. 

For example, to encrypt a value while Siebel CRM writes it to the 
Siebel database, you can use the following value in the 
Computation Expression property:

SiebelEncrypt.RC2([column_name])

where:

■ column_name identifies the column that Siebel CRM must 
encrypt.

For example:

SiebelEncrypt.RC2([PAY_ACCNT_NUM])

You can use this property for Case-insensitive and Accent-
Insensitive (CIAI) search functionality. For example:

CIAI([column_name])

where:

■ column_name identifies a column that contains all uppercase, 
nonaccented characters. You can then use this value in an index 
that allows Siebel CRM to search without respect to case or 
accent.

For example: 

Account Name ([S_ORG_EXT.NAME])

where:

■ NAME might reference a column that includes a value of La 
Française. Because this expression is difficult search, CIAI uses 
the CIAI([NAME]) computation expression to save this value. If 
Siebel CRM saves an account, then it updates the value in the 
column as LA FRANCAISE.

If you search for a string that is similar to la franca*, LA F*, 
then the Application Object Manager uses this column to find a 
match. It is not necessary for you to consider case or accent.

Default (O) For Oracle use only.

Default Insensitivity (O) Specifies to use a normal search or translate to CIAI mode. To view 
the values you can use, click the Default Insensitivity property in 
Siebel Tools.

Denormalization Path (O) For Oracle use only.

Table 171. Properties of the Column

Property Description
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EIM Processing Column Flag 
(O)

For Oracle use only.

Encryption Key Specifier Specifies where to save the encryption key for an encrypted field. 
This field is only required for a SiebelEncrypt computation 
expression. For more information, see the Computation Expression 
property for this object type.

FK Column 1:M Rel Name 
(O)

For Oracle use only.

FK Column M:1 Rel Name 
(O)

For Oracle use only.

Force Case (O) Specifies the case of the letters that the column can contain, such 
as Lower. To view the values you can use, click the Force Case 
property in Siebel Tools.

Foreign Key Table (Foreign 
Key Table Name) (O)

Specifies the table to which this column is a foreign key. EIM uses 
this value. You must leave this property empty in an extension 
column.

Inactive Specifies to make the column active or inactive. If TRUE, then 
Siebel CRM does not create this column when it installs the server 
database.

LOV Bounded (O) You can use one of the following values:

■ TRUE. Siebel CRM must populate any field that references this 
column with a value from the list that the LOV Type property 
identifies. It must first import LOV data into the S_LST_OF_VAL 
table and you must specify the LOV Type property. EIM can then 
examine the values it imports from the list that the LOV Type 
property identifies.

■ FALSE. There is no restriction on the values that Siebel CRM 
populates in a field that references this column.

The LOV Bounded property is read-only for a column that comes 
predefined with Siebel CRM. It is editable for a column that you add 
through the Database Extension Designer.

LOV Type (O) Specifies the list of values that Siebel CRM uses to validate this 
column. To define this list of values, you use the List Of Values 
administration views in the client.

The LOV Type property is read-only for a column that comes 
predefined with Siebel CRM. It is editable for a column that you add 
through the Database Extension Designer.

For more information, see the description for the LOV Bounded 
property.

Table 171. Properties of the Column

Property Description
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Name (R) Specifies the name for this column. This name must be unique in 
the table.

No Match Value (O) Specifies the string that Siebel CRM uses if it cannot match the 
primary Id field. You can configure this property only for the 
primary key column of a table that an external business component 
references, and only if this business component creates RowId 
values that might conflict with the default No Match Row Id string.

If the No Match Value property is empty, then Siebel CRM uses No 
Match Row Id as the default string.

Nullable (O) You can use one of the following values:

■ TRUE. Siebel CRM can save NULL in this column in the Siebel 
database.

■ FALSE. Siebel CRM cannot save NULL in this column in the 
Siebel database.

Physical Type Name 
(Physical Type) (R)

Specifies the data type of the column in the Siebel database. You 
can use one of the following values:

■ Character. Fixed-length text.

■ Date. Date values only without time.

■ Date Time. Date and time values in the same column.

■ Long. Long text.

■ Number. Any numeric data.

■ Time. Time values only without the date.

■ UTC Date Time. Time in Greenwich Mean Time (GMT). 

■ Varchar. Variable-length text.

Precision (R) For more information, see “About the Scale and Precision Properties” 
on page 17.

Primary Child Col (S) EIM uses this property. For Oracle use only.

Primary Child Column Name 
(O)

Specifies the name of the column that contains the primary ID 
value.

Primary Child Join Column 
Name (O)

Specifies the name of the child table column where Siebel CRM joins 
the record.

Primary Child Table Name 
(O)

Specifies the name of the table where Siebel CRM can locate the 
primary child.

Primary Inter Table Name 
(Primary Inter Table) (O)

EIM uses this property. For Oracle use only.

Table 171. Properties of the Column

Property Description
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Primary Join Column Name 
(O)

Specifies the name of the column that Siebel CRM uses to join the 
record.

Primary Key (O) You can use one of the following values:

■ TRUE. Siebel CRM uses this column as part of the primary key 
of the table.

■ FALSE. Siebel CRM does not use this column as part of the 
primary key of the table.

Required (O) You can use one of the following values:

■ TRUE. Siebel CRM requires a value in this column. This 
requirement is true even if the Siebel database allows an empty 
value in this column.

■ FALSE. Siebel CRM does not require a value in this column.

Scale (O) For more information, see “About the Scale and Precision Properties” 
on page 17.

Sequence (O) Specifies the order that Siebel CRM uses to save the columns of a 
cluster index. This property can contain only an integer. This 
property applies primarily with the MSSQL server. You can use it 
with other servers.

Sequence Object (O) Specifies the name of the RDBMS utility that creates a unique 
sequence number for the table column. For Oracle use only.

Status Specifies the state of the column, such as Active. To view the values 
you can use, click the Status property in Siebel Tools.

System Field Mapping (O) Specifies an alternative way to map the column to a system field. 
You can configure this property only for a table that an external 
business component uses. To view the values you can use, click the 
System Field Mapping property in Siebel Tools.

Text Length (O) Specifies the length in characters for a text or varchar column. The 
column size in Siebel Tools is not the same as the column size in 
the physical database. For more information about this difference, 
see 531960.1 (Article ID) on My Oracle Support. 

Translation Table Name (O) Specifies the name of the translation table. 

Txn Log Code (O) Not used.

Type (S) Specifies the column type.

Table 171. Properties of the Column

Property Description
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Properties for Custom Extension Columns
If you configure a custom extension column, then you must set only the following properties: 

■ Comments

■ Default

■ Foreign Key Table Name

■ Inactive

■ LOV Bounded

■ LOV Type

■ Name

■ Nullable

■ Physical Type

■ Precision

■ Scale

■ Text Length

Data Source (H)
A data source specifies the data source that the Application Object Manager uses to connect to an 
external table. You define this object only for a table that does not reside in the Siebel database.

This object type occurs in the following location in the object hierarchy:

Use FKey (S) You can use one of the following values:

■ TRUE. To determine visibility, Siebel CRM uses this column as 
a foreign key during synchronization. 

■ FALSE. Siebel CRM does not use this column as a foreign key. 
You must leave this column at the default FALSE setting for an 
extension column.

User Key Sequence (O) Specifies the sequence that Siebel CRM uses to place this column in 
the user key. For example, if you set the User Key Sequence 
property for Column A to 1, then Siebel CRM places Column A in the 
first position in the user key.

User Name (R) Specifies the user-friendly name for the column.

Valid Condition (O) Specifies the expression that Siebel CRM uses to validate a column 
value.

Table 171. Properties of the Column

Property Description
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■ Siebel Objects > Table > Data Source

Table 172 describes properties that Siebel CRM uses with a data source.

Index
An index creates a new index to improve performance of queries.

CAUTION: If you create a new index, then use caution. An index can decrease performance and use 
significant disk space.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Table > Index

Table 173 describes properties that Siebel CRM uses with an index.

Table 172. Properties of the Data Source

Property Description

Name (R) Specifies the name of the data source. This name must match one 
of the following items:

■ The value that the DataSources section specifies in the 
application configuration file 

■ The Alias name of an InfraDatasources server component type

Table 173. Properties of the Index

Property Description

Alias (O) Specifies the short name for the index.

Allow Reverse Scan (O) If TRUE, then Siebel CRM creates the index with a backward page 
reference and a forward page reference. This configuration allows 
Siebel CRM to read the index backwards. The Allow Reverse Scan 
property applies only to a DB2 or a UDB database.
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Based on Index Specifies a replacement index. For example, assume the following 
occurs:

1 A NAME index exists on the S_ORG_EXT table.

2 A LOC index exists on the S_ORG_EXT_Un table. 

3 You enable CIAI (Case-Insensitive and Accent-insensitive).

4 Siebel CRM creates new columns named NAME_CIAI and 
LOC_CIAI. 

5 You create an index named S_ORG_EXT_Un_C1 and set the 
Based on Index property of this index to S_ORG_EXT_Un.

6 In this situation, the Application Object Manager uses 
S_ORG_EXT_Un_C1 instead of S_ORG_EXT_Un.

Cluster (O) If TRUE, then Siebel CRM clusters the table on this index. For 
example, it physically saves the rows in the order that the index 
columns specify. The Cluster property applies only to a DB2 or a 
UDB database.

Cluster 2 (O) If TRUE, then Siebel CRM appends this cluster key to all other 
indexes. The Cluster 2 property applies to the MSSQL server. It is 
applicable only to unique indexes.

Name (R) Specifies the unique name. 

Number of Unique Columns 
(S)

If Siebel CRM populates this property, then the value it populates 
equals the number of columns that participate in the uniqueness 
constraint.

Siebel CRM sets the Include Only property to TRUE for the columns 
that do not participate in the uniqueness constraint. In this 
situation, the number of columns in the index is more than the 
value that the Number of Unique Columns property contains.

The Number of Unique Columns property applies only to a DB2 or a 
UDB database. It is applicable only to unique indexes.

Partition Indicator Specifies the partition that Siebel CRM uses with some databases to 
indicate where to place the index.

Target Platform Specifies the platform that Siebel CRM uses with some databases to 
indicate the platform.

Type (O) Specifies the index type.

Unique (O) If TRUE, then this index is unique. A unique index prevents multiple 
rows that include the same values in each of the index columns.

Table 173. Properties of the Index

Property Description
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Index Column
An index column creates a new index column.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Table > Index > Index Column

Table 174 describes properties that Siebel CRM uses with an index column.

Table
A table creates a new table to save additional attributes.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Table

Table 175 describes properties that Siebel CRM uses with a table.

User Name (R) Specifies the user-friendly name for the index.

User Primary Key (O) If TRUE, then EIM enforces uniqueness on this index. Siebel 
Enterprise Integration Manager (EIM) uses this property.

Table 174. Properties of the Index Column

Property Description

Column Name (R) Specifies the name of the column in the index.

Name (R) Specifies the name of the index column.

Sequence (R) Specifies the position of the index column in the index.

Sort Order (O) Specifies how Siebel CRM sorts the values in the index column. 
Starting with Siebel CRM version 8.1, to populate the repository, 
Siebel CRM sets the Sort Order property to Asc as the default value. 
If the index column is a Date type, then it sets the Sort Order 
property to Desc.

Table 173. Properties of the Index

Property Description
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Table 175. Properties of the Table

Property Description

Abbreviation 1 (O)

Abbreviation 2 (O)

Abbreviation 3 (O)

Abbreviation 4 (O)

Abbreviation 5 (O)

Abbreviation 6 (O)

Specifies an alternative abbreviation for the table. You must not 
modify the abbreviations that the EIM Generator and wizard use to 
determine how to name interface table columns in foreign key 
mappings.

Alias (O) Not used.

Append Data (O) If TRUE, then Siebel CRM inserts any new rows it creates at the end 
of the table. If a clustered index exists on this table, and if the 
Append Data property is TRUE, then Siebel CRM cannot access any 
new rows that it appends to this table.

Base Table Name (R) Specifies the name of the base table. If the Type property of this 
table is Ext or Journal, then Siebel CRM extends or journals the 
table that the Base Table Name property specifies.

Dflt Mapping Col Name 
Prefix (S)

Specifies the default prefix that Siebel CRM uses. If Siebel CRM 
creates an interface table column, then it adds this prefix to the 
name of this column.

For Oracle use only.

External API Write If TRUE, then the following applies:

■ An external API handles any insert, update, or delete in any 
external table.

■ The BusComp_PreWriteRecord must include a script that 
publishes the insert, update, or delete to this external API.

File (O) If TRUE, then Siebel CRM uses this table to save file attachment 
data.

Group (O) Specifies to group tables. Siebel CRM uses this property only for an 
IBM System 390. It places tables in groups that correspond to dock 
objects. It groups these tables according to table size, access 
frequency, and so on.

Key Generation Business 
Service

Specifies the business service that Siebel CRM uses to create the 
primary key for the business component. If this property is empty, 
then Siebel CRM uses the default row Id generator for tables that 
include a column that corresponds to the Id system field.

Key Generation Service 
Method

Specifies the name of the business service method that Siebel CRM 
calls when it creates the primary key for the business component.
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Name (R) Specifies a unique name for this table.

Node Type Specifies the client type that can use this table. For example, if you 
set this property to Mobile Only, then Siebel CRM includes this table 
in the Remote client database but not on the Siebel Server. 

Owner Organization 
Specifier

Not used. 

Parent Table Column1 Name 
(O)

Specifies the column that references the primary parent if this table 
is a child table or intersection table.

Parent Table Column2 Name 
(O)

Specifies the column that references the second parent if this table 
is an intersection table.

Status (O) Specifies the current status of this table. It can include one of the 
following values:

■ ACTIVE. Use this table in the current version of Siebel CRM.

■ INACTIVE. Discontinue and do not support this table in the 
current version of Siebel CRM. You must move any extension 
column that resides on an inactive table to another table. For 
example, you must the S_EMPLOYEE table to one of the 
following tables:

■ S_CONTACT

■ S_USER

■ S_EMP_PER

■ EOL (End of life). Do not use this table in the current version 
of Siebel CRM. You must delete this table because Siebel CRM 
no longer uses it. For example, Siebel CRM no longer uses the 
S_*_IF tables.

■ NOT USED. Use this table in the current version of Siebel CRM. 
Siebel CRM objects do not use this table in the current version 
but you can continue to use it. For example, you can use tables 
for docking or EIM.

Type (S) Specifies the type for this table.

User Name (R) Specifies the name for this table.

Volatile (O) If TRUE, then Siebel CRM does not use the statistics that the 
runstats utility creates on the Siebel database for this table.

Table 175. Properties of the Table

Property Description
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User Key
A user key specifies a set of attribute columns and other information that specifies how Siebel 
Enterprise Integration Manager (EIM) accesses table rows. For more information, see Configuring 
Siebel Business Applications.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Table > User Key

Table 176 describes properties that Siebel CRM uses with a user key.

User Key Attribute
A user key attribute specifies one user key attribute in the set of attribute columns that identify rows 
in the grandparent table. Siebel Enterprise Integration Manager (EIM) uses this object type. For more 
information, see Configuring Siebel Business Applications.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Table > User Key > User Key Attribute

Table 177 describes properties that Siebel CRM uses with a user key attribute.

Table 176. Properties of the User Key

Property Description

Inaccessible (S) If TRUE, then EIM can access the user key.

Index Name (S) Specifies the name of the index.

Name (S) Specifies the name of the user key.

Source Interface Table Name (S) Specifies the name of the source interface table for the user 
key.

User Key Type (S) Specifies the type of user key of the object definition.

Table 177. Properties of the User Key Attribute

Property Description

Attribute Sequence (S) Specifies the position of the attribute column in user key.

Name (S) Specifies the name of the attribute column.
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User Key Attribute Join
A user key attribute join specifies a join operation that Siebel CRM uses to convert a user key 
attribute that is a foreign key to another table into attribute column values in this table. Siebel 
Enterprise Integration Manager (EIM) uses this object type. For more information, see Configuring 
Siebel Business Applications.

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Table > User Key > User Key Attribute > User Key Attribute Join

Table 178 describes properties that Siebel CRM uses with a user key attribute join.

User Key Attribute Tree Node
A user key attribute tree node specifies the tree node for a user key attribute. Siebel Enterprise 
Integration Manager (EIM) uses this object type. For more information, see Configuring Siebel 
Business Applications. 

CAUTION: You must not modify this object type. Any modifications can adversely affect 
performance.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Table > User Key > User Key Attribute Tree Node

Table 179 describes properties that Siebel CRM uses with a user key attribute tree node.

Table 178. Properties of the User Key Attribute Join

Property Description

Join Column Name (S) Specifies the name of the column that Siebel CRM uses for the join.

Join Sequence (S) Specifies the order that Siebel CRM uses to process the join. This 
property can contain only an integer.

Join Type (S) Specifies the type of join that Siebel CRM uses.

Name (S) Specifies the name of the columns that Siebel CRM uses in the join.

Table 179. Properties of the User Key Attribute Tree Node

Property Description

Join Column Name (S) Specifies the name of the join column.

Join Sequence (S) Specifies the order that Siebel CRM uses to process the join. This 
property can contain only an integer.
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User Key Column
A user key column specifies a column for the user key. Siebel Enterprise Integration Manager (EIM) 
uses this object type. For more information, see Configuring Siebel Business Applications.

CAUTION: You must not modify this object type. Any modification you make might adversely affect 
Siebel CRM.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Table > User Key > User Key Column

Table 180 describes properties that Siebel CRM uses with a user key column.

Task Object Types
This topic describes the Task object type and object types that are children of this object type. It 
includes the following topics:

■ Task on page 253

■ Task Branch on page 255

■ Task Branch Criteria on page 256

■ Task Branch Criteria Value on page 257

■ Task Chapter on page 257

■ Task Chapter Locale on page 258

Name (S) Specifies the name of the user key.

Previous Tree Node Name 
(S)

Specifies the name of the previous tree node.

Sub Node Table Name (S) Specifies the name of the subnode table.

User Key Attribute Name (S) Specifies the name of the user key attribute.

Table 180. Properties of the User Key Column

Property Description

Column Name (S) Specifies the name of the column from the user key index.

Column Sequence (S) Specifies the order that Siebel CRM uses to process the join. This 
property can contain only an integer.

Name (S) Specifies the name of the column from the user key index.

Table 179. Properties of the User Key Attribute Tree Node

Property Description
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■ Task Event on page 258

■ Task Event IO Argument on page 259

■ Task Locale on page 261

■ Task Metric on page 261

■ Task Property on page 262

■ Task Step on page 264

■ Task Step Context on page 266

■ Task Step IO Argument on page 268

■ Task Step Locale on page 269

Task
A task defines a user interface that guides the user through task UI completion. A task UI can include 
one or more task UI steps, such as a start step, subtask, decision point, or business service step. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Task

Table 181 describes properties that Siebel CRM uses with a task.

Table 181. Properties of the Task

Property Description

Allow Pause (R) You can use one of the following values:

TRUE. The user can pause this task.

FALSE. The user cannot pause this task.

Business Object (R) Specifies the name of a business object. To choose this value, you 
use a drop-down list in Siebel Tools. This list only includes business 
objects that include a primary business component.

Display Name (R) Specifies the name that Siebel CRM displays in the task pane unless 
the Display Name - String Override property of the task group 
includes a value. The Display Name - String Reference property 
determines the value for the Display Name property. For more 
information about the String Reference property, see “Common 
Object Properties” on page 15.
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Inbox Disposition (R) You can use one of the following values:

■ Save A Record. Keep the inbox item that Siebel CRM creates 
for this task after this task finishes.

■ Discard Record. Delete this inbox item after this task finishes.

■ Do Not Care (Fastest). Create an inbox item after this task 
finishes only if the user has never paused this task. This option 
minimizes the number of database operations that Siebel CRM 
must perform to maintain the task UI inbox items. 

Is Subtask (R) Specifies if this task is a main task or a subtask. You can uses one 
of the following values:

■ TRUE. This task is a subtask. 

■ FALSE. This task is a main task.

Name (S) Specifies the name of this task. To set the value for this property, 
Siebel CRM uses the value that the Task Name property contains.

On Conflict (R) Specifies how to resolve a conflict that occurs while Siebel CRM 
writes data to the Siebel database. You can uses one of the 
following values:

■ Cancel Operation. Cancel the write operation and return the 
error.

■ Continue Operation. Use the resolution configuration to 
resolve the conflict and then continue the write operation. 

For information about resolving conflicts, see Siebel Business 
Process Framework: Task UI Guide. 

Status (S) Specifies the current status of this task. You can uses one of the 
following values:

■ In Progress. Editing in progress. 

■ Completed. Editing completed and ready for activation. 

■ Not In Use. Not in use and can be deleted.

Task Name (R) Specifies the internal name of this task that the task UI controller 
uses to identify this task.

Transactional (R) Flag that indicates if this task is transactional. You can uses one of 
the following values:

■ TRUE. This task is transactional. 

■ FALSE. This task is not transactional.

Table 181. Properties of the Task

Property Description
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Task Branch
A task branch connects two task steps. It controls the flow of a task UI.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Task > Task Branch

Table 182 describes properties that Siebel CRM uses with a task branch.

Transient BC (O) Specifies the name of the transient business component associated 
with this task. 

Version (S) Specifies the version number of this task. This property is read-
only. The default version is 0.

Table 182. Properties of the Task Branch

Property Description

Label (O) Specifies the text that Siebel CRM displays on this task branch in 
the Task Designer.

Name (R) Specifies the name of this task branch.

Parent Name (S) Specifies the name of the task step that contains this task branch.

Type (R) Specifies the type of this task branch. You can use one of the 
following values:

■ Condition. Use a condition for this task branch.

■ Default. If no other conditions are met, then use this task 
branch. Siebel CRM ignores any conditions that are defined for 
this task branch.

■ Connector. Do not use any condition branching.

■ Error Exception. Use exception handling. This connector type 
captures system errors. For example, the Assignment Manager 
server component is not available.

■ User Defined Exception. Use exception handling. This 
connector type captures errors that you define. For example, 
the user attempts to save an incomplete order.

Table 181. Properties of the Task

Property Description
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Task Branch Criteria
A task branch criteria specifies a list of conditions. At runtime, the task UI controller evaluates the 
task branch criteria. If the outcome of this evaluation for a task branch is true, then the task UI uses 
the path that the task branch defines.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Task > Task Branch > Task Branch Criteria

Table 183 describes properties that Siebel CRM uses with a task branch criteria.

Table 183. Properties of the Task Branch Criteria

Property Description

Applet Field Name Specifies the name of a control in an applet. If the Compare To 
property is Applet, then:

■ The Applet Field Name property is required. 

■ The Field drop-down list in the Compose Condition Criteria 
dialog box displays the controls that the applet contains.

Applet Name Specifies the name of an applet. If the Compare To property is 
Applet, then the Object drop-down list in the Compose Condition 
Criteria dialog box displays the applets you can choose.

Business Component Specifies the name of a business component. The business object 
that this task references includes this business component as a 
business object component. 

If the Compare To property is Business Component, then the Object 
drop-down list in the Compose Condition Criteria dialog box 
displays the business components that this business object 
references.

Business Component Field Specifies the name of a business component field. If the Compare 
To property is Business Component, then:

■ The Business Component Field property is required.

■ The Field drop-down list in the Compose Condition Criteria 
dialog box displays the fields that this business component 
contains.

Compare To (R) Specifies the object type that Siebel CRM uses to compare values.

Name (S) Specifies the name of this task branch criteria. 

Operation (R) Specifies the comparison operation. For more information, see the 
topic about creating expressions in Siebel Business Process 
Framework: Workflow Guide. 

Parent Name (S) Specifies the name of the parent task branch.
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Task Branch Criteria Value
A task branch criteria value is for Oracle use only. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Task > Task Branch > Task Branch Criteria > Task Branch Criteria Value

Task Chapter
A task chapter groups task steps. When a task step runs, Siebel CRM displays the task step name 
and the chapter name in the Current Task Pane.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Task > Task Chapter

Table 184 describes properties that Siebel CRM uses with a task chapter.

Preferred Sequence Specifies the order that Siebel CRM uses to examine task branch 
criteria. For example, assume a task includes branch A and branch 
B, and that the conditions for Branch A will handle most situations. 
To reduce the amount of processing Siebel CRM must perform, you 
can specify to examine task branch criteria for branch A first. If task 
branch criteria for branch A is met, then Siebel CRM does not 
examine task branch criteria for branch B.

Property Name (R) Specifies the task property that Siebel CRM uses to determine the 
condition. The drop-down list displays the properties of the task.

Table 184. Properties of the Task Chapter

Property Description

Color (R) Specifies the color that Siebel CRM uses to display the task steps 
for a task chapter in the Task Designer if the Show Chapter mode 
is enabled. You can set this color only in the Multi Value Property 
Window of the parent task object.

Display Name (O) Specifies a label for this task chapter that Siebel CRM displays in 
the Current Task pane. If the Display Name property is empty, then 
Siebel CRM does not display this task chapter.

Name (R) Specifies the name of this task chapter. It must be unique in a task.

Table 183. Properties of the Task Branch Criteria

Property Description
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Task Chapter Locale
A task chapter locale defines language overrides that Siebel CRM uses with the task chapter.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Task > Task Chapter > Task Chapter Locale

Table 185 describes properties that Siebel CRM uses with a task chapter locale.

Task Event
A task event defines the action that Siebel CRM performs if a task event occurs, such as Cancel, 
Delete, Pause, or Resume. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Task > Task Event

Table 186 describes properties that Siebel CRM uses with a task event.

Parent Name (S) Specifies the name of the task that contains this chapter.

Sequence (R) Specifies the order that Siebel CRM uses to display this task chapter 
in the current task pane with respect to other task chapters that the 
parent task contains. This property can contain only an integer.

Table 185. Properties of the Task Chapter Locale

Property Description

Display Name (O) Specifies the name that Siebel CRM displays for a task chapter for 
a language.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Table 184. Properties of the Task Chapter

Property Description
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Task Event IO Argument
A task event IO argument defines the input arguments and output arguments for an event handler.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Task > Task Event > Task Event IO Argument

Table 187 describes properties that Siebel CRM uses with a task event IO argument.

Table 186. Properties of the Task Event

Property Description

Business Service Method Specifies the name of the business service method that Siebel CRM 
calls. If the Business Service Name property contains a value, then 
the Business Service Method property is required. 

The drop-down list for this property displays the business service 
method that the business service contains.

Business Service Name Specifies the name of the business service that Siebel CRM calls. If 
the Workflow Process property is empty, then the Business Service 
Name property is required. 

The drop-down list for this property displays the business services 
that include a Hidden property that is FALSE.

Name (R) Specifies the name of this task event.

Parent Name (S) Specifies the name of the parent task.

Workflow Process Specifies the name of the workflow process that Siebel CRM calls. 
If the Business Service Name property is empty, then the Workflow 
Process property is required. 
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Table 187. Properties of the Task Event IO Argument

Property Description

Argument (O) Specifies the name of the output argument of the workflow process 
or business service that the event handler calls. If you set the 
Input/Output property of this task event IO argument to:

■ Input. You must set the Argument property to the name of an 
input argument of the event handler. The parent Task Event 
determines the values you can set. 

■ Output. You must set the Argument property to the name of an 
output argument of the event handler. The parent Task Event 
determines the values you can set.

Business Component Specifies the name of a business component that the business 
object references. The task references this business object. If the 
Type property is Business Component, then the Business 
Component property is required.

Business Component Field Specifies the name of a business component field. If the Type 
property is Business Component, then the Business Component 
Field property is required. The dropdown list for this property 
displays the fields that the business component contains.

Input/Output (R) Specifies if the argument is an input argument or an output 
argument.

Name (S) Specifies the name of this task event IO argument. The value you 
specify depends on one of the following types of arguments:

■ Input argument. You specify the input argument name of the 
business service method.

■ Output argument. You leave this Name property empty.

If you choose a workflow process as the event handler, then the 
value of this Name property must be RowId or ProcessName.

Parent Name (S) Specifies the name of the parent task event.

Preferred Sequence (O) Not used. Siebel CRM ignores this property.

Property Name Specifies the name of the task property that this task event IO 
argument references. If the Type property is Task Property, then 
the Property Name property required.

The drop-down list for this property includes the task properties 
that the parent task contains.
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Task Locale
A task locale defines language overrides that Siebel CRM uses with a task.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Task > Task Locale

Table 188 describes properties that Siebel CRM uses with a task locale.

Task Metric
A task metric defines metrics that Siebel CRM collects while a task runs.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Task > Task Metric

Table 189 describes properties that Siebel CRM uses with a task metric.

Type (R) Specifies the type of the argument. It can contain one of the 
following values:

■ Business Component

■ Literal

■ Expression

■ Task Property

Value (O) Specifies a value for this task event IO argument. If the Type 
property is Literal or Expression, then the Value property contains 
a literal value or an expression.

Table 188. Properties of the Task Locale

Property Description

Display Name (O) Specifies the name that Siebel CRM displays for a task for a 
language.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Table 187. Properties of the Task Event IO Argument

Property Description
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Task Property
A task property defines a field that Siebel CRM uses to save a value. It can use this value in a task 
step, in an input or output argument, or to perform an evaluation. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Task > Task Property

Table 190 describes properties that Siebel CRM uses with a task property.

Table 189. Properties of the Task Metric

Property Description

Metric Name (R) Specifies the name of the metric. The dropdown list for this 
property displays a list of predefined metrics.

Name (R) Specifies the name of the object. Siebel CRM automatically sets the 
value of the Name property to the value that the Metric Name 
property contains.

Parent Name Specifies the name of the parent object. This property is read-only.

Property Name (R) Specifies the name of a task property. Siebel CRM maps this task 
property to this task metric. The dropdown list for the Property 
Name property displays a list of task properties that the task 
contains.
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Table 190. Properties of the Task Property

Property Description

Access Mode (R) You can use one of the following values:

■ Read. Siebel CRM can only read this task property. 

■ R/W. Siebel CRM can read and update this task property. 

Data Type (R) Specifies the type of data that Siebel CRM can save. You can use 
one of the following values:

■ Binary. Save variant or binary data. If you choose Binary, then 
you must set the In/Out property of this task property to None.

■ Date. Save date data.

■ Hierarchy. Save data that Enterprise Application Integration 
(EAI) can use in a property set.

■ Integration Object. Save data that Enterprise Application 
Integration (EAI) can use in an integration object. 

■ Number. Save numeric data.

■ String. Save alphanumeric data.

■ Strongly Typed Integration Object. Save data that 
Enterprise Application Integration (EAI) can use in a strongly 
typed integration object.

Default (O) Specifies the predefault value of this task property.

In/Out (R) Specifies how to send the value that this task property contains. 
You can use one of the following values:

■ In. Send this value into the task.

■ Out. Send this value out of the task.

■ In/Out. Send this value into and out of the task.

■ None. Use this value only in the task.

If the Data Type property is Binary, then you cannot set the In/Out 
property to In, Out, or In/Out.

Integration Object Specifies the name of the integration object. If the Data Type 
property is Integration Object or Strongly Typed Integration Object, 
then the Integration Object property is required. For example:

Account - Get Oracle Customer (Oracle)

Name (R) Specifies the name of this task property.

Parent Name Specifies the name of the parent object. This property is read-only.
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Task Step
A task step defines a unit of work that the task controller performs.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Task > Task Step

Table 191 describes properties that Siebel CRM uses with a task step.

Table 191. Properties of the Task Step

Property Description

Business Component Specifies the name of a business component that the business 
object references. The task references this business object.

If the Type property is Siebel Operation, then the Business 
Component is required.

Chapter (O) Specifies the chapter that includes this task step. The drop-down 
list displays the chapters that the parent task includes.

Defer Write Record (O) Specifies when to save data. You can use one of the following 
values:

■ TRUE. Do not write this data to the Siebel database until a 
Commit step.

■ FALSE. Write this data to the Siebel database immediately.

Siebel CRM uses the Defer Write Record property only if the Type 
property is Siebel Operation.

Display Name (O) Specifies the name that Siebel CRM displays in the Current Task 
Pane or the Context Pane.

Display Name Type (O) Specifies to repeat the display name of the task views next to each 
other in the Current Task Pane or the Context Task pane. You can 
use one of the following values:

■ Normal. Repeat the display name.

■ Unique. Display the display name only one time.

Name (S) Specifies the name of this task step. 

Operation Specifies the type of the Siebel Operation that this task step uses.

If the Type property is Siebel Operation, then the Operation 
property is required.

Parent Name Specifies the name of the parent object. This property is read-only.
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Repeatable Specifies to run this task step more than one time while the task 
runs. You can use one of the following values:

■ TRUE. Allow Siebel CRM to run this task step more than one 
time.

■ FALSE. Allow Siebel CRM to run this task step only one time.

If the Type property is Business Service or Siebel Operation, then 
the Repeatable property is required.

Retain Applet Search Spec Specifies to retain the applet search specification that runs in the 
current step when the current step exits. You can use one of the 
following values:

■ TRUE. Retain the applet search specification.

■ FALSE. Delete the applet search specification.

If the Type property is Task View, then the Retain Applet Search 
Spec property is required.

Retain Task Search Spec Specifies to retain the task search specification that runs in the 
current step when the current step exits. You can use one of the 
following values:

■ TRUE. Retain the task search specification.

■ FALSE. Delete the task search specification.

If the Type property is Siebel Operation or Task View, then the 
Retain Task Search Spec property is required.

Retain User Search Spec Specifies to retain the user search specification that runs in the 
current step when the current step exits. You can use one of the 
following values:

■ TRUE. Retain the user search specification.

■ FALSE. Delete the user search specification.

If the Type property is Task View, then the Retain Task Search Spec 
property is required.

SubTask Name Specifies the name of the subtask. If the Type property is Subtask, 
then the SubTask Name property is required.

Table 191. Properties of the Task Step

Property Description



Siebel Object Types Reference Siebel 2018

Siebel Object Types Reference ■ Task Object Types

266 

Task Step Context
A task step context defines the context for a task step. To do this, it sets up a search specification 
for a business component that the business object references. You can use a task step context only 
if the Type property of the task step is Siebel Operation or Task View. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Task > Task Step > Task Step Context

Table 192 describes properties that Siebel CRM uses with a task step context.

Task View Specifies the name of the task view. If the Type property is Task 
View, then the Task View property is required.

Type (S) Specifies the type of this task step. You can use one of the following 
values:

■ Business Service. Call a business service.

■ Commit. Commit data to the Siebel database.

■ Decision Point. Do decision branching.

■ End. End the task.

■ Error. Cancel the task with error.

■ Siebel Operation. Do a Siebel operation.

■ Start. Start the task.

■ Subtask. Call a subtask. 

■ Task View. Display a task view.

Table 191. Properties of the Task Step

Property Description



Siebel Object Types Reference ■ Task Object Types

Siebel Object Types Reference Siebel 2018 267

Table 192. Properties of the Task Step Context

Property Description

Expression Business 
Component (O) 

Specifies the name of the business component that the right 
operand of the expression references. For example, consider the 
following expression:

[Account Id] = [Id] 

where:

■ = is the operator 

■ [Account Id] is the left operand

■ [Id] is the right operand

If the Expression Business Component is Account, then Siebel CRM 
treats the right operand as [Account.Id]. In this example, Siebel 
CRM uses the following expression:

[Account.Account Id] = [Account.Id]

Filter Business Component 
(O) 

Specifies the name of the business component that the left operand 
of the expression references. For example, consider the following 
expression:

[Account Id] = [Id] 

If the Filter Business Component is Contact, then Siebel CRM treats 
the left operand as [Contact.Account Id]. In this example, Siebel 
CRM uses the following expression:

[Contact.Account Id] = [Account.Id]

Is User Search Spec (R) You can use one of the following values:

■ TRUE. The search specification is a user search specification.

■ FALSE. The search specification is a task search specification.

Name Specifies the name of this task step context.

Search Specification (O) Specifies the value of the search specification. 

Type (R) Specifies the type of this task step context. You can use one of the 
following values:

■ Literal. This task step context uses a literal value.

■ Expression. This task step context uses an expression.
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Task Step IO Argument
A task step IO argument identifies the input and output arguments for a task step. Each task step 
accepts input from the task and sends output back to the task.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Task > Task Step > Task Step IO Argument

Table 193 describes properties that Siebel CRM uses with a task step IO argument.

Table 193. Properties of the Task Step IO Argument

Property Description

Argument (R) Specifies the name of this task step IO argument.

Business Component Specifies the name of the business component in the business 
object of the task. If the Type property is Business Component, 
then the Business Component property is required.

Business Component Field Specifies the name of a business component field. If the Type 
property is Business Component, then the Business Component 
Field property is required.

Input/Output (R) Specifies this task step IO argument as an input argument or an 
output argument.

Name (S) Specifies the name of this task step IO argument. 

Parent Name Specifies the name of the parent object. This property is read-only.

Preferred Sequence (O) Specifies the order that Siebel CRM uses when it evaluates multiple 
task step IO arguments for a single task step. When the task step 
runs, Siebel CRM evaluates the task step IO argument that contains 
the lowest preferred sequence first.

Siebel CRM uses this preferred sequence only for an input 
argument. If the Input/Output property is:

■ Input. Siebel CRM uses the Preferred Sequence property. 

■ Output. Siebel CRM ignores the Preferred Sequence property.

Property Name Specifies the name of the task property that this task step IO 
argument references. If the Type property is Task Property, then 
the Property Name property is required.
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Task Step Locale
A task step locale defines language overrides that Siebel CRM uses with a task step. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Task > Task Step > Task Step Locale

Table 194 describes properties that Siebel CRM uses with a task step locale.

Task Group Object Types
This topic describes the Task Group object type and object types that are children of this object type. 
It includes the following topics:

■ Task Group on page 270

■ Task Group Item on page 270

■ Task Group Locale on page 271

Type (R) Specifies the type for this task step IO argument. You can use one 
of the following values:

■ Business Component

■ Literal

■ Expression

■ Output Argument

■ Task Property

Value (O) Specifies a value. If the Type property is Literal or Expression, then 
Siebel CRM uses the value that the Value property contains.

Table 194. Properties of the Task Step Locale

Property Description

Display Name (O) Specifies the name that Siebel CRM displays for a task step for a 
language.

Name (O) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Parent Name Specifies the name of the parent object. This property is read-only.

Table 193. Properties of the Task Step IO Argument

Property Description
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Task Group
A task group defines a group of tasks that Siebel CRM displays on the Task Pane. For more 
information about configuring task groups, see Siebel Business Process Framework: Task UI Guide. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Task > Task Group

Table 195 describes properties that Siebel CRM uses with a task group.

Task Group Item
A task group item specifies a task and the sequence that Siebel CRM uses to display it in a task group. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Task > Task Group > Task Group Item

Table 196 describes properties that Siebel CRM uses with a task group item.

Table 195. Properties of the Task Group

Property Description

Display Name (R) Specifies the label that Siebel CRM displays in the Task Pane for this 
task group. 

Required Context BC (R) Specifies the business component that the tasks in this task group 
reference.

Table 196. Properties of the Task Group Item

Property Description

Context Business 
Component

Specifies the business component that Siebel CRM uses to set the 
task context. For more information, see Siebel Business Process 
Framework: Task UI Guide.

Name Specifies the name for this task group item. Siebel CRM sets the 
value for this property to the name of the Task, by default.

Sequence Specifies the order that Siebel CRM uses to display the task in the 
parent task group. The value of this property must be a number. 
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Task Group Locale
A task group locale defines language overrides that Siebel CRM uses with a task group.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Task > Task Group > Task Group Locale

Table 197 describes properties that Siebel CRM uses with a task group locale.

Text Style Object Types
This topic describes the Text Style object type.

Task (R) Specifies the task that Siebel CRM displays in the Task Pane. Adding 
a task to a task group item does not automatically configure Siebel 
CRM to display it in the Task Pane. The following items must also 
be true:

■ The Siebel Business Application that uses this task group is 
currently running. 

■ The configuration in the Task Administration screens allows the 
user to access this task.

■ The task is licensed for this module. 

If the Context Required property of the task group is TRUE, then 
Siebel CRM displays data from the business component that the 
task references. It displays this data in the current view.

Type Specifies to call a command or a task if the user picks an item from 
the task list for the task group.

Table 197. Properties of the Task Group Locale

Property Description

Display Name (O) Specifies the name that Siebel CRM displays for a task group for a 
language.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Parent Name Specifies the name of the parent object. This property is read-only.

Table 196. Properties of the Task Group Item

Property Description
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Text Style (H)
A text style specifies font information for controls, applets, views, or applications.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Text Style 

Table 198 describes properties that Siebel CRM uses with a text style.

Toolbar Object Types
This topic describes the Toolbar object type and object types that are children of this object type. It 
includes the following topics:

■ Toolbar on page 273

■ Toolbar Item on page 273

■ Toolbar Item Locale on page 274

■ Toolbar Locale on page 275

Table 198. Properties of the Text Style

Property Description

Bold (O) If TRUE, then this text style uses bold text.

Font Face (O) Specifies the font face name for this text style. For example, Arial, 
Courier, and so forth. If you do not specify this property, then 
Siebel CRM uses the default font that the object uses. For example, 
if a control uses a text style that does not specify a font face, then 
Siebel CRM uses the font that all controls in the parent applet use.

Font Size (O) Specifies the point size of the font that Siebel CRM uses. If you do 
not specify this property, then Siebel CRM uses the default font size 
that the object uses. For example, if a control uses a text style that 
does not specify font size, then Siebel CRM uses the font size that 
all controls in the parent applet use.

This value must use an integer.

Italic (O) If TRUE, then this text style uses Italic text.

Name (R) Specifies the name of this text style.

Underlined (O) If TRUE, then this text style uses underlined text.
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Toolbar
A toolbar defines a toolbar that the user can use in the client. Siebel CRM typically uses HTML 
toolbars where the buttons are static images and can be dimmed to indicate availability. Some 
applications, such as Siebel Call Center, use toolbar icons that Siebel CRM modifies in reply to an 
event, such as a blinking icon that indicates an incoming call. In this situation, Siebel CRM uses a 
Java toolbar.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Toolbar

Table 199 describes properties that Siebel CRM uses with a toolbar.

Toolbar Item
A toolbar item associates a command with a toolbar. This association places a toolbar icon on the 
toolbar. The toolbar item properties determine how Siebel CRM places icons on a toolbar and the 
order that it uses to place these icons. To override this configuration, the user can use the Customize 
dialog box in the client. Siebel CRM saves these modifications to a local preferences file.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Toolbar > Toolbar Item

Table 200 describes properties that Siebel CRM uses with a toolbar item.

Table 199. Properties of the Toolbar

Property Description

Class (O) Specifies the name of the Java class that implements this toolbar. 
The value for this property is empty for an HTML toolbar.

Client Restriction (O)(H) Specifies to display this toolbar only in the mobile client.

Display Name (O) Specifies the display name that Siebel CRM uses for this toolbar.

Name (R) Specifies the name of this toolbar that Siebel CRM displays in the 
list in the Toolbars tab of the Customize dialog box in the client.

Popup Indicator Bitmap (O) Specifies the name of the bitmap icon that Siebel CRM displays in 
this toolbar.
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Toolbar Item Locale
A toolbar item locale defines language overrides that Siebel CRM uses with a toolbar item.

This object type occurs in the following location in the object hierarchy:

Table 200. Properties of the Toolbar Item

Property Description

Command (R) Specifies the name of the command that specifies the bitmap, 
method, and target for this toolbar item. To insert a separator 
between icons, you can include one or more dashes (-) instead of 
the name of a command.

Display Name (O) Specifies the text name that Siebel CRM displays for this toolbar 
item. For example, to represent advanced search, Siebel CRM 
displays the following text instead of a bitmap image:

Advanced Search

Group (O) Specifies the group name. If you specify the Group property, then 
Siebel CRM uses a radio button for each toolbar item that this group 
contains. The user can choose only one radio button at a time.

HTML Attributes (O) Reserved for future use.

HTML Type (O) Specifies the type of control that Siebel CRM displays in the toolbar 
for this toolbar item.

HTML Width (O) Specifies the width of this toolbar item in pixels that Siebel CRM 
displays in the Siebel Web Client.

HTML Width - Language 
Override (O)

Specifies the width of this toolbar item in pixels that Siebel CRM 
displays in the Siebel Web Client if a language or locale is active.

Name (R) Specifies the name of this toolbar item.

Position (O) Specifies the position of this toolbar item.

Position - Language Override 
(O)

Specifies the position of this toolbar item if a language or locale is 
active.

Target View Frame (O) Specifies the HTML page that Siebel CRM loads into the frame that 
this property specifies.

Type (R) Specifies the toolbar item type.

Width (R) Specifies the width of this toolbar item.

Width - Language Override 
(O)

Specifies the width of this toolbar item if a language or locale is 
active.
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■ Siebel Objects > Toolbar > Toolbar Item > Toolbar Item Locale

Table 201 describes properties that Siebel CRM uses with a toolbar item locale.

Toolbar Locale
A toolbar locale defines language overrides that Siebel CRM uses with a toolbar.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Toolbar > Toolbar Locale

Table 202 describes properties that Siebel CRM uses with a toolbar locale.

Table 201. Properties of the Toolbar Item Locale

Property Description

Display Name (O) Specifies the text name that Siebel CRM displays for this toolbar 
item. For example, to represent advanced search, Siebel CRM 
displays the following text instead of a bitmap image:

Advanced Search

HTML Width (O) Specifies the width of this toolbar item in pixels that Siebel CRM 
displays in the Siebel Web Client.

Name (O) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Position (O) Specifies the position of this toolbar item.

Width (O) Specifies the width of this toolbar item.

Table 202. Properties of the Toolbar Locale

Property Description

Display Name (O) Specifies the text name that Siebel CRM displays for this toolbar. 
For example, to represent advanced search, Siebel CRM displays 
the following text instead of a bitmap image:

Advanced Search

Name (O) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU
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Type Object Types
This topic describes the Type object type and object types that are children of this object type. It 
includes the following topics:

■ Attribute on page 276

■ Type on page 277

Attribute
An attribute specifies a column that contains data. Siebel Enterprise Integration Manager (EIM) uses 
this object type. For more information, see Siebel Developer’s Reference.

CAUTION: You must not modify this object type. Any modification you make might adversely affect 
Siebel CRM.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Attribute > Attribute

Table 203 describes properties that Siebel CRM uses with an attribute.

Table 203. Properties of the Attribute

Property Description

Category (S) Specifies the group for the object properties that Siebel CRM 
displays on a property sheet. This grouping helps the user to use a 
property sheet.

Column Name (S) Specifies the name of the attribute column.

Language Override Attribute 
(S)

Specifies the order of attribute columns for a language or locale.

Name (S) Specifies the name of an attribute column in the client.

No Compile (S) You can use one of the following values:

■ TRUE. Siebel CRM does not compile the object definition if you 
use the Tools menu in Siebel Tools.

■ FALSE. Siebel CRM compiles the object definition if you use the 
Tools menu in Siebel Tools.
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Type
A type sets the type for object types in a repository.

CAUTION: You must not modify this object type. Any modification you make might adversely affect 
Siebel CRM.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Type

Table 204 describes properties that Siebel CRM uses with a type.

Siebel Wins (S) Specifies the attribute value to use if a conflict occurs during an 
upgrade. You can use one of the following values:

■ TRUE. Siebel CRM maintains the value that Oracle provides. 

■ FALSE. Siebel CRM uses the existing property value.

For example, assume the value for the Search Specification 
property of the Action business component in an existing release is:

[Type] <> 'Template'

Assume you modify this value to the following:

[Type] <> 'Template' AND [Type] <> 'ABC'

In a new release, assume Oracle modifies this value to the 
following:

[Type] <> 'Template' AND [Type] <> 'XYZ'

If you upgrade Siebel CRM, then a conflict occurs and Siebel CRM 
uses a value according to the following value that the Siebel Wins 
property contains:

■ TRUE. Siebel CRM uses the value that Oracle provides in the 
new release.

■ FALSE. Siebel CRM uses the existing value.

Translatable (S) Specifies one of the following values:

■ TRUE. Siebel CRM can translate the attribute.

■ FALSE. Siebel CRM cannot translate the attribute. 

Table 203. Properties of the Attribute

Property Description
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View Object Types
This topic describes the View object type and object types that are children of this object type. It 
includes the following topics:

■ View on page 278

■ View Locale on page 283

■ View Task Group on page 284

■ View Task Group Locale on page 285

■ View User Prop (H) on page 285

■ View Web Template on page 285

■ View Web Template Item on page 286

■ View Web Template Item Locale on page 288

View
A view defines a visual representation of business object data.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > View

Table 205 describes properties that Siebel CRM uses with a view.

Table 204. Properties of the Type

Property Description

Bitmap Category (S) Not used.

Business Component (S) Specifies the name of a business component.

Language Sub Type (S) Specifies the name of an object type for a locale. For example, an 
applet locale is associated with the Applet object property.

Name (S) Specifies the name of this type.

No Compile (S) If TRUE, and if you click Compile from the Tools menu in Siebel 
Tools, then Siebel Tools does not compile this type.

Table Name (S) Specifies the name of a table.
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Table 205. Properties of the View

Property Description

Add To History (O) If TRUE, then specifies to include this view in the historical list of 
views that the user navigates during a session. To access this 
history, the user clicks the browser Back button.

Admin Mode Flag (O) For more information, see “Setting the Admin Mode Flag Property of 
a View” on page 282

Background Bitmap (O)(H) Specifies the bitmap that Siebel CRM uses as the background for 
this view.

Bitmap Category (O)(H) Not used.

Business Object (R) Specifies the name of the business object that this view references.

Container Web Page (O)(H) Specifies the container page to that contains this view. If this 
property includes a value, then it overrides the value in the 
Container Web Page property of an application.

Default Applet Focus Specifies the applet that Siebel CRM highlights the first time it 
displays this view. If this property is empty, then it highlights the 
first applet that it displays in this view, starting at the upper left 
corner of this view.

Disable PDQ If TRUE, then Siebel CRM does not allow the user to create a default 
predefined query (PDQ).

Drop Sectors (R)(H) Specifies the pair of sectors that Siebel CRM drops in six sector 
mode for any resolution that is less than 1024 by 768. You can use 
one of the following values:

■ 0and4

■ 1and5

■ 2and6

■ 3and7

Explicit Logon (O) If TRUE, then the user must explicitly log in through the logon Web 
page to view this view.

Help Identifier (O) Specifies a topic name for context-sensitive help. This name is a 
string that includes all uppercase characters and no empty space. 
For example:

ID_VIEW_OPPORTUNITY_LIST

HTML Bitmap (O) Specifies the icon that Siebel CRM displays as a link to this view.
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HTML Popup Dimension (O) Specifies the dimensions of the pop-up window, in pixels. The value 
for this property must include a lowercase x and no spaces. For 
example:

640x480

Name (R) Specifies the name of this view. Objects use this name to reference 
this view.

No Borders (O)(H) If TRUE, then Siebel CRM does not display borders around the 
applets that this view displays.

Sector0 Applet (R)(H) Specifies the applet that Siebel CRM displays in sector 0 of this 
view.

Sector1 Applet (R)(H) Specifies the applet that Siebel CRM displays in sector 1 of this 
view.

Sector2 Applet (R)(H) Specifies the applet that Siebel CRM displays in sector 2 of this 
view.

Sector3 Applet (R)(H) Specifies the applet that Siebel CRM displays in sector 3 of this 
view.

Sector4 Applet (R)(H) Specifies the applet that Siebel CRM displays in sector 4 of this 
view.

Sector5 Applet (R)(H) Specifies the applet that Siebel CRM displays in sector 5 of this 
view.

Sector6 Applet (R)(H) Specifies the applet that Siebel CRM displays in sector 6 of this 
view.

Sector7 Applet (R)(H) Specifies the applet that Siebel CRM displays in sector 7 of this 
view.

Secure (O) If TRUE, then the Siebel Web Engine does the following:

■ Specifies the HTTPS protocol for all URLs that it creates to this 
view.

■ Verifies that the current request uses the HTTPS protocol. This 
configuration prevents a user from typing HTTP instead of 
HTTPS in the URL window of the browser to access a secure 
view.

The browser and the Web server handle HTTPS. The Siebel Web 
Engine only specifies to use HTTPS for a view. You must make sure 
HTTPS is enabled on any server that Siebel CRM expects to provide 
a secure view.

Status Text (O)(H) Not used.

Task Specifies the default task that this view uses.

Table 205. Properties of the View

Property Description



Siebel Object Types Reference ■ View Object Types

Siebel Object Types Reference Siebel 2018 281

Text Style (O)(H) Specifies the text style that Siebel CRM uses by default for all 
controls in the applets that this view uses. Siebel CRM uses this text 
style only if the control or applet does not explicitly specify a text 
style.

Thread Applet (O) Specifies the name of an applet. A field in this applet provides the 
data that Siebel CRM uses as part of the thread title. The Thread 
Field property identifies this field.

Thread Field (O) Specifies the name of the field of the thread applet. This field 
provides the data that Siebel CRM uses as part of the thread title.

Thread Title (O) Specifies the text that Siebel CRM uses for the thread title label.

Title (O) Specifies the browser history that Siebel CRM uses to display the 
names of views that the user has accessed. Siebel CRM uses this 
history if the user clicks the browser Back or Forward button.

Vertical Line Position 
(O)(H)

Specifies the position that Siebel CRM uses when it displays a 
dividing line between applets in sectors 0 to 3 and applets in sectors 
4 to 7. The Vertical Line Position property can include a value 
between 0 and 12, where:

■ 0. Positions the vertical line to the extreme left.

■ 12. Positions the vertical line to the extreme right.

■ 6. Positions the vertical line in the middle.

The default value is 6.

This property is useful for a view that contains a tree applet that 
must occupy only about one-third of the width of the area that the 
user can view. In this situation, it is recommended that you set the 
Vertical Line Position property to a value of 4 through 8. If you do 
not, then Siebel CRM might stretch or compress an applet to such 
an extent that it is difficult to view.

Table 205. Properties of the View

Property Description
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Setting the Admin Mode Flag Property of a View
The Account Administration view, Opportunity Administration view, and Product Administration view 
are examples of Admin mode views. If the Admin Mode Flag Property is TRUE, then Siebel CRM uses 
this view in Admin mode. It does the following:

■ Ignores any insert or update visibility rules that exist for this view. You set the Admin Mode Flag 
to TRUE only for an administrative view.

■ If pop-up visibility is set for the business component that provides data to this view, then Siebel 
CRM uses this pop-up visibility.

■ Ignores the visibility type for the business component unless this type is Organization.

■ Ignores any no insert, no merge, and no update settings that exist on a business component that 
provides data to this view. Admin mode does not affect these restrictions that are set on the 
applet or if the Read Only property of a field is TRUE.

■ Allows the user to display every record, even if no primary team member is set for a record. This 
visibility is different from All visibility where Siebel CRM only displays records that include a 
primary team member.

If the Admin Mode property is TRUE, then a conflict might occur in the following situations:

■ Visibility is configured on a multivalue link or multivalue field on the business component that 
provides data to this view.

■ The Force Active property is set on this business component or on this multivalue field.

Visibility Applet (O) Specifies the applet in this view that controls visibility. Typically this 
applet is one of the following:

■ The list applet in a list-form view.

■ The master applet in a master-detail view.

You must set the Visibility Applet property to the master applet of 
this view. 

For more information, see “Setting the Visibility Applet Properties of 
a View” on page 283.

Visibility Applet Type (O) Specifies the visibility mode that Siebel CRM applies to the applet 
that the Visibility Applet property specifies. The Applet Visibility 
Type property of the view Web template overrides the Visibility 
Applet Type property. For more information, see “Setting the 
Visibility Applet Properties of a View” on page 283.

Table 205. Properties of the View

Property Description
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Setting the Visibility Applet Properties of a View
If the user uses the Show drop-down list to navigate between views, and if the settings for the 
Visibility Applet property and the Visibility Applet Type property are different between these views, 
and if the configuration of the business components and the search specifications is consistent 
between these views, then Siebel CRM keeps the query context and record focus from the previous 
view.

If the user uses the Site Map or the Screen Tabs to navigate between views, and if the settings for 
the Visibility Applet property and the Visibility Applet Type property are different between these 
views, then Siebel CRM applies the most restrictive visibility configuration. In this situation, it 
typically uses the Personal or Sales Rep visibility, depending on the visibility settings of the business 
component and the Thread Applet property of the view.

View Locale
A view locale defines language overrides that Siebel CRM uses with a view.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > View > View Locale

Table 206 describes properties that Siebel CRM uses with a view locale.

Table 206. Properties of the View Locale

Property Description

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Status Text (O) (H) Not used.
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View Task Group
A view task group lists task groups and child tasks in the Task Pane. For more information, see Siebel 
Business Process Framework: Task UI Guide. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > View > View Task Group

Table 207 describes properties that Siebel CRM uses with a view task group.

Thread Title (O) Specifies the text that Siebel CRM displays as the thread title label.

Title (O) Specifies the text string that Siebel CRM displays in the title bar. 
Siebel CRM applies a prefix to this title depending on the following 
settings in the application configuration file:

■ The CaptionPrefix parameter specifies a prefix. Siebel 
CRM uses this prefix. 

■ The CaptionPrefix parameter does not specify a value. It 
uses the value that the ApplicationTitle parameter specifies. 

■ The CaptionPrefix parameter and the ApplicationTitle 
parameter do not specify a value. It uses the following value 
as the prefix text:

Siebel applications

For example, If the value of the Title property is My Accounts, and 
if the prefix text is Siebel Sales, and if this view is active, then 
Siebel CRM displays the following text in the title bar:

Siebel Sales - My Accounts

Table 207. Properties of the View Task Group

Property Description

Application Specifies the Siebel Business Application where Siebel CRM displays 
this task group. If empty, then Siebel CRM displays this task group 
for any application.

Sequence Specifies the order that Siebel CRM uses to display task groups in 
the Task Pane. This value is a number. 

Table 206. Properties of the View Locale

Property Description
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View Task Group Locale
A view task group locale defines language overrides that Siebel CRM uses with a view task group.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > View > View Task Group > View Task Group Locale

Table 208 describes properties that Siebel CRM uses with a view task group locale.

View User Prop (H)
A view user prop sends a value to the C++ code that implements specialized view configuration. 
Siebel CRM persists the value that you configure for a user property in the Siebel runtime repository. 
For more information, see “Object Types That You Must Not Modify” on page 18.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > View > View User Prop

Table 209 describes properties that Siebel CRM uses with a view user prop.

View Web Template
A view web template defines the layout of the applets in the view.

This object type occurs in the following location in the object hierarchy:

Table 208. Properties of the View Task Group Locale

Property Description

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Sequence (O) Specifies the name that Siebel CRM displays for a view task group 
for a language.

Task Group Specifies the task group that Siebel CRM displays in the Task Pane 
for this view.

Table 209. Properties of the View User Prop

Property Description

Name For Oracle use only.

Value For Oracle use only.
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■ Siebel Objects > View > View Web Template

Table 210 describes properties that Siebel CRM uses with a view web template.

View Web Template Item
A view web template item maps applet controls to placeholder IDs in the web template.

Used by the Siebel Web Engine to map swe:applet tag to applets.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > View > View Web Template > View Web Template Item

Table 211 describes properties that Siebel CRM uses with a view web template item.

Table 210. Properties of the View Web Template

Property Description

Name (R) Specifies the name of the view web template.

User Layout (O) If TRUE, then the user can modify the layout in the view.

Web Template (R) Specifies the web template that Siebel CRM uses to display the 
view.

Table 211. Properties of the View Web Template Item

Property Description

Applet (R) Specifies the name of the applet that Siebel CRM maps to the ID.

Applet Mode (O) Specifies the applet mode. You can use one of the following values:

■ Base

■ Edit

■ Edit List

■ Query

Applet Visibility Type (O) Specifies the applet visibility. This property overrides the Visibility 
Applet Type property of the view.

Display Size (O) Specifies to minimize or maximize the applet. If the Display Size 
property is Always Maximized, then the user cannot minimize the 
applet. Siebel CRM typically uses this property with an applet that 
it displays on a home page.
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Display Visibility (O) Specifies if the applet is visible or hidden. If the Display Visibility 
property is Always Show, then the user cannot hide the applet. 
Siebel CRM typically uses this property with an applet that it 
displays on a home page.

Expression Specifies how to limit the way Siebel CRM displays a control in a 
Siebel Business Application. It is similar to a search specification or 
query condition. The Expression property is typically empty and 
Siebel CRM does limit how it displays the control. For more 
information, see the topic about application mappings in 
Configuring Siebel Business Applications. 

Item Identifier (R) Specifies the ID of the swe:applet tag in the Web Template.

Item Identifier - Language 
Override (O)

Specifies the ID of the swe:applet tag in the web template if a 
language or locale is active.

Move Range (O) Specifies how far the user can move an applet. For example, 
assume the following:

■ An application home page includes two columns. 

■ The first applet uses the Column1 move range.

■ The second applet uses the Column2 move range. 

In this situation, the user can do the following:

■ Move any applet that uses the Column1 move range only in the 
first column.

■ Move any applet that uses the Column2 move range only in the 
second column.

If the Move Range property is empty, then the user cannot move 
the applet. For example, the Move Range property that Siebel CRM 
uses for the salutation applet on the home page is typically empty.

Name (R) Specifies the name of this view web template item.

Namespace (O) Specifies the qualifier that Siebel CRM uses for the item identifier. 
For example, if the swe:applet tag that Siebel CRM uses for this 
mapping resides in a swe:idgroup tag, then the Namespace 
property specifies the ID of the idgroup tag.

Namespace - Language 
Override (O)

Specifies the qualifier for the item identifier if a language or locale 
is active.

Position (O) Specifies the hierarchical relationship that Siebel CRM uses 
between the applets in the view.

Table 211. Properties of the View Web Template Item

Property Description
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View Web Template Item Locale
A view web template item locale defines the language override that Siebel CRM uses with a view web 
template item.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > View > View Web Template > View Web Template Item > View Web Template Item 
Locale

Table 212 describes properties that Siebel CRM uses with a view web template item locale.

Web Page Object Types
This topic describes the Web Page object type and object types that are children of this object type. 
It includes the following topics:

■ Web Page on page 288

■ Web Page Item on page 289

■ Web Page Item Locale on page 290

■ Web Page Item Parameter on page 290

■ Web Page Locale (H) on page 291

Web Page
A web page specifies the web page that Siebel CRM uses as a container for a view.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Web Page

Table 213 describes properties that Siebel CRM uses with a web page.

Table 212. Properties of the View Web Template Item Locale

Property Description

Item Identifier (O) Specifies the ID of the swe:applet tag in the web template.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses.

Namespace (O) Specifies the qualifier that Siebel CRM uses for the item identifier. 
For example, if the swe:applet tag that Siebel CRM uses for this 
mapping resides in a swe:idgroup tag, then the Namespace 
property specifies the ID of the idgroup tag.
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Web Page Item
A web page item identifies the object that Siebel CRM displays on a web page. It is similar to a control 
in an applet but Siebel CRM uses it outside the context of an applet on a Web page. Siebel CRM maps 
a web page item to a swe:pageitem tag in the Web page.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Web Page > Web Page Item

Table 214 describes properties that Siebel CRM uses with a web page item.

Table 213. Properties of the Web Page

Property Description

Do Not Use Container (O) You can use one of the following values:

■ TRUE. Display the template file for this page with the 
applications container web page.

■ FALSE. Display the template file for this page without the 
applications container web page.

Name (R) Specifies the name of the web page.

Title Not used.

Web Template (R) Specifies the name of the web template that Siebel CRM associates 
with this Web page.

Table 214. Properties of the Web Page Item

Property Description 

Caption (O) Specifies the display name of this web page item.

HTML Attributes (O) Specifies to add HTML tag attributes to the HTML tags that the client 
creates to display the web page item.

Item Identifier (R) Specifies the ID of the swe:pageitem tag.

Item Identifier - Language 
Override (O)

Specifies the ID of the swe:pageitem tag if a language or locale is 
active.

Method Invoked (O) Specifies the method that Siebel CRM calls.

Name (R) Specifies the name of the web page item.

Namespace (O) Specifies the qualifier that Siebel CRM uses for the item identifier. 
For example, if the swe:pageitem tag that Siebel CRM uses for this 
mapping resides in a swe:idgroup tag, then the Namespace 
property specifies the ID of the idgroup tag.
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Web Page Item Locale
A web page item locale defines language overrides that Siebel CRM uses with a web page item.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Web Page > Web Page Item > Web Page Item Locale

Table 215 describes properties that Siebel CRM uses with a web page item locale.

Web Page Item Parameter
A web page item parameter varies depending on the web page item. For example, if the Method 
Invoked property of a web page item is GoToView, then the web page item parameter identifies a 
view and the value is the name of this view.

This object type occurs in the following location in the object hierarchy:

Namespace - Language 
Override (O)

Specifies the qualifier for the item identifier if a language or locale 
is active.

Show Popup (O) You can use one of the following values:

■ TRUE. Open a browser window before calling the method.

■ FALSE. Call the method before opening a browser window.

Target View Frame (O) Specifies the HTML page that Siebel CRM loads into the frame that 
the Target View Frame property specifies.

Type (R) Specifies how to display this web page item on the HTML page.

Table 215. Properties of the Web Page Item Locale

Property Description

Caption (O) Specifies the display name of this web page item.

Item Identifier (O) Specifies the ID of the swe:pageitem tag.

Name (R) Specifies the abbreviation for the language that the Siebel Business 
Application uses. For example:

ENU

Namespace (O) Specifies the qualifier that Siebel CRM uses for the item identifier. 
For example, if the swe:pageitem tag that Siebel CRM uses for this 
mapping resides in a swe:idgroup tag, then the Namespace 
property specifies the ID of the idgroup tag.

Table 214. Properties of the Web Page Item

Property Description 
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■ Siebel Objects > Web Page > Web Page Item > Web Page Item Parameter

Table 216 describes properties that Siebel CRM uses with a web page item parameter.

Web Page Locale (H)
A web page locale defines language overrides that Siebel CRM uses with a web page.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Web Page > Web Page Locale

Table 217 describes properties that Siebel CRM uses with a web page locale.

Web Template
A web template defines a repository description that Siebel CRM uses for the Web template. Other 
objects that use a web template reference the web template name. Applets, views, and web pages 
are examples of these objects.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Web Template

Table 218 describes properties that Siebel CRM uses with a web template.

Table 216. Properties of the Web Page Item Parameter

Property Description

Name (R) Specifies the name of the web page item parameter.

Value (R) Specifies the value of the web page item parameter.

Table 217. Properties of the Web Page Locale

Property Description

Name (R) Specifies the name of the object. 

Title (O) Specifies the text that Siebel CRM uses for the title of the Web page 
for a language.
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Workflow Policy Column Object Type
This topic describes the Workflow Policy Column object type.

Workflow Policy Column
A workflow policy column identifies a column that Siebel CRM monitors in the Siebel database or an 
extension column. It also specifies the picklist that Siebel CRM uses for this column. One or more 
workflow processes can use the same workflow policy column. It is recommended that you do not 
modify any property of a predefined workflow policy column. If your implementation requires 
customization, then you can add a new workflow policy column. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Policy Column

Table 219 describes properties that Siebel CRM uses with a workflow policy column.

Table 218. Properties of the Web Template

Property Description

Name (R) Specifies the name of the web template.

Type (R) Specifies the web template type.

Table 219. Properties of the Workflow Policy Column

Property Description

Applet (O) Specifies the pick applet that Siebel CRM uses to display the picklist 
in the Workflow Policies view.

Column Name (R) Specifies the name of a column from the picklist of columns that 
exist in the table that the Table Name property specifies.

Name (R) Specifies the name of this workflow policy column. Siebel CRM 
displays this name in the Conditions list in the Workflow Policies 
view.

PickList (O) Specifies the picklist that Siebel CRM displays in the Workflow Policy 
Detail view for this column. The user who creates the policy uses 
this picklist to choose the comparison value for this workflow policy 
column. For more information, see Configuring Siebel Business 
Applications.
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Workflow Policy Object Types
This topic describes the Workflow Policy object type and object types that are children of this object 
type. It includes the following topics:

■ Assignment Object on page 293

■ Assignment Object Extension on page 308

■ Assignment User Prop on page 310

■ Dynamic Candidate (H) on page 311

■ Dynamic Candidate Attribute (H) on page 312

■ Dynamic Candidate Component (H) on page 312

■ Dynamic Candidate Component Col (H) on page 313

■ Dynamic Candidate Locale (H) on page 314

■ Dynamic Drilldown Destination on page 314

■ Workflow Policy Component on page 315

■ Workflow Policy Component Col on page 317

■ Workflow Policy Object on page 317

Assignment Object
An assignment object does the following:

■ Specifies how to assign a business entity to a candidate

■ Specifies how to update Siebel CRM data to complete an assignment 

■ Specifies other assignment arguments 

A workflow policy object includes column mappings in child workflow policy components and 
grandchild workflow policy component columns. An assignment attribute column can specify these 
mappings. It does this to determine if a match exists between a candidate and a business entity. It 
also monitors values that Siebel CRM modifies so that Siebel CRM can do a dynamic assignment.

Source Field (O) Specifies the business component field of the picklist that provides 
the source for the comparison value. This is a field name that 
resides in the picklist that the PickList property specifies.

Table Name (R) Specifies the name of the Siebel database table that contains this 
workflow policy column.

Table 219. Properties of the Workflow Policy Column

Property Description
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You must check in modifications you make. For more information, see “Checking In Assignment 
Objects” on page 104.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Policy Object > Assignment Object

Table 220 describes properties that Siebel CRM uses with an assignment object. Siebel Tools uses 
different labels for some assignment object properties. Table 220 includes only the label that displays 
in the Properties Window. For more information, see “How Siebel Tools Uses Different Labels for 
Assignment Object Properties” on page 306.

Table 220. Properties of the Assignment Object

Property Description

Add Team Members (O) You can use one of the following values:

■ TRUE. Assignment Manager deletes existing team members 
from the teams and existing assignment rules in the assignment 
rule intersection table that no longer qualify.

■ FALSE. Assignment Manager never deletes existing team 
members from the assignment object even if they no longer 
qualify.

Assignment Date Column 
(O)

Specifies the datetime stamp Siebel CRM uses to indicate the last 
time it assigned a record. This property can contain only the 
following value:

ASGN_DT

Assignment Mode (O) Determines how Assignment Manager assigns an object according 
to organization or person. You can use one of the following values:

■ Independent. Assigns any person and organization regardless 
of if a relationship exists between this person and organization.

■ Person-Oriented. Assigns a person and then assigns only 
organizations to which this person belongs.

■ Organization-Oriented. Assigns an organization and then 
assigns a person who belongs in this organization.

■ Organization and Person-Oriented. Identifies all qualified 
people and all qualified organizations. It then assigns a person 
and an organization only if a relationship exists between this 
person and the organization.
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Assignment Scoring Mode 
(R)

Specifies the mode that Siebel CRM uses to determine an 
assignment. You can use one of the following values:

■ Person-based. Set the assignment rule score to the score of 
the highest-scoring candidate. This is the default value.

■ Organization-based. Set the assignment rule score to the 
score of the highest-scoring organization.

Auto Reassign (R) You can use one of the following values:

■ TRUE. Assignment Manager automatically reassigns 
assignment objects if assignment attribute values are modified 
and if policies are defined. This is the default value.

■ FALSE. Assignment Manager does not automatically reassign 
assignment objects.

If the Generate Triggers server component creates triggers for the 
active assignment policy, and if the Auto Reassign property is 
FALSE, then it does not create any triggers for the update. 
Assignment occurs only one time when Siebel CRM inserts the 
record. If you modify this property after you run a Generate 
Triggers server component job, then you must regenerate triggers.

Calendar Activity Additional 
Fields (O)

Specifies a string that Siebel CRM uses for an activity that it assigns 
according to availability. This string uses the following format:

parent field, field 1, value1, field 2, value2

For example, you can specify the following fields for the Service 
Request object:

■ Activity SR Id

■ Type

■ ToDo

If the user creates a new activity, then Siebel CRM uses these field 
values for this new activity. 

For more information about assignments that Siebel CRM makes 
according to availability, see Siebel Assignment Manager 
Administration Guide.

Table 220. Properties of the Assignment Object

Property Description
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Calendar Create Activity (O) If Siebel CRM assigns an object according to availability, then you 
can use one of the following values:

■ TRUE. Assignment Manager can create an activity in an 
employee calendar.

■ FALSE. Assignment Manager cannot create an activity in an 
employee calendar. FALSE is the default value.

Siebel CRM assigns an object differently depending on if the object 
is an activity:

■ An Activity. If an assignment rule qualifies an employee, and 
if the Check Employee Calendar property of this assignment 
rule includes a check mark, and if no other employee qualifies 
for this assignment rule, then Siebel CRM reuses the same 
activity.

■ Not an activity. Siebel CRM creates a new activity for each 
employee who qualifies. It sets the parent activity for all 
activities to the original activity Id. 

Calendar Duration Column 
(O)

Specifies the column in the assignment object primary table that 
references the object duration. If Siebel CRM assigns an object 
according to availability, then you must specify this property.

Calendar Early Start Time 
Column (O)

Specifies the column in the assignment object primary table that 
references the early start time of the object. 

This column contains the earliest date and time that an activity can 
start. The time range from Calendar Early Start Time to Calendar 
Start Time defines the time range that the activity can start.

If you do not specify a value, then the activity can start any time 
before the value that the Calendar Start Time Column property 
contains.

If Siebel CRM assigns an object according to availability, then you 
must specify this property.

Calendar Start Time Column 
(O)

Specifies the column in the assignment object primary table that 
references the start time of the object. 

This column contains the latest time that an activity can start. The 
time range from Calendar Early Start Time to Calendar Start Time 
defines the time range that the activity can start.

If Siebel CRM assigns an object according to availability, then you 
must specify this property.

Table 220. Properties of the Assignment Object

Property Description
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Default Employee (O) Specifies the login ID of the default employee.

Assignment Manager assigns this employee if a conflict occurs and 
it cannot choose the correct set of employees. A conflict occurs if 
no assignment rules match or if two rules qualify with the same 
score.

If you do not specify this property, then Assignment Manager sets 
the owner Id field in the object row to No Match Row Id.

Default Group (O) Not used.

Default Org (O) Specifies the name of the default organization. Assignment 
Manager assigns this organization if a conflict occurs and it cannot 
choose the correct set of organizations. A conflict occurs if no 
assignment rules match or if two rules qualify with the same score.

If you do not specify this property, then Assignment Manager sets 
the owner Id field in the object row to No Match Row Id.

Default Position (O) Specifies the name of the default position. Assignment Manager 
assigns this position if a conflict occurs and it cannot choose the 
correct set of positions. A conflict occurs if no assignment rules 
match or if two rules qualify with the same score.

If you do not specify this property, then Assignment Manager sets 
the owner Id field in the object row to No Match Row Id.

Employee Column (O) Specifies the name of the column in the employee intersection table 
that references rows in the employee table (S_EMPLOYEE). If the 
Employee Table property is not empty, then this property is 
required.

Employee Denorm Column 
(O)

Specifies the name of a column in the employee intersection table. 
This column determines if the Assignment Manager can assign an 
employee in a denormalization program.

Employee Key Column (O) Specifies the name of the column that contains the key values of the 
employees that Siebel CRM assigns to the team at runtime. If the 
UseKeyValue server component parameter is True, then the 
Employee Key Column is required. 

Employee Manual Column 
(O)

Specifies the name of a column in the employee intersection table. 
This column determines if a user can manually assign an employee.

Table 220. Properties of the Assignment Object

Property Description
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Employee Primary Column 
(O)

Specifies the name of a column in the primary table. This column 
contains the primary employee on a team or a single-owner 
employee. A single-owner employee is a type of assignment where 
Assignment Manager can assign only one candidate to an object.

If you specify a value in the Employee Primary Column, and if you 
do not specify a value in the Employee Table, then Siebel CRM 
enables the assignment object for employees in the single-owner 
mode.

If the assignment rule is a single-owner rule, or if the Set Primary 
Employee property is TRUE, then the Employee Primary Column 
property is required.

Employee Primary Column 
List (O)

Specifies a comma-separated list of column names in the employee 
intersection table that Assignment Manager must copy if Siebel 
CRM modifies the primary employee. To copy the old primary 
employee to the new primary employee, Assignment Manager 
copies values from these columns.

Employee Primary Denorm 
Column (O)

Specifies the name of a column in the primary table. This column 
determines if Assignment Manager can assign a primary employee 
in denormalization mode.

If the assignment rule is a single-owner rule, or if the Set Primary 
Employee property is TRUE, then the Employee Primary Denorm 
Column property is required.

Employee Primary Manual 
Column (O)

Specifies the name of a column in the primary table. This column 
determines if a user can manually assign a primary employee.

If the assignment rule is a single-owner rule, or if the Set Primary 
Employee property is TRUE, then the Employee Primary Manual 
Column property is required.

Employee Primary System 
Column (O)

Specifies the name of a column in the primary table. This column 
determines if Assignment Manager can assign a primary employee 
in denormalization mode.

If the assignment rule is a single-owner rule, or if the Set Primary 
Employee property is TRUE, then the Employee Primary System 
Column property is required.

Employee System Column 
(O)

Specifies the name of a column in the employee intersection table. 
This column determines if Assignment Manager can assign an 
employee in non-Denormalization mode. 

If the Employee Table property is not empty, then the Employee 
System Column property is required.

Table 220. Properties of the Assignment Object

Property Description
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Employee Table (O) Specifies the name of the employee intersection table. If 
Assignment Manager can assign the assignment object to multiple 
employees, then this intersection table contains the set of 
employee IDs that it assigns to the assignment object IDs.

If Assignment Manager assigns objects according to team, then the 
Employee Table property is required.

Employee Team Score 
Column (O)

Specifies the name of the column in the team table that contains 
scores for each member of an employee team. This property can 
reference any column that contains a number.

Exclude Column (O) Specifies the name of the lock assignment column in the primary 
table, which is a column in the primary table of the assignment 
object that Siebel CRM can use to prevent Assignment Manager 
from processing some rows.

Most of the assignment object tables include an 
ASGN_USR_EXCLD_FLG column. Siebel CRM displays this column in 
the client as a field named Lock Assignment for some objects. If 
Siebel CRM does not display this column for an assignment object, 
then you can query the Siebel database for the 
ASGN_USR_EXCLD_FLG column in the appropriate table.

You typically set the value for this column through a business 
component, not through Assignment Manager. For example, if the 
user creates a new activity, then Siebel CRM automatically adds a 
check mark in the Lock Assignment checkbox for this activity. The 
user must remove this check mark before Siebel CRM can assign 
this activity.

Group Column (R) Specifies the name of a row ID column in the rule intersection table 
that references rows in the assignment rule table (S_ASGN_GRP).

This column provides a foreign key to the assignment rule table. 
This key uniquely identifies a rule for each relationship between an 
assignment entity and a rule.

If the Rule Table property is not empty, then the Group Column 
property is required.

Group Denorm Column (O) Specifies the name of a column in the rule intersection table. This 
column determines if Assignment Manager can use the assignment 
rule in denormalization mode.

Group Manual Column (O) Specifies the name of a column in the rule intersection table. This 
column determines if a user can manually use the assignment rule.

Table 220. Properties of the Assignment Object

Property Description
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Group Primary Column (O) Specifies the name of a column in the primary table. This column 
contains the primary or single-owner rule.

If the Set Primary Rule property is TRUE, then the Group Primary 
Column property is required.

Group Primary Column List 
(O)

Specifies a comma-separated list of column names in the rule 
intersection table that Assignment Manager copies if Siebel CRM 
modifies the primary rule. It copies values from these columns from 
the old primary rule to the new primary rule.

Group Primary Denorm 
Column (O)

Specifies the name of a column in the primary table. This column 
determines if Assignment Manager can use the primary rule in 
denormalization mode.

If the assignment rule is a single-owner rule, or if the Set Primary 
Group property is TRUE, then the Group Primary Denorm Column 
property is required.

Group Primary Manual 
Column (O)

Specifies the name of a column in the primary table. This column 
determines if a user can manually use the primary rule.

If the assignment rule is a single-owner rule, or if the Set Primary 
Group property is TRUE, then the Group Primary Manual Column 
property is required.

Group Primary System 
Column (O)

Specifies the name of a column in the primary table. This column 
determines if Assignment Manager can assign the primary rule in 
denormalization mode.

If the assignment rule is a single-owner rule, or if the Set Primary 
Group property is TRUE, then the Group Primary System Column 
property is required.

Group System Column (O) Specifies the name of a column in the rule intersection table. This 
column determines if Assignment Manager can assign the rule in 
denormalization mode.

Group Table (O) Specifies the name of the rule intersection table.

Ignore Assignment 
Attributes (R)

You can use one of the following values:

■ TRUE. Assignment Manager ignores assignment criteria that 
are not relevant to the assignment object. For example, if an 
assignment rule specifies Service Request Priority as a 
criterion, and if Assignment Manager assigns opportunities and 
accounts, then it ignores this criterion. Service Request Priority 
is an assignment attribute that is relevant only to a service 
request.

■ FALSE. Assignment Manager evaluates all assignment criteria.

Table 220. Properties of the Assignment Object

Property Description
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Keep Creator (R) You can use one of the following values:

■ TRUE. Assignment Manager cannot delete the creator of the 
assignment object from the team.

■ FALSE. Assignment Manager can delete the creator.

Keep Man Asgn Primary 
Employee (O)

If Assignment Manager assigns an object according to team, then 
you can use one of the following values:

■ TRUE. If the user explicitly sets the primary employee of a 
team, then Assignment Manager does not set this employee. 
Instead, it adds a check mark to the Primary Person Manual 
property of the primary table that the assignment object 
references.

■ FALSE. Assignment Manager sets the primary employee of a 
team.

Keep Man Asgn Primary 
Group (O)

If Assignment Manager assigns an object according to team, then 
you can use one of the following values:

■ TRUE. If the user explicitly sets the primary assignment rule for 
a team, then Assignment Manager does not set this rule. 
Instead, it adds a check mark to the Primary Assignment Rule 
Manual property of the primary table that the assignment 
object references.

■ FALSE. Assignment Manager sets the primary assignment rule 
even if the user already manually assigned it.

Keep Man Asgn Primary Org 
(O)

You can use one of the following values:

■ TRUE. If you define the Org Primary Manual Column property 
for an assignment object, and if the value in the column that 
this property references contains a Y, then Assignment Manager 
does not reassign the primary organization.

■ FALSE. Assignment Manager does examine the Org Primary 
Manual Column property.

Keep Man Asgn Primary 
Position (O)

If Assignment Manager assigns an object according to team, then 
you can use one of the following values:

■ TRUE. If the user explicitly sets the primary position for a team, 
then Assignment Manager does not set this position. Instead, it 
adds a check mark to the Primary Person Manual property of the 
primary table that the assignment object references.

■ FALSE. Assignment Manager sets the primary position.

Table 220. Properties of the Assignment Object

Property Description
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Keep User Assigned (R) If Assignment Manager assigns an object according to a team, then 
you can use one of the following values:

■ TRUE. Assignment Manager keeps manually assigned 
employees, positions, and assignment rules. In this situation, a 
position that a user adds to an account sales team is an 
example of a person. A territory that a user adds to a territory 
list for an opportunity is an example of an assignment rule.

■ FALSE. An automatic assignment operation can replace a 
manually assigned employee, position, or assignment rule.

To determine if a user manually assigned an object, Assignment 
Manager examines the value of the Team Manual Column property.

Max Number Per Role (O) Not used.

Name (R) Specifies the name of the assignment object. This property uniquely 
identifies the assignment object in the repository. It provides the 
name that Siebel CRM displays in the picklist and multivalue group 
applet for assignment rules in administration views.

Org Column (R) Specifies the name of the column in the organization intersection 
table that references rows in the organization table.

If the Org Table property is not empty, then the Org Column is 
required.

Org Denorm Column (O) Specifies the name of a column in the organization intersection 
table. This column determines if Assignment Manager can assign an 
organization in denormalization mode.

Org Key Column Specifies the name of a column. This column contains the key values 
of the organizations that Assignment Manager assigns to the team at 
runtime.

If the UseKeyValue server component parameter is True, then the 
Org Key Column property is required.

Org Manual Column (O) Specifies the name of a column in the organization intersection 
table. This column specifies if the user can manually assign an 
organization.

Table 220. Properties of the Assignment Object

Property Description
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Org Primary Column (O) Specifies the name of a column in the primary table. This column 
contains the primary organization for a team or a single-owner 
organization.

If you specify a value in the Org Primary Column property, and if 
you do not specify a value in the Org Table property, then Siebel 
CRM enables the assignment object for organizations that 
Assignment Manager assigns in single-owner mode.

If the assignment rule is a single-owner rule, or if the Set Primary 
Org property is TRUE, then the Org Primary Column property is 
required.

Org Primary Column List (O) Specifies a comma-separated list of column names in the 
organization intersection table. If Siebel CRM modifies the primary 
organization, then Assignment Manager copies values from these 
columns from the old primary organization to the new primary 
organization.

Org Primary Denorm Column 
(O)

Specifies the name of a column in the primary table. This column 
determines if Assignment Manager can assign the primary 
organization in denormalization mode.

If the assignment rule is a single-owner rule, or if the Set Primary 
Org property is TRUE, then the Org Primary Denorm Column 
property is required.

Org Primary Manual Column 
(O)

Specifies the name of a column in the primary table. This column 
determines if the user can manually assign the primary 
organization.

If the assignment rule is a single-owner rule, or if the Set Primary 
Org property is TRUE, then the Org Primary Manual Column 
property is required.

Org Primary System Column 
(O)

Specifies the name of a column in the primary table. This column 
determines if Assignment Manager can assign the primary 
organization in denormalization mode.

If the assignment rule is a single-owner rule, or if the Org Primary 
System Column property is TRUE, then the Org Primary Manual 
Column property is required.

Org System Column (O) Specifies the name of a column in the organization intersection 
table. This column determines if a user can manually assign an 
organization.

Table 220. Properties of the Assignment Object

Property Description
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Org Table (O) Specifies the name of the organization intersection table. If 
Assignment Manager can assign the assignment object to multiple 
organizations, then this intersection table contains the set of 
organization IDs that it assigns to assignment object IDs.

If Assignment Manager assigns objects according to team, then the 
Org Table property is required.

Org Team Score Column (O) Specifies the name of a column in the team table. This column 
contains scores for each member of an organization team. This 
property can reference any column that can contain a number.

Position Column (R) Specifies the name of a column in the position intersection table. 
This column references rows in the position table (S_POSTN).

If the Position Table property is not empty, then the Position 
Column property is required.

Position Denorm Column 
(O)

Specifies the name of a column in the position intersection table. 
This column determines if the denorm program can assign a 
position. 

If the Position Table property is not empty, then the Position 
Denorm Column property is required.

Position Key Column Specifies the name of a column. This column contains the key values 
of the employees that Assignment Manager assigns to the team at 
runtime.

If the UseKeyValue server component parameter is True, then the 
Position Key Column property is required. 

Position Manual Column (O) Specifies the name of a column in the position intersection table. 
This column determines if the user can manually assign a position.

If the Position Table property is not empty, then the Position Manual 
Column property is required.

Position Primary Column (O) Specifies the name of a column in the primary table. This column 
contains the primary position for teams or it contains a single-
owner position.

If the assignment rule is a single-position rule, or if the Set Primary 
Position property is TRUE, then the Position Primary Column 
property is required.

Position Primary Column List 
(O)

Specifies a comma-separated list of column names in the position 
intersection table. If Siebel CRM modifies the primary position, then 
Assignment Manager copies values from these columns from the old 
primary position to the new primary position. 

Table 220. Properties of the Assignment Object

Property Description
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Position Primary Denorm 
Column (O)

Specifies the name of a column in the primary table. This column 
determines if the denorm program assigns the primary position.

If the assignment rule is a single-position rule, or if the Set Primary 
Position property is TRUE, then the Position Primary Denorm 
Column property is required.

Position Primary Manual 
Column (O)

Specifies the name of a column in the primary table. This column 
determines if the user can manually assign a primary position.

If the assignment rule is a single-position rule, or if the Set Primary 
Position property is TRUE, then the Position Primary Manual Column 
property is required.

Position Primary System 
Column (O)

Specifies the name of a column in the primary table. This column 
determines if Siebel CRM assigns the primary position.

If the assignment rule is a single-position rule, or if the Set Primary 
Position property is TRUE, then the Position Primary System 
Column property is required.

Position System Column (O) Specifies the name of a column in the position intersection table. 
This column determines if Siebel CRM assigns a position.

This property is required if the Position Table property is not empty.

Position Table (O) Specifies the name of the position intersection table. If Assignment 
Manager can assign the assignment object to multiple positions, 
then this intersection table column contains the set of position IDs 
that it assigns to the assignment object IDs.

If Assignment Manager assigns objects according to a team, then 
the Position Table property is required.

Position Team Score Column 
(O)

Specifies the name of a column in the team table. This column 
contains scores for each member of a position team. This property 
can reference any column that can contain a number.

Primary Table (R) Specifies the name of a primary table. The business component 
references this table. For example, S_ORG_EXT is the primary table 
for the Account assignment object.

Set Primary Employee (O) Specifies the primary employee. This employee is typically the 
employee who possesses the highest score in the assignment rule 
that possesses the highest score. You can use one of the following 
values:

■ TRUE. Assignment Manager chooses and sets the primary 
employee.

■ FALSE. Assignment Manager does not choose and set the 
primary employee.

Table 220. Properties of the Assignment Object

Property Description



Siebel Object Types Reference Siebel 2018

Siebel Object Types Reference ■ Workflow Policy Object Types

306 

How Siebel Tools Uses Different Labels for Assignment Object 
Properties
Table 221 describes how the labels that Siebel Tools displays in the Properties Window are different 
from the labels that it displays for the same property in the Object List Editor.

Set Primary Group (O) Specifies the primary assignment rule. This rule is typically the rule 
that possesses the highest score in the assignment rule. You can 
use one of the following values:

■ TRUE. Assignment Manager chooses and sets the primary 
position.

■ FALSE. Assignment Manager does not choose or set the 
primary position.

Set Primary Org (O) Specifies the primary organization rule. This organization is 
typically the organization that possesses the highest score in the 
assignment rule. You can use one of the following values:

■ TRUE. Assignment Manager chooses and sets the primary 
organization.

■ FALSE. Assignment Manager does not choose or set the 
primary organization.

Set Primary Position (O) Specifies the primary position. This position is typically the position 
that possesses the highest score in the assignment rule. You can 
use one of the following values:

■ TRUE. Assignment Manager chooses and sets the primary 
position.

■ FALSE. Assignment Manager does not choose or set the 
primary position.

Skill Item Table (O) Specifies the name of the skill item table that contains skills for the 
assignment object. This table must be a child table of the table that 
the Skill Table property specifies. The Skill Id column is a foreign 
key column to the skill table.

Skill Table (O) Specifies the name of the table that contains skills for an 
assignment object.

Team You can use one of the following values:

■ TRUE. To determine the assignment criterion, Siebel CRM uses 
a column in the team table.

■ FALSE. To determine the assignment criterion, Siebel CRM 
does not use a column in the team table.

Siebel CRM uses this property for dynamic candidates.

Table 220. Properties of the Assignment Object

Property Description
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Table 221. How Siebel Tools Uses Different Labels for Assignment Object Properties

Label in the Properties 
Window Label in the Object List Editor

Add Team Members Replace Team Members

Default Org Default Organization

Employee Denorm Column Employee Team Denorm Column

Employee Manual Column Employee Team Manual Column

Employee Primary Column 
List 

Employee Team Copy Columns

Employee System Column Employee Team System Column

Exclude Column Lock Assignment Column

Group Column Rule Column

Group Denorm Column Rule Team Denorm Column

Group Manual Column Rule Team Manual Column 

Group Primary Column Rule Primary Column

Group Primary Column List Rule Team Copy Columns

Group Primary Denorm 
Column 

Rule Primary Denorm Column

Group Primary Manual 
Column 

Rule Primary Manual Column

Group Primary System 
Column 

Rule Primary System Column

Group System Column Rule Team System Column

Group Table Rule Table

Ignore Assignment 
Attributes

Ignore Extra Attributes

Keep Man Asgn Primary 
Employee 

Keep Manual Primary Employee

Keep Man Asgn Primary 
Group 

Keep Manual Primary Rule

Keep Man Asgn Primary 
Position 

Keep Manual Primary Position

Keep User Assigned Keep Manual Assigned

Org Column Organization Column

Org Table Organization Table
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Assignment Object Extension
An assignment object extension identifies the columns that Siebel CRM uses to determine the 
following items:

■ Candidates it adds or drops

■ Tables it uses for reporting

■ Column it uses as the key column

■ Columns it use for the position, employee, or organization

An assignment object extension contains the results tables. It does this only if Siebel CRM runs in 
reporting mode. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Policy Object > Assignment Object Extension

Table 222 describes properties that Siebel CRM uses with an assignment object extension.

Position Denorm Column Position Team Denorm Column

Position Manual Column Position Team Manual Column

Position Primary Column List Position Team Copy Columns

Position System Column Position Team System Column

Set Primary Group Set Primary Rule

Table 222. Properties of the Assignment Object Extension

Property Description

Employee Reporting Column 
(O)

Specifies the name of the column in the employee reporting 
intersection table that references rows in the employee table.

If the Employee Table property is not empty then the Employee 
Reporting Column property is required.

Employee Reporting 
Deletion Column

Specifies the column that contains data about the employees that 
Siebel CRM removes from a team. This property applies only in 
snapshot mode or delta reporting mode.

Employee Reporting 
Insertion Column

Specifies the column that contains data about the employees that 
Siebel CRM adds to a team. This property applies only in snapshot 
mode or delta reporting mode.

Table 221. How Siebel Tools Uses Different Labels for Assignment Object Properties

Label in the Properties 
Window Label in the Object List Editor
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Employee Reporting Key 
Column (O) 

Specifies the column that contains the key values of the employees 
that Siebel CRM assigns to a team at runtime. 

If the UseKeyValue server component parameter is TRUE, then the 
Employee Reporting Key Column property is required. 

Employee Reporting Table 
(O)

Specifies the name of the employee reporting intersection table. If 
Siebel CRM can assign the assignment object to multiple 
employees, then this intersection table contains the set of 
employee IDs that it assigns to the assignment object IDs.

Name (R) Specifies the name of the assignment object extension. This name 
must match the name of the assignment object.

Org Reporting Column (O) Specifies the column in the organization reporting intersection table 
that references rows in the organization table.

If the Organization Table property is not empty, then the Org 
Reporting Column property is required.

Org Reporting Deletion 
Column

Specifies the column that Siebel CRM uses to save data about the 
organizations that it removes from a team. This property applies 
only in snapshot mode or delta reporting mode.

Org Reporting Insertion 
Column

Specifies the column that contains data about organizations that 
Siebel CRM adds to a team. This property applies only in snapshot 
mode or delta reporting mode.

Org Reporting Key Column 
(O)

Specifies the column that contains the key values of the 
organizations that Siebel CRM assigns to a team at runtime. 

If you specify this property, then you must set the UseKeyValue 
server component parameter to True.

Org Reporting Table (O) Specifies the name of the organization reporting intersection table. 
If Siebel CRM can assign the assignment object to multiple 
organizations, then this intersection table contains the set of 
organization IDs that it assigns to the assignment object IDs.

Position Reporting Column 
(O)

Specifies the column in the position reporting intersection table that 
references rows in the position table.

If the Position Table property is not empty, then the Position 
Reporting Column property is required.

Position Reporting Deletion 
Column

Specifies the column that identifies the positions that Siebel CRM 
removes from a team. This property applies only in snapshot mode 
or delta reporting mode.

Position Reporting Insertion 
Column

Specifies the column that Marks the positions that are added to the 
team. This property applies only in snapshot mode or delta 
reporting mode.

Table 222. Properties of the Assignment Object Extension

Property Description
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Assignment User Prop
An assignment user prop sends a property value to the C++ code that implements specialized 
configuration. Siebel CRM persists the value that you configure for a user property in the Siebel 
runtime repository.

You can use the following types of assignment user properties:

■ PositionTeamDenormN, where N is any number. If Siebel CRM replaces one position with 
another position from the same rule, then you can use a PositionTeamDenormN property to copy 
additional columns. For example, you must replace an existing sales representative on an 
account team with another representative. For more information, see the topic about configuring 
an assignment object to copy additional columns to the team table in Siebel Assignment Manager 
Administration Guide.

■ User properties for assignment according to availability. For more information, see Siebel 
Assignment Manager Administration Guide.

A Column user property takes precedence over a corresponding Value user property. For example, 
if you define a Breakable Flag Column user property and a Breakable Flag Value user property, then 
the Breakable Flag Column user property takes precedence. Assignment Manager uses the following 
order of precedence:

1 Column user property

2 Value user property

3 Calendar Activity Additional Fields property

For more information, see “Object Types That You Must Not Modify” on page 18.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Policy Object > Assignment Object > Assignment User Prop

Table 223 describes properties that Siebel CRM uses with an assignment user prop.

Position Reporting Key 
Column (O)

Specifies the column that contains the key values of the positions 
that Siebel CRM assigns to a team at runtime. 

If you specify this property, then you must set the UseKeyValue 
server component parameter to True.

Position Reporting Table (O) Specifies the name of the position reporting intersection table. If 
Siebel CRM can assign the assignment object to multiple positions, 
then this intersection table contains the set of position IDs that it 
assigns to the assignment object IDs.

Table 222. Properties of the Assignment Object Extension

Property Description
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Dynamic Candidate (H)
A dynamic candidate defines employee, position, and organization candidates for an assignment rule 
that Siebel CRM dynamically specifies from an attribute on the object.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Policy Object > Assignment Object > Dynamic Candidate 

Table 224 describes properties that Siebel CRM uses with a dynamic candidate.

Table 223. Properties of the Assignment User Prop

Property Description

Name Specifies the name of the user property.

Value (R) Specifies the value of the user property.

Table 224. Properties of the Dynamic Candidate

Property Description

Attribute Id Column Not used.

Attribute Table Not used.

Display Name (O) Specifies the display name for the dynamic candidate.

The symbolic string must be created before setting the display 
name.

Name Specifies the name for this object.

Object Id Column Not used.

Score Column Not used.

Team Table Not used.

Team Table Attribute Id 
Column

Not used.

Team Table Candidate Id 
Column

Not used.

Team Type Specifies the candidate team to use employee, organization, or 
position.
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Dynamic Candidate Attribute (H) 
A dynamic candidate attribute applies to Siebel CRM versions earlier than version 7.8. For version 
7.8 and later, see “Dynamic Candidate Component (H)” on page 312 and “Dynamic Candidate 
Component Col (H)” on page 313.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Assignment Object > Dynamic Candidate (H) > Dynamic Candidate Attribute

Table 225 describes properties that Siebel CRM uses with a dynamic candidate attribute.

Dynamic Candidate Component (H)
A dynamic candidate component defines a list of joins from the assignment object to the candidate 
table.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Policy Object > Assignment Object > Dynamic Candidate (H) > Dynamic 
Candidate Component 

Table 226 describes properties that Siebel CRM uses with a dynamic candidate component.

Table 225. Properties of the Dynamic Candidate Attribute

Property Description

Assignment Criterion Not used.

Team Attribute Column Not used.

Table 226. Properties of the Dynamic Candidate Component

Property Description

Additional Join Spec Specifies an additional join.

Candidate Id Column Specifies the column in the Team table that contains the Id of the 
candidate employee, position, or organization.

Candidate Table Specifies to use the name of the source table that occurs at the last 
level of a join. If Candidate Table is TRUE, then the Candidate Id 
Column property is required.

This property was named Team Table in Siebel CRM versions prior 
to version 7.8.
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Dynamic Candidate Component Col (H)
A dynamic candidate component col maps columns in a source table at a level in a join to an 
assignment according to team criterion.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Policy Object > Assignment Object > Dynamic Candidate (H) > Dynamic 
Candidate Component (H) > Dynamic Candidate Component Col 

Table 227 describes properties that Siebel CRM uses with a dynamic candidate component col.

Primary This property can include one of the following values:

■ TRUE. Siebel CRM uses the primary table for the join. The 
primary table is the table that contains the assignment object. 
For example, assume a record in the S_ORG_EXT table is 
marked as the primary for an account, contact, and position 
dynamic candidate. In this situation, Assignment Manager 
determines that Siebel CRM must use the S_ORG_EXT table as 
the first table in the join.

■ FALSE. The Target Column Name property and the Target 
Component Name property are required.

Score Column Specifies the column in the Team table that contains the scores of 
the candidates.

Source Column Name (R) Specifies the column in the source table that relates to another 
dynamic candidate component.

Source Table Name (R) Specifies the table that the dynamic candidate component 
references.

Target Column Name Specifies the column in the target component that maintains a 
relationship with the column in the source column of the source 
table for this record. When Siebel CRM creates the SQL code, the 
inner join source table that the source column references on the 
source table equals the target column of the source table from the 
target component.

Target Component Name Specifies the target dynamic candidate component that joins to the 
source table in this dynamic candidate component.

Table 226. Properties of the Dynamic Candidate Component

Property Description
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Dynamic Candidate Locale (H)
A dynamic candidate locale defines language overrides that Siebel CRM uses with a dynamic 
candidate.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Policy Object > Assignment Object > Dynamic Candidate (H) > Dynamic 
Candidate Locale

Table 228 describes properties that Siebel CRM uses with a dynamic candidate locale.

Dynamic Drilldown Destination
A dynamic drilldown destination configures dynamic drilldown configuration for a drilldown field and 
the corresponding list column or control.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Applet > Drilldown Object > Dynamic Drilldown Destination

Table 229 describes properties that Siebel CRM uses with a dynamic drilldown destination.

Table 227. Properties of the Dynamic Candidate Component Col

Property Description

Assignment Criteria 
Attribute Name

Specifies the name of the assignment criteria attribute that Siebel 
CRM compares to the value in the Attribute Column Name property.

Assignment Criteria Name Specifies the name of the assignment criteria. If you set the 
Assignment Criteria Attribute Name property, then Siebel CRM 
automatically populates the Assignment Criteria Name property.

Attribute Column Name (R) Specifies the name of the column in the source table.

Copy Column Name Specifies the name of the column stamped on the team table if 
working in operational mode.

Reporting Copy Column 
Name

Specifies the name of the column stamped on the name reporting 
table if working in reporting mode.

Table 228. Properties of the Dynamic Candidate Locale

Property Description

Display Name (O) Specifies the display name for the dynamic candidate locale object.
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Differences Between Static and Dynamic Drilldowns
The drilldown object definition in a static drilldown or a dynamic drilldown identifies a drilldown field 
and a view. These properties specify the list column or control that includes drilldown capabilities 
and the destination view if the user clicks the drilldown. In a dynamic drilldown, the drilldown object 
also includes dynamic drilldown destination object definitions. Each of these definitions references 
the Type field in the business component and specifies a value that Siebel CRM uses to examine the 
value in this field. If Siebel CRM finds a match in a dynamic drilldown destination, then it uses a 
different drilldown object that typically resides in a different destination view.

To use a dynamic drilldown, the user must be assigned a responsibility that allows this user to view 
the default drilldown. For example, assume Applet A on View B uses a dynamic drilldown and that 
View C is the default view for this drilldown. To make sure this drilldown works property, the user 
must be assigned a responsibility that allows the user to use View B and View C. 

Workflow Policy Component
A workflow policy component identifies a database table and specifies a relationship with another 
table that the workflow process references. A primary workflow policy component is a workflow policy 
component that all other workflow policy components directly or indirectly reference. To define the 
workflow conditions that are available for monitoring in the workflow policy object, you can use these 
workflow policy components.

Table 229. Properties of the Dynamic Drilldown Destination

Property Description

Destination Drilldown Object 
(O)

Specifies the name of the drilldown object in the same applet that 
the drilldown displays if the field specified in the Field property 
matches the value specified in the Value property.

Field (O) Specifies the Type field in the business component that the applet 
references. Siebel CRM examines this field in the current record to 
determine if the value that it contains matches the setting in the 
Value property of the dynamic drilldown destination. If the value 
matches, then the drilldown displays the drilldown object that the 
Destination Drilldown Object property specifies.

Name (R) Specifies a name that uniquely identifies each dynamic drilldown 
destination object definition in the parent drilldown object.

Sequence (O) Specifies the order that Siebel CRM uses to search for the children 
of one drilldown object. It performs this search from lowest to 
highest according to the integer value that this property contains.

Value (O) Specifies the value that Siebel CRM must match with the Type field.
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This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Policy Object > Workflow Policy Component

Table 230 describes properties that Siebel CRM uses with a workflow policy component.

Table 230. Properties of the Workflow Policy Component

Property Description

Join Spec (O) Specifies a join between this workflow policy component and the 
target workflow policy component.

If the existing join references an intersection table that would result 
in Siebel CRM returning multiple rows, then you specify the Join 
Spec property. The join that the Join Spec property references 
restricts the join so that Siebel CRM returns only one row at a time. 
The expression that the Join Spec property contains is equivalent to 
an additional WHERE clause in SQL. It uses the following format:

workflow_component.foreign_key = 
business_component.primary_key

For example, the following join specification occurs in the Primary 
Opportunity/Position workflow policy component in the Opportunity 
workflow process:

[Primary Opportunity/Position].OPTY_ID = 
[Opportunity].ROW_ID 

You must enclose the component name with square brackets.

Name (R) Specifies the name of this workflow policy component.

Primary (O) If TRUE, then this workflow policy component is the primary 
workflow policy component for the parent workflow policy object. 
Each workflow policy object must include one and only one primary 
workflow policy component.

For example, the Primary property of the Account workflow policy 
component of the predefined Account workflow policy object is 
TRUE. This configuration defines the Account workflow policy 
component as the primary. Other workflow policy components in 
the Account workflow policy object are not primary workflow policy 
components.

Source Column Name (O) Specifies the column in the source table that another workflow 
policy component references. The drop-down list for this property 
displays columns from the table that the Source Table Name 
property specifies.

Source Table Name (R) Specifies the table that this workflow policy component references.
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Workflow Policy Component Col
A workflow policy component col identifies a column that Siebel CRM can monitor from the parent 
workflow policy component.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Policy Object > Workflow Policy Component > Workflow Policy 
Component Col

Table 231 describes properties that Siebel CRM uses with a workflow policy component col.

Workflow Policy Object
A workflow policy object groups workflow policy component objects and workflow policy component 
columns that Siebel CRM can monitor in the same workflow policy object. 

This object type occurs in the following location in the object hierarchy:

Target Column Name (O) Specifies the column in the target workflow policy component that 
Siebel CRM joins to the source column in this workflow policy 
component. The drop-down list for this property displays columns 
of the table that the target workflow policy component specifies.

Target Component Name 
(O)

Specifies the target workflow policy component. The drop-down list 
for this property displays a list of workflow policy components for 
the current workflow policy object.

Table 231. Properties of the Workflow Policy Component Col

Property Description

Alias Specifies the name of the column that Siebel CRM displays in the 
Conditions Field picklist in the Workflow Policies view.

Name (R) Specifies the name of the workflow policy component col that Siebel 
CRM displays in the Conditions applet in the Workflow Policy Detail 
view. This property defaults to the same value that the Workflow 
Column Name property contains.

Workflow Column Name (R) Specifies the name of the column that Siebel CRM monitors in the 
workflow policy component. This name must specify the object 
definition of an existing workflow policy column.

Workflow Object Name (R) Specifies the name of the workflow policy object for this workflow 
policy component col.

Table 230. Properties of the Workflow Policy Component

Property Description
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■ Siebel Objects > Workflow Policy Object

Table 232 describes properties that Siebel CRM uses with a workflow policy object.

Workflow Policy Program Object Types
This topic describes the Workflow Policy Program object type and object types that are children of 
this object type. It includes the following topics:

■ Workflow Policy Program on page 318

■ Workflow Policy Program Arg on page 320

Workflow Policy Program
A workflow policy program specifies the name and type of a workflow policy program or action that 
Siebel CRM can use in reply to meeting a workflow policy condition. Siebel CRM displays the workflow 
policy programs in the drop-down list of the Actions Applet field in the Workflow Policy Detail view. 
You can use predefined workflow policy programs that already configure variables except for the 
message text, or you can create a custom workflow policy program.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Policy Program

Table 233 describes properties that Siebel CRM uses with a workflow policy program.

Table 232. Properties of the Workflow Policy Object

Property Description

Name (R) Specifies the name of this workflow policy object.
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Setting the DB Operation
In some situations, if Siebel CRM modifies data, then it must also modify some other data. Siebel 
CRM typically implements this data dependency at the Object Manager layer through business 
components and run-time events. Database operations that workflow policies run provide an 
alternative that works at the Siebel database record level.

It is recommended that you configure Siebel CRM to use DB Operation only if the data dependency 
is centered around database records rather than business components. For example, if Siebel CRM 
must update one database record if it inserts another database record, then you can use DB 
Operation regardless of the business components that the two database records belong to, or 
whether the two database records belong to a business component at all.

Table 233. Properties of the Workflow Policy Program

Property Description

Name (R) Specifies the name of the action that Siebel CRM performs.

Type (R) Specifies one of the following types of actions:

■ DB Operation. For more information, see “Setting the DB 
Operation” on page 319.

■ External Program. Run an external program in Windows.

■ Send Message. Compose and send an automatic email 
message.

■ Send Page. Send a page to a pager.

■ Send Broadcast Message. Send a broadcast message to a 
group of users.

In some situations, if Siebel CRM modifies data, then it must also 
modify some other data. To configure this data dependency, you 
can do one of the following:

■ Use the Application Object Manager, business components, and 
run-time events. 

■ Use a database operation in a workflow policy object that 
modifies records at the database level.

It is recommended that you use this database operation only if this 
data dependency affects database records instead of business 
components. For example, if Siebel CRM must update one database 
record if it inserts another database record regardless of the 
business components that reference these database records, or if 
no business component references these records.

Workflow Object (O) Specifies the name of the workflow policy object.
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Using Variables In a Message
To make content more specific, you can use variables in the messages. This configuration also allows 
you to use the same message for more than one workflow policy object. For example:

The severity level for SR from account is value and has been open for 2 hours.

CAUTION: You must not modify or create an SQL statement or message that uses variables that 
other SQL statements set. For help with this configuration, see “Object Types That You Must Not 
Modify” on page 18.

Workflow Policy Program Arg
A workflow policy program arg defines recipients, database actions, and substitutions. Each workflow 
policy program typically contains several workflow policy program arguments.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Policy Program > Workflow Policy Program Arg

Table 234 describes properties that Siebel CRM uses with a workflow policy program arg.

Table 234. Properties of the Workflow Policy Program Arg

Property Description

Applet (O) Specifies the picklist applet.

Default Value (O) Specifies a text value. This text depends on the type of workflow 
policy program arg. For example, an SQL statement, the text of a 
message, or the email address of a recipient. The maximum length 
is 2000 characters.

CAUTION: Siebel CRM does not allow some kinds of text in the 
Default Value property of a workflow policy program arg. You must 
not include trailing spaces, newline, or escape characters. Using 
these characters might cause problems, such as a Workflow Monitor 
Agent failure at run time. You must create or modify a workflow 
policy program arg only with caution. For more information, see 
Siebel Business Process Framework: Workflow Guide.

Name (R) For more information, see “Setting the Name Property of a Workflow 
Policy Program Arg” on page 321.

Picklist (O) Specifies the object definition of a picklist.

Required (O) If TRUE, then data entry is required.

Source Field (O) Specifies the picklist source field.

Visible (O) If TRUE, then Siebel CRM displays the data that this argument 
provides.
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Setting the Default Value Property of a Workflow Policy Program Arg
To run a workflow policy program, the Siebel Server retrieves data from the Siebel database through 
an ODBC connection. The ODBC driver returns a date format that might be different from the format 
that the Siebel database uses. If you set the Default Value property of a workflow policy program 
arg, and if this workflow policy program arg references a time or date field, then you must use one 
of the following formats. This configuration makes sure the date formats are compatible:

■ Date Column: 2001-03-16

■ Time Column: 19:26:26

■ Date and Time Column: 2001-04-05 21:25:00

Setting the Name Property of a Workflow Policy Program Arg
To familiarize yourself with how Siebel CRM uses a workflow policy program argument, you can 
examine some of the predefined arguments. For example, in the Workflow Policy Programs list, you 
can query the Name property for Run External Program. Table 235 describes some of the workflow 
policy program arguments that this object references. Note the following:

■ You enter the value manually in the Name property of the workflow policy program arg.

■ If you run a database operation with Insert as the Operation Type, then you can choose a Default 
Value, New Row ID that provides the value for the ROW_Id field for the inserted row.

Table 235 describes values for workflow policy program arguments that are common to a workflow 
policy program.

Table 235. Arguments in the Name Property of the Workflow Policy Program Arguments List

Argument Description Value You Can Enter

Primary Id Specifies the row ID of the violating row on 
which the workflow policy program runs.

Empty.

Primary Table Specifies the base table where this workflow 
policy program arg applies an action. The 
base table can be unrelated to ‘the record of 
the primary ID. For example, the violating 
row resides in a child table and Siebel CRM 
must insert or update a record in the parent 
table. It can also update a table that is not 
related to the primary ID table. For 
example, to create a broadcast message 
when a monitored value in the opportunity 
becomes true.

The name of a table in the 
repository, as compared to the 
business object that a workflow 
process references. Siebel CRM 
uses the business object that a 
workflow process references to 
monitor values but not to code an 
action program.
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Update Row ID Specifies the row ID of a table other than 
the primary table of the workflow policy 
object. You can configure Siebel CRM to 
associate a workflow policy action with a 
workflow policy object that updates a table. 

Siebel CRM uses the Update Row ID 
property only if the Operation Type is set to 
Update.

The row ID that Siebel CRM must 
update.

Operation Type Specifies to perform an update operation or 
insert operation.

You can use one of the following 
values:

■ Update

■ Insert

Field Name Specifies the Name of the column in the 
base table that this operation updates. This 
value is one of two field column pairs.

You can use one of the following 
values:

■ Text

■ Variable

■ Function

New Row ID Specifies the row ID of the row that Siebel 
CRM must insert. Siebel CRM automatically 
populate this property with this row ID.

Empty.

Field Name 
(Column)

Specifies the field name using the following 
format:

Field_nameColumn

where:

■ Field name is the field name of the first 
column pair

This is the second of two column pairs.

Field name in the base table. This 
value cannot contain leading 
spaces.

Sql Statement Specifies the data from the Siebel database 
that Siebel CRM uses to populate 
substitutions when it performs an action.

Valid SQL query statement for 
one of the following RDBMS that 
your implementation uses: 

■ Oracle

■ MS SQL

■ Informix

■ Sybase

Table 235. Arguments in the Name Property of the Workflow Policy Program Arguments List

Argument Description Value You Can Enter



Siebel Object Types Reference ■ Workflow Policy Program Object Types

Siebel Object Types Reference Siebel 2018 323

Sending Multiple Variables to SQL Program Arguments
Multiple variables can be sent into SQL program arguments.

To send multiple variables to SQL program arguments
1 In the Workflow Policy Program Arguments list, choose Sql Statement Inputs.

2 Enter the variable names into the Default Value property.

Use the following format: 

[variable1], [variable2], [variable n]

Arguments for a Workflow Policy Program that Sends a Message
Table 236 describes workflow policy program arguments that the Send Email workflow policy program 
references. These arguments are specific to sending a message. To view these arguments, you can 
query the Name property for Send Email.

Sql Statement 
Inputs

Specifies the name of a column in the base 
table on which Siebel CRM performs an 
operation.

Not applicable.

Sql Statement 
Outputs

Specifies a variable for the values that the 
SQL Statement argument chooses.

Name of the variable.

Table 236. Properties of the Send Message Program Argument

Value in Name Property Usage Value

Email Message Specifies the body of the email message. Text with available 
substitutions.

Email Message Repeated Specifies the text that Siebel CRM 
repeats when it uses the Consolidate 
feature.

Text with available 
substitutions.

Email Subject Specifies the text in the subject line of 
the email message.

Text.

Send to Contact Specifies the contacts who are available 
in Siebel CRM.

Not applicable.

Send to Position Specifies the list of the positions that are 
available in Siebel CRM.

Not applicable.

Send to Employee Specifies the list of employees who are 
available in Siebel CRM.

Not applicable.

Table 235. Arguments in the Name Property of the Workflow Policy Program Arguments List

Argument Description Value You Can Enter
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Arguments for a Workflow Policy Program that Sends a Page
Table 237 describes workflow policy program arguments that are specific to some workflow policy 
programs that send a page.

Arguments for a Workflow Policy Program that Runs an External 
Program
Table 238 describes workflow policy program arguments that are specific to some workflow policy 
programs that run an external program.

Table 237. Properties of the Send Page Program Argument

Value in Name Property Usage Value

Send to Contact Specifies the contacts who are available 
in Siebel CRM.

Picklist of contacts.

Send to Employee Specifies the list of employees who are 
available in Siebel CRM.

Picklist of employees.

Send to Position Specifies the list of the positions that 
are available in Siebel CRM.

Picklist of positions.

Send to Relative Specifies to send to an individual or 
group of individuals who are related to 
the workflow process object.

Not applicable.

Alpha Numeric Page 
Message

Specifies the body of the text message. Text with available 
substitutions.

Numeric Page Message Specifies the body of the numeric 
message.

Text with available 
substitutions.

Table 238. Properties of the Run External Program Argument

Value in Name Property Usage Value

Command Line Specifies the parameters that Siebel CRM 
sends to the executable.

Not applicable.

Executable Name Specifies the full path to the executable that 
Siebel CRM runs.

Not applicable.

Executable Type Specifies the mode the Workflow Action Agent 
uses to run the external program.

You can use one of 
the following 
values:

■ Wait

■ No wait
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Workflow Process Object Types
This topic describes the Workflow Process object type and object types that are children of this object 
type. It includes the following topics:

■ WF Branch Connector (H) on page 325

■ WF Branch Criteria (H) on page 326

■ WF Branch Criteria Value (H) on page 327

■ WF Process Metric on page 328

■ WF Process Prop on page 328

■ WF Step on page 331

■ WF Step Branch (H) on page 337

■ WF Step I/O Argument (H) on page 339

■ WF Step Recipient (H) on page 340

■ Workflow Process on page 341

WF Branch Connector (H)
A WF branch connector branch is a link that connects two steps.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Process > WF Step > WF Step Branch (H) > WF Branch Connector

Table 239 describes properties that Siebel CRM uses with a WF branch connector.

Table 239. Properties of the WF Branch Connector

Property Description

From Step Name Specifies the name of the step where this WF branch connector 
begins.

Layout Specifies the coordinates of this WF branch connector on the 
Workflow Designer.

Name Specifies the name of this WF branch connector. It is recommended 
that you use a descriptive name that is consistent with your overall 
naming strategy and that is meaningful to you.

To Step Name Specifies the name of the step where this WF branch connector 
ends. 
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WF Branch Criteria (H)
A WF branch criteria specifies a list of conditions. At runtime, the workflow engine evaluates these 
conditions and then configures the workflow process to use the branch that meets the condition.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Process > WF Step > WF Step Branch (H) > WF Branch Criteria

Table 240 describes properties that Siebel CRM uses with a WF branch criteria.

Table 240. Properties of the WF Branch Criteria

Property Description

Applet Field Name Specifies the name of a field that includes the data that Siebel CRM 
compares. If the Compare To property is Applet, then the Applet 
Field Name property is required.

Applet Name Specifies the name of the applet that includes the field that Siebel 
CRM compares. If the Compare To property is Applet, then the 
Applet Name property is required.

Business Component Specifies the name of a business component that the business 
object references. The Business Object property of the workflow 
process references this business object. If the Compare to value is 
Business Component or Expression, then the Business Component 
property is required.

Business Component Field Specifies the name of a business component field. If the Compare 
to value is Business Component, then the Business Component 
Field property is required.

Compare To (R) Specifies the object that contains the comparison value.

Edit If TRUE, then the user can edit this WF branch criteria.

Item Type Name Specifies the assignment criterion record for an assignment criteria. 
For more information, see Siebel Assignment Manager 
Administration Guide. 

Name Specifies the name of this WF branch criteria.
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WF Branch Criteria Value (H)
A WF branch criteria value is for Oracle use only.

This object type occurs in the following location in the object hierarchy:

Operation Specifies the comparison operation. You can specify one of the 
following values:

■ All Must Match. All of the values must match exactly, including 
case.

■ All Must Match (ignore case). All of the values must match 
without regard to case.

■ Between. Value must occur between a range of values.

■ Greater Than. Value must be greater than the comparison 
value.

■ Is Not Null. Value cannot be empty.

■ Is Null. Value must be empty.

■ Less Than. Value must be less than the comparison value.

■ None Can Match. None of the values can match exactly, 
including case.

■ None Can Match (ignore case). None of the values can match 
without regard to case.

■ Not Between. Value cannot occur between a range of values.

■ One Must Match. One or more values must match exactly, 
including case.

■ One Must Match (ignore case). One or more values must 
match without regard to case.

■ This Must Match. The current value must match exactly, 
including case.

■ This Must Match (ignore case). The current value must 
match without regard to case.

Property Name (R) Specifies a property of a business process. To determine the 
condition, Siebel CRM uses the value of the property that the 
Property Name specifies.

Sequence (S) Specifies the order that Siebel CRM uses to evaluate the criteria. 
Siebel CRM uses this sequence during an upgrade.

Table 240. Properties of the WF Branch Criteria

Property Description
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■ Siebel Objects > Workflow Process > WF Step > WF Step Branch (H) > WF Branch Criteria (H) > 
WF Branch Criteria Value

WF Process Metric
A WF process metric defines a metric that Siebel CRM collects while the workflow process runs. 

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Process > WF Process Metric

Table 241 describes properties that Siebel CRM uses with a WF process metric.

WF Process Prop
A WF process prop stores values that Siebel CRM uses in a workflow step, input argument, output 
argument, or to perform an evaluation.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Process > WF Process Prop

Table 242 describes properties that Siebel CRM uses with a WF process property. Siebel Tools also 
displays these properties as fields in the Multi-Value Property Window. For more information, see 
Siebel Business Process Framework: Workflow Guide.

Table 241. Properties of the WF Process Metric

Property Description

Metric Name (R) Specifies the name of this WF process metric. The drop-down list 
for this property displays a list of predefined metrics. 

Name (R) Specifies the name of the object. Siebel CRM sets a predefault value 
for this name to the Metric Name.

Property Name (R) Specifies the name of a property of the workflow process. Siebel 
CRM maps this WF process metric to the property that the Property 
Name property specifies.
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Table 242. Properties of the WF Process Prop

Property Description

Access Mode Reserved for future use.

Business Component (O) Specifies the name of the business component that contains the 
virtual field that the Virtual Field property specifies.

The drop-down list for this property displays the business 
components that the business object references. The Business 
Object property of the workflow process references this object.

Business Object (O) Specifies the name of the business object that the parent workflow 
process references. This property is read-only. The drop-down list 
for this property displays only the business objects that include a 
primary business component.

Correlator Flag If TRUE, then this WF process prop works as a correlator, which is 
business data that identifies the recipient of the incoming message. 
For more information, see the topic about the Workflow User Event 
Service business service in Siebel Business Process Framework: 
Workflow Guide.
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Data Type Specifies the type of data that Siebel CRM can save. You can use 
one of the following values:

■ Alias. Sets the size limit for a default value, not a run-time 
value. The default value is 250 characters.

■ Binary. Specifies to use variant or binary information, usually 
for XML data. You must assign a binary type the None value in 
the In/Out property.

■ Date. Specifies to use dates.

■ Hierarchy. Specifies to use a data type that Siebel Enterprise 
Application Integration uses to store data from a property set. 
For more information, see Overview: Siebel Enterprise 
Application Integration.

■ Integration Object. Specifies to store integration objects. 
Integration objects use the Hierarchy data type.

■ Number. Specifies to use numeric data. It sets the size limit for 
the default value, not the run-time value. The default value is 
22 digits.

■ String. Specifies to use alphanumeric data, typically for UTF-16 
data. It sets the size limit for the default value, not the run-time 
value. The default value is 250 characters.

■ Strongly Typed Integration Obj. Specifies to use a special 
data type to display a workflow process as a Siebel inbound web 
service. Siebel business services use this property when 
creating WSDLs.

Siebel CRM treats values in the Strongly Typed Integration Obj 
property and the Integration Object property as the same data 
type for a workflow process or for a business service.

Default Date Specifies the starting value if this WF process prop is a date type.

Default Number Specifies the starting value if this WF process prop is a numeric 
type.

Default String Specifies the starting value if this WF process prop is a string type. 
You can enter text in this property. If you enter the following value, 
then Siebel CRM initializes the value of this WF process prop with 
the value in the Value field of the workflow input property set:

<Value>

Display Name Specifies the name that Siebel CRM displays in a view.

Table 242. Properties of the WF Process Prop

Property Description
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WF Step
A WF step defines a step in a workflow process.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Process > WF Step

Table 243 describes properties that Siebel CRM uses with a WF step.

In/Out Specifies how to send the value that this WF process prop contains. 
You can use one of the following values:

■ In. Send this value into the workflow process.

■ Out. Send this value out of the workflow process.

■ In/Out. Send this value into and out of the workflow process.

■ None. Use this value only in the workflow process.

If the Data Type property is Binary, then you cannot set the In/Out 
property to In, Out, or In/Out.

Integration Object Specifies the data type that Enterprise Application Integration (EAI) 
uses to save data from an integration object. For example:

Account - Get Oracle Customer (Oracle)

Name Specifies the name of the process property.

Virtual Field (O) Specifies the name of the business component field that Siebel CRM 
maps to the workflow process property. The drop-down list for the 
Virtual Field property displays business component fields. It 
displays only calculated fields that do not contain a calculated 
value. The workflow process does not specify this calculation.

A workflow process does not require you to specify a business 
component field as a virtual field. An applet can reference a virtual 
field in the same way that it references a nonvirtual field.

Table 242. Properties of the WF Process Prop

Property Description
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Table 243. Properties of the WF Step

Property Description

Allow Retry Flag Not used.

Business Component 
(O)(R) 

Specifies the business component field that Siebel CRM uses to 
determine the condition.

If the Compare to value is Business Component, then the Business 
Component property is required.

Business Service Method Specifies the name of the business service method that Siebel CRM 
calls.

Business Service Name Specifies the name of the business service that Siebel CRM calls. 
The drop-down list for this property displays business services that 
include a Hidden property is FALSE.

Error Code Specifies a number that identifies a string in the Siebel database 
that contains the error message.

Error Message Specifies the text of the error message. If you choose a value in the 
Error Code property, then Siebel Tools automatically enters a value 
in the Error Message property.

Maximum Iterations Specifies the maximum number of times Siebel CRM can run this 
step in a workflow process instance. If it reaches the maximum 
number of iterations, then it creates an Object Manager error and 
the workflow process returns an In Error status. If you require the 
process to run to completion, then you must configure an object to 
catch and handle the error, such as an error workflow process or 
exception branch. 

Name Specifies a descriptive name that includes the following 
characteristics:

■ Consistent with your overall naming strategy

■ Meaningful to the designer of the process

■ Unique

If you create a new WF step, then Siebel Tools automatically 
assigns a name depending on the type of step and a sequence 
number. You can modify this name or leave it as is.
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Properties of Different Types of Workflow Process Steps
This topic describes properties of the various steps and connectors in a workflow process.

Table 244 describes properties of the start step.

Operation Specifies the comparison operation. You can use one of the 
following values:

■ Delete

■ Insert

■ NextRecord

■ PrevRecord

■ Query

■ QueryBiDirectional

■ Update

■ Upsert

Processing Mode (O) Specifies the mode that Siebel CRM uses to run the workflow 
process if a runtime event triggers this workflow process, You can 
use one of the following values:

■ Local Synchronous. Runs the workflow process in the 
Application Object Manager. This value is the default value.

■ Remote Synchronous. Sends a synchronous request to the 
Workflow Process Manager server component to run the 
workflow process.

■ Remote Asynchronous. Sends an asynchronous request to 
the Workflow Process Manager server component to run the 
workflow process.

Subprocess Name Specifies the name of the subprocess step.

Type Specifies the type of WF step. Siebel Tools automatically enters this 
value when you create a new step in the Process Designer. This 
value is a read only property.

Update Snapshot If this property contains a check mark, and if Siebel CRM reaches 
this step in the workflow process at run time, then it uses a 
snapshot of the workflow process state. It does this so that it can 
can recover the state if a system failure occurs.

User Interact View Specifies the name of the Siebel view that Siebel CRM displays.

Table 243. Properties of the WF Step

Property Description
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Table 245 describes properties of the business service step.

Table 246 describes properties of the decision point step.

Table 247 describes properties of the subprocess step.

Table 244. Properties of the Start Step

Start Property Value

Name Start

Parent Name Workflow name:version

Processing Mode Local Synchronous

Table 245. Properties of the Business Service Step

Business Service Property Value

Allow Retry Flag FALSE

Business Service Name Choose the business service name from the picklist.

Business Service Method Choose the business service method from the picklist.

Name Business service 0. You can modify this value, as necessary.

Parent Name Workflow name:version

Table 246. Properties of the Decision Point

Decision Point Property Value

Name Decision Point 0. You can modify this value, as necessary.

Parent Name Workflow name:version

Table 247. Properties of the Sub Process Step

Sub Process Property Value

Name Sub Process 0. You can modify this value, as necessary.

Sub Process Name Choose the name of the subprocess from the picklist. Siebel 
CRM only displays subprocesses in this picklist that include 
a status of Complete.
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Table 248 describes properties of the Siebel operation step.

Table 249 describes properties of the task step.

Table 250 describes properties of the user interact step.

Table 251 describes properties of the wait step.

Table 248. Properties of the Siebel Operation Step

Siebel Operation Property Value

Allow Retry Flag FALSE

Business Component Choose the business component name from the picklist.

Name Siebel Operation 0. You can modify this value, as necessary.

Operation Choose the operation from the list.

Parent Name Workflow name:version

Table 249. Properties of the Task Step

Task Property Value

Name Task 0. You can modify this value, as necessary.

Task Name Choose the task name from the picklist.

Table 250. Properties of the User Interact Step

User Interact Property Value

Name User Interact 0. You can modify this value, as necessary.

Parent Name Workflow name:version

User Interact View Choose the view name from the picklist.

Table 251. Properties of the Wait Step

Wait Property Value

Business Service Method Sleep

Business Service Name Workflow Utilities

Maximum Iterations Not applicable
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Table 252 describes properties of the stop step.

Table 253 describes properties of the end step.

Table 254 describes properties of the error exception connector.

Name Wait 0. You can modify this value, as necessary.

Parent Name Workflow name:version

Table 252. Properties of the Stop Step

Stop Property Value

Error Code Choose the error code from the picklist.

Error Message If you choose the Error code, then Siebel Tools populates 
the Error Message property.

Name Stop 0. You can modify this value, as necessary.

Parent Name Workflow name:version

Table 253. Properties of the End Step

Stop Property Value

Name End 0. You can modify this value, as necessary.

Parent Name Workflow name:version

Table 254. Properties of the Error Exception Connector

Error Exception Connector Properties Value

Inactive FALSE

Name Error Exception 0. You can modify this value, as 
necessary.

Parent Name Siebel CRM enters this value from step name.

Type Error Exception

User Event Name Leave this field empty.

Table 251. Properties of the Wait Step

Wait Property Value
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WF Step Branch (H)
A WF step branch connects two workflow steps. It controls the data and process flow of a workflow 
process.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Process > WF Step > WF Step Branch

Table 255 describes properties that Siebel CRM uses with a WF step branch.

User Event Storage Leave this field empty.

User Event Timeout 0

Table 255. Properties of the WF Step Branch

Property Description

Event (O) (R) Specifies the event that this WF step branch supports. The set of 
events is different for different object types. If the Event Object 
Type property is not empty, then the Event property is required.

Event Cancel Flag (O) Specifies how Siebel CRM handles a cancel runtime event after the 
workflow process finishes. This property applies only to an event 
that Siebel CRM can cancel. It is similar to the CancelOperation in 
a script.

If the Event Cancel Flag property is FALSE, then Siebel CRM creates 
the following error when the workflow process runs: 

The specialized method method_name is not supported on 
this business component.

Event Object (O) (R) Specifies the event that Siebel CRM applies to this WF step branch. 
The values that you can set in the Event Object property depends 
on the value that you choose in the Event Object Type property. For 
example, if you set the Event Object Type to BusComp, then you 
choose only a business component in the Event Object property, 
such as Account.

Event Object Type (O) Specifies the type of object that this WF step branch references, 
such as business component. If the Event Object Type property is 
not empty, then the Event Object property is required.

Table 254. Properties of the Error Exception Connector

Error Exception Connector Properties Value
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Event Visibility Specifies to use a run-time event that Siebel CRM creates in the 
current local session or in another enterprise session. It uses this 
event to resume a workflow process instance that is waiting. If the 
workflow process is:

■ Persistent. You can set the Event Visibility property to 
Enterprise or Local. In most situations if a workflow process 
must wait for an event, then it must be persistent and you use 
Enterprise.

■ Not persistent. If it is not required that the workflow process 
be persistent, then it is recommended that you set the Event 
Visibility property to Local. If Event Visibility is Enterprise, then 
a run-time event searches for a matching workflow process 
instance. This configuration can affect performance.

Name Specifies the name of this WF step branch.
To import or export the workflow process, the name must be 
unique. If it is not unique, then you cannot commit the record.

Subevent (O) Specifies the name of the method or field in a business component 
that Siebel CRM monitors. You set the Subevent property only if the 
Object Type property is BusComp or Applet and the event is 
InvokeMethod or SetFieldValue.

For InvokeMethod, you specify the name of the method that Siebel 
CRM calls. For SetFieldValue, you specify the name of the field that 
Siebel CRM sets.

Type Specifies the type of WF step branch. You can use one of the 
following values:

■ Condition. Use a condition for this task branch.

■ Default. If no other conditions are met, then use this task 
branch. Siebel CRM ignores any conditions that are defined for 
this task branch.

■ Connector. Do not use any condition branching.

■ Error Exception. Use exception handling. This connector type 
captures system errors. For example, the Assignment Manager 
server component is not available.

■ User Defined Exception. Use exception handling. This 
connector type captures errors that you define. For example, 
the user attempts to save an incomplete order.

Table 255. Properties of the WF Step Branch

Property Description



Siebel Object Types Reference ■ Workflow Process Object Types

Siebel Object Types Reference Siebel 2018 339

WF Step I/O Argument (H)
A WF step I/O argument identifies the input and output arguments that a workflow process step uses. 
Each step accepts input from the workflow process and sends output to the workflow process.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Process > WF Step > WF Step I/O Argument

Table 256 describes properties that Siebel CRM uses with a WF step I/O argument.

User Event Name Specifies a name that describes the user event. You must define a 
name that is unique and that is sufficiently long so that it remains 
unique for the Siebel enterprise. For example:

Order Placed-Begin Processing Event for Service Request 
Automation-Version 2

User Event Storage Specifies the process property that Siebel CRM uses as the 
destination for the payload on the incoming user event. This value 
can be a process property. The correlator must mark this process 
property.

User Event Timeout (Days) Specifies the number days that a workflow process waits for a user 
event to resume operation. If the user event resides on a wait step, 
then you use this property. Do not set this property on a wait step.

Table 256. Properties of the WF Step I/O Argument

Property Description

Business Component Specifies the name of a business component that the business 
object references. The workflow process references this business 
object.

Business Component Field Specifies the name of a business component field.

Input Flag Specifies if the field is an input argument, output argument, or a 
search specification. This property is read only.

Name Specifies text that describes the purpose of this step I/O argument.

Table 255. Properties of the WF Step Branch

Property Description
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WF Step Recipient (H)
A WF step recipient use a step recipient to assign a workflow process to a user. This assignment 
occurs according to login name. This login name can be a literal value, contained in a process 
property, or the result of an expression.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Process > WF Step > WF Step Recipient

Table 257 describes properties that Siebel CRM uses with a WF step recipient.

Output Arg Specifies the name of the output argument from the business 
service. The drop-down list for this property includes the output 
arguments that exist for the method you choose. Siebel CRM 
displays arguments in this list that include the following:

■ Defined as an argument on a business service method 

■ The Hidden flag is FALSE

■ Type is Output or Input/Output

Preferred Sequence Specifies the order that Siebel CRM uses for this WF step I/O 
argument. For Oracle internal use only. 

Property Name (R) Specifies the name of the process property that Siebel CRM uses to 
save the value of this WF step I/O argument.

Sequence Specifies the order that Siebel CRM uses for this WF step I/O 
argument for upgrade purposes.

Type (R) Specifies the type of argument.

Value/Search Specification Specifies a search specification. If the Type property is Expression, 
then enter the Value/Search Specification property must contain an 
expression. For example:

[Status] LIKE '*Open*'

The Expression business component evaluates this expression.

Table 257. Properties of the WF Step Recipient

Property Description

Business Component Field Specifies the name of a business component field.

Business Component Name Specifies the name of a business component that the business 
object references. The workflow process references this business 
object.

Table 256. Properties of the WF Step I/O Argument

Property Description
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Workflow Process
A workflow process allows you to use a familiar flowcharting interface to define the business 
processes that your company uses. A workflow process includes one or more process steps, such as 
start steps, subprocesses, decision points, and tasks.

This object type occurs in the following location in the object hierarchy:

■ Siebel Objects > Workflow Process

Table 258 describes properties that Siebel CRM uses with a workflow process.

Expression Specifies an expression that evaluates a value. it evaluates the 
expression that the Value column contains. If this expression 
references a business component field, then you must enter the 
name of the business component that contains this field. You enter 
this value in the Business Component column.

Name (R) Specifies the name of this WF step recipient.

Process Property Name (R) Specifies the name of a process property.

Recipient Name Specifies the login name of the user.

Recipient Type Code Specifies the type of this WF step recipient. You can choose only 
User.

Value Type Code Specifies the value type code of this WF step recipient. 

Table 258. Properties of the Workflow Process

Property Description

Auto Persist If TRUE, then this workflow process is persistent.

Business Object Specifies the name of the business object that this workflow 
process references. Optional. The drop-down list for this property 
displays only business objects that include a primary business 
component.

Effective End Date Specifies a date that Siebel CRM uses to retire this workflow 
process. For example, you can set the start date to a future date 
and set the end date for the existing version to the same date. 
Siebel CRM uses the new version starting on this date.

Effective Start Date Specifies a date that Siebel CRM uses to start using this workflow 
process.

Table 257. Properties of the WF Step Recipient

Property Description
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Error Process Name Specifies the name of a workflow process. If the workflow process 
on which you specify the Error Process Name property encounters 
an error, then it runs the workflow process that you define in this 
property.

Group Specifies the name of a group. This group allows you to group 
similar workflow processes according to your criteria, such as all the 
workflow processes that support a particular business process. To 
define this group, you use the List of Values view in the Application 
Administration screen in the client.

This property only applies to workflow processes before Siebel CRM 
version 7.7. Starting with version 7.7, it is recommended that you 
do not use this property. You can use the Project property instead.

Name (R) Specifies a name for this workflow process.

Pass By Ref Hierarchy If TRUE, and if this workflow process is a subprocess of another 
workflow process, then Siebel CRM uses a reference to send any 
modifications it makes in this workflow process to the parent 
workflow process. This property can reduce the amount of memory 
that a workflow process requires because Siebel CRM sends data 
through a reference instead of sending a value.

Process Name Specifies a name that describes the work that this workflow process 
performs.

Replication Level Specifies how Siebel CRM synchronizes this workflow process with 
a Mobile Web Client. You can use one of the following values:

■ All. Synchronize this workflow process to all Remote users and 
to all regional nodes of the Siebel Server.

■ Regional. Synchronize this workflow process only to regional 
nodes.

■ None. Do not synchronize this workflow process.

State Management Type For more information, see “State Management Type Property of a 
Workflow Process” on page 343.

Status Displays the current status of this workflow process.

Version Displays the version number of this workflow process. The default 
version is 0. Siebel Tools increments this version number by one 
each time you revise this workflow process.

Table 258. Properties of the Workflow Process

Property Description
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State Management Type Property of a Workflow Process
The State Management Type property specifies the type of business service request that Siebel CRM 
sends while this workflow process runs. A stateless business service does not depend on a state that 
is specific to the business service. You can set this property to one of the following values:

■ Stateful. The Object Manager does not release a stateful or cached business service that the 
workflow process calls if the user pauses or finishes an instance of this workflow process. The 
Object Manager waits for the object that called the Workflow Engine to release the cached 
business service. To release this business service, the caller can use methods from the Web 
Channel Dedicated Block Service business service.

■ Stateless. The Object Manager releases a stateful or cached business service that a workflow 
process calls if the user pauses or finishes an instance of this workflow process.

Every business service that this workflow process instance calls must be stateful or stateless.

The session state for the Object Manager requires a business service to contain a state management 
type. You must define a business service as Stateless or Stateful, or as a business service that the 
the Siebel Server manages.

For more information, see “State Management Type Property of a Workflow Process” on page 343 and 
Siebel Business Process Framework: Workflow Guide.

How the Workflow Mode Affects the State Manage Type
Siebel CRM sets the State Management Type property of a workflow process to Stateful, by default 
It does this to preserve the behavior for releases that occur earlier than Siebel CRM 8.1. If a workflow 
process runs through Web Channel, then it might be necessary to modify the State Management Type 
to Stateless to take advantage of the session pooling that the Object Manager provides. For more 
information about Web Channel, see Siebel Web UI Dynamic Developer Kit Guide.

Table 259 describes how the Workflow Mode property of a workflow process affects the State 
Management Type property.

Web Service Enabled (O) If TRUE, then Siebel CRM exposes this workflow process as a Web 
service and can independently call it. Setting this property to TRUE 
does not automatically implement the workflow Web service. 
Defining the workflow process for a Web service does not set this 
property to TRUE.

Workflow Mode Specifies the mode that defines the runtime configuration of this 
workflow process.

Table 258. Properties of the Workflow Process

Property Description
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Table 259. How the Workflow Mode Affects the State Manage Type

Workflow Mode

State 
Management 
Type Description

Service Flow Stateless A service workflow process cannot contain a user interact 
step or wait step. Siebel CRM runs the entire workflow 
process before the Object Manager can release the session 
back to the session pool.

Interactive Flow Stateless An interactive workflow process can move between sessions 
through the Universal Inbox. The State Management Type 
property is relevant only if the workflow process runs through 
Web Channel. An interactive workflow process runs in a user 
interactive session so the State Management Type does not 
effect the behavior of an interactive workflow.

Long Running 
Flow

Stateless The Workflow Engine allows a long-running workflow process 
to run between sessions even if the user pauses this workflow 
process.

It is recommended that you do not define a long-running 
workflow process to call a stateful business service because 
Siebel CRM loses the state of this business service if the 
instance of a long-running workflow process moves from one 
user session to another user session.

7.0 Flow Stateful Do not modify this setting unless you are sure none of the 
business services that the workflow process calls directly or 
indirectly is a stateful business service.
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properties (table) 63
Chart Element object type, about and 

properties (table) 54
Chart Locale object type, about and 

properties (table) 64
Chart object type

about and properties (table) 48
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Category Field, contents of 52
Check Bitmap Identifier property 84
Check DObj Visibility Strength 

property 177
Check Dock Object Name property 177
Check No Match property 141
Check Visibility property 174
Child Business Component property 211
Class Method Menu Item Locale object type, 

about and properties (table) 163
Class Method Menu Item object type, about 

and properties (table) 163
Class Method object type, about and 

properties (table) 162
Class object type

about and properties (table) 161
Class property

Applet object type 33
Business Component object type 115
Business Service object type 155
Control object type 66
Toolbar object type 273

Class User Prop object type, about and 
properties (table) 164

Class User Prop Value object type, about and 
properties (table) 165

Client Restriction property
Screen View object type 227
Toolbar object type 273

Close Bitmap property 198
Cluster 2 property 246
Cluster property 246
Code or Class Id property 173
Code Symbol property

Server Component Event Subtype object 
type 230

Server Component Event Type object 
type 230

Server Component Parameter object 
type 231

Server Component State Value object 
type 232

Server Component Statistic object 
type 233

Server Component Type object type 234
Collapse Bitmap property 198
Collapse Elbow Bitmap property 198
Collapse Tee Bitmap property 198
Color property 55

Task Chapter object type 257
Column Name property

Attribute object type 276
Index Column object type 247
User Key Column object type 252

Workflow Policy Column object type 292
Column object type

about and properties (table) 239
custom extension columns, about 

configuring 244
Column property

Field object type 124
Import Field Column object type 201
Integration Component Field object 

type 205
Single Value Field object type 148

Column Sequence property 252
Column Span - Language Override property

Applet Web Template Item object type 45
Column Span property

Applet Web Template Item Locale object 
type 47

Applet Web Template Item object type 45
Command Locale object type, about and 

properties (table) 170
Command object type, about and properties 

(table) 168
Command property

Applet Method Menu Item 41
Class Method Menu Item object type 163
Menu Item object type 216
Toolbar Item object type 274

Comments property 15
Company Logo Bitmap property 95
Compare property 48
Compare To property

Task Branch Criteria object type 256
WF Branch Criteria object type 326

Component Definition Settable 
property 231

Component Settable property 231
Constrain property

MVF Pick Map object type 144
Pick Map object type 145
SVF Pick Map object type 151

Contact Id Field property 238
Container Web Page property

Application object type 95
View object type 279

Content Fixup Name property
Control object type 67
List Column object type 84

Content Object object type, about and 
properties (table) 170

Content Object View object type, about and 
properties (table) 171

Context Business Component property
Task Group Item object type 270

Control Locale object type, about and 
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properties (table) 78
Control object type

about and properties (table) 65
Control property 46
Control User Prop object type

about and properties (table) 79
changing undocumented user 

properties 244
Coordinates property 55
Correlator Flag property

WF Process Prop object type 329
Country Code Column property 202
Currency Code Field property

Field object type 124
Single Value Field object type 148

Current String Value property
Symbolic String object type 236

custom extension columns, about 
configuring 244

D
Data Example property

Entity Attribute object type 187
Data Function property 48
Data Point Captions property

Chart Locale object type 64
Chart object type 49

Data Point Field property 49
Data property 110
Data Source object type, about and 

properties (table) 245
Data Source property 116
Data Type property

Assignment Attribute object type 103
Business Service Method Arg object 

type 157
Entity Attribute object type 187
Server Component Parameter object 

type 231
Server Component State Value object 

type 232
Server Component Statistic object 

type 233
Task Property object type 263
WF Process Prop object type 330

data types
DTYPE_BOOL 132
DTYPE_CURRENCY 132
DTYPE_DATE 132
DTYPE_DATETIME 132
DTYPE_ID 132
DTYPE_INTEGER 132
DTYPE_NOTE 132

DTYPE_NUMBER 132
DTYPE_PHONE 132
DTYPE_TEXT 133
DTYPE_TIME 133

DBX SQL Statement property 177
Debug Only property

Server Component Type object type 234
Default Applet Focus property 279
Default Button property 67
Default Date property

WF Process Prop object type 330
Default Employee property

Assignment Object object type 297
Default Find property 98

Application object type 95
Default Group property

Assignment Object object type 297
Default Map Column Name Prefix 

property 183
Default Number property

WF Process Prop object type 330
Default Org property

Assignment Object object type 297, 307
Default Organization property

Assignment Object object type 307
Default Position property

Assignment Object object type 297
Default property

Column object type 240
EIM Interface Table Column object 

type 181
Task Property object type 263

Default String property
WF Process Prop object type 330

Default Value property
Server Component Parameter object 

type 231
Workflow Policy Program Arg object 

type 320
Default View property 225
Defect Id Field property 238
Defer Write Record property

Task Step object type 264
Definition property

Symbolic String object type 236
Denormalization Path property

Column object type 240
EIM Interface Table Column object 

type 181
Description property

Class User Prop object type 164
Class User Prop Value object type 166
Server Component Event Subtype object 

type 15
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Dest Field property 124
Destination Business Component 

property 141
Destination Column property

Join Constraint object type 136
Join Specification object type 137

Destination Drilldown Object 
property 315

Destination Field property
Drilldown Object object type 80
Find object type 191
Link object type 211

Destination Link property 141
Destination Table Name property 183
Detail Applet property

Control object type 67
List Column object type 84

Dflt Mapping Col Name property 248
Dirty Reads property 116
Disable PDQ property 279
Display Flag property Assignment Criteria 

object type 106
Display Format property

Chart Element object type 55
Control object type 67
List Column object type 84

Display In Page property
Screen View object type 227

Display In Site Map property
Screen View object type 227

Display Name property
Accelerator Locale object type 167
Accelerator object type 167
Application Locale object type 98
Application object type 95
Assignment Criteria Attribute Locale object 

type 109
Assignment Criteria Attribute object 

type 107
Assignment Criteria Locale object type 109
Assignment Criteria object type 106
Business Service Locale object type 156
Business Service Method Arg Locale object 

type 159
Business Service Method Arg object 

type 157
Business Service Method object type 157
Business Service object type 155
Command Locale object type 170
Command object type 168
Dynamic Candidate Locale object type 314
Dynamic Candidate object type 311
Find Field Locale object type 194
Find Field object type 192

Find Locale object type 194
Find object type 191
Import Field Locale object type 201
Import Field Map object type 202
Import Field object type 200
List Column Locale object type 89
List Column object type 84
Server Component Event Subtype object 

type 230
Server Component Event Type object 

type 230
Server Component Parameter object 

type 231
Server Component State Value object 

type 232
Server Component Statistic object 

type 233
Server Component Type object type 234
Task Chapter Locale object type 258
Task Chapter object type 257
Task Group Locale object type 271
Task Group object type 270
Task Locale object type 261
Task object type 253
Task Step Locale object type 269
Task Step object type 264
Toolbar Item Locale object type 275
Toolbar Item object type 274
Toolbar Locale object type 275
Toolbar object type 273
Tree Node Locale object type 94
Tree Node object type 92
WF Process Prop object type 330

Display Name Type property
Task Step object type 264

Display Sequence - Language Override 
property

Assignment Criteria Attribute object 
type 107

Display Sequence property
Assignment Criteria Attribute Locale object 

type 109
Assignment Criteria Attribute object 

type 107
Display Size property 286
Display Visibility property 287
Distinct property 116
Divisions property 56
DLL object type, about and properties 

(table) 172
DLL property 161
Do Not User Container property 289
Dock Code property 173
Dock Object object type, about and 
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properties (table) 173
Dock Object Related DObj object type, about 

and properties (table) 174
Dock Object Sub Type property

Dock Object Table object type 175
Dock Object Visibility Rule object type 177

Dock Object Table object type, about and 
properties (table) 175

Dock Object Visibility Rule object type, about 
and properties (table) 176

Drilldown Business Component property
Find Field object type 192

Drilldown Destination Field property
Find Field object type 192

Drilldown Object Locale object type, about 
and properties (table) 82

Drilldown Object object type, about and 
properties (table) 80

Drilldown Source Field property
Find Field object type 192

Drilldown View property
Find Field object type 192
Find object type 191

drilldowns, differences between static and 
dynamic 315

Drop Sectors property 279
DTYPE_BOOL data type 132
DTYPE_CURRENCY data type 132
DTYPE_DATE data type 132
DTYPE_DATETIME data type 132
DTYPE_ID data type 132
DTYPE_INTEGER data type 132
DTYPE_NOTE data type 132
DTYPE_NUMBER data type 132
DTYPE_PHONE data type 132
DTYPE_TEXT data type 133
DTYPE_TIME data type 133
Dynamic Candidate Attribute object type, 

about and properties (table) 312
Dynamic Candidate Component Col object 

type, about and properties 
(table) 313

Dynamic Candidate Component object type, 
about and properties (table) 312

Dynamic Candidate Locale object type, about 
and properties (table) 314

Dynamic Candidate object type, about and 
properties (table) 311

Dynamic Drilldown Destination object type
about and properties (table) 314
drilldowns, differences between static and 

dynamic 315
Dynamic Tooltip property 168

E
Edit property

WF Branch Criteria object type 326
Editable property 49
Effective End Date property

Workflow Process object type 341
Effective Start Date property

Workflow Process object type 341
EIM Delete Proc Column Name 

property 180
EIM Exists Proc Column Name 

property 183
EIM Explicit Primary Mapping object type, 

about and properties (table) 179
EIM Export Proc Column Name 

property 180
EIM Foreign Key Proc Column 

property 184, 185
EIM Interface Table Column object type, 

about and properties (table) 181
EIM Interface Table object type, about and 

properties (table) 180
EIM Merge Proc Column Name 

property 180
EIM Processing Column Flag property

Column object type 241
EIM Interface Table Column object 

type 181
EIM ROW_ID Proc Column Name 

property 183
EIM Status Proc Column Name 

property 183
EIM Table Mapping object type, about and 

properties (table) 183
EIM Unique Proc Column Name 

property 183
Elbow Bitmap property 198
Employee Column Name property 177
Employee Column property

Assignment Object object type 297
Employee Denorm Column property

Assignment Object object type 297, 307
Employee Field property 219
Employee Key Column property

Assignment Object object type 297
Employee Manual Column property

Assignment Object object type 297, 307
Employee Primary Column List property

Assignment Object object type 298, 307
Employee Primary Column property

Assignment Object object type 298
Employee Primary Denorm Column property

Assignment Object object type 298
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Employee Primary Manual Column property
Assignment Object object type 298

Employee Primary System Column property
Assignment Object object type 298

Employee Reporting Column property
Assignment Object object type 308

Employee Reporting Deletion Column 
property

Assignment Object object type 308
Employee Reporting Insertion Column 

property
Assignment Object object type 308

Employee Reporting Key Column property
Assignment Object object type 309

Employee Reporting Table property
Assignment Object object type 309

Employee Skill property Assignment Criteria 
object type 106

Employee System Column property
Assignment Object object type 298, 307

Employee Table Name property 177
Employee Table property

Assignment Object object type 299
Employee Team Copy Columns property

Assignment Object object type 299, 307
Employee Team Denorm Column property

Assignment Object object type 307
Employee Team Manual Column property

Assignment Object object type 307
Employee Team System Column property

Assignment Object object type 307
Enclosure Id Field property 116
End Name 1 property

Entity Relation object type 189
End Name 2 property

Entity Relation object type 189
Enterprise Integration Manager (EIM), 

object types 18
Enterprise Settable property 231
Entity 1 property

Entity Relation object type 189
Entity 2 property

Entity Relation object type 189
Entity Attribute object type, about and 

properties (table) 187
Entity object type, about and properties 

(table) 186
Entity Physical Relation object type, about 

and properties (table) 188
Entity Relation object type, about and 

properties (table) 188
Entity Relationship Diagram object type, 

about and properties (table) 189
Error Code property

WF Step object type 332
Error Message property

WF Step object type 332
Error Process Name property

Workflow Process object type 342
Error Web Page property 95
Event Cancel Flag property

WF Step Branch object type 337
Event Name property 97
Event Object property

WF Step Branch object type 337
Event Object Type property

WF Step Branch object type 337
Event property

WF Step Branch object type 337
Event Visibility property

WF Step Branch object type 338
Exchange Date Field property

Field object type 125
Single Value Field object type 148

Exclude Column property
Assignment Object object type 299, 307

Expand Bitmap property 198
Expand Elbow Bitmap property 198
Expand Tee Bitmap property 198
Explicit Logon property 279
Explicit Mapping property 184
Expression Business Component property

Task Step Context object type 267
Expression property 287

Applet Web Template Item object type 46
Applet Web Template object type 44
WF Step Recipient object type 341

Extension Type property 117
External API Write property

Table object type 248
External Data Type property 205
External Length property 205
External Major Version property 209
External Minor Object property 209
External Name property

Integration Component Field object 
type 205

Integration Component object type 204
Integration Object object type 209

External Precision property 205
External Required property 205
External Scale property 205
External Search Engine object type 190
External Search Engine object type, about 

and properties (table) 190
External Sequence property

Integration Component Field object 
type 206
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Integration Component object type 204
External Use property 155

F
Field - Language Override property

Applet Message Variable object type 40
Field Locale object type, about and 

properties (table) 134
Field Name property

Find Pick View object type 195
Integration Component Key Field object 

type 208
Field object type

about and properties (table) 124
type property, about and table of 

values 131
virtual business components, supported (list 

of) 134
Field property

Applet Message Variable Locale object 
type 40

Applet Message Variable object type 40
Control object type 67
Dynamic Drilldown Destination object 

type 315
Find Field object type 192
Import Field Map object type 202
Import Field object type 201
List Column object type 84
Multi Value Field object type 139
MVF Pick Map object type 144
MVF Pick Map UpdOnlyIfNull object 

type 145
Pick Map object type 145
Pick Map UpdOnlyIfNull object type 147
SVF Pick Map object type 151
SVF Pick Map UpdOnlyIfNul object 

type 152
Field Retrieval Type property

Control object type 67
List Column object type 84

Field Type property
Control object type 67
Integration Component Field object 

type 206
Field User Prop object type

about and properties (table) 135
File Name property

Bitmap object type 110
DLL object type 173

File property
EIM Interface Table object type 180
Table object type 248

Filter Business Component property
Task Step Context object type 267

Filter Sql Statement property 175
Find Field Locale object type, about and 

properties (table) 193
Find Field object type

about and properties (table) 191
field restriction, about 193
query by example (QBE). about different 

behaviors 193
Find Locale object type, about and properties 

(table) 194
Find object type, about and properties 

(table) 191
Find Pick View object type

about and properties (table) 195
applet, associating with and example 194

Find property 98
Find View object type

about and properties (table) 195
FK Column 1:M Rel Name property 241
FK Column M:1 Rel Name property 241
Font Effect property 56
Font Face property 272
Font Name property 56
Font Size property

Chart Element object type 56
Text Style object type 272

Font Style property 56
Force Active property

Business Component object type 117
Field object type 125
Multi Value Field object type 139
Single Value Field object type 148

Force Case property
Column object type 241
EIM Interface Table Column object 

type 181
Field object type 125
Single Value Field object type 148

Force Enable property 168
Foreground Text Style property 68
Foreign Key Column Name property 184
Foreign Key Mapping Column object type, 

about and properties (table) 185
Foreign Key Mapping object type, about and 

properties (table) 184
Foreign Key Table Name property

Column object type 241
EIM Interface Table Column object 

type 181
Foreign Key Table property 241
Format String property

Entity Attribute object type 187
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From Step Name property
WF Branch Connector object type 325

functions
GetProperty 160
SetProperty 160

G
GenReassignAct property 117
GetProperty function 160
GGParent property 15
Glossary property

Symbolic String object type 236
GParent property 15
Graphic property 63
Graphic Type property 57
Grid Property property

Applet Web Template Item object type 46
Group Column property

Assignment Object object type 299, 307
Group Denorm Column property

Assignment Object object type 299, 307
Group Manual Column property

Assignment Object object type 299, 307
Group Primary Column List property

Assignment Object object type 300, 307
Group Primary Column property

Assignment Object object type 300, 307
Group Primary Denorm Column property

Assignment Object object type 300, 307
Group Primary Manual Column property

Assignment Object object type 300, 307
Group Primary System Column property

Assignment Object object type 300, 307
Group property

Control object type 68
Integration Component Field object 

type 206
Table object type 248
Toolbar Item object type 274
Workflow Process object type 342

Group System Column property
Assignment Object object type 300, 307

Group Table property
Assignment Object object type 300, 307

guidelines
DB operations, using 319
long-running workflows, using a stateful 

business service with 344

H
Handheld Client property 161
Height - Language Override property 68
Height property

Applet object type 33
Bitmap object type 110
Control Locale object type 78
Control object type 68

Help Id object type, about and properties 
(table) 196

Help Identifier property
Applet object type 33
Screen object type 225
View object type 279

hidden object types and properties
about 13

Hidden property
Business Service Method Arg object 

type 157
Business Service Method object type 157
Business Service object type 155
Field object type 125
Multi Value Field object type 139
Single Value Field object type 148

Hierarchy Parent Field property 117
High Interactivity Enabled property 162
HTML Attribute property 85
HTML Attributes property

Control object type 68
Toolbar Item object type 274
Web Page Item object type 289

HTML Bitmap property
Command object type 169
Control object type 68
View object type 279

HTML Closed Bitmap property 92
HTML Default Control property 68
HTML Disabled Bitmap property

Command object type 169
Control object type 68

HTML Display Mode property
Control object type 69
List Column object type 85

HTML Height - Language Override property
Control object type 70
List Column object type 85

HTML Height property
Control Locale object type 78
Control object type 70
List Column Locale object type 89
List Column object type 85

HTML Help URL property 197
HTML Hierarchy Bitmap object type, about 

and properties (table) 197
HTML Hierarchy Bitmap property

List object type 83
Tree object type 91

HTML Icon Map property
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Control object type 70
List Column object type 85

HTML List Edit property 85
HTML Max Chars Displayed - Language 

Override property
Control object type 70
List Column object type 85

HTML Max Chars Displayed property
Control Locale object type 78
Control object type 70
List Column Locale object type 90
List Column object type 85

HTML Multi Row Edit property 83
HTML Multi Row Select property 83
HTML Number of Rows

property 33
HTML Only property

Control object type 70
List Column object type 85

HTML Open Bitmap property 92
HTML Popup Dimension property

Applet object type 34
Command object type 169
View object type 280

HTML Row Sensitive property
Control object type 71
List Column object type 86

HTML Sequence - Language Override 
property

Control object type 71
List Column object type 86

HTML Sequence property
Control Locale object type 78
Control object type 71
List Column Locale object type 90
List Column object type 86

HTML Type property
Control object type 71
List Column object type 86
Toolbar Item object type 274

HTML Width - Language Override property
Control object type 71
List Column object type 86
Toolbar Item object type 274

HTML Width property
Control Locale object type 78
Control object type 71
List Column Locale object type 90
List Column object type 86
Toolbar Item Locale object type 275
Toolbar Item object type 274

Hyperlink Field property 81

I
ICL Upgrade Path property 15

Applet object type 34
Icon Map object type, about and properties 

(table) 199
Icon object type, about and properties 

(table) 199
Ignore Assignment Attributes property

Assignment Object object type 300, 307
Ignore Extra Attributes property

Assignment Object object type 307
Immediate Post Changes property 125
Import Aux Field object type

about and properties (table) 200
duplicate keys and searching 200

Import Field column object type, about and 
properties (table) 201

Import Field Locale object type, about and 
properties (table) 201

Import Field Map object type, about and 
properties (table) 202

Import Field object type, about and 
properties (table) 200

Import Key Field object type, about and 
properties (table) 202

Import Object object type
about and properties (table) 203

Import Source object type, about and 
properties (table) 203

In/Out property
Task Property object type 263, 331
WF Process Prop object type 331

Inaccessible property 250
Inactive property 15
Inbox Disposition property

Task object type 254
Index Column object type, about and 

properties (table) 247
Index Name property 250
Index object type

about and properties (table) 245
caution, creating indexes and decreasing 

performance 245
Inf Tbl Exp Primary Flg Col Name property

EIM Explicit Primary Mapping object 
type 179

information access, objects related to 19
Input Flag property

WF Step I/O Argument object type 339
Input/Output property

Task Event IO Argument object type 260
Task Step IO Argument object type 268

Insert Applet property 34
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Insert Position property 34
Insert Update All Columns property 117
Integration Component Field object type, 

about and properties (table) 205
Integration Component Field User Prop 

object type
about and properties (table) 207

Integration Component Key Field object 
type, about and properties 
(table) 208

Integration Component Key object type, 
about and properties (table) 208

Integration Component object type, about 
and properties (table) 204

Integration Component User Prop object 
type

about and properties (table) 209
Integration Object object type, about and 

properties (table) 209
Integration Object property

Business Service Method Arg object 
type 158

Content Object object type 171
Task Property object type 263
WF Process Prop object type 331

Integration Object User Prop object type
about and properties (table) 210

Inter Child Column property 211
Inter Child Delete property 211
Inter Parent Column property 211
Inter Table property

Link object type 211
Interactive property

Server Component Type object type 234
Interface Table Data Column property

Attribute Mapping object type 179
Foreign Key Mapping Column object 

type 185
Interface Table User Key Usage object type, 

about and properties (table) 186
Internal Pick Applet property 125
Invert property 49
Is Subtask property

Task object type 254
Is User Search Spec property

Task Step Context object type 267
Italic property 272
Item Identifier - Language Override property

Applet Web Template Item object type 46
View Web Template Item object type 287
Web Page Item object type 289

Item Identifier property
Applet Web Template Item Locale object 

type 47

Applet Web Template Item object type 46
View Web Template Item Locale object 

type 288
View Web Template Item object type 287
Web Page Item Locale object type 290
Web Page Item object type 289

Item Type Name property
WF Branch Criteria object type 326

J
Java Package property 173
Java Thin Client property 162
Join Alias property

Entity Physical Relation object type 188
Join Column Name property

User Key Attribute Join object type 251
User Key Attribute Tree Node object 

type 251
Join Constraint object type, about and 

properties (table) 136
Join object type

about and properties (table) 135
Join property

Field object type 126
Single Value Field object type 148

Join Sequence property
User Key Attribute Join object type 251
User Key Attribute Tree Node object 

type 251
Join Spec property 316
Join Specification object type

about and properties (table) 137
Join Type property 251

K
Keep Creator property

Assignment Object object type 301
Keep Man Asgn Primary Employee property

Assignment Object object type 301, 307
Keep Man Asgn Primary Group property

Assignment Object object type 301, 307
Keep Man Asgn Primary Org property

Assignment Object object type 301
Keep Man Asgn Primary Position property

Assignment Object object type 301, 307
Keep Manual Assigned property

Assignment Object object type 307
Keep Manual Primary Employee property

Assignment Object object type 307
Keep Manual Primary Position property

Assignment Object object type 307
Keep Primary Manual Rule property

Assignment Object object type 307
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Keep User Assigned property
Assignment Object object type 302, 307

Key Based Routing property 234
Key Field property 202
Key Generation Business Service property

Table object type 248
Key Generation Service Method property

Table object type 248
Key Sequence - Language Override 

property 167
Key Sequence Number property 208
Key Sequence property

Accelerator Locale object type 168
Accelerator object type 167

Key Type property 208

L
Label Field property 92
Label property

Task Branch object type 255
Language Code property 15

Applet Message Locale object type 39
Language Locked property 222
Language Override Attribute property 276
Language Sub Type property 278
Layout property

WF Branch Connector object type 325
Leaf Bitmap property 198
Left - Language Override property 71
Left property

Control Locale object type 79
Control object type 71

Left Text property 71
Legend property 63
Length property 206

Entity Attribute object type 187
Level property 232
Line Style property 57
Line Width property 57
Link Name property

Entity Physical Relation object type 188
Link object type

about and properties (table) 210
Link property 153
Link Specification property

Field object type 126
Multi Value Field object type 139
Single Value Field object type 149

List Column Locale object type, about and 
properties (table) 89

List Column object type, about and 
properties (table) 83

List Locale object type, about and properties 

(table) 91
List object type, about and properties 

(table) 82
List Of Values property 58
Lock Assignment Column property

Assignment Object object type 307
Locked By (Id) property 222
Locked Date property 222
Locked property 222
Log Base property 58
Log Changes property 117
Login Web Page property 96
Logoff Acknowledgement Page 

property 96
Long List property 220
LOV Bounded property

Column object type 241
EIM Interface Table Column object 

type 181
LOV Type property

Column object type 241
EIM Interface Table Column object 

type 182

M
Mail Address Field property 34
Mail Template property 34
Max Child Items property 93
Max Number Per Role property

Assignment Object object type 302
Max Rows property 190
Max Time property 190
Maximum Cursor Size property 118
Maximum Iterations property

WF Step object type 332
Menu Editor usage note

Applet Method Menu Item object type 41
Menu Item Locale object type, about and 

properties (table) 216
Menu Item object type, about and properties 

(table) 215
Menu object type, about and properties 

(table) 215
Menu property 96
Menu Text property

Applet Method Menu Item Locale object 
type 41

Applet Method Menu Item object type 41
Application Method Menu Item Locale object 

type 99
Application Method Menu Item object 

type 99
Class Method Menu Item Locale object 
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type 164
Class Method Menu Item object type 163
Drilldown Object Locale object type 82
Drilldown Object object type 81
Screen View Locale object type 229
Screen View object type 227

Message Category object type, about and 
properties (table) 217

Message Locale object type, about and 
properties (table) 218

Message object type, about and properties 
(table) 217

Method Argument property 169
Method Invoked property

Control object type 72
Web Page Item object type 289

Method Name property 97
Method property

Application Method Menu Item object 
type 99

Class Method object type 162
Command object type 169

Metric Name property
Task Metric object type 262
WF Process Metric object type 328

MIME Type property 110
Mode property 46
Module property 15
Move Range property 287
Multi Data Point property 49
Multi Line property 73
Multi Recipient Select property 118
Multi Value Field object type, about and 

properties (table) 138
Multi Value Link object type, about and 

properties (table) 140
Multi Value Link property

Field object type 126
Multi Value Field object type 139

Multi Valued property 126
MVF Pick Map object type

about and properties (table) 143
multi-value fields, about constraining pick 

maps on 144
MVF Pick Map UpdOnlyIfNull object type, 

about and properties (table) 144
MVG Applet property

Control object type 73
List Column object type 86

MVG business component 123

N
Name property

Accelerator Locale object type 168
Accelerator object type 167
Applet Browser Script object type 37
Applet Locale object type 38
Applet Message object type 38
Applet Message Variable Locale object 

type 40
Applet Method Menu Item 41
Applet Method Menu Item Locale object 

type 41
Applet object type 34
Applet Script object type 42
Applet Toggle object type 43
Applet User Prop object type 44
Applet Web Template Item Locale object 

type 47
Applet Web Template Item object type 46
Applet Web Template object type 44
Application Browser Script object type 96
Application Event Services object type 97
Application Find object type 98
Application Locale object type 98
Application Method Menu Item Locale object 

type 99
Application Method Menu Item object 

type 99
Application object type 96
Application Toolbar object type 100
Assignment Attribute Column object 

type 105
Assignment Attribute object type 103
Assignment Criteria Attribute Locale object 

type 109
Assignment Criteria Attribute object 

type 108
Assignment Criteria Locale object type 109
Assignment Criteria object type 106
Assignment Object Extension object 

type 309
Assignment Object object type

Assignment Object object type 302
Assignment User Prop object type 311
Attribute Mapping object type 179
Attribute object type 276
Bitmap Category object type 111
Bitmap Locale object type 112
Bitmap object type 110
BusComp Browser Script object type 113
BusComp View Mode object type 114
Business Component object type 118
Business Component User Prop object 

type 123
Business Object Component object 
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type 153
Business Object object type 153
Business Service Browser Script object 

type 156
Business Service Locale object type 156
Business Service Method Arg object 

type 158
Business Service Method Arg User Prop object 

type 159
Business Service Method object type 157
Business Service object type 155
Business Service Subsystem object 

type 160
Business Service User Prop object 

type 161
Chart Element Locale object type 64
Chart Element object type 59
Chart Locale object type 64
Chart object type 49
Class Method Menu Item Locale object 

type 164
Class Method Menu Item object type 163
Class Method object type 162
Class object type 162
Class User Prop object type 164
Class User Prop Value object type 166
Column object type 242
Command Locale object type 170
Command object type 169
Content Object object type 171
Content Object View object type 172
Control Locale object type 79
Control object type 73
Control User Prop object type 80
Data Source object type 245
DLL object type 173
Dock Object object type 173
Dock Object Related DObj object type 174
Dock Object Table object type 175
Dock Object Visibility Rule object type 177
Drilldown Object Locale object type 82
Drilldown Object object type 81
Dynamic Candidate object type 311
Dynamic Drilldown Destination object 

type 315
EIM Explicit Primary Mapping object 

type 179
EIM Interface Table Column object 

type 182
EIM Interface Table object type 180
EIM Table Mapping object type 184
Entity Attribute object type 187
Entity object type 187
Entity Physical Relation object type 188

Entity Relation object type 189
Entity Relationship Diagram object 

type 189
External Search Engine object type 190
Field object type 126
Field User Prop object type 135
Find Field Locale object type 194
Find Field object type 192
Find Locale object type 194
Find object type 191
Find Pick View object type 195
Foreign Key Mapping Column object 

type 185
Foreign Key Mapping object type 184
Help Id object type 197
HTML hierarchy bitmap properties 198
Icon Map object type 199
Icon object type 199
Import Aux Field object type 200
Import Field Column object type 201
Import Field Locale object type 201
Import Field Map object type 202
Import Field object type 201
Import Key Field object type 202
Import Object object type 203
Import Source object type 203
Index Column object type 247
Index object type 246
Integration Component Field object 

type 206
Integration Component Field User Prop object 

type 207
Integration Component Key Field object 

type 208
Integration Component Key object 

type 208
Integration Component object type 204
Integration Component User Prop object 

type 209
Integration Object object type 210
Integration Object User Prop object 

type 210
Interface Table User Key Usage object 

type 186
Join Constraint object type 137
Join object type 136
Join Specification object type 138
Link object type 212
List Column Locale object type 90
List Column object type 86
List Column User Prop object type 90
List Locale object type 91
List object type 83
Menu Item Locale object type 216
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Menu Item object type 216
Menu object type 215
Message Category object type 218
Message Locale object type 218
Message object type 217
Multi Value Field object type 139
Multi Value Link object type (multi-value 

name link) 142
Page Tab Locale object type 101
Pager Object object type 219
Pick List object type 220
Project object type 222
Repository object type 223
Screen Locale object type 226
Screen Menu Item Locale object type 102
Screen object type 225
Screen View Locale object type 229
Server Component Event Subtype object 

type 230
Server Component Event Type object 

type 230
Server Component Parameter object 

type 231
Server Component State Value object 

type 232
Server Component Statistic object 

type 233
Server Component Subsystem object 

type 234
Server Component Type object type 234
Single Value Field object type 149
Symbolic String object type 236
Table object type 249
Task Branch Criteria object type 256
Task Branch object type 255
Task Chapter Locale object type 258
Task Chapter object type 257
Task Event IO Argument object type 260
Task Event object type 259
Task Group Item object type 270
Task Group Locale object type 271
Task Locale object type 261
Task Metric object type 262
Task object type 254
Task Property object type 263
Task Step Context object type 267
Task Step IO Argument object type 268
Task Step Locale object type 269
Task Step object type 264
Text Style object type 272
Toolbar Item Locale object type 275
Toolbar Item object type 274
Toolbar Locale object type 275
Toolbar object type 273

Tree Node Locale object type 94
Tree Node object type 93
Tree object type 91
Type object type 278
User Key Attribute Join object type 251
User Key Attribute object type 250
User Key Attribute Tree Node object 

type 252
User Key Column object type 252
User Key object type 250
View Locale object type 283
View object type 280
View Task Group Locale object type 285
View User Prop object type 285
View Web Template Item Locale object 

type 288
View Web Template Item object type 287
View Web Template object type 286
Web Page Item Locale object type 290
Web Page Item object type 289
Web Page Item Parameter object type 291
Web Page Locale object type 291
Web Page object type 289
Web Template object type 292
WF Branch Connector object type 325
WF Branch Criteria object type 326
WF Process Metric object type 328
WF Process Prop object type 331
WF Step Branch object type 338
WF Step I/O Argument object type 339
WF Step object type 332
WF Step Recipient object type 341
Workflow Policy Column object type 292
Workflow Policy Component Col object 

type 317
Workflow Policy Component object 

type 316
Workflow Policy Object object type 318
Workflow Policy Program Arg object 

type 320
Workflow Policy Program object type 319
Workflow Process object type 342

Namespace - Language Override property
Applet Web Template Item object type 46
View Web Template Item object type 287
Web Page Item object type 290

Namespace property
Applet Web Template Item Locale object 

type 47
Applet Web Template Item object type 46
View Web Template Item Locale object 

type 288
View Web Template Item object type 287, 

288, 289, 290
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Web Page Item Locale object type 290
Web Page Item object type 289

naming conventions for object type 13
No Associate property

Link object type 212
Multi Value Link object type 142

No Borders property 280
No Clear property

MVF Pick Map object type 144
Pick Map object type 145
SVF Pick Map object type 151

No Compile property
Attribute object type 276
Type object type 278

No Copy property
Field object type 127
Multi Value Field object type 139
Multi Value Link object type 142
Single Value Field object type 149

No Delete property
Applet object type 35
Business Component object type 118
Link object type 212
Multi Value Link object type 142
Pick List object type 220

No Insert property
Applet object type 35
Business Component object type 118
Link object type 212
Multi Value Link object type 142
Pick List object type 220

No Inter Delete property 212
No Match Value property

Column object type 242
No Merge property

Applet object type 35
Business Component object type 119
Pick List object type 220

No Update property
Applet object type 35
Business Component object type 119
Link object type 212
Multi Value Link object type 142
Pick List object type 220

Node Column Name property 177
Node Language Filter property 175
Node Table Name property 177
Node Type property

Symbolic String object type 249
non-configurable object types 18
Notify property 175
Nullable property

Column object type 242
EIM Interface Table Column object 

type 182
Number of Unique Columns property 246
Numeric Template property 219

O
Object Id Column property

Dynamic Candidate object type 311
Object Language Locked property 16
Object Locked by Name property 16
Object Locked Date property 16
Object Locked property 16
Object Manager Restriction property 227
Object Type property 162
object types

non-configurable 18
object types and properties

hidden object types and properties, 
about 13

On Conflict property
Task object type 254

Open Bitmap property 198
Operation property

Task Branch Criteria object type 256
Task Step object type 264
WF Branch Criteria object type 327
WF Step object type 333

Opportunity Id Field property 238
Optional property 158
Optional, Property column value 13
Oracle Sequence Object property

Field object type 127
Single Value Field object type 149

Order By LOV Type property
Assignment Attribute object type 103

Org Column property
Assignment Object object type 302, 307

Org Denorm Column property
Assignment Object object type 302

Org Key Column property
Assignment Object object type 302

Org Manual Column property
Assignment Object object type 302

Org Primary Column List property
Assignment Object object type 303

Org Primary Column property
Assignment Object object type 303

Org Primary Denorm Column property
Assignment Object object type 303

Org Primary Manual Column property
Assignment Object object type 303

Org Reporting Column property
Assignment Object object type 309

Org Reporting Deletion Column property
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Assignment Object object type 309
Org Reporting Insertion Column property

Assignment Object object type 309
Org Reporting Key Column property

Assignment Object object type 309
Org Reporting Table property

Assignment Object object type 309
Org System Column property

Assignment Object object type 303
Org Table property

Assignment Object object type 304, 307
Org Team Score Column property

Assignment Object object type 304
Organization Column Name property 177
Organization Column property

Assignment Object object type 307
Organization Primary System Column 

property
Assignment Object object type 303

Organization Table Name property 177
Organization Table property

Assignment Object object type 307
Outer Join Flag property 136
Output Arg property

WF Step I/O Argument object type 340
Override Ref Column property 185
Owner Branch property

Project object type 222
Owner Delete property 119
Owner Draw property 73
Owner Organization Specifier property

Table object type 249
Owner Type property 114

P
Page Tab Locale object type, about and 

properties (table) 101
Page Tab object type, about and properties 

(table) 100
Pager Object object type, about and 

properties (table) 218
Parent Business Component property 213
Parent Category property

Screen View object type 227
Parent Integration Component 

property 204
Parent Interface Table Name property 180
Parent Name property 16

Task Branch Criteria object type 256
Task Branch object type 255
Task Chapter object type 258
Task Event IO Argument object type 260
Task Event object type 259

Task Group Locale object type 271
Task Metric object type 262
Task Property object type 263
Task Step IO Argument object type 268
Task Step Locale object type 269
Task Step object type 264

Parent property 16
Parent Table Column 1 Name property 180
Parent Table Column 2 Name property 180
Parent Table Column1 property 249
Parent Table Column2 property 249
Parse Middle Name property 202
Partial property 177
Performance Impact property

Server Component Parameter object 
type 231

Period property 49
persistence, Business Component object 

type 122
Phone Field property 219
Physical Data Type property 206
Physical Type Name property 242
Physical Type property

Column object type 242
EIM Interface Table Column object 

type 182
Pick Applet property

Assignment Criteria Attribute object 
type 108

Business Service Method Arg object 
type 158

Content Object object type 171
Control object type 74
List Column object type 86

Pick Field property
Assignment Attribute object type 103
Business Service Method Arg object 

type 158
Pick List Domain property

Entity Attribute object type 187
Pick List Field property

MVF Pick Map object type 144
Pick Map object type 145
SVF Pick Map object type 151

Pick List object type
about and properties (table) 220

Pick List property
Assignment Attribute object type 103
Content Object object type 171
Server Component Parameter object 

type 231
Pick List Required property

Entity Attribute object type 188
Pick Map Pick object type



Siebel Object Types Reference Siebel 2018

Index ■ P

364 

about and properties (table) 145
multi-value field, about constraining picklist 

on 145
Pick Map UpdOnlyIfNull object type

about and properties (table) 146
NULL constraining value, about 

ignoring 147
Picklist Function Captions property

Chart Locale object type 64
Chart object type 50

Picklist Functions property 50
Picklist Period Captions property

Chart Locale object type 64
Chart object type 50

Picklist Periods property 50
PickList property

Field object type 127
Multi Value Field object type 140
Single Value Field object type 149
Workflow Policy Column object type 292

Picklist property
Business Service Method Arg object 

type 158
Workflow Policy Program Arg object 

type 320
Picklist Type Captions property

Chart Locale object type 64
Chart object type 50

Picklist Types property 51
PIN Field property 219
Placeholder property 119
Plot property 63
Popup Dimension property 35
Popup Edit property

List Column object type 86
Popup Indicator Bitmap property 273
Popup Update Only property 142
Popup Visibility Auto All property 119
Popup Visibility Type property 120
Position - Language Override 

property 274
Position Column Name property 177
Position Column property

Assignment Object object type 304
Position Denorm Column property

Assignment Object object type 304, 308
Position Key Column property

Assignment Object object type 304
Position Manual Column property

Assignment Object object type 304, 308
Position Primary Column List property

Assignment Object object type 304, 308
Position Primary Column property

Assignment Object object type 304, 305

Position Primary Denorm Column property
Assignment Object object type 305

Position Primary Manual Column property
Assignment Object object type 305

Position Primary System Column property
Assignment Object object type 305

Position property
Applet Method Menu Item object type 41
Application Method Menu Item object 

type 99
Class Method Menu Item object type 163
Menu Item object type 216
Toolbar Item Locale object type 275
Toolbar Item object type 274
Tree Node object type 93
View Web Template Item object type 287

Position Reporting Column property
Assignment Object object type 309

Position Reporting Deletion Column property
Assignment Object object type 309

Position Reporting Insertion Column 
property

Assignment Object object type 309
Position Reporting Key Column property

Assignment Object object type 310
Position Reporting Table property

Assignment Object object type 310
Position System Column property

Assignment Object object type 305, 308
Position Table Name property 177
Position Table property

Assignment Object object type 305
Position Team Copy Columns property

Assignment Object object type 308
Position Team Denorm Column property

Assignment Object object type 308
Position Team Manual Column property

Assignment Object object type 308
Position Team Score Column property

Assignment Object object type 305
Position Team System Column property

Assignment Object object type 308
Post Default Value property

Field object type 127
Single Value Field object type 149, 150

Pre Default Value property
Field object type 128
Single Value Field object type 150

Precision property
Column object type 242
EIM Interface Table Column object 

type 182
Field object type 128
Integration Component Field object 
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type 206
Single Value Field object type 150

Predefined property 111
Preferred Sequence property 158

Task Branch Criteria object type 257
Task Event IO Argument object type 260
Task Step IO Argument object type 268
WF Step I/O Argument object type 340

PreFetch Size property 120
PreInvokeMethod event handler 40
Preview property

Find object type 191
Previous Tree Node Name property 252
Primary Business Component 

property 153
Primary Child Col property

Column object type 242
EIM Interface Table Column object 

type 182
Primary Child Column Name property

Column object type 242
EIM Interface Table Column object 

type 182
Primary Child Join Column Name 

property 242
Primary Child Table Name property

Column object type 242
EIM Interface Table Column object 

type 182
Primary Id Field property

Link object type 213
Multi Value Link object type 142

Primary Inter Table Name property
Column object type 242
EIM Interface Table Column object 

type 182
Primary Inter Table property 242
Primary Join Column Name property

Column object type 243
EIM Interface Table Column object 

type 182
Primary Key property

Column object type 243
EIM Interface Table Column object 

type 182
Primary property 316
Primary Table Name property 174
Primary Table property

Assignment Object object type 305
Private Field property 114
Procedure property

Applet Browser Script object type 37
Application Browser Script object type 97
BusComp Browser Script object type 113

Business Service Browser Script object 
type 156

Process Name property
Workflow Process object type 342

Process Property Name property
WF Step Recipient object type 341

Processing Mode property
WF Step object type 333

Program Language property
Applet Script object type 42

Project object type
about and properties (table) 222
object definitions and projects, about 222

Project property 16
Prompt property 74
Prompt Text property

Control Locale object type 79
Control object type 74
List Column Locale object type 90
List Column object type 86

properties
Run External Program Argument 324

Property Name property
Task Branch Criteria object type 257
Task Event IO Argument object type 260
Task Metric object type 262
Task Step IO Argument object type 268
WF Branch Criteria object type 327
WF Process Metric object type 328
WF Step I/O Argument object type 340

Q
query by example (QBE), different behaviors 

and the Find dialog box 193
Query List Business Component 

property 153

R
Read Only property

Control object type 74
Field object type 129
List Column object type 87
Multi Value Field object type 140
Single Value Link object type 150

Recipient Id Field property 120
Recipient Name property

WF Step Recipient object type 341
Recipient Type Code property

WF Step Recipient object type 341
Recursive Link property 93
Recursive property 93
Redo property 16
Rel DObj Visibility Strength property 174
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Related Dock Object Name property 174
Repeatable property

Task Step object type 265
Replace Team Members property

Assignment Object object type 294, 307
Repository Name property 16
Repository object type, about and properties 

(table) 223
Required Context BC property

Task Group object type 270
Required property

Column object type 243
EIM Interface Table Column object 

type 182
Field object type 129
Integration Component Field object 

type 206
Multi Value Field object type 140
Single Value Field object type 150
Workflow Policy Program Arg object 

type 320
Required, Property column value 13
Requires Component Reconfig 

property 231
Requires Server Reconfig property 231
Retain Applet Search Spec property

Task Step object type 265
Retain Task Search Spec property

Task Step object type 265
Retain User Search Spec property

Task Step object type 265
Reverse Fill Threshold property 120
Root Search Spec property 93
Row Span - Language Override property

Applet Web Template Item object type 47
Row Span property

Applet Web Template Item Locale object 
type 47

Applet Web Template Item object type 46
Rule Column property

Assignment Object object type 307
Rule Primary Column property

Assignment Object object type 307
Rule Primary Denorm Column property

Assignment Object object type 307
Rule Primary Manual Column property

Assignment Object object type 307
Rule Primary System Column property

Assignment Object object type 307
Rule Table property

Assignment Object object type 307
Rule Team Copy Columns property

Assignment Object object type 307
Rule Team Denorm Column property

Assignment Object object type 307
Rule Team Manual Column property

Assignment Object object type 307
Rule Team System Column property

Assignment Object object type 307
Run External

Program Argument properties, table 
of 324

Runtime property
Control object type 74
List Column object type 87

S
Scale property

Column object type 243
EIM Interface Table Column object 

type 182
Field object type 129
Integration Component Field object 

type 206
Single Value Field object type 150

Schema Maintenance Step From object 
type 224

Schema Maintenance Step To object 
type 224

Score Column property
Dynamic Candidate object type 311

Screen Locale object type, about and 
properties (table) 226

Screen Menu Item object type, about and 
properties (table) 101

Screen object type, about and properties 
(table) 224

Screen property
Page Tab object type 101
Screen Menu Item object type 102

Screen View Locale object type, about and 
properties (table) 228

Screen View object type
about and properties (table) 226
category menu text and category viewbar 

text, examples 228
Script Editor, about using Siebel VB and 

Siebel eScript 42
Script property

Applet Browser Script object type 37
Applet Script object type 42
Application Browser Script object type 97
BusComp Browser Script object type 113
Business Service Browser Script object 

type 156
Scripted property

Applet object type 35
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Application object type 96
Business Component object type 120

Search Specification property
Applet object type 36
Business Component object type 121
Link object type 213
Pick List object type 221
Task Step Context object type 267

Sector0 Applet property 280
Sector1 Applet property 280
Sector2 Applet property 280
Sector3 Applet property 280
Sector4 Applet property 280
Sector5 Applet property 280
Sector6 Applet property 280
Sector7 Applet property 280
Secure property 280
Selected Bitmap Index Field property 93
Selected Bitmap Index property 93
Selection Based property 51
Self Ref Mapping Column Name 

property 185
Self Reference Join property 185
Separator Character property 202
Sequence - Language Override property

Control object type 74
Find Field object type 193
List Column object type 87

Sequence Object property
Column object type 243
EIM Interface Table Column object 

type 182
Sequence property

Applet Script object type 42
Applet Toggle object type 43
Applet Web Template object type 44
Application Event Services object type 97
Application Find object type 98
Application Toolbar object type 100
Assignment Attribute Column object 

type 105
Column object type 243
Content Object object type 171
Content Object View object type 172
Control Locale object type 79
Control object type 74
Dock Object Related DObj object type 174
Dock Object Visibility Rule object type 177
Drilldown Object object type 81
Dynamic Drilldown Destination object 

type 315
Find Field Locale object type 194
Find Field object type 192, 194
Find View object type 196

Index Column object type 247
Integration Component Key Field object 

type 208
List Column Locale object type 90
List Column object type 87
Page Tab object type 101
Pick Map object type 145
Screen Menu Item object type 102
Screen View object type 227
Task Chapter object type 258
Task Group Item object type 270
View Task Group Locale object type 285
View Task Group object type 284
WF Branch Criteria object type 327
WF Step I/O Argument object type 340

Series Captions property
Chart Locale object type 64
Chart object type 51

Series Field property
Chart object type 51

Server Component Event Subtype object 
type, about and properties 
(table) 229, 230

Server Component Event Type object type, 
about and properties (table) 230

Server Component Parameter object type, 
about and properties (table) 230

Server Component State Value object type, 
about and properties (table) 232

Server Component Statistic object type, 
about and properties (table) 233

Server Component Subsystem object type, 
about and properties (table) 233

Server Component Type object type, about 
and properties (table) 234

Server Enabled property 155
Server Settable property 231
Service Name property 97
Service Request Id Field property 238
Set Primary Employee property

Assignment Object object type 305
Set Primary Group property

Assignment Object object type 306, 308
Set Primary Org property

Assignment Object object type 306
Set Primary Position property

Assignment Object object type 306
Set Primary Rule property

Assignment Object object type 308
SetProperty function 160
Show Category Legend property 59
Show In List - Language Override property

List Column object type 87
Show In List property
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List Column Locale object type 90
List Column object type 87

Show Popup property
Command object type 169
Control object type 75
Web Page Item object type 290

Siebel Enterprise Integration Manager 
(EIM). See individual EIM entries

Single Value Field object type, about and 
properties (table) 147

Skill Item Table property
Assignment Object object type 306

Skill Table property
Assignment Object object type 306

Sort Order property 247
Sort property 75
Sort Spec property 213
Sort Specification property

Business Component object type 121
Chart Element object type 59
External Search Engine object type 190
Pick List object type 221

Sort Web Page property 96
Source Column Name property

Dock Object Table object type 176
Dock Object Visibility Rule object type 177
Workflow Policy Component object 

type 316
Source Field property

Content Object object type 171
Drilldown Object object type 81
Join Specification object type 138
Link object type 213
Multi Value Link object type 143
Workflow Policy Column object type 293
Workflow Policy Program Arg object 

type 320
Source Id Field property 238
Source Interface Table Name 

property 250
Source Table Name property

Dock Object Visibility Rule object type 177
Workflow Policy Component object 

type 316
Space Bitmap property 198
SQL Statement property

Dock Object Related DObj object type 174
Dock Object Visibility Rule object type 177

Static property 221
Status Field property 121
Status property 249

Column object type 243
Entity Relationship Diagram object 

type 189

Task object type 254
Workflow Process object type 342

Status Text property
Command Locale object type 170
Command object type 169
Screen View Locale object type 229
Screen View object type 227
View Locale object type 283

Storage Type property 158
Store Column property

Assignment Criteria Attribute object 
type 108

String Map object type 235
String object type 235
String Override property 16
String Reference property 16
String Value property

Symbolic String Locale object type 237
Sub Node Table Name property 252
Subevent property

WF Step Branch object type 338
Subprocess Name property

WF Step object type 333
Subsystem property

Business Service Subsystem object 
type 160

Server Component Subsystem object 
type 234

SubTask Name property
Task Step object type 265

Super Class property 162
Suppress Menu Item property

Applet Method Menu Item object type 41
Class Method Menu Item object type 163

SVF Pick Map object type
about and properties (table) 151

SVF Pick Map UpdOnlyIfNull object type, 
about and properties (table) 152

Symbolic String Locale object type, about 
and properties (table) 237

Symbolic String Name property
Symbolic String Locale object type 237

Symbolic String object type, about and 
properties (table) 235

Synonym Field property 121
System Activity Objects object type, about 

and properties (table) 237
System Field Mapping property

Column object type 243
System, Property column value 13

T
Tab Stop property 75
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Table Name property
Dock Object Table object type 176
Type object type 278
Workflow Policy Column object type 293

Table object type, about and properties 
(table) 247

Table property
Business Component object type 121
Join object type 136

Target Column Name property
Dock Object Table object type 176
Dock Object Visibility Rule object type 177
Workflow Policy Component object 

type 317
Target Component Name property 317
Target Kay Name property 208
Target property 169
Target Table Name property

Dock Object Table object type 176
Dock Object Visibility Rule object type 178
EIM Interface Table object type 180

Target View Frame property
Control object type 75
Toolbar Item object type 274
Web Page Item object type 290

Task Branch Criteria object type, about and 
properties (table) 256

Task Branch Criteria Value object type, about 
and properties (table) 257

Task Branch object type, about and 
properties (table) 255

Task Chapter Locale object type, about and 
properties (table) 258

Task Chapter object type, about and 
properties (table) 257

Task Event IO Argument object type, about 
and properties (table) 259

Task Event object type, about and properties 
(table) 258

Task Group Item object type, about and 
properties (table) 270

Task Group Locale object type, about and 
properties (table) 271

Task Group object type, about and properties 
(table) 270

Task Group property
View Task Group object type 285

Task Locale object type, about and 
properties (table) 261

Task Metric object type, about and 
properties (table) 261

Task Name property
Task object type 254

Task object type, about and properties 

(table) 253
Task property

Task Group Item object type 271
View object type 280

Task Property object type, about and 
properties (table) 262

Task Settable property 231
Task Step Context object type, about and 

properties (table) 266
Task Step IO Argument object type, about 

and properties (table) 268
Task Step Locale object type, about and 

properties (table) 269
Task Step object type, about and properties 

(table) 264
Task View property

Task Step object type 266
Team Attribute Column property

Dynamic Candidate Attribute object 
type 312

Team property
Assignment Criteria object type 107
Assignment Object object type 306

Team Table Attribute Id Column property
Dynamic Candidate object type 311

Team Table Candidate Id Column property
Dynamic Candidate object type 311

Team Table property
Dynamic Candidate object type 311

Team Type property
Dynamic Candidate object type 311

Tee Bitmap property 198
Text Alignment - Language Override 

property
Control object type 76
List Column object type 87

Text Alignment property
Control Locale object type 79
Control object type 75
List Column Locale object type 90
List Column object type 87

Text Alignment-Label - Language Override 
property

Control object type 76
List Column object type 88

Text Length property
Column object type 243
EIM Interface Table Column object 

type 182
Field object type 129
Server Component Parameter object 

type 232
Server Component State Value object 

type 232



Siebel Object Types Reference Siebel 2018

Index ■ T

370 

Single Value Field object type 150
Text Message - String Override property

Applet Message object type 38
Text Message property

Applet Message Locale object type 39
Applet Message object type 38

Text property
Chart Element Locale object type 64
Chart Element object type 59
Message Locale object type 218
Message object type 217
Page Tab Locale object type 101
Page Tab object type 101
Screen Menu Item Locale object type 102
Screen Menu Item object type 102

Text Style object type, about and properties 
(table) 272

Text Style property
Applet object type 36
Application object type 96
Control object type 76
View object type 281

Text-Alignment Label property
Control Locale object type 79
Control object type 76
List Column Locale object type 90
List Column object type 87

Thin Client property 162
Thread Applet property 281
Thread Field property 281
Thread Title property

View Locale object type 284
View object type 281

Title property
Applet Locale object type 38
Applet object type 36
Chart Element object type 63
Find Field object type 193
View Locale object type 284
View object type 281
Web Page Locale object type 291
Web Page object type 289

To Step Name property
WF Branch Connector object type 325

Toolbar Item Locale object type, about and 
properties (table) 275

Toolbar Item object type
about and properties (table) 273

Toolbar Locale object type, about and 
properties (table) 275

Toolbar object type, about and properties 
(table) 273

Toolbar property 100
Tooltip Text property

Command Locale object type 170
Command object type 169
Control Locale object type 79
Control object type 76

Top - Language Override property 76
Top property

Control Locale object type 79
Control object type 76

Total Currency Code Expression 
property 88

Total Displayed property 83
Total Required property

List Column object type 88
List object type 83

Transactional property
Task object type 254

Transient BC property
Task object type 255

Translatable property 277
Translate Pick Field property

Assignment Attribute object type 104
Translate property 16
Translation Table Name property

Column object type 243
EIM Interface Table Column object 

type 183
Transparent Color property 110
Tree Node Locale object type, about and 

properties (table) 94
Tree Node object type, about and properties 

(table) 92
Tree object type, about and properties 

(table) 91
Txn Log Code property 243
Type Field property

Multi Value Link object type 143
Pick List object type 221

Type object type, about and properties 
(table) 277

Type property
Applet object type 36
Applet Web Template Item object type 47
Applet Web Template object type 45
Business Service Method Arg object 

type 158
Chart Element object type 60
Chart object type 52
Class User Prop object type 165
Column object type 243
Control object type 76
Dock Object Visibility Rule object type 178
EIM Interface Table Column object 

type 183
EIM Interface Table object type 180
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Field object type 131
Field object type (field’s data type) 129
Help Id object type 197
Index object type 246
List Column object type 88
Screen View object type 228
Single Value Field object type 151
Symbolic String object type 236
Table object type 249
Task Branch object type 255
Task Event IO Argument object type 261
Task Group Item object type 271
Task Step Context object type 267
Task Step IO Argument object type 269
Task Step object type 266
Toolbar Item object type 274
Web Page Item object type 290
Web Template object type 292
WF Step Branch object type 338
WF Step I/O Argument object type 340
WF Step object type 333
Workflow Policy Program object type 319

Type Value property
Multi Value Link object type 143
Pick List object type 221

U
Underlined property 272
undocumented user properties, changing

Assignment User Prop object type 276
Unique property 246
UNIX Support property 162
Unrestricted Viewbar property 225
Upgrade Ancestor property 17
Upgrade Behavior property 17
Use Category MVGroup Data property 52
Use Expertise property

Assignment Criteria object type 107
Use FKey property

Column object type 244
EIM Interface Table Column object 

type 183
Use Key Sequence property 183
Use Primary Join property 143
Use Range property

Assignment Attribute object type 104
User Event Name property

WF Step Branch object type 339
User Event Storage property

WF Step Branch object type 339
User Event Timeout (Days) property

WF Step Branch object type 339
User Interact View property

WF Step object type 333
User Kay Name property 185
User Key Attribute Join object type, about 

and properties (table) 251
User Key Attribute Name property

Foreign Key Mapping Column object 
type 185

User Key Attribute Tree Node object 
type 252

User Key Attribute object type, about and 
properties (table) 250

User Key Attribute Tree Node object type, 
about and properties (table) 251

User Key Column object type, about and 
properties (table) 252

User Key Flag property
Entity Attribute object type 188

User Key Name property 186
User Key object type, about and properties 

(table) 250
User Key Sequence property 244
User Key Type property 250
User Layout property 286
User Name property

Column object type 244
Dock Object object type 174
EIM Interface Table Column object 

type 183
EIM Interface Table object type 180
Index object type 247
Table object type 249

User Primary Key property 247
User Visible property 206

V
Valid Condition property

Column object type 244
EIM Interface Table Column object 

type 183
Validation Message property

Field Locale object type 135
Validation property

Field object type 130
Single Value Field object type 151

Value property
Applet Message Variable object type 40
Applet User Prop object type 44
Assignment User Prop object type 311
Business Component User Prop object 

type 123
Business Service Method Arg User Prop object 

type 159
Business Service User Prop object 
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type 161
Control User Prop object type 80
Dynamic Drilldown Destination object 

type 315
Field User Prop object type 135
Help Id object type 197
Integration Component Field User Prop object 

type 207
Integration Component User Prop object 

type 209
Integration Object User Prop object 

type 210
Join Constraint object type 137
List Column User Prop object type 90
Task Event IO Argument object type 261
Task Step IO Argument object type 269
View User Prop object type 285
Web Page Item Parameter object type 291

Value Type Code property
WF Step Recipient object type 341

Value Type property
Class User Prop object type 165

Value/Search Specification property
WF Step I/O Argument object type 340

Variable Row Height property 83
Version property

Task object type 255
Workflow Process object type 342

Vertical Line Position property 281
Vertical property 60
Vertical Scroll property 77
View Locale, about and properties 

(table) 283
View Name property

Content Object View object type 172
Find Pick View object type 195

View object type
about and properties (table) 278

View property
Drilldown Object object type 82
Find View object type 196
Screen View object type 228

View Task Group Locale object type, about 
and properties (table) 285

View Task Group object type, about and 
properties (table) 284

View User Prop object type, about and 
properties (table) 285

View Web Template Item Locale object type, 
about and properties (table) 288

View Web Template Item object type, about 
and properties (table) 286

View Web Template object type, about and 
properties (table) 286

Viewbar Text property
Screen Locale object type 226
Screen object type 225
Screen View Locale object type 229
Screen View object type 228

Virtual Field property
WF Process Prop object type 331

Visibility Applet property
View object type 282

Visibility Applet Type property 282
Visibility Auto All property

Link object type 213, 214
Pick List object type 221

Visibility Event Columns property
Dock Object Related DObj object type 175
Dock Object Visibility Rule object type 178

Visibility Event property 176
Visibility Field property 114
Visibility Level property 174
Visibility MVField property 114
Visibility MVLink property 114
Visibility property

Server Component Parameter object 
type 232

Server Component State Value object 
type 232

Server Component Statistic object 
type 233

Visibility Rule Applied property 214
Visibility Strength property

Dock Object Related DObj object type 175
Dock Object Table object type 176
Dock Object Visibility Rule object type 178

Visibility Type property
Drilldown Object object type 82
Link object type 214
Pick List object type 221

Visible - Language Override property
Control object type 77

Visible property
Control Locale object type 79
Control object type 77
Workflow Policy Program Arg object 

type 320
Volatile property

Table object type 249

W
Want Return property 77
Web Page Item Locale object type, about and 

properties (table) 290
Web Page Item object type, about and 

properties (table) 289
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Web Page Item Parameter object type, about 
and properties (table) 291

Web Page Locale object type, about and 
properties (table) 291

Web Page object type, about and properties 
(table) 288

Web Template object type, about and 
properties (table) 291

Web Template property
Applet Web Template object type 45
View Web Template object type 286
Web Page object type 289

WF Branch Connector object type, about and 
properties (table) 325

WF Branch Criteria object type, about and 
properties (table) 326

WF Branch Criteria Value object type, about 
and properties (table) 328

WF Process Metric object type, about and 
properties (table) 328

WF Process Prop object type, about and 
properties (table) 328

WF Step Branch object type, about and 
properties (table) 337

WF Step I/O Argument object type, about 
and properties (table) 339

WF Step object type, about and properties 
(table) 331

WF Step Recipient object type, about and 
properties (table) 340

Width - Language Override property
Control object type 77
List Column object type 88
Toolbar Item object type 274

Width property
Applet object type 36
Bitmap object type 110
Control Locale object type 79
Control object type 77
List Column Locale object type 90
List Column object type 88
Toolbar Item Locale object type 275
Toolbar Item object type 274

Workflow Column Name property 317
Workflow Component Column property

Assignment Attribute Column object 
type 105

Workflow Component property 105
Workflow Mode property

Workflow Process object type 343
Workflow Object Name property 317
Workflow Object property

Assignment Attribute Column object 
type 105

Workflow Policy Program object type 319
Workflow Policy Column object type

about and properties (table) 292
Workflow Policy Component Col object type, 

about and properties (table) 317
Workflow Policy Component object type, 

about and properties (table) 316
Workflow Policy Components

list, function of 316
Workflow Policy Object object type, about 

and properties (table) 318
Workflow Policy Program Arg object type, 

about and properties (table) 320
Workflow Policy Program object type

about and properties (table) 318
variables in messages, about and 

example 320
Workflow Process object type, about and 

properties (table) 341
Workflow Process property

Task Event object type 259
Write DB cache property 174

X
XA Attribute Value BusComp property 122
XA Class Id Field property 122
XML Container Element property 204
XML Literal Value property 206
XML Parent Element property 206
XML Sequence property

Integration Component Field object 
type 207

Integration Component object type 205
XML Style property 207
XML Tag property

Integration Component Field object 
type 207

Integration Component object type 205
Integration Object object type 210
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